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About This Guide

Novell Identity Manager is a data sharing and synchronization service that enables applications,
directories, and databases to share information. It links scattered information and enables you to

establish policies that govern automatic updates to designated systems when identity changes occur.

Identity Manager provides the foundation for account provisioning, security, single sign-on, user

self-service, authentication, authorization, automated workflows, and Web services. It allows you to
integrate, manage, and control your distributed identity information so you can securely deliver the
right resources to the right people.

This guide provides detailed information on using Designer 4.0.2 for Identity Manager 4.0.2.

*

*

*

Chapter 1, “Overview,” on page 15

Chapter 3, “Managing Policies with the Policy Builder,” on page 19
Chapter 4, “Using Additional Builders and Editors,” on page 43
Chapter 5, “Using the XPath Builder,” on page 73

Chapter 6, “Defining Schema Map Policies,” on page 79

Chapter 7, “Controlling the Flow of Objects with the Filter,” on page 95
Chapter 8, “Using Predefined Rules,” on page 111

Chapter 9, “Testing Policies with the Policy Simulator,” on page 147
Chapter 10, “Storing Information in Resource Objects,” on page 171
Chapter 11, “Using ECMAScript in Policies,” on page 177

Chapter 12, “Conditions,” on page 191

Chapter 13, “Actions,” on page 235

Chapter 14, “Noun Tokens,” on page 321

Chapter 15, “Verb Tokens,” on page 363

There are additional reference chapters for the pre-Identity Manager Policy Builder:

*

*

*

Chapter 2, “Using the Pre-Identity Manager 3.5 Policy Builder,” on page 17
Chapter 16, “Pre-Identity Manager 3.5 Builders,” on page 385

Chapter 17, “Pre-Identity Manager 3.5 Conditions,” on page 401

Chapter 18, “Pre-Identity Manager 3.5 Actions,” on page 429

Chapter 19, “Pre-Identity Manager 3.5 Noun Tokens,” on page 485
Chapter 20, “Pre-Identity Manager 3.5 Verb Tokens,” on page 511

Audience

This guide is intended for Identity Manager administrators.

About This Guide
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Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation and enter your comments there.

Documentation Updates

For the most recent version of Policies in Designer, visit the Identity Manager Documentation Web site
(http://www.netiq.com/documentation/idm402/).

Additional Documentation

For documentation on using the Identity Manager drivers, see the Identity Manager Driver
Documentation Web site (http://www.netiq.com/documentation/idm402drivers/index.html).

For more information on using Designer, see Understanding Designer for Identity Manager and the

Designer 4.0.2 for Identity Manager 4.0.2 Administration Guide.

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and
items in a cross-reference path.

Policies in Designer 4.0.2


http://www.netiq.com/documentation/idm402/
http://www.netiq.com/documentation/idm402drivers/index.html
http://www.netiq.com/documentation/idm402drivers/index.html

1.1

Overview

Policies manage the data that is synchronizing between the Identity Vault and the remote data store.
The policies are stored in the policy sets (see “Understanding Policy Components” in Understanding
Policies for Identity Manager 4.0.2.) Designer provides a wide set of tools for defining and debugging
policies to control how information flows from one system to another, and under what conditions.
The following sections explain how to use the tools that are provided to help manage the policies:

¢ Chapter 3, “Managing Policies with the Policy Builder,” on page 19

¢ Chapter 4, “Using Additional Builders and Editors,” on page 43

¢ Chapter 5, “Using the XPath Builder,” on page 73

¢ Chapter 6, “Defining Schema Map Policies,” on page 79

¢ Chapter 7, “Controlling the Flow of Objects with the Filter,” on page 95

¢ Chapter 8, “Using Predefined Rules,” on page 111

¢ Chapter 9, “Testing Policies with the Policy Simulator,” on page 147

¢ Chapter 10, “Storing Information in Resource Objects,” on page 171

¢ Chapter 11, “Using ECMAScript in Policies,” on page 177

This section also contains a detailed reference section to all of the elements in DirXML Script. For
more information on DirXML Script, see “DirXML Script DTD” in the Identity Manager 4.0.2 DTD
Reference.

¢ Chapter 12, “Conditions,” on page 191

¢ Chapter 13, “Actions,” on page 235

¢ Chapter 14, “Noun Tokens,” on page 321

¢ Chapter 15, “Verb Tokens,” on page 363

There are also reference sections for the pre-Identity Manager Policy Builder:

¢ Chapter 2, “Using the Pre-Identity Manager 3.5 Policy Builder,” on page 17
Chapter 16, “Pre-Identity Manager 3.5 Builders,” on page 385

*

*

Chapter 17, “Pre-Identity Manager 3.5 Conditions,” on page 401

*

Chapter 18, “Pre-Identity Manager 3.5 Actions,” on page 429

*

Chapter 19, “Pre-Identity Manager 3.5 Noun Tokens,” on page 485

*

Chapter 20, “Pre-Identity Manager 3.5 Verb Tokens,” on page 511

Policies

As part of understanding how policies work, it is important to understand the components of
policies.

¢ Policies are made up of rules.

Overview 15
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A rule is a set of conditions (see Chapter 12, “Conditions,” on page 191) that must be met before
a defined action (see Chapter 13, “Actions,” on page 235) occurs.

Actions can have dynamic arguments that derive from tokens that are expanded at runtime.
Tokens are broken up into two classifications: nouns and verbs.

¢ Noun tokens (see Chapter 14, “Noun Tokens,” on page 321) expand to values that are
derived from the current operation, the source or destination data stores, or some external
source.

¢ Verb tokens (see Chapter 15, “Verb Tokens,” on page 363) modify the concatenated results
of other tokens that are subordinate to them.

Regular expressions (see “Regular Expressions”in Understanding Policies for Identity Manager
4.0.2) and XPath 1.0 expressions (see “XPath 1.0 Expressions”in Understanding Policies for Identity
Manager 4.0.2) are commonly used in the rules to create the desired results for the policies.

A policy operates on an XDS document and its primary purpose is to examine and modify that
document.

An operation is any element in the XDS document that is a child of the input element and the
output element. The elements are part of the Novell nds . dtd; for more information, see “NDS
DTD” in the Identity Manager 4.0.2 DTD Reference.

An operation usually represents an event, a command, or a status.

The policy is applied separately to each operation. As the policy is applied to each operation in
turn, that operation becomes the current operation. Each rule is applied sequentially to the
current operation. All of the rules are applied to the current operation unless an action is
executed by a prior rule that causes subsequent rules to no longer be applied.

A policy can also get additional context from outside of the document and cause side effects
that are not reflected in the result document.

Policies in Designer 4.0.2



Using the Pre-ldentity Manager 3.5
Policy Builder

Designer contains two Policy Builders: the pre-Identity Manager 3.5 Policy Builder and the Identity
Manager 3.5 and Newer Policy Builder. The Policy Builders are similar except for the following:

¢ You can enable and disable trace only at the driver level in the pre-Identity Manager 3.5 Policy
Builder.
¢ The DirXML Script elements are different between the two builders.

These differences require two Policy Builders. For information on how to use both Policy Builders,
see Chapter 3, “Managing Policies with the Policy Builder,” on page 19, which documents the
Identity Manager 3.5 and Newer Policy Builder. The only difference is an additional icon that enables

¢ and disables #° tracing on rules, actions, conditions, and tokens.
For a list of the DirXML Script elements for the pre-Identity Manager 3.5 Policy Builder:
¢ Chapter 17, “Pre-Identity Manager 3.5 Conditions,” on page 401
¢ Chapter 18, “Pre-Identity Manager 3.5 Actions,” on page 429
¢ Chapter 19, “Pre-Identity Manager 3.5 Noun Tokens,” on page 485
¢ Chapter 20, “Pre-Identity Manager 3.5 Verb Tokens,” on page 511
For a list of the DirXML Script elements for the Identity Manager 3.5 and Newer Policy Builder:

¢ Chapter 12, “Conditions,” on page 191

¢ Chapter 13, “Actions,” on page 235

¢ Chapter 14, “Noun Tokens,” on page 321
¢ Chapter 15, “Verb Tokens,” on page 363

Using the Pre-Identity Manager 3.5 Policy Builder 17
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3.1

Managing Policies with the Policy
Builder

The Policy Builder is a complete graphical interface for creating and managing the policies that
define the exchange of data between connected systems.

¢ Section 3.1, “Accessing the Policy Builder,” on page 19

¢ Section 3.2, “Using the Policy Builder,” on page 21

¢ Section 3.3, “Creating a Policy,” on page 22

¢ Section 3.4, “Creating a Rule,” on page 26

¢ Section 3.5, “Creating an Argument,” on page 31

¢ Section 3.6, “Variable Selector,” on page 33

¢ Section 3.7, “Editing a Policy,” on page 37

¢ Section 3.8, “Viewing the Policy in XML,” on page 40

Accessing the Policy Builder

There are two different Policy Builders included in Designer: one that works with the new policy

features for Identity Manager 3.5 and newer, and an older one that does not support these features.

The Policy Builder version is determined by the version of Identity Manager. To set the version of
Identity Manager:

1 Open a project in Designer.

2 Click the Outline tab, then select the Show Model Outline icon %.
3 Right-click the server object, then click Properties.

4 Select the appropriate Identity Manager Version.

When the Identity Manager version is set to 3.5 or newer, the new Policy Builder is available. If the
version is set to anything older than 3.5, the old Policy Builder is available.

The Policy Builder can be accessed from the Model Outline view, from the Policy Flow view, or from

a policy set.

¢ Section 3.1.1, “Model Outline View,” on page 20
¢ Section 3.1.2, “Policy Flow View,” on page 20
¢ Section 3.1.3, “Policy Set,” on page 20

Managing Policies with the Policy Builder
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3.1.1 Model Outline View

1 Open a project in Designer.

2 Click the Outline view, then select the Show Model Outline icon .

3 Double-click a policy H listed in the Model Outline view or right-click and select Edit.

3.1.2 Policy Flow View

1 Open a project in Designer.

2 Select the Outline tab, then select the Show Policy Flow icon.

3 Double-click a policy in the Policy Flow view.

You can also right-click in the Policy Flow view, select Edit Policy, then select the policy you want
to edit.

3.1.3 Policy Set

1 Open a project in Designer.
2 Click the Outline view, then select the Show Model Outline icon.
3 Select the policy in the policy set, then click Edit the policy.
You can also right-click the policy in the policy set, then click Edit.

(2. Policy set &7 = O

Active Directory Driver Policy Sets
= K =
= L,_El/- Input Transformation
Er| InputTransform
Er| Password{Pub}-Sub Email Motifications
+ E- Oukput Transformation
+ g Schema Mapping

+ (B Filter

To see all of the information in the Policy Builder window without scrolling, double-click the policy
tab so the Policy Builder fills the entire window. To minimize the window, double-click the policy tab.
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Figure 3-1 Policy Builder Full Screen

¢ Design_doc - Developer £2 | "B Matching £ =0

F- BR ey 03 5 @

Policy Builder fﬁn

esign_doc/Design_doc. proj i_-

“H Matching, Publisher, Active Directory . entitlment DOCIDMTEST

¥ Policy Description

Rules

+
1‘\
AN SN SN SN

account entitlement: do not match existing accounts

remember relative position in hierarchy
veto out-of-scope events
match users based on NT logon name

match users based on full name

B 5 match everything else

“H Palicy Builder | XML Source | XML Tree

For information on using the Policy Builder, see Section 3.2, “Using the Policy Builder,” on page 21.

Using the

Policy Builder

The Policy Builder enables you to add, view, and delete the rules that make up a policy. You can also
use it to import and save policies and rules, and manage XML namespaces. The Policy Builder
contains the “Action Builder” on page 43 and the “Condition Builder” on page 50.

The following tips describe how to perform some common Policy Builder tasks:

Table 3-1 Common Policy Builder Tasks

Tasks Description
/ Disable Disables a policy, rule, condition, or action.
@ Enable Enables a policy, rule, condition, or action.

5 Disable Trace
50 Enable Trace
5 in the tool bar

& Edit

H Delete

Disables tracing on a rule, condition, or action.
Enables tracing on a rule, condition, or action.
Enables DirXML Script tracing on the policy.

Edits the name of a rule or edits the description of a
rule.

Deletes a rule or a policy.
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3.3

Policies in Designer 4.0.2

Tasks

Description

Q%Browse

= Add arule
z=Import

[L]save to File
.EDepon
:'?%Compare

&Policy Simulator

&;} Edit Namespace

BaXPath Builder

+| Expand

—| Collapse
i Move up
I+ Move down

[Hsave

Policy Description

Browses a list of values to use when populating a field.
Adds a new rule or a predefined rule.

Imports a policy from a file.

Saves a policy to a file.

Deploys a policy to the Identity Vault.

Compares the policy in the Policy Builder to an existing
policy in the Identity Vault.

Launches the Policy Simulator and tests the policies in
the Policy Builder.

Adds multiple XML namespaces to the rule or policy.

Launches the XPath Builder to create XPath
expressions.

Expands all of the rules in a policy.
Collapses all of the rules in a policy.

Moves a rule up in the policy.
Moves a rule down in the policy.

Click the save icon in the tool bar, click File > Save, or
press Ctrl+S to save your work.

Adds a comment to a policy or rule. Comments are
stored directly in the policy or rule, and can be as long
as necessary.

Creating a Policy

A policy sends data to the connected systems. A policy is created through the policy set.

¢ Section 3.3.1, “Accessing the Policy Set,” on page 23

¢ Section 3.3.2, “Using the Policy Set,” on page 23
¢ Section 3.3.3, “Using the Add Policy Wizard,” on page 24



3.3.1 Accessing the Policy Set

1 Select a driver object from the Outline view in an open project.

2 Select the Policy Set tab.

Active Directory Driver Policy Seks
v XK =
=R PR Input TransFormation
InputTransform
Password{Pub}-Sub Email Motifications
+ [B Oukput Transformation
+ [E achema Mapping

- Filker

3.3.2 Using the Policy Set

The policy set contains a toolbar and a list of policies.

The policy list displays all the policies contained in the selected policy set. During a transformation,
the policies within the list are executed from top to bottom. The toolbar contains buttons and a drop-
down menu that you can use to manage policies displayed in the list, including, editing, adding,
deleting, renaming, and changing the processing order of the policies.

Policy Set Toolbar

The policy set displays a copy of the policy. The buttons on the toolbar are enabled or disabled
depending upon the item you have selected. The different icons are described below.

Table 3-2 Policy Set Toolbar

Operation Description

ZEdit the policy Launches the Policy Builder.

& Create or add a new policy to the Policy Set Launches the Add Policy Wizard.

¥ Remove and delete the selected policy Deletes the policy from the project.

= Remove the selected policy from the Policy Set, but Removes the policy from the selected policy set object

do not delete it but doesn’t delete the policy.
4 Move the policy up the policy chain Moves the policy up in the processing order.
T Move the policy down the policy chain Moves the policy down in the processing order.

Keyboard Support

You can move through the policy set with keystrokes as well as using the mouse. The supported
keystrokes are listed below.
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Table 3-3 Keyboard Support

Keystroke Description

Up-arrow Moves the selected policy up in the processing order.

Down-arrow Moves the selected policy down in the processing
order.

Delete Deletes the policy from the project.

Minus Removes the policy from the selected policy set, but

does not delete it.

Plus Launches the Add Policy Wizard.
Ctrl+z Undoes the last operation.
Ctrl+Y Redoes the last operation.

3.3.3 Using the Add Policy Wizard

24

The Add Policy Wizard launches when you click the Create or add a new policy to the Policy Set icon in
the toolbar. The Add Policy Wizard enables you to do the following:

¢ “Creating a Policy” on page 24

¢ “Copying a Policy” on page 25

¢ “Linking to a Policy” on page 26
To launch the Add Policy Wizard:

1 Select a driver in the Outline view.

2 Select a policy set item in the policy set, then click Create or add a new policy to the Policy Set =r.

Creating a Policy

1 In the Add Policy Wizard, select Create a new policy, then click Next.

You can also add a policy by right-clicking a policy set in the Policy Flow view, selecting Add
Policy, then selecting how to create the policy:

DirXML Script
XSLT
Link To Existing

*

*

*

¢ Copy Existing
¢ Schema Map (Only displayed, if the Schema Map policy set is selected.)
2 In the Create Policy dialog box, specify a policy name, then click Next.

Select Open Editor after creating object to automatically launch the Policy Builder after creating
the new policy.
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Create Policy

i

Specify the name of the new palicy and the container where it will
be created,

Palicy Mame:

Policy Container:

Active Directory IDMDrivers. IDMDESIGNTREE

[ ] open Editor after creating object.

Accept the default container, or browse to and select the Driver, Publisher, or Subscriber object
where you want the policy to be created.

If a policy is not reused by multiple drivers, you typically create that policy under the driver or
channel that is using it.

This decision depends on how you want to organize the policies. By default, policies are placed
under the container object that is selected in the Outline tab when the Add Policy Wizard is
launched.

For example, if you move to a Publisher object in the Outline tab and then add a policy to a
policy set, the policy defaults to the Publisher container.

You can change this setting if you want to create policies in a different container. For example,
you can set up a policy library, put all of the common policies under this driver, and then simply
reference the policies from the other drivers. That way, the policy is common. If you need to
change a policy, you need to do it only once.

3 In the Select Type dialog box, select the type of policy you want to implement, then click Finish.

The policy type defaults to DirXML Script. You can select XSLT, if you don’t want to use DirXML
Script.

If you create a Schema Map policy set, an additional option is available for Schema Map.

The new policy appears in the expanded policy set.

Copying a Policy

1 In the Add Policy Wizard, select Copy a policy, then click Next.
2 In the Create Policy dialog box, provide the necessary policy information, then click OK.

¢ Specify a name for the new policy
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¢ Accept the default container, or browse to and select the Driver, Publisher, or Subscriber
object where you want the policy to be created.

¢ Browse to and select the policy you want to copy, then click Finish.

Copy Policy

Specify the name of the new policy, the container where it will be created and
the policy to be copied.

]

Palicy Mame:
Matching

Policy Conkainer:
Active Directory IDMDrivers. IDMDESIENTREE

Policy to be Copied:
Matching. Publisher . Active Directary, IDMDrivers, IDMDESIGMTR. | Browse. ..

[CJopen Editar after creating object.

Linking to a Policy

1 In the Add Policy Wizard, select Link a policy, then click Next.

2 In the Link Policy dialog box, click Browse to launch the model browser.

Link Policy E
Specify the existing policy ko link inko the Policy Set. —

Erowse, .,

3 Browse to and select the Policy object you want to link into the policy set, then click OK.

i |

Policy to Link:

Linking a policy into a policy set doesn’t create a new Policy object. Instead, it adds a reference to
an existing policy. This reference can be to any existing policy within the current Identity Vault.
It doesn’t need to be contained within the current Driver object, but the policy type must be valid
for the policy set that it is being linked to. For example, you can’t link a Schema Map policy into
an Input policy set.

Linking a policy into a policy set is not permitted when viewing all policies.

4 Click Finish to link to the selected policy.

3.4 Creating a Rule

A rule is a set of conditions that must be met before a defined action occurs. Rules are created from
condition groups, conditions, and actions.
Rules can be created in four different ways:

¢ Section 3.4.1, “Creating a New Rule,” on page 27

¢ Section 3.4.2, “Using Predefined Rules,” on page 29

¢ Section 3.4.3, “Including an Existing Rule,” on page 30

*

Section 3.4.4, “Importing a Policy From an XML File,” on page 30
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3.4.1 Creating a New Rule

When you create a rule, you create condition groups, conditions, and actions. Each rule is composed
of conditions, actions, and arguments. For more information, click the Help icon (Z) when creating
each item. The help files contain a definition and an example of the item being used.

¢ “Creating a Rule” on page 27

¢ “Creating a Conditional Group” on page 28

¢ “Creating a Condition” on page 29

¢ “Creating an Action” on page 29

Creating a Rule

Policy Builder includes a wizard to step you through the process of creating a rule.

NOTE: On any of the wizard dialog boxes, you can click Finish to exit the wizard and create a rule
with the details you have specified to that point.

1 In Policy Builder toolbar, click Rule 3= .
2 In the Name and Describe Rule dialog box, specify the name of the rule, then click Next.

3 In the Select the Condition Structure dialog box, select the rule’s condition structure, then click
Next.

You can choose OR Conditions, AND Groups or AND Conditions, OR Groups.

4 In the Define the Condition dialog box, select the condition you want, specify the appropriate
information, then click Next.

Define the Condition

Select the values ko complete the synkax of the condition, Yalues with an * are required ko be valid,
The first condition is automatically inserted inta & new condition group,

Condition 1 of Graup 1

Condition | attribute v
Mame * | GivenMame 4“_1; k;': &
Operator * | nok available "

The icons next to the Name field let you browse the Identity Vault schema, the connected
application schema, or use the Variable Selector to select the appropriate information.

5 In the Continue Defining Conditions dialog box, select the appropriate option, then click Next.

If desired, you can define additional conditions or condition groups before proceeding. For this
example, there is only one condition.

Managing Policies with the Policy Builder 27



28

Continue Defining Conditions?

=i

Select whether to continue defining your condition or proceed ko defining actions For
wour rule,

Select one:
() Continue {Define actions For the rule)
() Define another condition in the same condition group

(") Define a new condition in & new condition group

6 In the Define the Action dialog box, select the action that you want, then click Next.
7 In the Continue Defining Actions dialog box, select the appropriate option, then click Next.

If desired, you can define additional actions before proceeding. For this example, there is only
one action.

8 In the Summary page, click Finish to create the rule.

You can expand or collapse the view of the rule by clicking the plus or minus sign.

Summary P’
¥

The Faollowing is a summary of the new rule to be created, =

Rule Summary

=l Reguire Users to have Given Mame
= Conditions
=|-Group 1
if aktribute 'Given Mame' not available
= Ackions
wetbol)

Creating a Conditional Group

1 In the Policy Builder, right-click the Conditions tab then click Append Condition Group.

You can also right-click the name of the Condition Group, then click New > Insert Condition Group
Before or Insert Condition Group After.

Change the condition for the Condition Groups by clicking the And/Or icon.

" % Condition Group 1

v 5 if attribute 'Given Mame' nok available

& i attribute 'Surmname’ nok available

% Condition Group 2
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Creating a Condition

1 Right-click the condition, then click New > Insert Condition Before or Insert Condition After.

Conditions

" % Condition Group 1

if aktribute 'Siven Mame' gok avalable

"% Insert Condition Befare. ..
22 Edit... +~ Insert Condition After. ..

Ackions

You can change the condition by clicking the And/Or icon.

Conditions

.~ % Condition Group 1
v & i attribute 'Given Mame' not available
And
/% Condition Group 2

v % i attribute 'Surname’ not available

Creating an Action

1 Right-click the action, then click New > Insert Action Before or Insert Action After.

Conditions

% Condition Group 1

v & if attribute 'Given Mame' not available

s ¢ [

‘ £ Edit... & Insert Action After..,

E_uf Insert Action Before, .

3.4.2 Using Predefined Rules

Designer includes a list of predefined rules. You can import and use these rules as well as create your
own rules.

1 Right-click in the Policy Builder and select New > Predefined Rules > Insert Predefined Rule Before or
Insert Predefined Rule After.
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See Chapter 8, “Using Predefined Rules,” on page 111 for more information.

Rules

Predefined Ruls L4 "';j Insert Predefined Rule Before. ..
2 o Include | BB 1nisert Predefined Rule after...
- ot Append Condition Group, ..

3.4.3 Including an Existing Rule

Designer allows you to include the rules from another policy.

1 Right-click in the Policy Builder and click New > Include > Insert Include Before or Insert Include

After.
Rules

v 7 e N

ule
v & Sende (== Import Policy From File. .. Predefined Rule + Manager data store pas:
d B = - e v,
Edit... . ’
& Ed Append Condition Group. .. = Insert Include After. ..

2 Click the Browse icon C&

3 Browse to the policy 2 you want to include, then click OK.
4 The field is now populated with the path to the policy. Click OK.

Palicy ta Inchude: | . JPublisheriMatching |

[#]55et DM relative to policy: oK l [ Cancel ]

The rule is a link to the original rule. You cannot edit the rule in this location. Access the original
rule to make changes.

Rules

v 5 Require Users bto have Given Mame

WA Include .. Publisher'Matching

3.4.4 Importing a Policy From an XML File

Rules and policies can be saved as XML files. If you have a file that contains a rule or a policy you
want to use, the Policy Builder allows you to import the file.

1 In the Policy Builder, right-click and select Import Policy from file.
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Rules

Hv Z

v 5 Se B Import Policy From File. ..

2 Select one of the two options: Append the rules from the imported policy or Replace the rules from the
imported policy.

(#)iappend the rules from the imported policy:

() Replace the rules from the imported policy

Specify the DirsML Scripk File to import,

Ok H Zancel ]

3 Click the browse icon and select the file that contains the policy, then click Open.
4 Click OK.

Creating an Argument

The Argument Builder provides a dynamic graphical interface that enables you to construct complex
argument expressions for use within the Policy Builder. To access the Argument Builder, see
“Argument Builder” on page 45.

Arguments are dynamically used by actions and are derived from tokens that are expanded at run
time.

Tokens are broken up into two classifications: nouns and verbs. Noun tokens expand to values that
are derived from the current operation, the source or destination data stores, or some external source.
Verb tokens modify the results of other tokens that are subordinate to them.

To define an expression, select one or more noun tokens (values, objects, variables, etc.), and combine
them with verb tokens (substring, escape, uppercase, and lowercase) to construct arguments.
Multiple tokens are combined to construct complex arguments.
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Figure 3-2 Argument Builder

Create and edit arguments

Add or remove vour compaonents to the expression area bo construct waur argument, Specify component values in the

Editor.

B Expression @ (7 &5 Mouns = v

Z* Editor * pequired

Texk

Added Entitlerment
Association
Aktribute
Character b

Yerbs dh v

asend Decode
Basetd Encode
Canverk Time
Escape Destination DM
Escape Source DN
Jain
Lowercase
Map
Parze DN

<

% Description

Canstant kext,

For example, if you want the argument set to an attribute value, you select the attribute noun, then

select the attribute name:

1 Double-click Attribute in the list of noun tokens to add it to the Expression pane.

&4 Mouns &

Texk A
Added Entitlement

Association

Character

Class Mame

Destination Atkribute

Destination DM

Destination MName

Document

Entitlement 5

2 Browse to and select the attribute name in the Editor field.

2# Editor * Required

Mame: * | Given Mame & g &

You can browse the Identity Vault schema or the connected application schema.
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3.6

If you only want a portion of this attribute, you can combine the attribute token with the

substring token. The expression displays a substring length of 1 for the Given Name attribute

combined with the entire Surname attribute.

= A % Substring(length="1", Attribute("Given Narme"}}

& & Attribute("Given Mame")
& & Attribuke("Surname")

After you add a noun or verb, you can provide values in the editor, then immediately add another
noun or verb. You do not need to refresh the Expression pane to apply your changes; they appear

when the next operation is performed.

See “Noun Tokens” on page 321 and “Verb Tokens” on page 363 for a detailed reference on the noun
and verb tokens. See “Argument Builder” on page 45 for more information on the Argument Builder.

Variable Selector

The variable selector provides a list of variables that you can select and insert into conditions, actions,

and tokens.

VYariable Selector

Select a local wariable From the list,

LCY Selector . GCY Selector

@ variable Selector E]

current-node
currenk-op
current-value
Framids

Policy Scope . Driver Scope | Error Yariables

@ [ ok

] [ Cancel

*

*

*

*

*

Section 3.6.5, “XPath Expressions,” on page 37

Section 3.6.1, “Dynamic Variable Expansion,” on page 34

Section 3.6.2, “Accessing the Variable Selector From the Conditions Tab,” on page 34
Section 3.6.3, “Accessing the Variable Selector From the Actions Tab,” on page 35
Section 3.6.4, “Accessing the Variable Selector From the Argument Builder,” on page 36
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3.6.1

3.6.2

Dynamic Variable Expansion

The variable selector allows for the use of dynamic variable expansion in conditions, actions, and
tokens. It is used when the writer of the DirXML script doesn’t know what value to enter during the
design phase, and wants the value to be populated dynamically when the code is run (for local
variables) or when the driver starts (for global variables). Dynamic variables are not used when the
policy needs to refer directly to the variable itself. Instead, they are used when the policy needs to
refer to the value of the variable.

Many actions support dynamic variable expansion in their attributes or content. Where supported,
an embedded reference of the form $variable-name$ is replaced with the value of the local variable
with the given name. An embedded reference of the form ~variable-name~ is replaced with the value
of the global variable name. $variable-name$ and ~variable-name~ must be legal variable names. For
information on what constitutes a legal XML name, see W3C Extensible Markup Language (XML)
(http://www.w3.0rg/TR/2006/REC-xml111-20060816/#sec-suggested-names).

If the given variable does not exist, the reference is replaced with the empty string. Where it is
desirable to use a single $ and not have it interpreted as a variable reference, use an additional $ as an
escape character (for example, You owe me $$100.00).

NOTE: If the global variable doesn’t exist on the driver or driver set, the driver does not start.

Accessing the Variable Selector From the Conditions Tab

1 In the Policy Builder, double-click the Conditions tab.

For instructions on accessing the Policy Builder, see Section 3.1, “Accessing the Policy Builder,”
on page 19.

2 Select one of the following conditions:
¢ If Attribute (page 194)
¢ If Destination Attribute (page 200)
¢ If Entitlement (page 204)
¢ If Global Configuration Value (page 207)
¢ If Local Variable (page 209)
¢ If Named Password (page 213)
¢ If Operation Attribute (page 217)
¢ If Source Attribute (page 226)

-3
3 Click the Launch variable browser icon > next to the field where you want to insert a dynamic
variable.

4 Select the variable, then click OK.
Or, for conditions that don’t bring up the Launch variable browser icon:

1 Select one of the following operators:
¢ Equal
¢ Greater than
¢ Less than

¢ Not equal
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¢ Not greater than
* Not less than

2 Click the Launch variable browser icon next to the field where you want to insert the dynamic
variable.

3 Select the variable, then click OK.

3.6.3 Accessing the Variable Selector From the Actions Tab

1 In the Policy Builder, double-click the Actions tab.

For instructions on accessing the Policy Builder, see Section 3.1, “Accessing the Policy Builder,”
on page 19.

2 In the Do field, select one of the following options:
¢ Add Destination Attribute Value (page 238)
¢ Add Destination Object (page 240)
¢ Add Role (page 242)
¢ Add Source Attribute Value (page 246)
¢ Add Source Object (page 247)
¢ Append XML Element (page 248)
¢ Append XML Text (page 250)
¢ Clear Destination Attribute Value (page 253)
¢ Clear Source Attribute Value (page 255)
¢ Clear SSO Credential (page 256)
¢ Clone By XPath Expressions (page 257)
¢ Clone Operation Attribute (page 258)
¢ Delete Destination Object (page 260)
¢ Delete Source Object (page 261)
¢ Move Destination Object (page 272)
¢ Move Source Object (page 274)
¢ Reformat Operation Attribute (page 275)
¢ Remove Destination Attribute Value (page 278)
¢+ Remove Role (page 279)
¢ Remove Source Attribute Value (page 283)
¢ Rename Destination Object (page 284)
¢ Rename Operation Attribute (page 285)
¢ Rename Source Object (page 286)
¢ Send Email from Template (page 289)
¢ Set Default Attribute Value (page 291)
¢ Set Destination Attribute Value (page 293)
¢ Set Destination Password (page 295)
¢ Set Local Variable (page 296)Set Source Attribute Value (page 304)
¢ Set Source Password (page 306)
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¢ Set SSO Credential (page 307)

¢ Set SSO Passphrase (page 308)

¢ Set XML Attribute (page 309)

¢ Start Workflow (page 310)

¢ Strip Operation Attribute (page 313)

¢ Strip XPath Expression (page 314)

¢ Veto If Operation Attribute Not Available (page 318)

=
3 Click the Launch variable browser icon — next to the field where you want to insert the dynamic
variable.

4 Select the variable, then click OK.

3.6.4 Accessing the Variable Selector From the Argument Builder

1 In the Argument Builder, select one of the following noun tokens from the Nouns section:
¢ Text (page 323)
¢ Added Entitlement (page 325)
¢ Attribute (page 327)
¢ Destination Attribute (page 330)
¢ Entitlement (page 336)
¢ Generate Password (page 337)
¢ Global Configuration Value (page 338)
¢ Local Variable (page 339)
¢ Named Password (page 341)
¢ Operation Attribute (page 344)
¢ Query (page 348)
¢ Removed Attribute (page 350)
¢ Removed Entitlement (page 351)
¢ Source Attribute (page 353)
¢ Time (page 356)
¢ Unique Name (page 357)
¢ XPath (page 361)
Or, select one of the following verb tokens from the Verbs section:
¢ Convert Time (page 366)
¢+ Map (page 372)

=
2 Click the Launch variable browser icon > next to the field where you want to insert the dynamic
variable.

3 Select the variable, then click OK.
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3.6.5

3.7

3.7.1

XPath Expressions

Instead of using the DirXMLScript engine to perform the variable expansion, as is the case with most
variable expansion, XPath uses built in XPath functionality and the XSLT processor to do the variable
expansion.

For conditions, actions, and tokens that contain XPath expressions, a single $ sign at the beginning of
the policy denotes a dynamic variable, which is displayed in the Value field. This is also true for the
XPath token in the Argument Builder, and for all actions that contain XPath. This is because in order
to maintain valid XPath, only one $ sign can be used.

The following procedure gives an example of using the variable selector with XPath expressions:

1 In the Policy Builder, click the Actions tab.
2 In the Do field, select the clone by XPath expressions option.

=3
3 After the Specify source XPath expression field, click the Launch variable browser icon =
4 Select an item and click OK.
Only one $ sign is displayed before the policy.

Editing a Policy

The Policy Builder allows you to create and edit policies. You can drag and drop rules, conditions and
actions. For additional operations, access the Policy Builder toolbar. To display a context menu, right-
click an item.

¢ Section 3.7.1, “Actions and Menu Items in the Policy Builder,” on page 37

¢ Section 3.7.2, “Keyboard Support,” on page 39

¢ Section 3.7.3, “Renaming a Policy,” on page 39

¢ Section 3.7.4, “Saving Your Work,” on page 39

¢ Section 3.7.5, “Policy Description,” on page 40

Actions and Menu Items in the Policy Builder
The table contains a list of the different actions and menu items in the Policy Builder.

Table 3-4 Policy Builder Actions and Menu Items

Operation Description

= Collapse All Collapses all expanded rules.

Compares the policy in the Policy Builder to an existing

= .
=ZCompare Deployed Polic
s P Pioy 4 policy in the Identity Vault.

E2Copy Copies the selected item to the Clipboard.

Copy and drop Select the item, press Ctrl, then drag the item.
«#Cut Cuts the selected item and copies it to the Clipboard.
¥ Delete Deletes the selected item.
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Operation

Description

.EDepon Policy

@ Disable
5 Disable Trace

z DirXML Script Tracing

Drag and drop

& Edit

v Enable

59 Enable Trace

+| Expand All

z=Import Policy from file

cLaunch Policy Simulator

Move and drop

4 Move down
1 Move up
New > Append Condition Group

New > Include > Insert Include Before or Insert Include
After

New > Predefined Rule > Insert Predefined Rule
Before or Insert Predefined Rule After

New > Rule > Insert Rule Before or Insert Rule After

[BPaste

i-|Preferences

r*\D Redo

Select

‘1:11 Undo

Deploys the policy into the Identity Vault.

Displays a rule, condition, or action as disabled.
Disables trace on the rule.

Enables DirXML Script Tracing on the policy.
Enables you to select an item, then relocate it. Select

the item, then drag it to the new location.

Enables you to edit the selected item. To open the
Rule Builder, select a rule, then click Edit.

Displays a rule, condition, or action as enabled.

Enables tracing on the rule.
Expands all the rules so that you can view the
conditions and actions of each rule.

Imports a policy from the file system and appends it to
the policy, or replaces all the rules of the policy.

Launches the Policy Simulator.

Enables you to select and move an item. Select the
item, then drag it.

Moves the item down in the list of policies.
Moves the item up in the list of policies.

Creates a new condition group after a selected item.

Creates a new Include before or after the selected
item.

Inserts a predefined rule before or after the selected
item.

Creates a new rule before or after the selected item.

Pastes the contents of the Clipboard after the selected
item.

Enables you to change how the information is
displayed.

Redoes the previous action.

Click any item to select it.

Undoes the previous action.
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3.7.2 Keyboard Support

You can move through the Policy Builder with keystrokes as well as using the mouse. The supported

keystrokes are listed below.

Table 3-5 Keyboard Support in the Policy Builder

Keystroke Description

Ctrl+C Copies the selected item into the Clipboard.

Ctrl+X Cuts the selected item and adds it to the Clipboard.

Ctrl+Vv Pastes the contents of the Clipboard after the selected
item.

Delete Deletes the selected Item.

Left-arrow Collapses a rule node.

Right-arrow Expands a rule node.

Up-arrow Navigates up.

Down-arrow Navigates down.

Ctrl+z Undo

Ctrl+Y Redo

3.7.3 Renaming a Policy

1 In the Outline view, select the policy you want to rename.
2 Right-click and select Properties.
3 Change the name of the policy in the Policy Name field.

1. General

Policy Mame: | Match

4 Click OK.

3.7.4  Saving Your Work

Do one of the following:

¢ From the main menu, click File > Save (or Save All).

¢ Close the editor by clicking the X in the editor’s tab.

*

Select Close from the main menu’s file menu.
Press Ctrl+S.

*
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3.7.5 Policy Description

The description fields provide a place to add notes about the functionality of the policy. You can add
a description for the policy and you can add a description for the rule.

1 In the Policy Builder, click Policy Description.

Policy Builder for IDM 3.5 and Newer 2 ~ ._E :'-% o Sir:- & 7w

match, Publisher, Active Directory, Driver Set, Identity Waolk

= Policy Description

2 Provide a description of the policy.
3 Save the policy by pressing Ctrl+S.

To add a description to a rule:

1 Double-click the name of the rule.

Rules

B Require User to have Given Name'

Mo description available

Mame | Require User ko have Given Mame

«<Specify Description and Comments =
Descripkion

2 Specify a description of the rule in the Description field.
3 Save the rule by pressing Ctrl+S.

3.8 Viewing the Policy in XML

Designer enables you to view, edit, and validate the XML by using an XML editor. Click the XML
Source or XML Tree tabs to access the XML editor. For more information about the XML editor, see
“The Novell XML Editor” in the Designer 4.0.2 for Identity Manager 4.0.2 Administration Guide.
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Figure 3-3 View Policy in XML

¢ Policy Description

Rules
v & remember relative position in hierarchy
¥ 5 veto out-of-scope events
v 5 match users based on NT logon name
v % match users based on full name
v & match everything else

i Policy Build ML Source | <ML Tree
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411

Using Additional Builders and Editors

Although you define most arguments in the Argument Builder, there are several more builders and
editors that are used by the Condition editor and Action editor in the Policy Builder. Each builder can
recursively call anyone of the builders in the following list:

¢ Section 4.1, “Action Builder,” on page 43

¢ Section 4.2, “Actions Builder,” on page 44

¢ Section 4.3, “Argument Builder,” on page 45

¢ Section 4.4, “Condition Builder,” on page 50

¢ Section 4.5, “Conditions Builder,” on page 52

¢ Section 4.6, “Match Attribute Builder,” on page 53

¢ Section 4.7, “Action Argument Component Builder,” on page 55

¢ Section 4.8, “Argument Value List Builder,” on page 56

¢ Section 4.9, “Named String Builder,” on page 57

¢ Section 4.10, “Condition Argument Component Builder,” on page 58

¢ Section 4.11, “Pattern Builder,” on page 59

¢ Section 4.12, “String Builder,” on page 61

¢ Section 4.13, “XPath Builder,” on page 61

¢ Section 4.14, “Mapping Table Editor,” on page 61

¢ Section 4.15, “Global Configuration Value Definition Editor,” on page 66

¢ Section 4.16, “Namespace Editor,” on page 68

¢ Section 4.17, “Local Variable Selector,” on page 70

Action Builder

The Action Builder enables you to add, view, and delete the actions that make up a rule. Actions can
also contain other actions.

Creating an Action

1 In the Policy Builder, create a new rule or edit an existing rule.

2 Double-click the Actions tab to launch the Action Builder.
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Define new action belaw

Do | <Select an action=

3 Select the desired action from the drop-down list, then click OK.

Additional Options for the Action Builder

There are additional options in the action builder to manage the actions. Right-click the action to see

the additional options.

Table 4-1 Action Builder Additional Options

Option

Description

New > Insert Action Before

New > Insert Action After

& Edit

1 Move up

I Move down
o Cut
E=Copy

[BPaste
K Delete
= Undo

r*\D Redo

s-|Preferences

Adds a new action before the current action.

Adds a new action after the current action.

Launches the Action Builder.

Moves the selected action up in the order of execution.
Moves the selected action down in the order of execution.
Cuts the selected action and adds it to the clipboard.
Copies the action to the clipboard.

Pastes the action that is in the clipboard to the desired location in the
Action Builder.

Deletes the selected action.
Undoes the prior action.
Redoes the prior action.

Allows you to set default functionality in the Policy Builder.

4.2 Actions Builder

The Actions Builder allows you to create an action inside of another action. To launch the Actions

Builder, select one of the following actions, then click the Edit the actions icon .

¢ For Each (page 265)

¢ Implement Entitlement (page 271)
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+ If (page 269)
¢ While (page 319)

In the following example the add destination attribute value action is performed for each Group
entitlement that is being added in the current operation.

Figure 4-1 For Each Action

Do [For each v | 7
Specify node set: * | Added Entitlement"Group™)
Specify ackion: * | do-add-dest-attr-walue

To define the action of the add destination attribute value, click the Edit the actions icon. This launches
the Actions Builder. In the Actions Builder, you define the desired action. In the following example,
the member attribute is added to the destination object for each added Group entitlement.

Figure 4-2 Actions Builder

Lo |add destination attribute value v (7
Specify attribute narme: * | Member 'J;' 'F: -3
Specify class name: | Group Q@ & &
Select mode: | add ko current aperation W
Select object: | DR W
Specify DM * | Local Yariable!"current-node™)

Specify value bvpe: | string

Enter string: * | Destination DR

4.3 Argument Builder

The Argument Builder provides a dynamic graphical interface that enables you to construct complex
argument expressions for use within Rule Builder.
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Figure 4-3 Argument Builder

Create and edit arguments .
Add ar remowe your components ko the expression area bo construck wour argument. Specify component values in the ﬂ =
Editor.
= Expression i) {7} & Nouns = o

Texk ~

Added Entitlement

Association

Attribuke

Characker e
Yerbs g

Basetd Decode
Baseéd Encode
Canvert Time

Escape Destination DM
Escape Source DN

Jain

Lowercase

Map

Parse DN e
# Editor *Required @ pageription @

Zonskank bexk,

The Argument Builder consists of six separate sections:

Nouns: Contains a list of all of the available noun tokens. Double-click a noun token to add it to the
Expression pane. See “Noun Tokens” on page 321 for more information.

Verbs: Contains a list of all of the available verb tokens. Double-click a verb token to add it to the
Expression pane. See “Verb Tokens” on page 363 for more information.

Description: Contains a brief description of the selected noun or verb token. Click the Help icon to
launch additional help.

Expression: Contains the argument that is being built. Multiple noun and verb tokens can be added
to a single argument. Tokens can be arranged in different orders through the Expression pane.

Editor: Provide the values for the nouns and the verbs in the Editor pane.

Toolbar: Allows you to manipulate the noun and verb tokens. See Table 4-2 for a list of all of the
options in the toolbar.

Table 4-2 Argument Builder Toolbar Options

Option Description

¥ Delete Deletes the selected token.
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Option

Description

o Cut
Copy

[@ Paste

i+ Move Up

I+ Move Down
@' Help

=5F Append noun

':II:II:I Insert noun

- Append noun to child token
list

=- Insert noun at beginning of
child token list

5¢ Append verb

5P Insert verb

% Append verb to child token
list

. Insert verb at beginning of
child token list

Cuts the selected token to the Clipboard.

Copies the selected token to the Clipboard.

Pastes the token from the Clipboard into the Argument Builder.
Moves the selected token up.

Moves the selected token down.

Launches the help.

Appends a noun token to the end of the argument as a sibling token.

Inserts a noun token into the argument.

Appends a noun token as a child token instead of as a sibling token.

Inserts a noun token into the argument as the first child in the token list
instead of as a sibling token.

Appends a verb token to the end of the argument as a sibling token.
Inserts a verb token into the argument.

Appends a verb token as a child token instead of as a sibling token.

Inserts a verb token into the argument as the first child in the token list
instead of as a sibling token.

You can select to trace each token or disable the tracing of the token in the Argument Builder. To

disable tracing:

1 Click the trace icon to disable tracing.

% Attributef"Given Mame")

To enable tracing;:

1 Click the disable trace icon to enable tracing.

. Atkribuke!"Given Mame", notrace="truz")

¢ Section 4.3.1, “Launching the Argument Builder,” on page 48

¢ Section 4.3.2, “Argument Builder Example,” on page 49
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4.3.1 Launching the Argument Builder

To launch the Argument Builder, select one of the following actions, then click the Edit the arquments
icon [El.

*

*

Add Association (page 237)

Add Destination Attribute Value (page 238)

Add Destination Object (page 240)

Add Source Attribute Value (page 246)

Append XML Text (page 250)

Clear Destination Attribute Value (page 253) (when the selected object is DN or Association)
Clear Source Attribute Value (page 255) (when the selected object is DN or Association)
Delete Destination Object (page 260) (when the selected object is DN or Association)
Delete Source Object (page 261) (when the selected object is DN or Association)

Find Matching Object (page 262)

For Each (page 265)

Move Destination Object (page 272)

Move Source Object (page 274)

Reformat Operation Attribute (page 275)

Remove Association (page 277)

Remove Destination Attribute Value (page 278)

Remove Source Attribute Value (page 283)

Rename Destination Object (page 284) (when the selected object is DN or Association and Enter
String)

Rename Source Object (page 286) (when the selected object is DN or Association and Enter
String)

Set Destination Attribute Value (page 293) (when the selected object is DN or Association and
Enter Value Type is not structured)

Set Destination Password (page 295)
Set Local Variable (page 296)

Set Operation Association (page 298)
Set Operation Class Name (page 299)
Set Operation Destination DN (page 300)
Set Operation Property (page 301)

Set Operation Source DN (page 302)
Set Operation Template DN (page 303)
Set Source Attribute Value (page 304)
Set Source Password (page 306)

Set XML Attribute (page 309)

Status (page 312)

Trace Message (page 315)
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4.3.2 Argument Builder Example

The following example creates an argument for a username from the first letter of the first name and
the entire last name:

1 Double-click Attribute from the list of nouns.

4 Nouns o

Text ~
added Enkitlemnent

Associakion

haracker

lass Mame

Destination Attribuke

Destination DM

Destination Marme

Docurnent

Enkitlement i

2 Specify or select the Given Name attribute.

£ Editor * Required

Mame: * | Given Hame & & &

You can browse the Identity Vault attributes, the application attributes, or launch the variable
browser. For more information on the variable browser, see Section 3.6, “Variable Selector,” on

page 33.
3 Double-click Substring from the list of verbs.

Yerbs 9 T

Map ~
Parse DN

Replace ol

Replace First

Silit

Uppetcase
xML Parse
*ML Serialize b

4 Type 1 in the Length field.

22 Editor
Skart: | 0O
Length: |1

5 Select the Given Name attribute, then click the Move Down icon.
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I EXpression *x Of' Eeé @ @

% Aktributed"Given Mame")

/& Substring(length="1")

6 Double-click Attribute from the list of nouns.

7 In the Name field, specify or browse to the Surname attribute.

2= EXpression

B ./ & Substringilength="1"}
& & Aktribube!"Given Name")

e Btribute"Surname")

The argument takes the first character of the Given Name attribute and adds it to the Surname
attribute to build the desired value.

8 Click Finish to save the argument.

4.4 Condition Builder

The Condition Builder enables you to add, view, and delete the conditions that make up a rule. A
condition contains one or more conditions and one or more condition groups. The condition groups
contain two different condition structures, which define the logic of condition groups. The two
condition structures are:

¢ OR Conditions, AND Groups
¢+ AND Conditions, OR Groups

To create and customize a condition, see the following sections:

¢ Section 4.4.1, “Creating a Condition,” on page 50

¢ Section 4.4.2, “Additional Options for the Condition Builder,” on page 51

4.4.1 Creating a Condition

1 In the Policy Builder, create a new rule or edit an existing rule.

2 Double-click the Conditions tab to launch the Condition Builder.
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4.4.2

ondikions

.~ % Condition Group 1

Define new condition below

Condition | Select a condition

3 Select the desired condition from the drop-down list, then click OK.

Additional Options for the Condition Builder

There are additional options in the condition builder to manage the conditions. Right-click the

condition to see the additional options.

Table 4-3 Condition Builder Options

Option

Description

New > Insert Condition Before

New > Insert Condition After

& Edit

1 Move up

I Move down

= Cut
E2Copy

[BPaste

H Delete
‘ff) Undo
r*\::?’Redo

[EZPreferences

Adds a condition before the current condition.

Adds a condition after the current condition.

Launches the Condition Builder.

Moves the selected condition up in the order of execution.
Moves the selected condition down in the order of execution.
Cuts the select condition and adds it to the clipboard.
Copies the condition and adds it to the clipboard.

Pastes the condition that is in the clipboard in the desired location
in the Condition Builder.

Deletes the selected condition.
Undoes the prior action in the Condition Builder.
Redoes the prior action in the Condition Builder.

Allows you to set default functionality in the Policy Builder.

For additional information on the Condition Builder and the rules, see Section 3.4, “Creating a Rule,”

on page 26.
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4.5 Conditions Builder

The Conditions Builder allows you to create a condition inside of an action. To launch the Conditions

Builder, select one of the following actions, then click the Edit the actions icon [E next to the If
conditions field.

+ If (page 269)
¢ While (page 319)

1 In the Conditions Builder, browse to and select the desired condition.

Create a list of Conditions

i

=

Create, delete, or rearrange a list of conditions.

Condition List S He R 4A£BRB ¢+ 3 @

& Conditian Group 1

v 5 Define new condition below

Condition |Select a condition v @

QK | [ Cancel * Fequired

< b4

2 Define the condition, then click OK.

The Conditions Builder has additional options that the Condition Builder. Right-click the Conditions
Builder.

Table 4-4 Conditions Builder Options

Option Description

New > Insert Condition Group Before Adds a condition group before the selected condition
group.

New > Insert Condition Group After Adds a condition group after the selected condition
group.

Append Conditions Appends a condition in the condition group.

Expands all conditions that are part of the selected

+| Expand All Conditions condition group

Collapses all conditions that are part of the selected

—| Collapse All Conditions .
condition group.

i+ Move up Moves the selected condition group up in the rule.

I Move down Moves the selected condition group down in the rule.

«#Cut Cuts the selected condition group from the rule and
adds it to the clipboard.

EECopy Copies the selected condition group and adds it to the
clipboard.
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4.6

Option Description

[BPaste Pastes the condition group from the clipboard into the
Conditions Builder.

¥ Delete Deletes the selected condition or condition group.

< Undo Undoes the prior action in the Conditions Builder.

> Redo Redoes the prior action in the Condition Builder.

“-|Preferences Allows you to set default functionality in the Policy

Builder.

If you have multiple conditions and conditions groups, the And/Or icons are tied together. If you
change the And/Or icon for the condition groups, it is changed for the conditions as well.

Figure 4-4 Conditions Builder And/Or Icons

Create a list of Conditions

Create, delete, or rearrange a lisk of conditions.

Condition List 2 H+ R A£A£BEB T @
& tCandition Group 1

W 5 if aktribute 'Given Mame' available

and o & i attribute ‘Surname’ available

& tCondition Group 2

v 5 if association available

Match Attribute Builder

The Match Attribute Builder enables you to select attributes and values used by the Find Matching
Object (page 262) action to determine if a matching object exists in a data store.

For example, if you wanted to match users based on a common name and a location:

1 Select the action of find matching object.
2 Select the scope of the search for the matching objects. Select from entry, subordinates, or subtree.

3 Specify the DN of the starting point for the search.
4 Click the Edit match attributes icon E{ to launch the Match Attribute Builder.
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Do |find matching object v| )]

Select scope: |su|:|tree V|
Specify DM | "Nowvel” |
Specify match attribukes: |

5 Click the Browse the Identity Vault attributes icon, the Browse application attributes icon, or the
Launch variable browser icon. For more information on the Launch variable browser icon, see
Section 3.6, “Variable Selector,” on page 33.

Match Attributes + K 4 BB @
|| @_ G:' @Use walues from the current object v||
—

6 Browse to and select the desired attribute, then click OK.

Afrbutes

@ @
Attributes of: | <All Classes = v|
[Anything] s
[Mothing] |
arcessCarddumber
Account Balance
ACL

fliased Cbject Mame
allowaliasToAncestor

Allow Unlimited Credit
assistant

assiskantPhone
associatediame
aktrEncryptionDefinition
attrEncryptionRequiresSecure
attributeCertificate

audio

Audit: & Encryption Kew
Audit:B Encryption Key
Audit: Contents

Audit: Current Encryption Key
Audit:File Link

Audit:Link List

Audit:Path

Audik: Palicy

Audit: Type

atharitative

[CJonly show changes

[ K H Cancel ] E]

£

If you want to add more than one attribute, click the Append new item icon to add another line.

Match Attributes @ X 4 BB 4 2
| | @ L_a.:l @f_ |Use values From the current object v|
| | @ L_ﬂ.:l E]“—r |Use values From the current object v|

You can browse the Identity Vault schema or the connected system schema.
7 Click Finish.

The Match Attribute Builder also allows you to specify another value, instead of using the value from
the current object. For more information about value types, see “value” in the Identity Manager 4.0.2
DTD Reference.

Policies in Designer 4.0.2



To use another value:

1 Launch the Match Attribute Builder, then select Other Value from the drop-down list.
2 Select the desired value type.

¢ counter

¢ dn

¢ int

¢ interval

¢ octet

* state

¢ string

¢ structured

¢ teleNumber

+ time

3 Specify the value, then click OK.

Action Argument Component Builder

To launch the Action Argument Component Builder, select one of the following actions when the
Select Value Type selection is structured, then click the Edit the components icon [E.

¢ Add Destination Attribute Value (page 238)

¢ Add Source Attribute Value (page 246)

¢ Reformat Operation Attribute (page 275)

¢ Remove Destination Attribute Value (page 278)

¢ Remove Source Attribute Value (page 283)

¢ Set Destination Attribute Value (page 293)

¢ Set Source Attribute Value (page 304)

Figure 4-5 Add Destination Attribute Value Action

Do | add destination attribute value v @
Specify attribute narme: * | Given Name U@ i -3
Specify class name: | User gdes
Select mode: |write directly bo destination dataskore L
Select object: | Current object w

£

Specify value t':.:'pe:

Enter components: * | user

1 Make sure the value type is set to structured, then click the Edit the components icon [E.

2 Create the value of the action component.
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You can type the value, or click the Edit the arguments E] icon to create the value in the Argument

Builder.
Argument Components |
The argument components are structured argument values, ﬁ =
MName Yalues + B of IE @
| user | | value |

3 Click Finish.

4.8 Argument Value List Builder

To launch the Argument Value List Builder, select the following action, then click the Edit the
arguments icon [El.

¢ Set Default Attribute Value (page 291)

Figure 4-6 Set Default Attribute Value

Do | set default atkribuke walue w | @
Specify atkribute name; * | Company | @ '3:' &
Wite back: |False V|
Specify argument walues: * | |

1 Select the type of the value: counter, dn, int, interval, octet, state, string, structured, teleNumber, time.

@ Argument Value List Builder

Argument Yalues

Argument values specify the values that are to be used for an attribute,

Type Argument Yalues + B of IE @

v | | E

stake .
sEring
structured
teleMumnber —
tirme b

2 Create the value of the list.

You can type the value, or click the Edit the arguments icon to create the value in the Argument
Builder.
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@ Argument Value List Builder | E

Argument Yalues T
f =

argument walues specify the values that are to be used For an attribute,

Type Argument Yalues + B of IE (@
| string v| | | 1@

3 Click Finish.

4.9 Named String Builder

To launch the Named String Builder, select one of the following actions, then click the Edit the strings
icon [E next to the Strings field.

¢ Add Role (page 242)
¢ Generate Event (page 266)

*

Remove Role (page 279)

Send Email (page 287)

Send Email from Template (page 289)
Start Workflow (page 310)

* *

*

A=Y

Select the name of the string from the drop-down list.

@ Named String Builder |:

Named String Builder | o
String elements provide values For arguments,
Name String Yalue + X o+ BB 4@
B 3| |
subect 3| I=
| message v |

2 Create the value for the string by clicking the Edit the arguments icon to launch the Argument
Builder.
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& Named String Builder

Named String Builder |
String elements provide values For argumens. ¥=
Name String ¥alue + X o BB 4 @
= 9|
| subject v/| |
[esses el [E

3 Click Finish.

For a Send Email action, the named strings correspond to the elements of the e-mail. A complete list
of possible values is contained in the help file corresponding to the action that launches the Named
String Builder.

4.10 Condition Argument Component Builder

To launch the Condition Argument Component Builder, select one of the following conditions, then
select the structured selection for Mode in order to see the Launch ArgComponent Builder icon [@].

¢ If Attribute (page 194)

¢ If Destination Attribute (page 200)

¢ If Operation Attribute (page 217)

¢ If Source Attribute (page 226)

Figure 4-7 If Attribute mode

Zondition |destinatil:|n attribute v| @
Mame * | Given Mame @& &
Cperator * |equal w |
Mode structur@ V|

Yalue | | @E_

1 Specify the name and value of the condition component.
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4.11

@ Condition Argument Component Builder

Argument Components

Mame

The condition argurment components are namevalue pairs,

¥Yalues + X ‘{. IE @

2 Click Finish.

Pattern Builder

You can launch the Pattern Builder from the Argument Builder editor when the Unique Name
(page 357) token is selected. The Argument Builder editor pane shows a Pattern field where you can

click to launch the Pattern Builder.

For information on how to access the Argument Builder, see “Launching the Argument Builder” on

page 48.
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Figure 4-8 Unique Name Token in the Argument Builder

Create and edit arguments

Add or remove your components to the expression area to construck your argument. Specify component walues in the Editor,

- Expression B o @ (7 (& Nouns

Unique Marr ter-ps ted allb: 0 arvailz Character

Class Marne
Destination Attribute
Drestination DM
Destination Mame
Document
Entitlement
Generate Password
Global Configuration Yalues
Local Yariable
Mamed Password
Operation

Operation Attribute
Dperation Property
Fassword

Query

Removed Attribute
Removed Entitlement
Resalve

Source Attribute
Source DN

Source Mame

Time:

~

LInique Mame
Unmatched Source DM
#Path

3

-/ ¥erbs

Basetd Decode
Basef4 Encode
Convert Time

Escape Destination DN
Escape Source DN =
Jain
Lowercase
Map

Parse DN

- i L
# Editor FRequired 2 & poceription [©)]

B3

| £

Attribute name: | | @ L—T @@ & generated unique name.

Start search:
Goean ] @
When to use counters:

Use caunter with which pattern:

Counter stark: | 1 digits: | 1 Pad counter with lzading 0's

|€

1 Click the Edit patterns icon E to launch the Pattern Builder.

@ Pattern Builder

Pattern Builder

Define a list of patterns

Pattern Yalues + XK °3b % @
Patterm: |

2 Specify the pattern or click the Edit the arguments icon E to use the Argument Builder to create
the pattern.

3 Click Finish.
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4.12

4.13

4.14

String Builder

The String Builder enables you to construct name/value pairs for use in certain actions, including Set
SSO Credential and Clear SSO Credential.

To open String Builder, select the Edit the Strings icon [Z4 next to the appropriate field when defining a
new action or modifying an existing action. For example, The Set SSO Credential action contains a
Login Parameter Strings field for necessary login parameter strings. String Builder allows you to create
the appropriate strings.

In the String Builder, specify a name for each string you want to add to the action, then manually, or
using the Argument Builder, create the appropriate string value.

Figure 4-9 String Builder Example

@ String Builder - @@
String Builder

String elements provide values for anguments. ﬁz
- String Value + X AR T2 O
LSS Artribate{"LID") W

pacsward Mamed Password("ussrpascs) m ]

[_prsh || concol |

XPath Builder

The XPath Builder is a powerful tool that allows you to build and test an XPath expression against
any XML document. See “Using the XPath Builder” on page 73 for more information.

Mapping Table Editor

The Mapping Table editor allows you to create, edit, and manage mapping table objects. A mapping
table object is used by a policy to map a set of values to another set of corresponding values. After a
mapping table object is created, the Map (page 372) token maps the results of the specified tokens
from the values specified in the mapping table.

To use a mapping table object, the following steps must be completed:

1. Section 4.14.1, “Creating a Mapping Table Object,” on page 62
2. Section 4.14.2, “Adding a Mapping Table Object to a Policy,” on page 63

To edit a mapping table, see Section 4.14.3, “Editing a Mapping Table Object,” on page 65.
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4.14.1 Creating a Mapping Table Object

A mapping table object can be created in a library, driver object, Publisher channel, or Subscriber
channel.

1 In the Outline view, right-click the location to create the mapping table, then select New >
Mapping Table.

2 Specify the name of the mapping table object, then click OK.
Select Open the editor after creating the object to open the Mapping Table editor.

® Mew Mapping Table

Chonse Mapping Table name
Creabe a Mapping Tabls resource

Harme: | “ew Mapping Table

[+#] ey thee editor after creating the object

ok J[ concel ]

3 In the File Conflict message, click Yes to save the project before opening the Mapping Table
editor.

4 In the Mapping Table editor, select column_new-1.

column_new-1 =
Case Insensitive

5 Specify a column name and data type, then click Close.

Column names must be unique. The data type lets you specify if the column values are Case
Sensitive, Case Insensitive, or Numeric.
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13| Design_doc - Developer £ = 8
Mapping Table Editor rE] rEl Fi= = =

MappingTable. fctive Direckory, entitiment, DOCIDMTEST

Column MName: | SRS

Colurnn Type
{:} Zase Sensitive

G} Case Insensitive

) Mumeric

Close

Mapping Table Editar | %ML Source | ML Tree

6 Select New Value to specify a cell value.

MapTablel Delimited Text.Driver Set,

Depk =
Case Insensitive
Mew Yalue

7 (Optional) To add another column, click the Add Column icon F&} , then repeat Step 4 and Step 5.

8 (Optional) To add another row, click the Add Row icon “=, then repeat Step 6.

9 Press Ctrl+S to save the mapping table object.
10 Continue with Section 4.14.2, “Adding a Mapping Table Object to a Policy,” on page 63.

4.14.2 Adding a Mapping Table Object to a Policy

1 Either create a policy to use the mapping table in, or select an existing policy to edit.

2 Launch the Argument Builder in the Policy Builder.
For information on how to access the Argument Builder, see “Launching the Argument Builder”
on page 48.

3 Double-click Map from the list of verbs to add it to the expression panel.
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Create and edit arguments

Add or remove your components to the expression area ko construct wour argument. Specify component walues in the Editor,

2 Expression ® o B {7 & Nouns

£# Editor * Required

Mapping Table DM: * | | q 'E_‘@

[] 5t DN relative to policy

Source colurn name: * |

Destination column name: * | |

Diefault value: |

4 In the Mapping Table DN field, browse to and select the mapping table object created in

Texk

Added Entitlemant
Association
Atkribute
Character

Class Marne

-/ ¥erbs

Basetd Decode
Baseed Encode
Corvett Time

Escape Destination DM
Escape Source DM
Jain

Lowercase

Parse DM

% Description

£

1€

W

@

Maps the resulk of the encosed tokens
from the values specified by the source
column to the destination column in the

specified mapping table.

Section 4.14.1, “Creating a Mapping Table Object,” on page 62, then click OK.

Select an object:

= (& 1dentity vaul
= E Diriver Set
= i’ﬂ e Libraty

Wapping Table

5 Select whether the mapping table DN is set relative to the policy or not.

6 Select the source column name by clicking the Browse icon.

2# Editor

Mapping Table DM; * | \[root]ynullDriver SetiMew LibraryMew Mapping Table |

[]5et DM relative ta palicy

Q
Source column name; * | |®

_— = .
Destinakion column name: * | | Q& locakion

Default value: | |

7 Select the destination column name by clicking the Browse icon.
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4.14.3

2# Editor

Mapping Table DM; * | \[rootlynulhDriver SetiMew Library\New Mapping Table @ |

[ =&t DM relative ko policy

Source column name: * | dept
Destination column name: *

Default value:

-

yo

o

&

S

code
location

The mapping table can be used in any manner at this point. In this example, the OU attribute is
populated with the value derived from the mapping table.

= 5.. Map({dest="location", src="dept", table="\[root]irull\Driver SetiLibraryiMapping Table", Operation Attribuke" O™

&L & Operation Attribube("OU")

Editing a Mapping Table Object

Designer provides the following options to edit the mapping table:

Table 4-5 Editing Options for the Mapping Table Editor

Option

Description

Q’-f Undo Add Column

r35’Redo Add Column

m
£l Add Column
“= Add Row

X,
FilDelete Column
*=Delete Row

1 Move Row Up

I Move Row Down
Move Column Left

=* Move Column Right

Undoes the last action performed in the table.
Redoes the action that was undone.

Inserts a column to the mapping table.

Inserts a row to the mapping table.
Deletes a column from the mapping table.
Deletes a row from the mapping table.

Moves the selected row up in the mapping table.
Moves the selected row down in the mapping table.

Moves the selected column left in the mapping table.

Moves the selected column right in the mapping table.

The Mapping Table Editor also supports keyboard shortcuts for several of its operations:

Table 4-6 Keyboard Shortcuts for the Mapping Table Editor

Keyboard Shortcut Description

Ctrl+Shift+Insert Insert a column to the right of the current column.
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4.14.4

4.14.5

4.14.6

4.15

Keyboard Shortcut Description

Ctrl+Shift+Delete Delete the current column. You are prompted to confirm the deletion.
Ctrl+Shift+C Rename the current column. Opens the Column Edit dialog box.
Alt+Insert Insert a row below the current row.

Alt+Delete Delete the current row. You are prompted to confirm the deletion.
Ctrl+Up Arrow Navigate up one row.

Ctrl+Down Arrow Navigate down one row.

Ctrl+Left Arrow Navigate left one column.

Ctrl+Right Arrow Navigate right one column.

Importing Data from a CSV File

The Mapping Table editor allows you to import data that is stored in a CSV file. It then populates the
table with the information in the CSV file. To import a CSV:

1 In an empty Mapping Table, select Import From CSV file = .
2 Browse to and select the CSV file, then click Open.
3 Click Yes to overwrite your existing data.

4 Press Ctrl+S to save the data in the table.

Exporting Data to a CSV File

The Mapping Table editor allows you to export data to a CSV file. To export data to a CSV file:

1 When the data in the Mapping Table is ready to export, select Export To CSV File &,
2 Click Yes to save this editor’s changes and continue.

3 Specify a name and location for the CSV file, then click Save.

Testing a Mapping Table Object

You can use the Policy Simulator to test the functionality of the mapping table. The Policy Simulator
tests the mapping table by testing the policy that is using the mapping table. For more information,
see Chapter 9, “Testing Policies with the Policy Simulator,” on page 147.

Global Configuration Value Definition Editor

Global Configuration objects contain global configuration variables (GCVs) and are used when the
configuration values are referenced from content in packages.

To create a Global Configuration object:

1 Right-click an Identity Vault, driver set, or driver in the Modeler, then click New > Global
Configuration.

2 Specify a name for the Global Configuration object, then click OK.
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3 Double-click the new object in the Outline view, then click GCVs.
4 Click Add, then fill in the following fields to create the GCVs:
Name: Specify the name for the GCV.

Display Name: Specify the name that is displayed for the GCV.

Description: Specify a description of the GCV.

Type: Select the type of GCV that you are creating and fill in the appropriate information for the
type. The options are:

*

string: Select whether the string is contained on multiple lines by clicking Multi-line. A
string value is a sequence of Unicode characters.

integer: Specify the minimum value and maximum value of the integer. An integer value
contains one or more Unicode characters.

real: Specify the minimum value and maximum value of the real. A real value describes a
real or floating point number.

boolean: The boolean value is either true or false.

enumeration: The enumeration value is a defined set of strings. To create an enumeration
value, click Add, then specify the display name and value for the enumeration, then click
OK. Repeat this process for each string you add to the enumeration value.

dn: The dn value is obtained from the DN syntax of an object in the Identity Vault. You
must select the dn syntax type and the namespace of the DN.

¢ Syntax: The syntax options are ldap, slash, qualified-slash, dot, qualified-dot, and
custom.

¢ DN Space: Select whether the namespace is from the connected system (application)
or from Identity Manager (dirxml).

list: The list value contains an ordered list of zero or more strings. Specify the delimiter
character that is used to separate the items in the list.

password-ref: Specify the key value of a named password. A named password key valued
can be any non-empty sequence of Unicode characters.

structured: A structured value is similar to structures in the C programming language. A
structure contains to fundamental parts: a template that defines a set of simpley types, and
zero or more instances that contain the actual values of the structured control value. Specify
the minimum and maximum instances, as well as the value separator and instance
separator for the structure value.
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3 Global Configuration Value Definition

Define GCV
@ MName and Display MName cannot be empty

Mame:

Display name:

Description:

& Cancel

5 Click Finish.
6 Repeat Step 4 and Step 5 for each GCV you want to add, then click OK to save the changes.

For more information about defining GCVs, you can refer to Explaining GCVs (http://
www.novell.com/communities/node/11344/explaining-gcvs-part-1).

4.16 Namespace Editor

The Policy Builder enables you to use multiple XML namespaces within your XML documents. You
launch the Namespace editor when you access the following DirXML Script elements in the Policy
Builder:

¢ Append XML Element (page 248)

¢ Append XML Text (page 250)

¢ Clone By XPath Expressions (page 257)

¢ Set XML Attribute (page 309)

¢ Strip XPath Expression (page 314)

¢ XPath (page 361)

1 Click the Edit the policy’s namespace definitions . icon.
2 Specify the namespace prefix.
3 Specify the URL
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4.16.1

4 Do not select Java Extension.

@ Namespace Editor

Edit Policy's Namespace Definitions ‘
7]
Policy Builder enables vou ko use multiple XML namespace definitions within your XML < >
documents,
+- X A BB @
Prefiz IURI Java Extension
| O
[ Finish ] [ Cancel

You can also access Java* classes through XPath by using XML namespaces. To create a namespace
for a Java class, specify the namespace prefix in the Name field, the class name in the URI field, and
select the Java Extension check box.

Accessing Java Classes Using Namespaces

Novell provides several Identity Manager Java classes that can be called by using XPath expressions
from the Policy Builder. The following links open Javadoc references for these Java classes:

¢ com.novell.nds.dirxml.driver.XdsQueryProcessor (http://developer.novell.com/documentation/
dirxml/dirxmlbk/api/com/novell/nds/dirxml/driver/XdsQueryProcessor.html)

¢ com.novell.nds.dirxml.driver. XdsCommandProcessor (http://developer.novell.com/
documentation/dirxml/dirxmlbk/api/com/novell/nds/dirxml/driver/
XdsCommandProcessor.html)

¢ com.novell.nds.dirxml.driver. DNConverter (http://developer.novell.com/documentation/
dirxml/dirxmlbk/api/com/novell/nds/dirxml/driver/DNConverter.html)

The Java Developer Kit (JDK*) also provides several useful classes, such as java.lang.String, and
java.lang.System. References for these classes are available with the JDK.

For additional information on using XPath and the Novell Java classes listed above, consult the
DirXML Driver Developer Kit (http://developer.novell.com/documentation/dirxml/dirxmlbk/ref/
dirxmlfaq.html).
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4.17 Local Variable Selector

Policies use local variables and they have different scopes. A local variable is defined for a specific
policy or it is defined for a driver. If a local variable scope is set to driver, then any policy in the driver
can use this variable.

The Policy Builder contains a Local Variable Selector that allows you to select any local variables that
have been defined for use in the selected policy.

Figure 4-10 Local Variable Selector

¥ Local Variable Selector ]E|

Local Variable Selector
Select & local variable From the lisk.

Fdic:.r 5:1:1::; Diriver Scupé | Error Variables |

current-node
current-op
current -value
fromids

@ | ok || cencel |

The Local Variable Selector is accessed through the following actions, conditions, and tokens:

¢ If Local Variable (page 209)
¢ Set Local Variable (page 296)
¢ Local Variable (page 339)

The Local Variable Selector displays three tabs:
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Figure 4-11 Error Variables

X

@ Local Yariable Selector

Local Yariable Selector

This list has all local variables that are errors that
can occur within a policy

Policy Scope | Driver Scope | Error Yariables

error, do-clear-sso-credential
error,.do-set-sso-credential

error, do-set-sso-passphrase
error,do-send-email
error,do-send-email-From-template
error, do-skart-warkFow

) [ (0] H Cancel ]

Policy Scope: Lists any local variables with a scope of policy.
Driver Scope: Lists any local variables with a scope of driver.

Error Variables: Lists local variables that are set, if an error is encountered during the execution of
the policy that contains the following actions:

¢ Clear SSO Credential (page 256)

¢ Set SSO Credential (page 307)

¢ Set SSO Passphrase (page 308)

¢ Send Email (page 287)

¢ Send Email from Template (page 289)
¢ Start Workflow (page 310)
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Using the XPath Builder

The XPath Builder is a powerful tool that allows you to build and test an XPath expression against
any XML document. You can test different expressions against an XDS document and modify the
XDS document while testing the expression. For more information about XPath expression, see
“XPath 1.0 Expressions” in Understanding Policies for Identity Manager 4.0.2.

Figure 5-1 XPath Builder

Create an XPath Expression
Impaort an %03 document, select the current conkext in the ¥Path Context Seleckar, then build and test an XPath expression in P on e o
the ¥Path Expression kext area. e & B L ]

¥[S Dacument Location: %Path Selected Conkext
| 7 (®) Generic () Unique
Mo conkext currenthy selecked
¥ML Tree | ML Source
%Path Context Selector [F] 2 | [S] ¥Path Exprassion @ (¥

The document is empky,
Right mouse click here to insert cantent,

Resulks:

Ikem Location

¥Path:

‘ :

[ OK ] [ Cancel

To use the XPath Builder:

1 In the Policy Builder, select any of the following conditions or actions, then click the Launch
XPath Builder icon 8,
¢ If XPath Expression (page 232)
¢ Append XML Element (page 248)
¢ Append XML Text (page 250)
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¢ Clone By XPath Expressions (page 257)
¢ Set XML Attribute (page 309)
¢ Strip XPath Expression (page 314)

2 Select Import to browse to and select the XDS document to test.

=05 Docurment Locakion:

|| ZI] [lmpu:urt... D

Designer comes with sample event files you can use to test the XPath expression against. The
files are located in the plug-in com.novell.designer.idm.policy version\simulation,
where version is the current version of Designer. The events are Add, Association, Delete,
Instance, Modify, Move, Query, Rename, and Status.

Lok, jr: |l'f} simulation V‘ (€] ? ? -
. (Cindd
___J |- Association
Recent IS Delete
[ Instance
= [ Modify
L CMove
Desktop (Query
) Rename
. I 5takus
My Documents
iy Computer
. File name: | hd | [ Open ]
My Mebaork Files of type: * wrl v| [ Cancel ]

3 Double-click the folder to display the available events. Each event has different files you can
select. For example, if you select Add you have three options: Organization.xml,
OrganizationalUnit.xml, and User.xml. The file indicates the event. If you select User.xm1, it
is an Add event for a User object.

4 Select a file, then click Open.

The input document is now displayed in the XPath Context Selector view. The XML Source tab
allows you to use an XML source editor to edit the imported document, or an XML document
from another editor can be copied and pasted into the source view. If you change the document,
click Save As to save the changed document.

74 Policies in Designer 4.0.2



aML Tree | =ML Source |

@F‘ath Context Selectur)

=

[s]

=2 wml

= [e] nds
drdwersion
nidsversion

wmlispace
1]

= [8] input
[€] add

»Path:

If you want to see the XDS document without scrolling, click the Hide XPath Details icon E] .To
see the XPath Expression and Results windows, click Show XPath Details icon.

EML Tree | ZML Source |

¥Path Context Selector

P2 el

= [&] nds
drdversion
ndsversion

xml;space
]

= [&] input

= [e] add
class-name
qualified-sre-dn
src-dn
[8] assaciation
[8] add-attr
[8] add-attr
[8] add-atkr
[8] add-atkr
[8] add-atkr
(8] add-atkr
(8] add-atkr
[e] passwaord

BHEBHEEBB

=RNE
version="1.0" encoding="UTF-3"
1.0
8.5
default
User

o=dir=ML Testhou=Usersicn=serl
o=dir<ML Testiou=Usersicn=IJserl
o=dir¥ML Testou=Usersicn=User1

initialpwd

%Path:
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5 Select the current position in the document from which you want to start building your XPath
expression.

HML Tree | 5ML Source
wPath Context Selech =REE]

P2 el

=[] nds
dtdwersion
nidsversion

xmlispace
Q

= [&] input

class-narne

qualified-src-dn

sre-dn

[e] association
[e] add-attr
[e] add-attr
[e] add-attr
[8] add-atkr
[8] add-atkr
[8] add-atkr
[8] add-attr

[8] passward

wPath: /ndsfinput][1]fadd[1]

The XPath context that you have selected is displayed in the XPath Selected Context as shown.

%Path Selected Context
@' EEneric {:} Unique
{",l'nds,l'input,l’add'j

6 Select Generic or Unique.

Generic searches the entire XML document to match the specified XPath expression. It returns
results for each instance of the XPath expression. In this example, the XPath expression is “/nds/
input/add”. It searches the entire XML document for each instance of add.

Unique searches the XML document until it finds a match and then stops. The unique XPath
expression is “/nds/input[1]/add[1]”. It searches for the first instance of add and then stops. You
can specify which instance you want to use by selecting the next instance of the XPath element in
the XML Context Selector.

7 Specify an XPath expression in the XPath Expression field.
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®Path Expression 4 {}

[
add-attr Y
associakion
passiward
kexkl)
i
processing-instruckionr
descendant::
preceding::
attribute::
parent::
zelf:; =z

Collo...ie — LI _..

NOTE: Using the keystroke combination Ctrl+Space+3, /, [, or ( triggers code completion. The
expression is evaluated up until the cursor location, and insertable elements are shown in a
drop-down box.

The results of your XPath expression appear in the Results text area below.

%Path Expression B O
add-atkr

(Resulks: 7 nodeis

Ikem Lacation
[8] element"add-attr™) lime &8 - 10
[e] element("add-attr") line 11 - 13
[2] element("add-attr") line 14 - 16
|e] element"add-attr™ lime 17 - 19
[2] element("add-attr™) line 20 - 22
[e] element"add-attr") line 23 - 25
[e] element"add-att") line 26 - 32
£ >

If the XPath editor does not evaluate the expression, click the Evaluate XPath expression icon Do
force the XPath Builder to evaluate the expression.

(Optional) Click the ECMA Expression Editor icon to use a valid ECMAScript expression instead
of an XPath expression.

When you are finished building and testing an XPath expression, click OK to close the XPath
Builder.

The text displayed in the XPath Expression is placed into the policy that you are editing.
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Defining Schema Map Policies

Schema Map policies map class names and attribute names between the Identity Vault namespace
and the application namespace. All documents passed between the Metadirectory engine and the

application shim in either direction on either channel are passed through the Schema Map policy.

There is one Schema Map policy per driver.

Figure 6-1 The Schema Map Editor

_\I,‘E{ Design_doc - Developer M- Schemahapping 52 =8
Schema Map Editor fc] B c . ."J' F‘ 5 '._E} -
M SchemaMapping.Active Directory. entitiment, DOCIDMTEST

@] Ao

Identity Yault Active Direchory

+ MNon-class-specific Mapping Mon-class-spicific Mapping

+ Group group

Locality locality

+ Crganization organization

+ Organizational Unit organizationallini

= User usst
DirxML-ADAliasMame sAMADCoUnEN ame
L physicalDeliveryOfficaMans
nsprnbistributionPassword nspraDistributionPassword

Physical Delivery Office Name I

Mapping Editor | XML Source XML Tree

NOTE: The Schema Map editor is for creating and managing schema map policies. If you want to
manage the actual schema on the Identity Vault or Application, use the Manage Schema tool, which

is accessible by clicking the pull-down menu =, then selecting Manage Identity Vault Schema *i or

Manage Application Schema <.

For more information, see “Managing the Schema” in the Designer 4.0.2 for Identity Manager 4.0.2
Administration Guide.
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6.1

6.1.1

This section includes the following topics:

¢ Section 6.1, “Using the Schema Map Editor,” on page 80

¢ Section 6.2, “Editing a Schema Map Policy,” on page 83

¢ Section 6.3, “Testing Schema Map Policies,” on page 90

¢ Section 6.4, “Exporting and Importing with the Schema Map Editor,” on page 90
¢ Section 6.5, “Accessing the Schema Map Policy in XML,” on page 90

¢ Section 6.6, “Additional Schema Map Policy Options,” on page 91

Using the Schema Map Editor
The Schema Map editor allows you to edit the Schema Map policies. This section includes the
following topics:

¢ Section 6.1.1, “Accessing the Schema Map Editor,” on page 80
¢ Section 6.1.2, “Navigating the Schema Map Editor,” on page 81
¢ Section 6.1.3, “Understanding the Schema Map Editor Toolbar,” on page 82

Accessing the Schema Map Editor

There are three different ways to access the Schema Map editor in Designer:
Outline View To open the Schema Map editor from the Outline view:

1 In an open project, click the Outline tab.
2 Click Show Model Outline .

3 Expand the driver where you want to manage the schema map policy.
4 Double-click the Schema Map icon ¥= to launch the Schema Map editor.
You can also right-click the icon, then select Edit.

Policy Flow View To open the Schema Map editor from the Policy Flow view:

1 In an open project, click the Outline tab.

2 Click Show Policy Flow .

3 Double-click the Schema Mapping object, select the Schema Mapping policy, then click Edit to
launch the Schema Map Editor.
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You can also right-click the Schema Mapping object, then select Edit Policy to launch the Schema
Map Editor.

Generic Designer

=

A

Input | | Output

Scherna Mapping

Publisher

Evert

Policy Set View To open the Schema Map editor from the Policy Set view:

In an open project, click the Outline tab.

1
2 Click the Show Model Outline icon. &

3 In the Outline view, select the appropriate driver object.
4

In the Policy Set view, open the Schema Mapping folder, then double-click the Schema Mapping
policy to launch the Schema Map editor.

You can also right-click the Schema Mapping policy, then click Edit to launch the Schema Map
editor.

[ policy Set &3 = 0O

Active Directory Driver Policy Sets

x K =
+ [,_El,- Input Transformation
+ @- Oukput Transformation

= E Schema Mapping
M= schemaMapping

+- (2 Filter

6.1.2 Navigating the Schema Map Editor

The Schema Map Editor uses standard point-and-click navigation. However, it also provides
keyboard-based navigation options as described in Table 6-1.

NOTE: The Schema Map Editor lets you order the list of mapped classes and attributes alphabetically
(ascending or descending.) To do so, click either the gray Identity Vault header or the gray
application datastore header that appears above the list of mapped classes. If you first select a class
mapping and then click one of the headers, only the attributes within the class mapping are ordered.
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Table 6-1 Schema Map Editor Keyboard Support

Keystroke Description

Up-arrow Moves the cursor up in the Schema Map editor.

Down-arrow Moves the cursor down in the Schema Map editor.

Left-arrow Collapses the information displayed

Right-arrow Expands the information displayed.

Insert Adds a class.

Ctrl+Insert Adds an attribute.

Delete Deletes the selected items.

Enter Opens edit mode for the currently selected field. Press
Enter a second time to commit the change in Schema
Map editor.

Esc Exits the edit mode.

6.1.3 Understanding the Schema Map Editor Toolbar

The Schema Map editor includes a toolbar that provides access to the following features. Several of

these features, along with an option to Edit &’ a selected mapping, is also available from a drop-down
menu by right-clicking in the Schema Map editor.

Tool Description

C Insert Identity Vault Class launches a dialog box from which you can add a new ID Vault class,
and its associated attributes, to the schema map. For more information, see “Adding an Identity
Vault Class or Attribute” on page 84.

Insert Identity Vault Attribute launches a dialog box from which you can add additional attributes
to an existing ID Vault class in the schema map. For more information, see “Adding an Identity
Vault Class or Attribute” on page 84.

&

Insert Application Class launches a dialog box from which you can add a new Application class,
and its associated attributes, to the schema map. For more information, see “Adding an
Application Class or Attribute” on page 86.

e

Insert Application Attribute launches a dialog box from which you can add additional attributes to
an existing Application class in the schema map. For more information, see “Adding an
Application Class or Attribute” on page 86.

c Insert Class Row adds an empty class row to the schema map. You can then populate the class
fields manually or by selecting from the drop-down menu of available classes.

@ Insert Attribute Row adds an empty attribute row to the selected class in the schema map. You
can then populate the attribute fields manually or by selecting from the drop-down menu of
available attributes.

3% Delete deletes the selected class or attribute mappings from the schema map.

Clear All Items deletes all class and attribute entries from the schema map.
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Tool Description

2 Synchronize with the Filter Editor instructs the Schema Map editor to update the Filter policy with
any schema mappings you have added in the Schema Map editor. The Schema Map editor does
not synchronize deleted entries to the Filter policy.

For more information about filter policies and the Filter editor, see Chapter 7, “Controlling the
Flow of Objects with the Filter,” on page 95.

& Launch Policy Simulator launches the Policy Simulator. For more information, see Chapter 9,
“Testing Policies with the Policy Simulator,” on page 147.
(@ Help launches the context-sensitive help for the Schema Map editor.
) The pull-down menu opens a secondary menu of schema map editor tools, including the
following:

=l Save to File exports the current schema map to an XML file.
= Import from File imports a schema map from a previously saved XML file.

2 Manage Identity Vault Schema launches the Manage Schema tool. For more information,
see “Managing the Schema” in the Designer 4.0.2 for Identity Manager 4.0.2 Administration
Guide.

2 Manage Application Schema launches the Manage Schema tool. For more information, see
“Managing the Schema” in the Designer 4.0.2 for Identity Manager 4.0.2 Administration
Guide.

'~‘;’><h Refresh Application Schema queries a live application for its current schema. This lets you
update the application schema in Designer as it changes on the live system.

Editing a Schema Map Policy

The Schema Map editor allows you to create and edit schema map policies. This section includes the
following topics:

¢ Section 6.2.1, “Adding or Deleting Classes and Attributes,” on page 84
¢ Section 6.2.2, “Refreshing the Application Schema,” on page 88

*

Section 6.2.3, “Editing Items,” on page 88

*

Section 6.2.4, “Sorting Schema Map Entries,” on page 89

*

Section 6.2.5, “Managing the Schema,” on page 89

For information about exporting and importing a schema map policy, see Section 6.4, “Exporting and
Importing with the Schema Map Editor,” on page 90.
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6.2.1 Adding or Deleting Classes and Attributes

There are three types of classes or attributes you can add to a schema map. The process for adding
each type of class or attribute varies.

When you add or remove a class or attribute in the Schema Map policy, Designer updates relevant
filters at the same time. For more information about filters, see Chapter 7, “Controlling the Flow of
Objects with the Filter,” on page 95.

¢ “Adding an Identity Vault Class or Attribute” on page 84

¢ “Adding an Application Class or Attribute” on page 86

¢ “Adding a Non-class-specific Attribute Mapping” on page 87

¢ “Deleting a Class or Attribute Mapping” on page 87

Adding an Identity Vault Class or Attribute

You can both add new Identity Vault classes and attributes to a schema map, and add additional
Identity Vault attributes to an existing class mapping.

To add a new Identity Vault class and attributes to a schema map:

1 In the Schema Map Editor, select Insert Identity Vault Class &= .
You can also right-click in the Schema Map editor, then click Insert Identity Vault Class.

2 In the Select Identity Vault Class and its Attributes page, select a class and the relevant class
attributes to add to the schema map, then click OK.

Use Shift+click and Ctrl+click to select multiple attributes, if desired.
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El Select Identity Vault Class and its Attributes E]

Classes: Attributes of this class: e
srvpryTaskiGroupiux I | =
srvpreTeam ou
| srvprvTeamDefs
srvpry TeamBequest
| srvprvTheme accessCardiumbeer
srvprliseriic Account Balance
srvprvwebappConfig ACL
srvprorkflow
srvpreworkflowDefs M':""‘" Uniimibed Cred
sshadmnConfiguration assistant
sshadmnServer assistantFhone
sssServerPolicies audio
sesServerPolicyOverride Audit:Fie Link
mfgm:g Authorty Revocation
Template auxClassCompatibility
Top Back Link
Tres Root Bandery Pr (4
uamPosixConfig mﬂ:’;ﬂf’ Y
uamPosboEroup ; i
uamPosidlser CA Private Key
uamPosiaWiorkstakion A Public Key
carLicenss
Cactificabe Revocstt
userSecurityInformation ' acan
Vol ¥ Certificabe Yalidity Interyal
WANMAN:LAN Area
| ¥ Tiar o e
[]show ausdiary attribubes
Ok | Cancel

3 In the Schema Map Editor, double-click each class and attribute you added to the schema map,
then specify the appropriate Application class (or attribute) to which you want to map it.

You can either select the class or attribute name from the drop-down list, or type it in the field

manually.

Identity Waulk
Mon-class-specific Mapping

Ackive Direcbory
Mon-class-specific Mapping

[= Group group
DirxrML-ADaliasMame saMAccountManme
GID v || quid v
Locality localicy

Organization
Crganizational Unik
Lser

organization
arganizationallnit
user

4 To save the schema map changes, select File > Save.

To add additional Identity Vault attributes to an existing class mapping:

1 In the Schema Map Editor, select a class mapping, then select Add Identity Vault Attributes & .

You can also right-click in the Schema Map editor, then select Insert Identity Vault Attributes.

2 In the Select ID Vault Attributes page, select the desired attributes to add to the class mapping,

then click OK.

Use Shift+click and Ctrl+click to select multiple attributes, if desired.
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3 In the Schema Map Editor, double-click each attribute you added to the schema map, then
specify the appropriate Application attribute to which you want to map it.

You can either select the attribute from the drop-down list, or type it in the field manually.

Identity Waulk Active Direckary
¥ Mon-class-specific Mapping Mon-class-specific Mapping
=l Group group
DirxrL-aDaliasMarme saMAccountMame
GID w || | guid L
Locality lozality
+| Drganizakion organization
¥ Organizational Unit arganizationalUnit
+ User user

4 To save the schema map changes, select File > Save.

Adding an Application Class or Attribute

You can both add new Application classes and attributes to a schema map, and add additional
Application attributes to an existing class mapping.

IMPORTANT: To view an application’s schema classes and attributes, the driver must be able to
retrieve the schema information from a live application environment. This occurs automatically
when a driver starts (right-click the driver, then select Live > Start Driver). However, you can refresh

the application schema at any time by selecting Refresh Application Schema .

To add a new Attribute class and attributes to a schema map:

1 In the Schema Map Editor, select Insert Application Class .
You can also right-click in the Schema Map editor, then click Insert Application Class.

2 In the Select Application Class and its Attributes page, select a class and the relevant class
attributes to add to the schema map, then click OK.

Use Shift+click and Ctrl+click to select multiple attributes, if desired.

3 In the Schema Map Editor, double-click each class and attribute you added to the schema map,
then specify the appropriate Application class (or attribute) to which you want to map it.

You can either select the class or attribute name from the drop-down list, or type it in the field

manually.
Identity Waulk Active Direckary
¥ Mon-class-specific Mapping Mon-class-specific Mapping
=l Group group
DirxrL-aDaliasMarme saMAccountMame
GID w || | guid L
Locality lozality
+| Drganizakion organization
¥ Organizational Unit arganizationalUnit
+ User user

4 To save the schema map changes, select File > Save.
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To add additional Application attributes to an existing class mapping:

1 In the Schema Map Editor, select a class mapping, then select Insert Application Attributes ..
You can also right-click in the Schema Map editor, then select Insert Identity Vault Attributes.

2 In the Select App Attributes page, select the desired attributes to add to the class mapping, then
click OK.

Use Shift+click and Ctrl+click to select multiple attributes, if desired.

3 In the Schema Map Editor, double-click each attribute you added to the schema map, then
specify the appropriate Identity Vault attribute to which you want to map it.

You can either select the attribute from the drop-down list, or type it in the field manually.

Identity vault Active Directory
+ Mon-class-specific Mapping Mon-class-specific Mapping
= Group group
DirxrML-ADaliasMame saMAccountManme
GID w || | guid L
Locality localicy
1 Organization organization
¥ Organizational Unit arganizationallnit
+ User user

4 To save the schema map changes, select File > Save.

Adding a Non-class-specific Attribute Mapping

Sometimes an attribute mapping doesn’t apply to a specific class. In this case you can define the
attribute mapping in the Non-class-specific container.

To add a non-class-specific attribute mapping;:

1 Select the Non-class-specific Mapping entry in the Schema Map Editor.
2 Add the appropriate attribute mapping using one of the methods described previously.

For more information, see “Adding an Identity Vault Class or Attribute” on page 84 and
“Adding an Application Class or Attribute” on page 86.

Deleting a Class or Attribute Mapping

If you do not want an Identity Vault class or an attribute to be mapped to an Application class or
attribute, the best practice is to completely remove the class or the attribute from the Schema Map
policy. To remove multiple classes or attributes at the same time, use Ctrl-click or Shift-click to select
more than one class or attribute at a time.
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Identity vault Ackive Directory
Mon-class-specific Mapping Mon-class-specific Mapping
Group group

Locality locality

[=] ©rganization organization
L phesicalbeliveryOFficellanne
Phrysical Delivery OFfice Marme |

Organizational Unik organizationallnit

[= User user
DirsML-ADAliasMame seMAccountMame

physicalDelivery OfficeMarne

nspmbistributionPassword nspmbistributionPassword

Physical Delivery OFfice Mame |

You can add or remove attributes and classes from the Schema Map policy in the following ways:

+ Select the classes or attributes you want to remove, then right-click and select Delete.

¢ Select the classes or attributes you want to remove, then click Delete ¥ in the Schema Map editor
toolbar.

¢ Select the classes or attributes you want to remove, then press the Delete key.

You can also delete all classes and attributes at once by selecting Clear All Items &

6.2.2 Refreshing the Application Schema

If you have modified the schema in the application, these changes need to be reflected in the Schema
Map policy. To make the new schema available, click the toolbar pull-down menu, then select Refresh

Application Schema .

Refreshing the application schema requires a connection to the live application because the
application driver must be able to query the application for the updated schema.

6.2.3 Editing Items

88

To edit a mapping, double-click the selected row. An in-place editor appears, allowing you to edit the
mapping.
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6.2.4

6.2.5

Figure 6-2 In-line Edits in the Schema Map Editor

5 E

Identity Yaulk Active Directary
+ Mon-class-specific Mapping Mon-class-specific Mapping
+ | K=y || | User £
+ Organizational Unit organizationallnit
+ Organization organization
Locality locality
1 Group group

Sorting Schema Map Entries

The Schema Map editor allows you to sort entries in ascending/descending order by clicking on the
column heading. Click the Identity Vault heading to sort entries based on Identity Vault items. Click
the connected system heading to sort entries based on connected system items.

Managing the Schema

Designer allows you to manage the Identity Vault schema and any connected system's schema. You
can import the schema, modify it, and deploy the changed schema back into the Identity Vault or the
Application.

To manage the Identity Vault schema, click the pull-down menu +, then select Manage Identity Vault

Schema +i. This opens the Manage Schema tool and displays information about the classes and
attributes in the Identity Vault schema.

To manage the Application schema, click the pull-down menu =, then select Manage Application

Schema <+ . This opens the Manage Schema tool and displays information about the classes and
attributes in the Application schema.

For more information about how to manage the schema, see “Managing the Schema” in the Designer
4.0.2 for Identity Manager 4.0.2 Administration Guide.
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6.3

6.4

6.4.1

6.4.2

6.5

Testing Schema Map Policies

Designer comes with a tool called the Policy Simulator. It allows you to test your policies without
implementing them in a production environment. You can launch the Policy Simulator through the
Schema Map editor to test your policy after you have modified it.

To access the Policy Simulator and test the Schema Map policy:

1 Click the Launch Policy Simulator icon “& in the toolbar.

2 Select To Identity Vault or From Identity Vault as the simulation point of the Schema Map policy.

For more information on the Policy Simulator, see Chapter 9, “Testing Policies with the Policy
Simulator,” on page 147.

Exporting and Importing with the Schema Map Editor

Designer allows you to export a schema map policy document to an XML file. It also allows you to
Import an XML file from a particular point on the file system to the Schema Map Editor.

Exporting a Schema Map Policy

Schema Map policies can be exported from the editor and saved as an XML file located in the file
system.

1 In the Schema Map editor, click the pull-down menu =, then select Save to File 5, .

2 Specity a filename and location where you want to export your schema map policy, then click
Save.

Importing a Schema Map Policy

The Exported policies which were saved as XML files on the file system can be re-imported to the
Schema Map editor. This functionality saves you the effort of redoing the class or attribute mappings
again. To import a schema map policy:

1 In the Schema Map editor, click the pull-down menu =, then select Import from File = .

2 In the Import a Schema Map File dialog box, browse to the schema file you want to import, then
click Open.

Specify whether you want to append the imported schema mappings to the existing schema
map, or replace the existing schema map with the imported schema map.

Accessing the Schema Map Policy in XML

Designer enables you to view, edit, and validate the XML by using an XML editor. Click the XML
Source tab or the XML Tree tab to access the XML editor. For more information about the XML editor,
see “The Novell XML Editor” in the Designer 4.0.2 for Identity Manager 4.0.2 Administration Guide.
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6.6.1

Additional Schema Map Policy Options

When you right-click a Schema Map policy, there are multiple options presented in the Outline view,

the Policy Flow view, and the Policy Set view.

¢ Section 6.6.1, “Outline View Additional Options,” on page 91

¢ Section 6.6.2, “Policy Flow View Additional Options,” on page 92

¢ Section 6.6.3, “Policy Set View Additional Options,” on page 93

Outline View Additional Options

There are additional options to manage the Schema Map policy in the Outline view. Right-click the

Schema Map policy in the Outline view to see the additional options.

Table 6-2 Schema Map Policy Options in the Outline View

Option Description
Z Edit Launches the Schema Map editor. For more
i information, see Section 6.2, “Editing a Schema Map
Policy,” on page 83.
E2Copy Creates a copy of the Schema Map policy.
[Llsave As Saves the Schema Map policy as a .xm1 file.
&Simulate Tests the Schema Map policy. For more information,

Export to Configuration File

Live > Deploy

:'T%Live > Compare

Open With > Designer Built-in Editor

Open With > Novell XML Editor

Open With > Text Editor

H Delete

Properties

see Section 6.3, “Testing Schema Map Policies,” on
page 90.

Saves the Schema Map policy as a .xml file.

Deploys the Schema Map policy into the Identity Vault.

For more information, see “Deploying a Policy to an
Identity Vault” in the Designer 4.0.2 for Identity
Manager 4.0.2 Administration Guide.

Compares the Schema Map policy in Designer to the
Schema Map policy in the Identity Vault. For more
information, see “Using the Compare Feature When
Deploying” in the Designer 4.0.2 for Identity Manager
4.0.2 Administration Guide.

Launches the Schema Map editor.

Launches the XML editor. For more information, see
“The Novell XML Editor” in the Designer 4.0.2 for
Identity Manager 4.0.2 Administration Guide.

Launches the text editor.

Deletes the selected Schema Map policy.

Allows you to rename the Schema Map policy.

Defining Schema Map Policies

91



92

6.6.2

Policy Flow View Additional Options

There are additional options to manage the Schema Map policy in the Policy Flow view. Right-click
the Schema Map policy in the Policy Flow view to see the additional options.

Table 6-3 Enter Table Title Here

Option

Description

H Add Policy > DirXML Script

A=Add Policy > XSLT

M= Add Policy > Schema Map

Add Policy > Link to Existing

Add Policy > Copy Existing

M= Edit Policy > Schema Map

= DirXML Script Tracing

aSimulate

Live > Import

Live > Deploy

Live > Compare

Live > Driver Configuration > Import Attribute

Adds a new Schema Map policy by using DirXML
Script.

Adds a new Schema Map policy by using XSLT.

Adds a new Schema Map policy containing no
information.

Allows you to browse and select an existing Schema
Map policy to link to the current Schema Map policy.

Allows you to browse to and select an existing
Schema Map policy to copy to the current Schema
Map policy.

Launches the Schema Map editor. For more
information, see Section 6.2, “Editing a Schema Map
Policy,” on page 83.

Enables DirXML Script tracing on the Schema Map
policy.

Tests the Schema Map policy. For more information,
see Section 6.3, “Testing Schema Map Policies,” on
page 90.

Imports and existing Schema Map policy from the
Identity Vault. For more information, see “Importing
Channels, Policies, and Schema ltems from the
Identity Vault” in the Designer 4.0.2 for Identity
Manager 4.0.2 Administration Guide.

Deploys the selected Schema Map policy into the
Identity Vault. For more information, see “Deploying a
Policy to an Identity Vault"Designer 4.0.2 for Identity
Manager 4.0.2 Administration Guide.

Compares the selected Schema Map policy to a
Schema Map policy in the Identity Vault. For more
information, see “Using the Compare Feature When
Deploying” in the Designer 4.0.2 for Identity Manager
4.0.2 Administration Guide.

Allows you to import attributes from the Identity Vault
and compare the attributes from the Identity Vault to
what is in Designer. For more information, see
“Importing Channels, Policies, and Schema Items from
the Identity Vault” in the Designer 4.0.2 for Identity
Manager 4.0.2 Administration Guide.
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Option

Description

Live > Driver Configuration > Deploy Attributes

Live > Driver Configuration > Compare Attributes

Live > Driver Status
Live > Start Driver
Live > Stop Driver
Live > Restart Driver
Delete All Set Policies

Remove All Set Policies

Allows you to deploy attributes from Designer into the
Identity Vault and compare the attributes from
Designer with the attributes in the Identity Vault. For
more information, see “Deploying a Policy to an
Identity Vault” in the Designer 4.0.2 for Identity
Manager 4.0.2 Administration Guide.

Allows you to compare attributes from the selected
Schema Map policy to attributes in the Identity Vault.
For more information, see “Using the Compare
Feature When Deploying” in the Designer 4.0.2 for
Identity Manager 4.0.2 Administration Guide.

Displays the status of the driver.

Starts the driver.

Stops the driver.

Restarts the driver.

Deletes all policies in the selected policy set.

Removes all policies from the selected policy set, but
does not delete the existing policies.

Policy Set View Additional Options

There are additional options to manage the Schema Map policy in the Policy Set view. Right-click the
Schema Map policy in the Policy Set view to see the additional options.

Table 6-4 Policy Set View Options

Option Description
& Edit Launches the Schema Map editor. For more
) information, see Section 6.2, “Editing a Schema Map
Policy,” on page 83.
E=Copy Creates a copy of the Schema Map policy.
[Llsave As Saves the Schema Map policy as a . xm1 file.
&Simulate Tests the Schema Map policy. For more information,
see Section 6.3, “Testing Schema Map Policies,” on
page 90.
= Remove Removes the Schema Map policy from the policy set,

Link to Existing Policy

1 Move up

but does not delete the Schema Map policy from the
Identity Vault.

Allows you to browse to another Schema Map policy
and link it into the existing policy.

Moves the Schema Map policy up in the execution
order of the policy.
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Option

Description

- Move down

Export to Configuration File
Live > Deploy

Live > Compare

H Delete

Properties

Moves the Schema Map policy down in the execution
order of the policy.

Saves the Schema Map policy as a . xm1 file.
Deploys the Schema Map policy into the Identity Vault.

Compares the Schema Map policy in Designer to the
Schema Map policy in the Identity Vault.

Deletes the selected Schema Map policy.

Allows yo to rename the Schema Map policy.
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Controlling the Flow of Objects with the
Filter

The Filter editor allows you to manage the filter. In the Filter editor, you define how each class and
attribute should be handled by the Publisher and Subscriber channels.

Figure 7-1 The Filter Editor

Filter Editor @@ X &E a8 B w®
ﬁ Active Directary Filker, Active Directory, entitiment, DOCIDMTEST
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Create home directory
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When information is synchronized between connected systems, the connected system can receive the

changes or just be notified that a change has occurred. Designer displays this information in the
Policy Flow view as Sync and Notify filters.
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If a filter is set to Sync, then the objects modifications are automatically synchronized to the
connected system. If the filter is set to Notify, then the object modification is reported to the
metadirectory engine, but the object is not automatically synchronized. For more information, see
Section 7.2.5, “Changing the Filter Settings,” on page 101.

This section includes the following topics:

¢ Section 7.1, “Using the Filter Editor,” on page 96

¢ Section 7.2, “Editing the Filter,” on page 100

¢ Section 7.3, “Testing the Filter,” on page 106

¢ Section 7.4, “Exporting and Importing Filter Files,” on page 106

¢ Section 7.5, “Adding Comments to Classes and Attributes,” on page 106
¢ Section 7.6, “Viewing the Filter in XML,” on page 107

¢ Section 7.7, “Deploying the Filter,” on page 107

¢ Section 7.8, “Additional Filter Options,” on page 107

7.1 Using the Filter Editor

The Filter editor allows you to edit filter policies. This section includes the following topics:

¢ Section 7.1.1, “Accessing the Filter Editor,” on page 96
¢ Section 7.1.2, “Navigating the Filter Editor,” on page 99
¢ Section 7.1.3, “Understanding the Filter Editor Toolbar,” on page 99

7.1.1 Accessing the Filter Editor

96

The Filter editor allows you to edit the filter. There are three different ways to access the Filter editor:

¢ “Model Outline View” on page 96
¢ “Policy Flow View” on page 97
¢ “Policy Set View” on page 98

Model Outline View

1 In the Outline view, select the Show Model Outline icon .

2 In the Model Outline, open the driver for which you want to manage a filter.
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3 Double-click the Filter object (or right-click it and select Edit) to launch the Filter editor.

Policy Flow View

1 In the Outline view, select the Show Policy Flow icon.
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Active Directory

Publisher

Identity Yault

2 In the Policy Flow, double-click the Sync icon or the Notify objects (or Right-click and select Edit
Policy > Filter) to launch the Filter editor.

Policy Set View

1 Double-click the filter object in the Policy Set view.
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Active DirectoryDriver Policy Sets

s + X - 48
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7.1.2

7.1.3

Navigating the Filter Editor

The Filter Editor uses standard point-and-click navigation. However, it also provides keyboard-
based navigation options as described in Table 7-1.

NOTE: The Filter Editor lets you order the classes/attributes as needed:

¢ Click the header bar above the class/attribute list to switch between ascending and descending
order. This sorts both the classes and the attributes within the classes.

¢ Click and drag individual classes or attributes to create a custom order.

Table 7-1 Filter Editor Keyboard Support

Keystroke Description

Up-arrow Moves the cursor up in the Filter editor.
Down-arrow Moves the cursor down in the Filter editor.
Left-arrow Collapses the information displayed.

Right-arrow Expands the information displayed.

Insert Adds a class.

Ctrl+Insert Adds an attribute.

Delete Deletes the selected items.

Esc Exits the edit mode.

Ctrl+A Selects all classes and attributes in the Filter editor.

Understanding the Filter Editor Toolbar

The Filter editor includes a toolbar that provides access to the following features. Each of these

features, along with options to Undo < and Redo " recent actions, is also available from a drop-
down menu by right-clicking in the Filter Editor.

Tool Description
@ Add Attributes opens the Schema Browser so you can select attributes from the selected class to
add to the filter policy. For more information, see “Adding an Attribute” on page 101.
Gi Add Classes opens the Schema Browser so you can select classes from the Identity Vault schema
to add to the filter policy. For more information, see “Adding a Class” on page 101.
3% Delete deletes the selected attributes and classes from the filter policy.
i Default Attribute Settings lets you define default values for all attributes added to the filter policy.

e

For more information, see Section 7.2.4, “Setting Default Values for Attributes,” on page 101.

o Copy an Existing Filter lets you copy the filter policy from another Designer object. For more
- information, see Section 7.2.3, “Copying an Existing Filter,” on page 101.

G Import Filter imports an existing filter policy from a previously saved XML file. For more
information, see Section 7.4.2, “Importing a Filter File,” on page 106.
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Tool Description

Export Filter saves the current filter policy to an XML file. For more information, see Section 7.4.1,

=
“Exporting a Filter File,” on page 106.
! Deploy Filter deploys the filter policy to a live Identity Manager environment. For more information,
see Section 7.7, “Deploying the Filter,” on page 107.
o Expand All expands all Class/Attribute groups in the filter policy.
= Collapse All collapses all Class/Attribute groups in the filter policy.
& Clear Filter deletes all class and attribute entries from the filter policy.
& Launch Policy Simulator launches the Policy Simulator. For more information, see Chapter 9,
“Testing Policies with the Policy Simulator,” on page 147.
(@ Help launches the context-sensitive help for the Filter editor.

7.2 Editing the Filter

The Filter editor allows you to create and edit the filter. It provides the following primary tasks:

¢ Section 7.2.1, “Removing or Adding Classes and Attributes,” on page 100
Section 7.2.2, “Modifying Multiple Attributes,” on page 101

*

*

Section 7.2.3, “Copying an Existing Filter,” on page 101

*

Section 7.2.4, “Setting Default Values for Attributes,” on page 101

*

Section 7.2.5, “Changing the Filter Settings,” on page 101

7.2.1  Removing or Adding Classes and Attributes

By removing or adding classes and attributes, you determine the objects that synchronize between
the connected data store and the Identity Vault.

¢+ “Removing a Class or Attribute” on page 100
¢ “Adding a Class” on page 101
¢ “Adding an Attribute” on page 101

Removing a Class or Attribute

If you do not want a class or an attribute to synchronize, the best practice is to completely remove the
class or the attribute from the filter. To remove attributes and classes from the filter, do one of the
following:

¢ Right-click the class or attribute you want to remove, then select Delete.
+ Select the class or attribute you want to remove, then click Delete ¥ .

¢ Click Clear Filter i to delete all classes and attributes from the filter.
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Adding a Class

1 Click Add Classes (.

You can also right-click in the Filter editor, then select Add Classes.
2 Browse and select the class you want to add, then click OK.
3 Change the options to synchronize the information.

4 To save the changes, click File > Save.

Adding an Attribute

1 Click Add Attributes @ .

You can also right-click in the Filter editor, then select Add Attribute.
2 Browse and select the attribute you want to add, then click OK.
3 Change the options to synchronize the information.

4 To save the changes, click File > Save.

7.2.2  Modifying Multiple Attributes

The Filter editor allows you to modify more than one attribute at a time. Press the Ctrl key and select
multiple attributes; when the option changes, it is changed for all of the selected attributes.

7.2.3  Copying an Existing Filter

You can copy an existing filter from another driver and use it in the driver you are currently working
with.

1 Click Copy an Existing Filter &,
You can also right-click in the Filter editor, then select Copy an Existing Filter.
2 Browse to and select the filter object you want to copy, then click OK.

If you have more than one Identity Vault in your project, you can copy filters from the other
Identity Vaults. When you are browsing to select the other object, you can browse to the other
Identity Vault and use a filter stored there.

7.2.4  Setting Default Values for Attributes

You can define the default values for new attributes when they are added to the filter.

1 Click Default Attribute Settings .

2 Select the options you want new attributes to have, then click OK.

7.25 Changing the Filter Settings

The Filter editor gives you the option of changing how information is synchronized between the
Identity Vault and the connected system. The filter has different settings for classes and attributes.

1 In the Filter editor, select a class.
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2 Change the filter settings for the selected class.

See Table 7-2 on page 103 for information on each of the class settings available in the Filter
Editor.

3 In the Filter Editor, select an attribute.
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4 Change the filter settings for the selected attribute, then click Save |5 (in the Designer toolbar) to

save the changes.

See Table 7-3 on page 104 for information on each of the attribute settings available in the Filter

Editor.

Table 7-2  Filter Editor Class Settings

Options Definitions

Publish .

Synchronize: Allows the class to synchronize from the
connected system into the Identity Vault.

Ignore: Does not synchronize the class from the connected
system into the Identity Vault.

Subscribe + Synchronize: Allows the class to synchronize from the Identity
Vault into the connected system.
¢ Ignore: Does not synchronize the class from the Identity Vault
into the connected system.
Create Home Directory Create Home Directory allows you to create a home directory for a

User object in eDirectory. The option only works for eDirectory.

*

*

Track Member of Template ¢

Yes: Automatically creates home directories.

No: Does not create home directories.

Yes: Determines whether or not the Publisher channel
maintains the Member of Template attribute when it creates
objects from a template.

No: Does not track the Member of Template attribute.

When a User object is created using an eDirectory Template
object, the eDirectory driver maintains the Member of Template
attribute, if the Track Member of Template option is selected.
The option only works for eDirectory.
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Table 7-3  Filter Editor Attribute Settings

Options

Definitions

Publish

Subscribe

+ Synchronize: Changes to this object are reported and

automatically synchronized.

Ignore: Changes to this object are neither reported nor
automatically synchronized.

Notify: Changes to this object are reported, but not automatically
synchronized.

Reset: Resets the object value to the value specified by the
opposite channel. (You can set this value on either the Publisher
channel or Subscriber channel, not both.)

The Reset option makes a data store the authoritative source of
information. For example, if employee addresses should only be
changed in the HR database, then set the Reset option in the filter
for this attribute. When an address is changed in the e-mail
system and sent to the HR database, the filter sends the
information from the HR database back to the e-mail system and
the employee’s address is not changed.

Synchronize: Changes to this object are reported and
automatically synchronized.

Ignore: Changes to this object are neither reported nor
automatically synchronized.

Notify: Changes to this object are reported, but not automatically
synchronized.

Reset: Resets the object value to the value specified by the
opposite channel. (You can set this value on either the Publisher
channel or Subscriber channel, not both.)

The Reset option makes a data store the authoritative source of
information. For example, if employee addresses should only be
changed in HR database, then set the Reset option in the filter for
this attribute. When an address is changed in the e-mail system
and sent to the HR database, the filter sends the information from
the HR database back to the e-mail system and the employee’s
address is not changed.
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Options

Definitions

Merge Authority

Optimize Modification to
Identity Manager

+ Default: If an attribute is not being synchronized in either channel,

no merging occurs.

If an attribute is being synchronized in one channel and not the
other, then all existing values on the destination for that channel
are removed and replaced with the values from the source for that
channel. If the source has multiple values and the destination can
only accommodate a single value, then only one of the values is
used on the destination side.

If an attribute is being synchronized in both channels and both
sides can accommodate only a single value, the connected
application acquires the Identity Vault values unless there is no
value in the Identity Vault. If this is the case, the Identity Vault
acquires the values from the connected application (if any).

If an attribute is being synchronized in both channels and only one
side can accommodate multiple values, the single-valued side’s
value is added to the multi-valued side if it is not already there. If
there is no value on the single side, you can choose the value to
add to the single side.

This is always valid behavior.

Identity Vault: Behaves the same way as the default behavior if
the attribute is being synchronized on the Subscriber channel and
not on the Publisher channel.

This is valid behavior when synchronizing on the Subscriber
channel.

Application: Behaves the same as the default behavior if the
attribute is being synchronized on the Publisher channel and not
on the Subscriber channel.

This is valid behavior when synchronizing on the Publisher
channel.

None: No merging occurs regardless of synchronization.

Yes: Changes to this attribute are examined on the Publisher
channel to determine the minimal change made in the Identity
Vault.

No: Changes are not examined.

When an operation is a Modify on the Publisher channel, the
Metadirectory engine examines the current state of the object in
the Identity Vault and changes the Modify to update only the
values that are changing. For example, if an object has attributes
of a, b, ¢, and d and the Publisher channel receives a Modify event
to remove all existing values and add a, b, d, and e, the optimize
process knows that the minimal change is to remove d and add e.

Using this option can take a long time to process events on
attributes that have more than 1,000 values.

Controlling the Flow of Objects with the Filter

105



1.3

1.4

741

71.4.2

7.5

Testing the Filter

Designer comes with a tool called the Policy Simulator, which allows you to test policies without
implementing them in a production environment. You can launch the Policy Simulator through the
Filter editor to test your policy after you have modified it.

1 Click Launch Policy Simulator “@.
2 Select To Identity Vault or From Identity Vault as the simulation point of the filter.

For more information on the Policy Simulator, see Chapter 9, “Testing Policies with the Policy
Simulator,” on page 147.

Exporting and Importing Filter Files

Designer allows you to Import an XML filter file from a particular point on the file system to the filter
editor. It also allows you to Export an XML filter file to a particular location on the file system.

¢ Section 7.4.1, “Exporting a Filter File,” on page 106
¢ Section 7.4.2, “Importing a Filter File,” on page 106

Exporting a Filter File

1 Select Export Filter (&l

2 In the Export Filter dialog box, specify a file name and location for the XML filter file, then click
Save.

Importing a Filter File

1 Select Import Filter = .
2 In the Import Filter File dialog box, browse to the filter file you want to import, then click Open.

Specify whether you want to append the imported filter rules to the existing filter rules, or
replace the existing filter rules with the imported filter rules.

NOTE: Both the Import and Export features enable the user to export filter editor documents and re-
import them if required, thereby avoiding the need to redo the entire task of adding classes and
attributes and assigning their properties.

Adding Comments to Classes and Attributes

Filter Editor lets you add additional comments to the classes and attributes in the filter. These
comments are visible in the Filter Editor, and in Designer’s generated documentation for the project.

1 In the Filter Editor, select the class or attribute to which you want to add a comment, then type
the desired comment in the Comments field.

Once entered, the comment is visible in the Comments column next to its associated class or attribute.
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1.6

1.7

7.8

7.8.1

Viewing the Filter in XML

Designer enables you to view, edit, and validate the XML by using an XML editor. Click the XML
Source tab or the XML Tree tab to access the XML editor. For more information about the XML editor,
see “The Novell XML Editor” in the Designer 4.0.2 for Identity Manager 4.0.2 Administration Guide.

Deploying the Filter
To deploy the filter to the live Identity Vault:

1 Click Deploy Filter £ .
2 In the Deployment Summary page, click Deploy.

The Deployment Summary displays Designer’s Compare feature so you know what the
differences are between Designer’s filter and the currently deployed filter, if any. For more
information about the Compare feature, see “Using the Compare Feature When Deploying” in
the Designer 4.0.2 for Identity Manager 4.0.2 Administration Guide.

3 In the Deployment Results page, click OK.

The Deployments Results page notes any errors or warnings that occurred during the
deployment process.

Additional Filter Options

When you right-click a filter object, there are multiple options presented in the Outline view, the
Policy Flow view, and the Policy Set view.

¢ Section 7.8.1, “Outline View Additional Options,” on page 107
¢ Section 7.8.2, “Policy Flow View Additional Options,” on page 108
¢ Section 7.8.3, “Policy Set View Additional Options,” on page 109

Outline View Additional Options

The Outline view offers the following filter-related options. To access them, right-click the filter object
in the Outline view.

Table 7-4 Filter Outline View Additional Options

Option Description
Z Edit Launches the Filter editor. For more information, see
Section 7.2, “Editing the Filter,” on page 100.
[Lsave As Saves the filter as a .xm1 file.
=Simulate Launches the Policy Simulator. For more information,

see Section 7.3, “Testing the Filter,” on page 106.
Export to Configuration File Saves the filter as a . xm1 file.

Live > Deploy Deploys the filter into the Identity Vault.
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Option Description

Live > Compare Compares the filter with and existing filter object in the
Identity Vault.
Open With > Designer Built-in Editor Launches the Filter editor. For more information, see

Section 7.2, “Editing the Filter,” on page 100.

Open With > Novell XML Editor Launches the XML editor. For more information, see
“The Novell XML Editor” in the Designer 4.0.2 for
Identity Manager 4.0.2 Administration Guide.

Open With > Text Editor Launches the built-in text editor.

7.8.2  Policy Flow View Additional Options

The Policy Flow view offers the following filter-related options. To access them, right-click the filter
object in the Policy Flow view.

Table 7-5 Filter Policy Flow View Additional Options

Option Description

2 Edit Launches the Filter edit. For more information, see
' Section 7.2, “Editing the Filter,” on page 100.

Saves the selected Policy Set as a . xm1 file.

L;:j_|Save As
&Simulate Launches the Policy Simulator. For more information,
see Section 7.3, “Testing the Filter,” on page 106.

Live > Import Allows you to import filter details from the Identity
Vault.

Live > Deploy Allows you to deploy the filter into the Identity Vault.

Live > Compare Compares the filter to an existing filter in the Identity
Vault.

Live > Driver Configuration > Import Attributes Allows you to import attributes from the Identity Vault
and compare the attributes from the Identity Vault to
what is in Designer.

Live > Driver Configuration > Deploy Attributes Allows you to deploy attributes from Designer into the
Identity Vault and compare the attributes from
Designer with the attributes in the Identity Vault.

Live > Driver Configuration > Compare Attributes Allows you to compare attributes from the selected
Schema Map policy to attributes in the Identity Vault.

Live > Driver Status Displays the status of the driver.

Live > Start Driver Starts the driver.

Live > Stop Driver Stops the driver.

Live > Restart Driver Restarts the driver.
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7.8.3

Policy Set View Additional Options

The Policy Set view offers the following filter-related options. To access them, right-click the filter
object in the Policy Set view.

Table 7-6 Filter Policy Set View Additional Options

Option Description

& Edit Launches the Filter editor. For more information, see
' Section 7.2, “Editing the Filter,” on page 100.

Saves the filter as a .xm1 file.

L;:j_|Save As
&Simulate Launches the Policy Simulator. For more information,
see Section 7.3, “Testing the Filter,” on page 106.
Export to a Configuration File Save the filter as a . xm1 file.
Live > Deploy Allows you to deploy the filter into the Identity Vault.
Live > Compare Compares the filter to an existing filter in the Identity

Vault.
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Using Predefined Rules

Designer includes 19 predefined rules. You can import and use these rules as well as create your own
rules. These rules include common tasks that administrators use. You need to provide information
specific to your environment to customize the rules.

¢ Section 8.1, “Command Transformation - Create Departmental Container - Part 1 and Part 2,” on
page 112

¢ Section 8.2, “Command Transformation - Publisher Delete to Disable,” on page 115

¢ Section 8.3, “Creation - Require Attributes,” on page 116

¢ Section 8.4, “Creation - Publisher - Use Template,” on page 118

¢ Section 8.5, “Creation - Set Default Attribute Value,” on page 120

¢ Section 8.6, “Creation - Set Default Password,” on page 121

¢ Section 8.7, “Event Transformation - Scope Filtering - Include Subtrees,” on page 123

¢ Section 8.8, “Event Transformation - Scope Filtering - Exclude Subtrees,” on page 124

¢ Section 8.9, “Input or Output Transformation - Reformat Telephone Number from (nnn) nnn-
nnnn to nnn-nnn-nnnn,” on page 126

¢ Section 8.10, “Input or Output Transformation - Reformat Telephone Number from nnn-nnn-
nnnn to (nnn) nnn-nnnn,” on page 127

¢ Section 8.11, “Matching - Publisher Mirrored,” on page 129

¢ Section 8.12, “Matching - Subscriber Mirrored - LDAP Format,” on page 131
¢ Section 8.13, “Matching - By Attribute Value,” on page 133

¢ Section 8.14, “Placement - Publisher Mirrored,” on page 134

¢ Section 8.15, “Placement - Subscriber Mirrored - LDAP Format,” on page 136
¢ Section 8.16, “Placement - Publisher Flat,” on page 138

¢ Section 8.17, “Placement - Subscriber Flat - LDAP Format,” on page 140

¢ Section 8.18, “Placement - Publisher By Dept,” on page 141

¢ Section 8.19, “Placement - Subscriber By Dept - LDAP Format,” on page 144

To access the predefined rules:

1 In the Policy Builder, right-click and select New > Predefined Rules > Insert Predefined Rule Before or
Insert Predefined Rule After.

Rules

RV 4 1

(== Import Policy From file,., Predefined Rule
] Include 4
£ Edt... Append Condition Group. ..
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8.1

8.1.1

The Predefined Rules dialog box displays a list of the available rules.

@ Predefined Rules _

Select Predefined Rules

Select a predefined rule and click Ok,

Zommand TransFormation - Create Departmental Container - Part 1

Command Transformation - Create Departmental Container - Part 2

Command TransFormation - Publisher Delete ko Disable

Zreation - Require atkributels)

Zreation - Publisher - Use Template

Creation - Set Defaulk Attribute Value

Creation - Set Defaulk Password

Ewent Transformation - Scope Filkering - Include subkreels)

Ewent Transformation - Scope Filkering - Exclude subtreels)

Input or Qukput Transformation - Reformat Telephone Mumber From {nnn) nnn-nnnn ko nnn-nnn-nnnn
Input or Cukput Transformation - Reformat Telephone Mumber From nnn-nnn-nnnn to (nnn) non-nnnn
Matching - Publisher Mirrored

Matching - Subscriber Mirrored - LDAP Format

Matching - by attribute value

Placement - Publisher Mirrored

Placement - Subscriber Mirrored - LDAP Format

Placement - Publisher Flak

Placement - Subscriber Flat - LDAP Format

Placement - Publisher Bv Dept

Placement - Subscriber By Dept - LDAP Format

(7 [ a4 H Zancel ]

Command Transformation - Create Departmental Container
- Part 1 and Part 2

This rule creates a department container in the destination data store, if one does not exist.
Implement the rule on the Command Transformation policy in the driver. You can implement the
rule on either the Subscriber or the Publisher channel or on both channels.

There are two steps involved in using the predefined rules: creating a policy in the Command
Transformation policy set and importing the predefined rule. If you already have a Command
Transformation policy that you want to add this rule to, skip to Importing the Predefined Rule.

¢ Section 8.1.1, “Creating a Policy,” on page 112

¢ Section 8.1.2, “Importing the Predefined Rule,” on page 113

¢ Section 8.1.3, “How the Rule Works,” on page 114

Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher or Subscriber channel.
2 Select the Command Transformation policy set in the Policy Set view, then click Create or add a
new policy to the Policy Set icon 5 to create a new policy.

3 Click Create a new policy, then click Next.
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4 Name the policy.
5 Use the default location or browse and select another location to place the policy in the driver.
Create Policy

Specify the name of the new policy and the container where it will be
created.

Policy Marne:

| Creake Container| |

Policy Container:

| Publisher.LDAP IDM Driver Set 2,JDMDESIGNTREE | Browse...

Open the editor after creating the object.

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Command Transformation policy is saved.

9 Continue with Importing the Predefined Rule.

8.1.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Command Transformation - Create Department Container - Part 1, then click OK.

= + % Command Transformation - Create Departmental Container - Part 1

Mo description available

Conditions

% Condition Group 1

% if operation equal "add"

set local variable("target-containet”, Destination DMN({length="-Z"Y

v &
v &

sef local variable("does-target-exist”, Destination Atkribute
—{"objectclass", class name="Crganizational Unit", drflocal
—Yariablef"target-containet™ i

3 Right-click in the Policy Builder and click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

4 Select Command Transformation - Create Department Container - Part 2, then click OK.
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8.1.3

F " % Command Transformation - Create Departmental Container - Part 2

Mo description available

% Condition Group 1

v 5 if local wariable 'does-target-exist' available

v % if local variable 'does-target-exist' equal ™

& add destination object{class name="Crganizational Unit”, direct="
—+true", dnflaocal Variahblel"target-container "))

a 5 add destination aktribute value"ou"”, direct="true", dn(Local
—Nariable{"target-container")), Parse DN{"dest-dn", "dot”, length="
—1", skart="-1", Local Yariable{"target-container")))

5 Save the rule by clicking File > Save.

There is no information to change that is specific to your environment.

IMPORTANT: Make sure that the rules are listed in order. Part 1 must be executed before Part 2.

How the Rule Works

This rule is used when the destination location for an object does not exist. Instead of getting a veto
because the object cannot be placed, this rule creates the container and places the object in the
container.

Part 1 looks for any Add event. When the Add event occurs, two local variables are set. The first local
variable is named target-container. The value of target-container is set to the destination DN. The
second local variable is named does-target-exist. The value of does-target-exist is set to the
destination attribute value of objectclass. The class is set to OrganizationalUnit. The DN of the
OrganizationalUnit is set to the local variable of target-container.

22 Editor
Mame: * | ohjectclass 8 g &
Class name: | Crganizational Unik 8 g &
Select object: |DM W
Specify DM: * | Local Wariable("target-containet™)

Part 2 checks to see if the local variable does-target-exist is available. It also checks to see if the value
of the local variable does-target-exist is set to a blank value. If the value is blank, then an
Organizational Unit object is created. The DN of the organizational unit is set to the value of the local
variable target-container. It also adds the value for the OU attribute. The value of the OU attribute is
set to the local variable of target-container. It uses the source format as the destination DN and the
destination format is dot format.
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8.2 Command Transformation - Publisher Delete to Disable

This rule transforms the Delete event for a user object into disabling the user object. Implement the

rule on the Command Transformation policy in the driver. The rule needs to be implemented on the
Publisher channel.

There are two steps involved in using the predefined rules: creating a policy in the Command
Transformation policy set and importing the predefined rule. If you already have a Command
Transformation policy that you want to add this rule to, skip to Importing the Predefined Rule.

¢ Section 8.2.1, “Creating a Policy,” on page 115

¢ Section 8.2.2, “Importing the Predefined Rule,” on page 115
¢ Section 8.2.3, “How the Rule Works,” on page 116

8.2.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher channel.

2 Select the Command Transformation policy set in the Policy Set view, then click Create or add a
new policy to the policy set icon 5 to create a new policy.

3 Select Create a new policy, then click Next.

4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

|

Specify the name of the new policy and the container where it will be
created.

Policy Mame:
Delete to Disable

Policy Container:

Publisher . LOWP, I0M Driver Set 2. [DMDESIGNTREE

[¥]iopen the editor after creating the object,

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to
save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Command Transformation policy is saved.

9 Continue with Importing the Predefined Rule.

8.2.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Command Transformation - Publisher Delete to Disable, then click OK.
3 Expand the predefined rule.

Using Predefined Rules 115



= % Command Transformation - Publisher Delete to Disable

Mo description available,

. % Condition Group 1

v % if operation equal "delete”

v & Fclass name equal "User"

. Zr  set destination attribute value("Login Disablad”, “rrus")

" Zr  remove associationf association{Associakioni 1))

4 Save the rule by clicking File > Save.

There is no information to change in the rule that is specific to your environment.

8.2.3 How the Rule Works

This rule is used when a Delete event occurs in the connected data store. Instead of the user object
being deleted in the Identity Vault, the User object is disabled. Anytime a Delete event occurs for a
User object, the destination attribute value of Login Disabled is set to True and the association is
removed from the User object. The User object can no longer log in to the Novell eDirectory tree, but
the User object was not deleted.

8.3 Creation - Require Attributes

This rule does not allow user objects to be created unless the required attributes are populated.
Implement the rule on the Creation policy in the driver. You can implement the rule on either the
Subscriber or the Publisher channel or on both channels.

There are two steps involved in using the predefined rules: creating a policy in the Creation policy set
and importing the predefined rule. If you already have a Creation policy that you want to add this
rule to, skip to Importing the Predefined Rule.

¢ Section 8.3.1, “Creating a Policy,” on page 116

¢ Section 8.3.2, “Importing the Predefined Rule,” on page 117

¢ Section 8.3.3, “How the Rule Works,” on page 118

8.3.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher or Subscriber channel.

2 Select the Creation policy set in the Policy Set view, then click Create or add a new policy to the
Policy Set icon &F to create a new policy.

3 Click Create a new policy, then click Next.

4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.
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Create Policy

Specify the name of the new policy and the container where it will be
created.

Policy Mame:

| Creation Policy |

Palicy Container:

| Publisher LDAP. IDM Driver Set 2. IDMDESIGMTREE | B

[¥]open the editor afker creating the object, :

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Creation policy is saved.

9 Continue with Importing the Predefined Rule.

8.3.2 Importing the Predefined Rule
1 Right-click in the Policy Builder and click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Creation - Require attributes, then click OK.
3 Expand the predefined rule.

SISV N Creation - Require attribute(s)

Mo description available

Conditions

+~ % Condition Group 1

v 5 if class name equal "User"

v 5 veko if operation atkribube not availabled[Enter name of required
—attribute]")

4 Edit the action by double-clicking the Actions tab.

5 In the Specify Name field, browse to and select the attributes you require for a User object to be
created, then click OK.

6 Click OK.
7 Save the rule by selecting File > Save.
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8.3.3

8.4

8.4.1

How the Rule Works

This rule is used when your business processes require a user to have specific attributes populated
when the user object is created. When a user object is created, the rule vetoes the creation of the object
unless the required attributes are provided. You can have one or more required attributes.

If you want more than one required attribute, right-click the Actions tab and select Append Action.
Select veto if operation attribute not available, then browse to the attribute you want to require.

Creation - Publisher - Use Template

This rule allows the use of a Novell eDirectory template object during the creation of a User object.

Implement the rule on the Publisher Creation policy in the driver. You can implement the rule only
on the Publisher channel.

There are two steps involved in using the predefined rules: creating a policy in the Creation policy set

and importing the predefined rule. If you already have a Creation policy that you want to add this
rule to, skip to Importing the Predefined Rule.

¢ Section 8.4.1, “Creating a Policy,” on page 118
¢ Section 8.4.2, “Importing the Predefined Rule,” on page 119
¢ Section 8.4.3, “How the Rule Works,” on page 119

Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher channel.

2 Select the Creation policy set in the Policy Set view, then click Create or add a new policy to the
Policy Set icon o to create a new policy.

3 Select Create a new policy, then click Next.

4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

Specify the name of the new palicy and the container where it will be
created.

Palicy Mame:
Creation Policy

Policy Container:

Publisher LDWP, DM Driver Set 2. IDMDESIGNTREE

[]iopen the editor after creating the object, !

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Creation policy is saved.

9 Continue with Importing the Predefined Rule.

Policies in Designer 4.0.2



8.4.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.
2 Select Creation - Publisher - Use Template, then click OK.

3 Expand the predefined rule.

B ¢ § Creation - Publisher - Use Template

Mo descripkion available

Conditions

+ % Condition Group 1

W & if dass name equal "User"

| % setoperation template DNCdR("[Enter DN of Template object]) |

Edit the action by double-clicking the Actions tab.

Delete [Enter DN of Template object] from the Enter DN field.

Click the Edit the arguments icon [ to launch the Argument Builder.
Select Text in the noun list.

Double-click Text to add it to the argument.

© 00 N o o b~

In the editor, click the browse icon, browse to and select the template object, then click OK.
10 Click Finish.
11 Save the rule by clicking File > Save.

8.4.3 How the Rule Works

This rule is used when you want to use a template object to create a user in the Identity Vault. If you
have attributes that are the same for different users, using the template saves time. You fill in the
information in the template object, and when the User object is created, Identity Manager calls the
template and uses that to create the User object.

During the creation of User objects, the rule performs the action of the set operation template DN.
The action calls the template object and creates the User object with the information in the template.
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8.5

8.5.1

8.5.2

Creation - Set Default Attribute Value

This rule allows you to set default values for attributes that are assigned during the creation of User

objects. Implement the rule on the Subscriber Creation policy or Publisher Creation policy in the
driver.

There are two steps involved in using the predefined rules: creating a policy in the Creation policy set

and importing the predefined rule. If you already have a Creation policy that you want to add this
rule to, skip to Importing the Predefined Rule.

¢ Section 8.5.1, “Creating a Policy,” on page 120
¢ Section 8.5.2, “Importing the Predefined Rule,” on page 120
¢ Section 8.5.3, “How the Rule Works,” on page 121

Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher or Subscriber channel.

2 Select the Creation policy set in the Policy Set view, then click the Create or add a new policy to the
Policy Set icon &r to create a new policy.

3 Click Create a new policy, then click Next.
4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

|

Specify the name of the new palicy and the container where it will be
created,

Palicy Mame:
Creation Policy

Palicy Container:

Publisher LDAP. IDM Driver Set 2. IDMDESIGNTREE

[*]iopen the editor after creating the object,

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Creation policy is saved.

9 Continue with Importing the Predefined Rule.

Importing the Predefined Rule
1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Creation - Set Default Attribute Value, then click OK.
3 Expand the predefined rule.
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8.5.3

8.6

SRV (reation - Set Default Attribute Yalue

Mo description available

Conditions

" % Condition Group 1

¥ 5 if class name equal "User"

v 5 sek defaulk atkribute valuel"[Enter attribute name]”, write-back="

—trug", "[Enter default attribute walue]")

4 Edit the action by double-clicking the Actions tab.

5 In the Specify attribute name field, click the browse icon, then browse to and select the attribute
you want to create.

6 Click the Edit the value list icon [E to launch the Argument Value List Builder.
7 Select the type of data you want the value to be.

8 Delete [Enter default attribute value], then click the Edit the arquments icon Ei to launch the
Argument Builder.

9 Create the value for the attribute in the Argument Builder, then click OK.
10 Click Finish.
11 Save the rule by clicking File > Save.

How the Rule Works

This rule is used when you want to create a User object with default attributes and values. When a
User object is created, the rule sets the attribute and the value for that attribute.

If you want more than one attribute value defined, right-click the Actions tab and click Append Action.
Select the action, set the default attribute value, and follow Step 1 on page 120 through Step 11 on
page 121 to assign the value to the attribute.

Creation - Set Default Password

During the creation of user objects, this rule sets a default password for user objects. Implement the
rule on the Creation policy in the driver. You can implement the rule on either the Subscriber or the
Publisher channel or on both channels.

There are two steps involved in using the predefined rules: creating a policy in the Creation policy set
and importing the predefined rule. If you already have a Creation policy that you want to add this
rule to, skip to Importing the Predefined Rule.

¢ Section 8.6.1, “Creating a Policy,” on page 122

¢ Section 8.6.2, “Importing the Predefined Rule,” on page 122

¢ Section 8.6.3, “How the Rule Works,” on page 123
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8.6.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher or Subscriber channel.

2 Select the Creation policy set in the Policy Set view, then click Create or add a new policy to the
Policy Set icon & to create a new policy.

3 Click Create a new policy, then click Next.
4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

Specify the name of the new policy and the container where it will be
created.

Policy Mame:

| Creation Policy |

Palicy Container:

| Publisher LDAP. IDM Driver Set 2. IDMDESIGMTREE | B

[¥]open the editor afker creating the object, :

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Creation policy is saved.

9 Continue with Importing the Predefined Rule.

8.6.2 Importing the Predefined Rule
1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Creation - Set Default Password, then click OK.
3 Expand the predefined rule.

B 5 Creation - Set Default Password

Mo description available

Conditions

& Condition Group 1

¥ 5 if class name equal "Lser"

& setdestination password|Attribute"GEiven Name"j+Atkribute
—{"Surname'"y)

4 Save the rule by clicking File > Save.

There is no information to change in the rule that is specific to your environment.
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8.6.3 How the Rule Works

This rule is used when you want User objects to be created with a default password. During the
creation of a User object, the password that is set for the User object is the Given Name attribute plus
the Surname attribute of the User object.

You can change the value of the default password by editing the argument. You can use the
Argument Builder to set the password to any other value you want.

8.7 Event Transformation - Scope Filtering - Include Subtrees

This rule excludes all events that occur except for the specific subtree. Implement the rule on the
Event Transformation policy in the driver. You can implement the rule on either the Subscriber or the
Publisher channel or on both channels.

There are two steps involved in using the predefined rules: creating a policy in the Event
Transformation policy set and importing the predefined rule. If you already have an Event
Transformation policy that you want to add this rule to, skip to Importing the Predefined Rule.

¢ Section 8.7.1, “Creating a Policy,” on page 123

¢ Section 8.7.2, “Importing the Predefined Rule,” on page 124

¢ Section 8.7.3, “How the Rule Works,” on page 124

8.7.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher or Subscriber channel.

2 Select the Event Transformation policy set in the Policy Set view, then click Create or add a new
policy to the Policy Set icon ar to create a new policy.

3 Click Create a new policy, then click Next.

4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

|

Specify the name of the new policy and the container where it will be
created,

Palicy Mame:
Event TransFormation

Palicy Container:

Publisher.LDAP, IDM Driver Set 2. IDMDESIGNTREE

[¥]iopen the editor after creating the objeck,

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to
save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Event Transformation policy is saved.

9 Continue with Importing the Predefined Rule.
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8.

8.

124

1.2

7.3

8.8

Importing the Predefined Rule

1 Right-click in the Policy Builder, then select New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.
2 Select Event Transformation - Scope Filtering - Include subtrees, then click OK.

3 Expand the predefined rule.

B 5 Event Transformation - Scope Filtering - Include subtree(s)

Mo description available

Conditions

+* & Condition Group 1

v 5 if source DM not in subtree "[Enter a subtree to incude]"

| v & vetol)

4 Edit the condition by double-clicking the Conditions tab.

5 Delete [Enter a subtree to include] in the Value field.

6 Click the browse button to browse the Identity Vault for the part of the tree you were you want
events to synchronize, then click OK.

7 Click OK.
8 Save the rule by clicking File > Save.

How the Rule Works

This rule is used when you want to exclude part of the Identity Vault from synchronizing. It allows
you to synchronize some objects and not other objects, without using the Filter. When an event occurs
anywhere but in that specific part of the Identity Vault, it is vetoed.

Event Transformation - Scope Filtering - Exclude Subtrees

This rule excludes all events that occur in a specific subtree. Implement the rule on the Event
Transformation policy in the driver. You can implement the rule on either the Subscriber or the
Publisher channel or on both channels.

There are two steps involved in using the predefined rules: creating a policy in the Event
Transformation policy set and importing the predefined rule. If you already have an Event
Transformation policy that you want to add this rule to, skip to Importing the Predefined Rule.

¢ Section 8.8.1, “Creating a Policy,” on page 125

¢ Section 8.8.2, “Importing the Predefined Rule,” on page 125

¢ Section 8.8.3, “How the Rule Works,” on page 126

Policies in Designer 4.0.2



8.8.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher or Subscriber channel.

2 Select the Event Transformation policy set in Policy Set view, then click Create or add a new policy
to the Policy Set icon 5 to create a new policy.

3 Click Create a new policy, then click Next.

4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

Specify the name of the new palicy and the container where it will be
created.

Policy Mame:
Event Transformation

Policy Container:

Publisher . LOWP, DM Driver Set 2. IDMDESIGNTREE

[¥]pen the editar after creating the object,

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to
save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Event Transformation policy is saved.

9 Continue with Importing the Predefined Rule.

8.8.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule.
2 Select Event Transformation - Scope Filtering - Exclude subtrees, then click OK.
3 Expand the predefined rule.

H fr Event Transformation - Scope Filtering - Exclude subtree(s)

Mo description available

Conditions

& Condition Group 1

v 5 if source DM in subtree "[Enter a subkree to exclude]”

| W & wetal) |

4 Edit the condition by double-clicking the Conditions tab.

5 Delete [Enter a subtree to exclude] in the Value field.

6 Click the browse icon to browse the Identity Vault for the part of the tree where you want to
exclude events from synchronizing, then click OK.
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7 Click OK.
8 Save the rule by clicking File > Save.

8.8.3 How the Rule Works

This rule is used when you want to exclude part of the Identity Vault from synchronizing. It allows
you to synchronize some objects and not other objects, without using the Filter. When an event occurs
in that specific part of the Identity Vault, it is vetoed.

8.9 Input or Output Transformation - Reformat Telephone
Number from (nnn) nnn-nnnn to nnn-nnn-nnnn

This rule transforms the format of the telephone number when a desired condition is met. Implement
the rule on the Input or Output Transformation policy in the driver. You can implement the rule on
either the Subscriber or the Publisher channel or on both channels.

There are two steps involved in using the predefined rules: creating a policy in the Input or Output
Transformation policy set and importing the predefined rule. If you already have an Input or Output
Transformation policy that you want to add this rule to, skip to Importing the Predefined Rule.

¢ Section 8.9.1, “Creating a Policy,” on page 126
¢ Section 8.9.2, “Importing the Predefined Rule,” on page 127
¢ Section 8.9.3, “How the Rule Works,” on page 127

8.9.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select a driver.

2 Select the Input or Output Transformation policy set in the Policy Set view, then click Create or
add a new policy to the Policy Set icon 5 to create a new policy.

3 Click Create a new policy, then click Next.

4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

il

Specify the name of the new policy and the container where it will be
created.

Policy Mame:
Input Transformation

Palicy Container:

Fublisher.LD&R. IOM Driver Set 2. IDMDESIGMTREE

[¥]iopen the editor after creating the object,

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.
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8.9.2

8.9.3

8.10

8 A file conflict window appears with the message “Before editing this item you need to
save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Input or Output Transformation policy is saved.

9 Continue with Importing the Predefined Rule.

Importing the Predefined Rule
1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Input or Output Transformation - Reformat Telephone Number from (nnn) nnn-nnnn to nnn-
nnn-nnnn, then click OK.

3 Expand the predefined rule.

=4 5 Input or Output Transformation - Reformat Telephone Number from
—{nnn) nnn-nnnn to nnN-nnn-nnnn

Mo description available

£ Condition Group 1

Define new condition here

reformat operation attributel"phone”, Replace Firsk(" 4 dydidi)
—is*didid-Odidd g, "$1-$2-43", Local Wariablel current-
—value"))

Edit the condition by double-clicking the Conditions tab.

Define the condition you want to have occur when the telephone number is reformatted.
Click OK.

Save the rule by clicking File > Save.

~N o o1 b~

How the Rule Works

This rule is used when you want to reformat the telephone number. You define the condition that is
to be met when the telephone number is reformatted.

Input or Output Transformation - Reformat Telephone
Number from nnn-nnn-nnnn to (nnn) nnn-nnnn

This rule transforms the format of the telephone number when a desired condition is met. Implement
the rule on the Input or Output Transformation policy. You can implement the rule on either the
Subscriber or the Publisher channel or on both channels.

There are two steps involved in using the predefined rules; creating a policy in the Input or Output
Transformation policy set and importing the predefined rule. If you already have an Input or Output
Transformation policy that you want to add this rule to, skip to Importing the Predefined Rule.

¢ Section 8.10.1, “Creating a Policy,” on page 128

¢ Section 8.10.2, “Importing the Predefined Rule,” on page 128

¢ Section 8.10.3, “How the Rule Works,” on page 129
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8.10.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select a driver.

2 Select the Input or Output Transformation policy set in the Policy Set view, then click Create or
add a new policy to the Policy Set icon 5 to create a new policy.

3 Click Create a new policy, then click Next.

4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

|

Specify the name of the new policy and the container where it will be
created,

Policy Mame:
Input Transformation

Policy Container:

Publisher . LOWP, I0M Driver Set 2. IDMDESIGMTREE

[¥]iopen the editar after creating the object,

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to
save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Input or Output Transformation policy is saved.

9 Continue with Importing the Predefined Rule.

8.10.2 Importing the Predefined Rule

1 Right-click in the Policy Builder and click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Click Input or Output Transformation - Reformat Telephone Number from nnn-nnn-nnnn to (nnn) nnn-
nnnn, then click OK.

3 Expand the predefined rule.

= 5 Input or Output Transformation - Reformat Telephone Number from
—nnn-nnn-nnnn to {nnn) nnn-nnnn

Mo description available

£ Condition Group 1

Define new condition here

reformat operation attributed"phone", Replace First("~{dd\d}-
—{di )= didh g, L) $2-43", Lacal Wariabled"current-
—yalue™in)

4 Edit the condition by double-clicking the Conditions tab.
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8.10.3

8.11

8.11.1

5 Define the condition you want to have occur when the telephone number is reformatted.
6 Click OK.
7 Save the rule by clicking File > Save.

How the Rule Works

This rule is used when you want to reformat the telephone number. You define the condition that is
to be met when the telephone number is reformatted.

Matching - Publisher Mirrored

This rule matches for objects in the Identity Vault by using the mirrored structure in the data store
from a specified point. Implement the rule on the Matching policy in the driver. You can implement
the rule only on the Publisher channel.

There are two steps involved in using the predefined rules: creating a policy in the Matching policy
set and importing the predefined rule. If you already have a Matching policy that you want to add
this rule to, skip to Importing the Predefined Rule.

¢ Section 8.11.1, “Creating a Policy,” on page 129
¢ Section 8.11.2, “Importing the Predefined Rule,” on page 130
¢ Section 8.11.3, “How the Rule Works,” on page 130

Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher channel.

2 Select the Matching policy set in the Policy Set view, then click Create or add a new policy to the
Policy Set icon Ar to create a new policy.

3 Click Create a new policy, then click Next.

4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

il

Specify the name of the new policy and the container where it will be
created,

Policy Mame:
Matching

Policy Conkainet:

Publisher.LDAF. IDM Driver Set 2. [DMDESIGNTREE

[#]iopen the editor after creating the object. :

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.
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8.11.2

8.11.3

130

8

9

1

A file conflict window appears with the message “Before editing this item you need to
save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Matching policy is saved.

Continue with Importing the Predefined Rule.

Importing the Predefined Rule

Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Matching - Publisher Mirrored, then click OK.
3 Expand the predefined rule.

ol

6
7
8
9

10
11
12

13
14

SIS N Mat ching - Publisher Mirrored

Mo description available

" % Condition Group 1

& if source DM in subtree "[Enter base of source histarchy]"

o & setlocal variable("dest-base”, "[Enter base of destinatian
—hierarchy]")

v 5 find matching object{scope="entry", dniLocal Yariable"dest-basa™
—+""+Unmatched Source DM{convert="true"}7}

Edit the condition by double-clicking the Conditions tab.

In the Value field, browse to and select the container in the source hierarchy where you want the
matching to start, then click OK.

Click OK.

Edit the action by double-clicking the Actions tab.

Delete [Enter base of destination hierarchy] from the Specify string field.
Click the Edit the arguments icon [ to launch the Argument Builder.
Select Text in the noun list.

Double-click Text to add it to the argument.

In the editor, click the browse button, browse to the container in the destination hierarchy where
you want the source structure to be matched, then click OK.

Click Finish.
Save the rule by clicking File > Save.

How the Rule Works

This rule matches for objects in the Identity Vault by using the mirrored structure in the data store
from a specified point. When an Add event occurs and the driver checks to see if the object exists, it
starts checking at the specific DN in the data store. The driver then sets a local variable of dest-base to
be the starting point in the Identity Vault that the structure is mirrored to in the data store. The driver
then creates the context it is searching by adding the local variable of dest-base plus a \ and the
source DN of the object. It creates the path it is looking for in the slash format.
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8.12 Matching - Subscriber Mirrored - LDAP Format

This rule matches for objects in the data store by using the mirrored structure in the Identity Vault

from a specified point. Implement the rule on the Matching policy in the driver. You can implement
the rule only on the Subscriber channel.

There are two steps involved in using the predefined rules: creating a policy in the Matching policy

set and importing the predefined rule. If you already have a Matching policy that you want to add
this rule to, skip to Importing the Predefined Rule.

¢ Section 8.12.1, “Creating a Policy,” on page 131
¢ Section 8.12.2, “Importing the Predefined Rule,” on page 131
¢ Section 8.12.3, “How the Rule Works,” on page 132

8.12.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Subscriber channel.

2 Select the Matching policy set in the Policy Set view, then click Create or add a new policy to the
Policy Set icon &r to create a new policy.

3 Click Create a new policy, then click Next.
4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

|

Specify the name of the new policy and the container where it will be
created.

Palicy Mame:
Matching

Palicy Containet:

Publisher LDAP.IDM Driver Set 2. IDMDESIGNTREE

[*]open the editor after creating the ohieck, :

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Matching policy is saved.

9 Continue with Importing the Predefined Rule.

8.12.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Matching - Subscriber Mirrored - LDAP format, then click OK.
3 Expand the predefined rule.
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8.12.3

132

ol

6
7
8
9

10
11
12

13
14

SR N Mat ching - Subscriber Mirrored - LDAP format

Mo description available

Conditions

+ 2% Condition Group 1

« & if source DN in subtree "[Enter base of source hierarchy]"

v 5 zet local variable('dest-base", "[Enter base of destination
—hierarchy]™

v 5 find matching object{scope="entry", dniUnmatched Source DM

—{converk="true")+","+Local Yariable{"dest-base")))

Edit the condition by double-clicking the Conditions tab.

In the Value field, browse to and select the container in the source hierarchy where you want the
matching to start, then click OK.

Click OK.

Edit the action by double-clicking the Actions tab.

Delete [Enter base of destination hierarchy] from the Specify String field.
Click the Edit the arguments icon [ to launch the Argument Builder.
Select Text in the noun list.

Double-click Text to add it to the argument.

In the editor, click the browse icon, browse to and select the container in the destination
hierarchy where you want the source structure to be matched, then click OK.

Click Finish.
Save the rule by clicking File > Save.

How the Rule Works

This rule matches for objects in the data store by using the mirrored structure in the Identity Vault
from a specified point. When an Add event occurs and the driver checks to see if the object exists, it
starts checking at the specific DN in the Identity Vault. The driver then sets a local variable of dest-
base to be the starting point in the data store that the structure is mirrored to in the Identity Vault.
The driver then creates the context it is searching by adding the source DN of the object and a local
variable of dest-base. It creates the path it is looking for in LDAP format.
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8.13 Matching - By Attribute Value

This rule matches for objects by specific attribute values. Implement the rule on the Matching policy

in the driver. You can implement the rule on either the Subscriber or the Publisher channel or on both
channels.

There are two steps involved in using the predefined rules; creating a policy in the Matching policy

set and importing the predefined rule. If you already have a Matching policy that you would like to
add this rule to, skip to Importing the Predefined Rule.

¢ Section 8.13.1, “Creating a Policy,” on page 133
¢ Section 8.13.2, “Importing the Predefined Rule,” on page 133
¢ Section 8.13.3, “How the Rule Works,” on page 134

8.13.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher or Subscriber channel.

2 Select the Matching policy set in the Policy Set view, then click Create or add a new policy to the
Policy Set icon &r to create a new policy.

3 Click Create a new policy, then click Next.
4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

|

Specify the name of the new policy and the container where it will be
created.

Palicy Mame:
Matching

Palicy Containet:

Publisher LDAP.IDM Driver Set 2. IDMDESIGNTREE

[*]open the editor after creating the ohieck, :

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Matching policy is saved.

9 Continue with Importing the Predefined Rule.

8.13.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.
2 Select Matching - by attribute value, then click OK.

3 Expand the predefined rule.
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8.13.3

8.14

S M Matching - by attribute value

Mo description available

Conditions

" % Condition Group 1

v 5 if class name equal "User"

& find matching objectidn{"[Enter base DM to start search]”), match
—{"[Enter name of attribute ko match on]"))

4 Edit the action by double-clicking the Actions tab.
Delete [Enter base DN to start search] from the Specify DN field.

Click the Edit the arguments icon [ to launch the Argument Builder.

5

6

7 Select Text in the noun list.

8 Double-click Text to add it to the argument.
9

In the editor, click the browse button, browse to and select the container where you want the
search to start, then click OK.

10 Click Finish.

11 In the Specify Match Attributes field, click the Edit the match attributes icon E to launch the Match
Attribute Builder.

12 Click the browse button and select the attributes you want to match. You can select one or more
attributes to match against, then click OK.

13 Click Finish.
14 Save the rule by clicking File > Save.

How the Rule Works

This rule matches for User objects by attributes. When a User object is synchronized, the driver uses
the rule to check and see if the specified attributes exist. If the attributes do not exist, a new User
object is created.

Placement - Publisher Mirrored

This rule places objects in the Identity Vault by using the mirrored structure in the data store from a
specified point. Implement the rule on the Placement policy in the driver. You can implement the rule
only on the Publisher channel.

There are two steps involved in using the predefined rules: creating a policy in the Placement policy
set and importing the predefined rule. If you already have a Placement policy that you want to add
this rule to, skip to Importing the Predefined Rule.

¢ Section 8.14.1, “Creating a Policy,” on page 135

¢ Section 8.14.2, “Importing the Predefined Rule,” on page 135

¢ Section 8.14.3, “How the Rule Works,” on page 136
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8.14.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher channel.

2 Select the Placement policy set in the policy set, then click Create or add a new policy to the Policy
Set icon ar to create a new policy.

3 Click Create a new policy, then click Next.
4 Name the policy.

Use the default location or browse and select another location to place the policy in the driver.

Create Policy

i | &

Specify the name of the new palicy and the container where it will be
created,

Policy Mame:
Matching

Policy Container:

Publisher LDAP. IDM Driver Set 2. IDMDESIGNTREE

[¥]iopen the editor after creating the object, |

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Placement policy is saved.

9 Continue with Importing the Predefined Rule.

8.14.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Placement - Publisher Mirrored, then click OK.
3 Expand the predefined rule.

= el Placement - Publisher Mirrored

Mo description available

Z  Condition Group 1

£ if source DM in subtres "[Enter base of source hisrarchy]"

5 sef local variable!"dest-base”, "[Enter base of deskination
—hierarchy]")

4 set operation destination DM{dn{Local Yariabled"dest-base"1+""
—+Unmatched Source DMconvert="true"1}

4 Edit the condition by double-clicking the Conditions tab.
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8.14.3

8.15

8.15.1

5 In the Value field, browse to and select the container in the source hierarchy where you want the
object to be acted upon, then click OK.

Edit the action by double-clicking the Actions tab.
Delete [Enter base of destination hierarchy] from the Specify String field.

Click the Edit the arguments icon [ to launch the Argument Builder.

© 00 N O

Select Text in the noun list.
10 Double-click Text to add it to the argument.

11 In the editor, click the browse button, browse to and select the container in the destination
hierarchy where you want the object to be placed, then click OK.

12 Click Finish.
13 Save the rule by clicking File > Save.

How the Rule Works

If the User object resides in the source hierarchy, the object is placed in the mirrored structure from
the data store. The placement starts at the point that the local variable dest-base is defined. It places
the User object in the location of dest-base\ unmatched source DN. The rule uses the slash format.

Placement - Subscriber Mirrored - LDAP Format

This rule places objects in the data store by using the mirrored structure in the Identity Vault from a
specified point. Implement the rule on the Placement policy in the driver. You can implement the rule
only on the Subscriber channel.

There are two steps involved in using the predefined rules: creating a policy in the Placement policy
set and importing the predefined rule. If you already have a Placement policy that you want to add
this rule to, skip to Importing the Predefined Rule.

¢ Section 8.15.1, “Creating a Policy,” on page 136

¢ Section 8.15.2, “Importing the Predefined Rule,” on page 137

¢ Section 8.15.3, “How the Rule Works,” on page 138

Creating a Policy

1 From the Outline view or the Policy Flow view, select the Subscriber channel.

2 Select the Placement policy set in the Policy Set view, then click Create or add a new policy to the
Policy Set icon Ar to create a new policy.

3 Click Create a new policy, then click Next.

4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.
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Create Policy

|

Specify the name of the new policy and the conkainer where it will be
created,

Palicy Mame:
Placement Paolicy

Palicy Container:

Publisher LDAP . IDM Driver Set 2 IDMDESIGHNTREE

[¥]open the editor after creating the object,

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to
save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Placement policy is saved.

9 Continue with Importing the Predefined Rule.

8.15.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Placement - Subscriber Mirrored - LDAP format, then click OK.
3 Expand the predefined rule.

B 5 Placement - subscriber Mirrored - LDAP format

Mo description available

& Condition Group 1

& if source DN in subtree "[Enter base of source histarchy]"

v 5 sek local variable("dest-base”, "[Enter base of destination
—hierarchy]")

& setoperation destination DN{dn{Unmatched Source DM{convert="
—true"i+", "+Local Yariabled"dest-base") i)

4 Edit the condition by double-clicking the Conditions tab.

(6]

In the Value field, browse to the container in the source hierarchy where you want the object to be
acted upon, then click OK.

Edit the action by double-clicking the Actions tab.
Delete [Enter base of destination hierarchy] from the Specify String field.

Click the Edit the arguments icon [ to launch the Argument Builder.

© 00 N O

Select Text in the noun list.
10 Double-click Text to add it to the argument.

11 In the editor, click the browse button, browse to the container in the destination hierarchy where
you want the object to be placed, then click OK.
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12 Click Finish.
13 Save the rule by clicking File > Save.

8.15.3 How the Rule Works

If the User object resides in the source hierarchy, then the object is placed in the mirrored structure
from the Identity Vault. The placement starts at the point that the local variable dest-base is defined.

It places the User object in the location of the unmatched source DN, dest-base. The rule uses LDAP
format.

8.16 Placement - Publisher Flat

This rule places objects from the data store into one container in the Identity Vault. Implement the
rule on the Placement policy in the driver. You can implement the rule only on the Publisher channel.

There are two steps involved in using the predefined rules: creating a policy in the Placement policy
set and importing the predefined rule. If you already have a Placement policy that you want to add
this rule to, skip to Importing the Predefined Rule.

¢ Section 8.16.1, “Creating a Policy,” on page 138
¢ Section 8.16.2, “Importing the Predefined Rule,” on page 139
¢ Section 8.16.3, “How the Rule Works,” on page 139

8.16.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher channel.

2 Select the Placement policy set in the Policy Set view, then click Create or add a new policy to the
Policy Set icon 5 to create a new policy.

3 Click Create a new policy, then click Next.
4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

il |

Specify the name of the new policy and the container where it will be
created.

Policy Mame:
Placement Policy

Policy Containet:

Publisher LD . IDM Driver Set 2. IDMDESIGHTREE

[¥]iopen the editor after creating the object,

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.
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8.16.2

8.16.3

8 A file conflict window appears with the message “Before editing this item you need to
save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Placement policy is saved.

9 Continue with Importing the Predefined Rule.

Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Placement - Publisher Flat, then click OK.
3 Expand the predefined rule.

= ol Placement - Publisher Flat

Mo description available

% Condition Group 1

Z i class name equal "User"

5 zet [ocal variablel"dest-base”, "[Enter DM of destination container]")

£ set operation destination DH{dn{Local Yariable("dest-base"+""
—+Escape Destination DM{URnique Mame("CN", scope="subtree",
— owercaselSubstringflength="1", Operation Atkributes"Given
—Mame")1+Operation Attributed"Surname")), LowercaselSubskring
—{length="2", Operation Attributed” Given Mame" 11+ 0peration
—fktribuke Surnanme" T

Edit the action by double-clicking the Actions tab.

Delete [Enter DN of destination container] from the Specify String field.
Click the Edit the arguments icon [ to launch the Argument Builder.
Select Text in the noun list.

Double-click Text to add it to the argument.

© 00 N o o b~

In the editor, click the browse button, then browse to and select the destination container where
you want all of the User objects to be placed, then click OK.

10 Click Finish.
11 Save the rule by clicking File > Save.

How the Rule Works

This rule places all User objects in the destination DN. The rule sets the DN of the destination
container as the local variable dest-base. The rule then sets the destination DN to be the dest-
base\CN attribute. The CN attribute of the User object is the first two letters of the Given Name
attribute plus the Surname attribute in lowercase. The rule uses slash format.
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8.17 Placement - Subscriber Flat - LDAP Format

This rule places objects from the Identity Vault into one container in the data store. Implement the
rule on the Subscriber Placement policy in the driver.

There are two steps involved in using the predefined rules: creating a policy in the Placement policy

set and importing the predefined rule. If you already have a Placement policy that you want to add
this rule to, skip to Importing the Predefined Rule.

¢ Section 8.17.1, “Creating a Policy,” on page 140
¢ Section 8.17.2, “Importing the Predefined Rule,” on page 140
¢ Section 8.17.3, “How the Rule Works,” on page 141

8.17.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Publisher channel.

2 Select the Placement policy set in Policy Set view, then click Create or add a new policy to the Policy
Set icon 4 to create a new policy.

3 Click Create a new policy, then click Next.
4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

|

Specify the name of the new policy and the conkainer where it will be
created,

Policy Mame:
Placement Policy

Policy Container:

Publisher LDAP . IDM Driver Set 2 IDMDESIGHNTREE

[¥]open the editor after creating the object,

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Placement policy is saved.

9 Continue with Importing the Predefined Rule.

8.17.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.

2 Select Placement - Subscriber Flat - LDAP format, then click OK.
3 Expand the predefined rule.
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8.17.3

8.18

SR Placement - Subscriber Flat - LDAP format

Mo description available

" % Condition Group 1

v 5 if class name equal "User"

v 5 set local variable('dest-base", "[Enter DM of destination container]")

v 5 sek operation destination DN(dn("uid="+Escape Destination DM
—{Unique Mame:"uid", scope="subtree", Lowercase{3ubstring
—{length="1", Operation Attribute)"Given Mame"))+Operation
—Akkribube"Surname"), LowercaseSubstring(length="2",
—ioperation Attribute"Given Mame" i+ Operation Attribute
—{"surname"11)+","+Local Mariable"dest-base" 1))

4 Edit the action by double-clicking the Actions tab.
Delete [Enter DN of destination container] from the Specify String field.

Click the Edit the arguments icon [ to launch the Argument Builder.

5

6

7 Select Text in the noun list.

8 Double-click Text to add it to the argument.
9

In the editor, add the destination container where you want all of the User objects to be placed.
Make sure the container is specified in LDAP format, then click OK.

10 Click Finish.
11 Save the rule by clicking File > Save.

How the Rule Works

This rule places all User objects in the destination DN. The rule sets the DN of the destination
container as the local variable dest-base. The rule then sets the destination DN to be uid=unique
name,dest-base. The uid attribute of the User object is the first two letters of the Given Name attribute
plus the Surname attribute in lowercase. The rule uses LDAP format.

Placement - Publisher By Dept

This rule places objects from one container in the data store into multiple containers in the Identity
Vault. Implement the rule on the Placement policy in the driver. You can implement the rule only on
the Publisher channel.

There are two steps involved in using the predefined rules: creating a policy in the Placement policy
set and importing the predefined rule. If you already have a Placement policy that you want to add
this rule to, skip to Importing the Predefined Rule.

¢ Section 8.18.1, “Creating a Policy,” on page 142

¢ Section 8.18.2, “Importing the Predefined Rule,” on page 142

¢ Section 8.18.3, “How the Rule Works,” on page 143
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8.18.1 Creating a Policy

1
2

From the Outline view or the Policy Flow view, select the Publisher channel.

Select the Placement policy set in the Policy Set view, then click Create or add a new policy to the
Policy Set icon &r to create a new policy.

3 Click Create a new policy, then click Next.

Name the policy.

Use the default location or browse and select another location to place the policy in the driver.

Create Policy

|

Specify the name of the new policy and the conkainer where it will be
created,

Palicy Mame:
Placement Paolicy

Policy Container:

Publisher LDWF . IDM Driver Set 2. IDMDESIGHTREE

[¥]iopen the editor after creating the object,

Select Open Editor after creating policy, then click Next.
Select DirXML Script for the type of policy, then click Finish.

A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Placement policy is saved.

Continue with Importing the Predefined Rule.

8.18.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or

Insert Predefined Rule After.

2 Select Placement - Publisher By Dept, then click OK.
3 Expand the predefined rule.
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= Gl Placement - Publisher By Dept

Mo description available

Z Condition Group 1
£ iF class name equal "User

And Z if attribute 'oU" available

5. sek local variablel"dest-base", "[Enter DM of destination
—Organization]™

5 sek operation destination DM(dn(Local Yariable!"dest-basa"+""
—+Atkributed"oU"+""+Escape Destination DM{Unique MameiCh",
—scope="subtree", LowercaselSubstringflength="1", Operation
—Atkribukel " Given Mame")+Operation Akkribukel"Surname"),

— owercasel substringflength="2", Operation Aktributed"Given
—Mame"+Operation Atkributed"Surname Y0

Edit the action by double-clicking the Actions tab.

Delete [Enter DN of destination Organization] from the Specify String field.
Click the Edit the arguments icon [ to launch the Argument Builder.
Select Text in the noun list.

Double-click Text to add it to the argument.

© o N o o b

In the editor, click the browse button, then browse to and select the parent container in the
Identity Vault. Make sure all of the department containers are child containers of this DN, then
click OK.

10 Click Finish.
11 Save the rule by clicking File > Save.

8.18.3 How the Rule Works

This rule places User objects in proper department containers depending upon the value that is
stored in the OU attribute. If a User object needs to be placed and has the OU attribute available, then
the User object is placed in the dest-base\value of OU attribute\CN attribute.

The dest-base is a local variable. The DN must be the relative root path of the department containers.
It can be an organization or an organizational unit. The value stored in the OU attribute must be the
name of a child container of the dest-base local variable.

The child containers must be associated for the user objects to be placed. The value of the OU
attribute must be the name of the child container. If the OU attribute is not present, this rule is not
executed.

The CN attribute of the User object is the first two letters of the Given Name attribute plus the
Surname attribute in lowercase. The rule uses slash format.
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8.19 Placement - Subscriber By Dept - LDAP Format

This rule places objects from one container in the Identity Vault into multiple containers in the data
store based on the OU attribute. Implement the rule on the Placement policy in the driver. You can
implement the rule only on the Subscriber channel.

There are two steps involved in using the predefined rules: creating a policy in the Placement policy
set and importing the predefined rule. If you already have a Placement policy that you want to add
this rule to, skip to Importing the Predefined Rule.

¢ Section 8.19.1, “Creating a Policy,” on page 144
¢ Section 8.19.2, “Importing the Predefined Rule,” on page 144
¢ Section 8.19.3, “How the Rule Works,” on page 145

8.19.1 Creating a Policy

1 From the Outline view or the Policy Flow view, select the Subscriber channel.

2 Select the Placement policy set in the Policy Set view, then click Create or add a new policy to the
Policy Set icon &r to create a new policy.

3 Click Create a new policy, then click Next.
4 Name the policy.

5 Use the default location or browse and select another location to place the policy in the driver.

Create Policy

|

Specify the name of the new policy and the conkainer where it will be
created,

Policy Mame:
Placement Policy

Policy Container:

Publisher LDAP . IDM Driver Set 2 IDMDESIGHNTREE

[¥]open the editor after creating the object,

6 Select Open Editor after creating policy, then click Next.
7 Select DirXML Script for the type of policy, then click Finish.

8 A file conflict window appears with the message “Before editing this item you need to

save. Do you wish to save the editor’s changes and continue?” Click Yes. The Policy
Builder is launched and the new Placement policy is saved.

9 Continue with Importing the Predefined Rule.

8.19.2 Importing the Predefined Rule

1 Right-click in the Policy Builder, then click New > Predefined Rule > Insert Predefined Rule Before or
Insert Predefined Rule After.
2 Select Placement - Subscriber By Dept - LDAP format, then click OK.

3 Expand the predefined rule.
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8.19.3

=] 5 Placement - Subscriber By Dept - LDAP format

Mo description available

% Condition Group 1

Z i class name equal "User!

And £ if atbribute 'oU" available

set local variable("dest-base”, "[Enter DM of destination
—iorganization]")

zet operation destination DR{dn"uid="+Escape Destination DN
—{Unigue Mame("uid", scope="subtree”, LowetrcaselSubstring
—{length="1", Cperation Attribute"Given Mame"YiH+Operation
—Atkribuked"Surname)), Lowercase{Substringlength="z",
—Operation Attributel"Given Mame" 1+ Operation Attribuke
—{"Surname"N+", ou="+atkribuked"OU"+", "+Local Yariable!"dest-
—base"1

Edit the action by double-clicking the Actions tab.

Delete [Enter DN of destination Organization] from the Specify string field.
Click the Edit the arguments icon [ to launch the Argument Builder.
Select Text in the noun list.

Double-click Text to add it to the argument.

© 0o N o o b~

In the editor, add the parent container in the data store. The parent container must be specified
in LDAP format. Make sure all of the department containers are child containers of this DN,
then click OK.

10 Click Finish.
11 Save the rule by clicking File > Save.

How the Rule Works

This rule places User objects in proper department containers depending upon the value that is
stored in the OU attribute. If a User object needs to be placed and has the OU attribute available, then
the User object is placed in the uid=unique name,ou=value of OU attribute,dest-base.

The dest-base is a local variable. The DN must be the relative root path of the department containers.
It can be an organization or an organizational unit. The value stored in the OU attribute must be the
name of a child container of the dest-base local variable.

The child containers must be associated for the User objects to be placed. The value of the OU
attribute must be the name of the child container. If the OU attribute is not present, then this rule is
not executed.

The uid attribute of the User object is the first two letters of the Given Name attribute plus the
Surname attribute as lowercase. The rule uses LDAP format.
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9.1

Testing Policies with the Policy
Simulator

The Policy Simulator allows you to test and debug a single policy or a group of policies contained in
a policy set without implementing the policy in the Identity Vault. It also provides a graphical editor
to create XDS Input documents. With these features, you can test the policies without affecting the
production environment or the connected system.

For more information about common tasks with the Policy Simulator, see the following sections:

¢ Section 9.1, “Accessing the Policy Simulator,” on page 147

¢ Section 9.2, “Creating an XDS Input Document,” on page 148

¢ Section 9.3, “Using the Operation Data Editor,” on page 156

¢ Section 9.4, “Using the Hex Editor,” on page 157

¢ Section 9.5, “Simulating a Policy,” on page 164

¢ Section 9.6, “Simulating Policies with Java Extensions,” on page 168

¢ Section 9.7, “Simulating Policies with Referenced Directories,” on page 169
The Policy Simulator uses XML. The eDirectory document type definition file (nds . dtd) defines the
schema of the XML documents that the Metadirectory engine can process. XML documents that do
not conform to this schema generate errors. To verify whether the document conforms to the nds . dtd

and to find information about why errors are occurring, see the “NDS DTD” in the Identity Manager
4.0.2 DTD Reference.

If the policy uses a mapping table object or ECMAScript object, the Policy Simulator tests these
objects when the policy is tested. It also allows you to test included policies and referenced GCVs.

The Policy Simulator cannot simulate the initial policy sets from application drivers such as SOAP
and Delimited text. These drivers use comma-separated files or text files as input, and the XML or
XDS is derived from policies in the policy chain. Currently, the Policy Simulator only accepts valid
XML or XDS as input. Additional functionality is being considered for future releases.

Accessing the Policy Simulator

The Policy Simulator can be accessed in three different ways:

¢ “Outline View” on page 148
¢ “Policy Flow View” on page 148
+ “Editors” on page 148

Testing Policies with the Policy Simulator 147



9.1.1

9.1.2

9.1.3

9.2

Outline View

1 Click the Show Model Outline icon &.
2 Right-click the driver, publisher, subscriber, mapping rule, filter, or any policy you want to

simulate, then select Simulate “.

Policy Flow View

1 Click the Show Policy Flow icon .
2 Right-click the Input, Output, Schema Map, filter, or any policy set icons you want to simulate,

then select Simulate “c.

Editors

You can access the Policy Simulator through the Policy Builder, the Schema Map editor, or the Filter
editor by selecting the Policy Simulator icon “& in the toolbar of each editor.

Creating an XDS Input Document

In order to simulate a policy, you must have a valid XDS Input document. The policy consumes the
input document and the results are displayed as if the policy was executed. The simulator provides a
graphical editor, to help you create the input document. The editor is called the XDS Builder.

You access the XDS Builder by clicking the XDS Builder tab in the Policy Simulator.

For information on how to access the Policy Simulator, see “Accessing the Policy Simulator” on
page 147.
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Figure 9-1 XDS Builder

Input Document

Begin by selecting a paint of simulation. Then create the input E@]
document by selecting an operation and providing parameters.
Select the source tab to edit the XML of the input document.

0% | & [E &

Simulation Point: | Input -

Cperation:
Add v

Parameter Value A
Class

Associgtion

Password

Source DN

Drestination DN b
< >

Attributes: =

XD Builder | Source

@ I [esct > H Close ]

W& Simulate Policy Transformation - Active Direct... E@

Click the Source tab in the Policy Simulator to display the input document in XML. The XDS Builder
creates this input document. You can modify the XML by editing the XML directly or using the XDS

Builder.

The XDS Builder allows you to select the operation type as well as provide the operation parameters,
attributes, and values. XDS Builder saves the parameters and values of the simulator for the current
Designer session. To make the simulator input available after Designer has been shut down, save the

input document to disk.

After you have created the XDS input document, you need to analyze the results. For more
information, see Section 9.5, “Simulating a Policy,” on page 164.

The Policy Simulator has several different components. Each component helps create the input

document to test the policy against.

¢ Section 9.2.1, “Source,” on page 150

¢ Section 9.2.2, “Import an XDS Document,” on page 150

¢ Section 9.2.3, “Use an Identity Vault Object As a Template,” on page 150
¢ Section 9.2.4, “Clear All Parameters,” on page 150

¢ Section 9.2.5, “Configuration Options,” on page 151

¢ Section 9.2.6, “Save the Input Document,” on page 151

¢ Section 9.2.7, “Simulation Point,” on page 151

¢ Section 9.2.8, “Operation,” on page 152

¢ Section 9.2.9, “Parameter and Value,” on page 152

¢ Section 9.2.10, “Attributes,” on page 154
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9.2.1

9.2.2

9.2.3

9.24

Source

The Policy Simulator allows you to create the input document in XML without using the builder. The

Source tab is an XML editor.

Import an XDS Document
The Policy Simulator allows you to import an existing input document to test the policy against.

1 In the toolbar, select Import an XDS input document from a file iy
2 Browse to and select the existing input document, then click Open.

3 Click Next to test the policy against this existing information.

Designer comes with sample input document files you can use. The files are located in the plug-in

com.novell.designer.idm.policy\simulation. The events are Add, Association, Delete, Instance,

Modify, Move, Query, Rename, and Status.

Use an Identity Vault Object As a Template

The Policy Simulator allows you to use an existing Identity Vault object to populate the input
document.

1 In the toolbar, select Browse to an object in the Identity Vault to use as a template 4,

2 If you are not logged in to the Identity Vault, specify the following information; otherwise skip

to Step 3.
2a Specify the host name of the Identity Vault server.

It can be the IP address of the server or the DNS name of the server.
2b Specify a DN of a user object to authentication to the Identity Vault.
2c Specity the password of the user in Step 2b, then click OK.

3 Browse to and select the desired object, then click OK.

If the simulation point is set to Input, Output, or Schema Map Inbound, a warning message is

displayed. (For more information about simulation points, see “Simulation Point” on page 151.)
The warning message informs the user that the input document should be created by using the
application’s attribute names and value formats. The XDS Builder converts the Identity Vault
attribute names to the corresponding application attribute by using the Schema Map policy, as

long as the driver references the Schema Map policy. However, the values for the attributes
might be in an incorrect format.

4 Click OK if a warning message is displayed.
5 Click Next to test the policy against the object.

Clear All Parameters

The Policy Simulator allows you to clear all parameters, attributes, and values that have been set. You

can create a new input document without launching the XDS Builder again.

1 In the toolbar, select Clear £ .

2 Specify information to create a new input document.
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9.2.5 Configuration Options

The Policy Simulator allows you to set configuration options for the simulation.

1 In the toolbar, select Configure options for the simulation |}
2 Specify the desired XSL Trace Level.

If you have XSL in your policy and you want to see the XSL trace results, specify a value. If the
value is set to 0, no information is displayed. The range of the trace value is 0 to 4.

3 Specity the desired Driver Trace Level.

To set the results of the simulation, set a value in the Driver Trace Level field. The range of the
trace value is 0 to 5.

4 Click OK.
® simulation Options g|
#3L Trace Level i} =
Driver Trace Level |5 —

I Ok H Cancel ]

9.2.6 Save the Input Document

The Policy Simulator does not store the input document for future sessions in Designer. If you want
to use the input document for a later session in Designer, the input document must be saved.

1 In the toolbar, click Save &l
2 Browse to a location where you want to save the file, then specify a filename.

3 Click Save to save the input document.

Novell recommends that you do not save the input document in the same directory where Designer
is installed or it might be overwritten during a Designer upgrade.

9.2.7 Simulation Point

The Policy Simulator allows you to select a policy set or group of policies to simulate with a specific
operation.

Figure 9-2  Simulation Point in the Policy Simulator
Simulation Paint: | Inpuk w

You can select a Driver object, Publisher channel, Subscriber channel, policy, or rule as the simulation
point. If you select a Driver object, Publisher channel, or Subscriber channel, the Simulation Point
options are:

Input Publisher Placement Subscriber Command
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Schema Map Inbound
Publisher Event
Publisher Sync Filter
Publisher Matching

Publisher Creation

Publisher Command

Publisher Notify Filter

Output

Schema Mapping Outbound

Subscriber Notify Filter

Subscriber Placement
Subscriber Creation
Subscriber Matching
Subscriber Event

Subscriber Sync Filter

NOTE: If you want to test a single policy, launch the simulator from the selected policy. If you do
select a specific policy or rule to test, the Simulation Point options are To Identity Vault and From

Identity Vault.

9.2.8 Operation

The XDS Builder allows you to select the type of operation that the input document performs.

9.2.9

152

Figure 9-3 Operation Options in the XDS Builder

Cperakion:

Add b

The available operations are:

Add

Add Association

Check Object Password
Check Password

Delete

Get Named Password

Modify

Modify Association
Modify Password
Move

Query

Extended Query

Remove Association
Rename

Status

Sync

Instance

Depending upon which operation is selected, the XDS Builder displays different options and screens.

Parameter and Value

The XDS Builder allows you to define parameters and specify values for the selected operation. Each
operation displays different parameters.
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Figure 9-4 Parameters and Values in the XDS Builder

Operation:

Add w

Parameter Yalue o
Class | Liser
Association
Password
Source DN
Destination DM
Template DM
Event ID b

Attributes: ¥ =

<Mo Attributes= Add Attribute. ..

The list of parameters for each operation is set, and cannot be changed. You do not need to have each
parameter defined for the simulation to work; just define the parameters that apply to your policy.
You can edit the parameter value by double-clicking the value or selecting the value and clicking the
Edit button.

All parameter values are edited inline, with the exception of Class and Operation Data parameters.
Editing these parameters launches a dialog box that allows you to select a class name or edit the
operation data.

Parameters that contain a reference to an object enable the Browse button. Although these values can
be edited inline, the Browse button allows you to browse for an object in the application or the
Identity Vault, depending on the current simulation point. For any Publisher channel or Input
simulation point the Browse button for any source parameters such as Source DN launches the
application browser. While all destination parameters such as Destination DN launches the Identity
Vault Browser.

Likewise, for any Subscriber channel or Output simulation point, the Browse button for any source
parameters such as Source DN launches the Identity Vault browser. However, the Browse button for
all destination parameters such as Destination DN, launches the application Browser.

Editing the Class parameter launches the application class browser when the Input, Output, or
Schema Map inbound policy simulation point is selected. For all other simulation points, the Identity
Vault class browser is opened. If the desired class is not included in the application or Identity Vault
schema, it can be added during the simulation process. For more information about managing a
schema in Designer, see “Class List Toolbar” in the Designer 4.0.2 for Identity Manager 4.0.2
Administration Guide.

Editing the Operation Data parameter launches the Operation Data editor. For more information, see
Section 9.3, “Using the Operation Data Editor,” on page 156.
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0.2.10 Attributes

The Input Document Attributes field allows you to add, edit, and remove attribute values for
simulating operations.

+ “Working with Attribute Values” on page 154
¢ “Simulating the Adding of an Attribute” on page 155
¢ “Simulating the Modification of an Attribute” on page 155

Figure 9-5 XSD Input Document - Attribute Field

Attributes: H =
= Telephone MNumber Add Attribuke. .
801-555-0234
= Facsimile Telephone Mumber
=l skruckured-value

FaxMumber=801-555-9999 Edit...

faxBitCount=3
fFaxParameters=9,

Remove

= audio
FOAGAAEdAAAAAAAAAAAAAAAAGOAAAAAAAAAALAALAAALAAAALAAALL

Working with Attribute Values

Because there are several different attribute types, the Attributes field provides different ways of
manipulating attribute values.

+ Add a New Attribute: To add a new attribute to the attribute list, click Add Attribute. For more
information, see “Simulating the Adding of an Attribute” on page 155.

+ Remove an Attribute: To remove an attribute from the attribute list, select the attribute, then
click Remove (or right-click the attribute, then select Remove.)

¢ Add an Attribute Value: To add another value to an existing attribute, select the attribute, then
click Add (or right-click the attribute, then select Add.

¢+ Remove an Attribute Value: To remove a value from an existing attribute, select the value, then
click Remove (or right-click the value, then select Remove.)

¢ Change an Attribute Value: To change the value of an existing attribute, select an attribute
value, then click Edit (or double-click an attribute value.)

If the attribute uses a structured value, you can change each of the value components separately.
You cannot modify the entire structured value at once.

If the attribute is an octet string, Simulator opens the Hex Editor to modify the value. For more
information, see Section 9.4, “Using the Hex Editor,” on page 157.
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Identity Vault Schema When working with Identity Vault attributes with structured values, the
Simulator displays customized Value editor dialog boxes that describe each of the structured
value components. For example, adding a Facsimile Telephone Number attribute launches a
Value Editor dialog box that asks for the Fax Number, Bit Count, and Parameters for the
attribute, each of which is a component of the Facsimile Telephone Number structured value.

However, when working with an Application schema, the Simulator uses a generic structured
value dialog box since it cannot know the type of data that comprises the structured value.

Simulating the Adding of an Attribute

1
2
3
4

Select Add in the Operation field of the Simulator.
Double-click Class in the Parameter field of the Simulator.
Browse to and select the desired class, the click OK.
Click Add Attribute.

The Add Attribute icon launches the Identity Vault or application attribute browser, based on the
simulation point.

5 Browse to and select the desired attribute, then click OK.

6 Specify the attribute value, then click OK.

Based on the attribute type, Simulator opens either the Value editor or the Hex editor so you can
specify the attribute value.

Click Next in the Simulator to view the results of the Add operation with the specified attribute
value.

Simulating the Modification of an Attribute

There are multiple events that cause an attribute to be modified. They are:

*

*

*

*

Add Value: Adds a new value to the attribute.
Remove Value: Removes a single value from the attribute.
Remove All Values: Removes all values stored in the attribute.

Remove: Removes the attribute.

When you are simulating a Modify operation, you need to select which event occurs to modify the
attribute. The Simulator allows you to do that:

o 00~ W N P

In the Policy Simulator, select Modify in the Operation field of the XDS Builder.
Double-click Class in the Parameter column.
Browse to and select the desired class, then click OK.
Click the Add Attribute button.
Browse to and select the desired attribute, then click OK.
Right-click the attribute, then select one of the modifying events:
¢ Add Value
¢ Remove Value
¢ Remove All Values

* Remove

Testing Policies with the Policy Simulator 155



You can add multiple events to a single attribute.

7 Click Next in the Policy Simulator to view the results of the Modify operation.

The Policy Simulator allows you to modify the values of the attribute and change the order of events
that occur to an attribute. When you right-click an event in the Attributes field, you have additional
options that allow to make these changes:

¢ Add: Allows you to add content to the attribute value.

¢ Change to Add Value/Change to Remove Value: Allows you to change the event from Add
Value to Remove Value or vice versa.

¢+ Remove: Removes the selected event from the list of events to occur on an attribute.
¢ Move Up: Moves the selected event up in the order of execution.

+ Move Down: Moves the selected event down in the order of execution.

9.3 Using the Operation Data Editor

The Operation Data editor allows you to create an operation data element for the selected operation
by specifying attributes and values that should be included in the node. An XML fragment should
also be included in the node.

1 In the Parameter column of the Policy Simulator, double-click the Operation Data field.
2 In the Operation Data editor, click Add to add the desired attribute.

3 Specify the name of the attribute in the Attribute field.

4 Specify the value of the attribute in the Value field.

5 If you want to add an additional attribute, repeat Step 2 through Step 4.

6 Click the Data field, then specify the XML fragment.

Attribute Yalue

fram-reset krue
ald-dn cn=joe, 0=company'

Remaove

4 *

[Daka:

<nodexmy operation data</ nnde>|

7 Click OK to save the information.
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9.4

Using the Hex Editor

The Hex editor allows you to view or edit any attribute values in hex mode. For example, if you are

synchronizing eDirectory attribute values of type octet string, then you can edit this information

through Designer.

Figure 9-6 Hex Editor

@ Hex Editor

Enter the value.

Encoding: FEST MMM v |

Offset 0O 1 2 3 3 5 G 7 =] 9 A B i I E F A3CII

W

Offset: 000000000 of 00000000h | Malue: 0xFF (hex) = 234 (dec) = 0234 {oct) = 0101101011010C | Filesize: 100000

[Impurt... ] [Expurt... ]

@ I 04 ] ’ Cancel

¢ Section 9.4.1, “Accessing the Hex Editor,” on page 158

¢ Section 9.4.2, “Importing Data into the Hex Editor,” on page 158

¢ Section 9.4.3, “Inserting Data in the Hex Editor,” on page 159

¢ Section 9.4.4, “Appending Data in the Hex Editor,” on page 159

¢ Section 9.4.5, “Editing Data in the Hex Editor,” on page 160

¢ Section 9.4.6, “Reverting Changes in the Hex Editor,” on page 162
¢ Section 9.4.7, “Deleting Data in the Hex Editor,” on page 162

¢ Section 9.4.8, “Moving the Cursor in the Hex Editor,” on page 163
¢ Section 9.4.9, “Exporting Data from the Hex Editor,” on page 163
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9.4.1

9.4.2

Accessing the Hex Editor

The Hex editor is inside of the Policy Simulator. The Hex editor is opened for all attributes that have
an eDirectory syntax of octet string or unknown and an application syntax type of octet. You can also
access the Hex editor by following these steps:

1 Launch the Policy Simulator and do the following:

la Set the Simulation Point to Publisher Creation.

1b Add a class parameter of User.
1c Click the Add Attribute button to add

.‘ Schema Browser

Classes || A

a new attribute to the class.

2 In the Schema Browser, select Add an Attribute & .

Follow the steps in the New Attribute Wizard to create a new attribute. Make sure you specify
the attribute’s syntax type as Octet String.

For more information, see “Creating Identity Vault Attributes” in the Designer 4.0.2 for Identity
Manager 4.0.2 Administration Guide.

3 In the Schema Browser, select the new attribute, then click OK to launch the Hex editor.

Higher Privileges
Home Directary
hiarmePhone
homePostalfiddress

Initials
instantMessagingID
inkernationalisDMMurnber
Internet EMail Address
isManager

jackMumber

jobCode

jpeaPhoko

L

FiRxXE
attribukes of: | Iser v|
Facsimile Telephone Mumber s
Full Mame |
Generational Gualifier
Given Marme
aroup Membership
GLID

[Jonly show changes

E (0] 4 } Cancel

1 Click Import in the Hex editor.
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Importing Data into the Hex Editor

You can import data from a file into the Hex editor.

2 Browse to and select the file that has the information to import, then click Open.



9.4.3 Inserting Data in the Hex Editor

You can press the Insert key to insert a single byte, or you can use the following method to add

multiple bytes:

1 Select where you want to insert new data, then right-click in the Hex editor and select Insert.

Encoding: | ASCII w

Offset o 1 2 3 4 5

00000000: 2B 3D | 00 g
I Insert, ..

oooooolo: oo oo 00
oooooo=0: 0o 0o 00
ooooooso: oo oo 00 Undo
oooooo4o: oo oo 00 Redo
ooooooso: oo oo 00
ooooooed: 0o 00 00
ooooooyo: oo oo 00 Gata,..
ooooooso: oo 0o 00
ooooooso: oo oo 0o

Delete. ..

[ T T T T e B B e B e B o B o |

Abowt, .

2 Specify the amount of data to add in bytes (B) or kilobytes (kB).

Insert data r5_<|

Amount of data to insert: | 1 kB W
Initial hex value: E'@-

I Ok H Cancel ]

3 Specify the initial hex value, then click OK.

Insert data
Armount of data bo insert: | 1 | |B V|
Initial hex value:

[ (a]'4 ] l Cancel ]

9.4.4 Appending Data in the Hex Editor

1 Right-click in the Hex editor, then select Append.
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Enter the value.

Marne: | value 1

Enceding: | ASCIT v

Offset O 1 & 3 4 5 o

rl

Redo
Delete. ..

Goka,,.,

About, ..

The Append option is available when you right-click the first byte in the table, if there is no data.
It is also available when you right-click the last byte if there is data.

2 Specify the amount of data to append in bytes or kilobytes.

Append data [5__(|
Amount of data to append: | | |B w |
Initial hex value:

I Ok ][ Cancel ]

3 Specify the initial hex value, then click OK.

9.45 Editing Data in the Hex Editor

1 From the Encoding drop-down list, select the desired encoding for the value.
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(Iincnding: ASCII

Off=set
o0oooooo:
o0ooo01o:
o00000z0o:
o0o0o0o030:
o0ooo04o0:
o00000so:
o00000ED:
aoooooYo:
o00000s0:
o000o0s0:
o00000AD:
O00000ED:
o0ooo0co:
o00000no:
O00000ED:
O00000Fo:
ooooo100:
ooooo11o:
o0oo01z0o:

u}
2B
aa
aa
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aa
aa
aa
aa
aa
aa
aa
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aa
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aa

1
3D
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ao
ao
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ao
ao
ao
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oo
oo
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oo
oo

3
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u]u]
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oo
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oo
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aa
aa
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aa
aa
aa
aa
aa
aa
aa
aa
aa
aa
aa
aa
aa
aa
aa

ao
ao
ao
ao
ao
ao
ao
ao
ao
ao
ao
ao
ao
ao
ao
ao
ao
ao
ao

Offset: 000000030 of 0000012Fh (6936) | Walue: 0x00 (hex) = 0 (dec) = 00 {ock) = 00000000 (bin)

Filesize: 204 bytes

When the encoding is selected, the far right column displays the value encoded.
2 Select the cell of data to edit, then edit the data.

Encoding: | A3CII

Offset
aoooooon:
goooooolin:
o0oooozo:
o0oooo30:
o0oooo40:
o0oooos0:
o0oooosn:
aooooo70:
oooooos0:
oooooosa:
o0000o0an:
O00000Ed:
aoooooca:
o0oooono:
O00000ED:
Oo00o0ara:
oooooilo0:
ooooo11id:
ooooolzo:

0
ZE
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo

1
3D
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo
oo

w

&
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When a cell is selected, the value is displayed in blue.
3 Click OK to save the changes.

The Hex editor also displays the value as hex, decimal, octet, and binary.

Filesize: 304 bytes
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Figure 9-7 Value Displayed in Multiple Formats
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9.4.6 Reverting Changes in the Hex Editor

If you make a change in the Hex editor and want to undo it:

1 Right-click in the Hex editor, then select Undo.

The last change you had made is undone.
If you decide you want that change back:

1 Right click in the Hex editor, then select Redo.

The change that was undone is now redone.

9.4.7 Deleting Data in the Hex Editor

You can delete a single byte of data by pressing the Delete key. The Hex editor also allows you to
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delete sections of data from the table:

1 Right-click in the Hex editor, then select Delete.

2 Specify the amount of data to delete in bytes or kilobytes, then click OK.
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Delete data g|

Amount of data to delete: | 1] | |B v|

[]From the cursor position ko the end

[ Ok H Cancel ]

Data is deleted from the current cursor position.

If you select From the cursor position to the end, it deletes all data in the Hex editor from the cursor
position in the table to the end of the table.

9.4.8 Moving the Cursor in the Hex Editor

You can move the cursor to a specified position in the Hex editor:

1 Right-click in the Hex editor, then select Goto.

2 Select whether the address specified in the table is a Decimal or Hexadecimal offset, then specify

the value.
Go to address Pz|
Mode
() Decimal (®) Absolute
(%) Hexadecimal () Relative down

Osltve

[ 4 ] [ Cancel

3 Select the mode of moving the cursor:
¢ Absolute: Moves the cursor to the specified offset.

¢ Relative Down: Moves the cursor down from where the cursor is currently located in the
Hex editor.

¢ Relative Up: Moves the cursor up from where the cursor is currently located in the Hex
editor.

4 Click OK to move the cursor.

9.4.9 Exporting Data from the Hex Editor

You can export data from the Hex editor to a file.

1 Click Export in the Hex editor.

2 Specity a filename and location for the file, then click Save.

Testing Policies with the Policy Simulator 163



9.5 Simulating a Policy

After the XDS input document has been created, you can use it to simulate the behavior of a policy.

1 In the Policy Simulator, after the XDS input document is complete, click Next.

W& Simulate Policy Transformation - Active Directory Driver01

Input Document I
Begin by selecting a point of simulation. Then create the input document by %]
selacting an operation and providing pararmeters, Select the source tab to edit
the XML of the input document,
Mma| & E G
Simulation Point: |INput v
Operation:
Add v
Parameter ValLie A
Class User
Associaton o=dirxML Test\ou=Users\c...
Passwiard inidalpwrc
Source DN o=dirkML Test\ou=Users\c...
Destination DM
Template D
Ewvent I
Operation Data >
Affributes: =
Strname ~ | Add Attribute. .
Giver Mame
Initials Add...
Full Mame
Generational Qualifier
Facsimile Telephone Mumber 3
XD Builder | Source
@ et = ] [ Close

2 If the policy you are simulating generates a query, review the query in the Query tab, and model
the query response in the Response tab, then click Next.

NOTE: As with Input Documents, you can browse the Identity Vault for objects that you want to
use as templates for the simulator query or response.
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W& Simulate Policy Transformation - Active Directory Driver01 B@S‘

Destination Query T
A query was generated, provide the response by entering or importing an X0S L@]
instance document on the "Response” tab. -
M £ 8

Query | Responze
Cperation.

Quiery

Parameter Walue

Class

Association

Destination DY nuihDriver Set\Actve Directory DriverOl

Scope entry

Search Classes

Read Atrbutes  Object Class

Operation Data

Atiributes:

<No Atributes = Add Atribute...
#OS Builder | Source
@ Mext> | [ Close
Field Description

Parameter Table

Attributes Field

Submit to Vault

Displays the query parameters generated during the
policy simulation. This matches the XML displayed in the
Source tab. For information on using the Parameter
table, see Section 9.2.9, “Parameter and Value,” on
page 152.

You can adjust the query parameters to vary the
response generated when you send the query to the
Application or ID Vault.

Allows you to refine your query by searching for objects
that contain particular values. For information on the
Attributes field, see Section 9.2.10, “Attributes,” on
page 154.

Sends the specified query to the Identity Vault to
generate a Response instance document. The Simulator
determines the query destination automatically and
displays the appropriate button.

Submit to Vault requires valid associations in the
Association parameter. This is typically possible only
when the ID Vault is deployed.
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Similarly, you can model the Response instance page from the Response tab, which displays a
list of objects that satisfy the query. The policy uses this response data to determine what it

should do.

W& Simulate Policy Transformation - Active Directory Driver01 Q@B‘

Destination Query

Guery | Response

Cperation.

Instance

Parameter

Class

Assaciation

Source DM

Qualified Source D
Destination DN

Parent Association

Parent Source OMN

Farent Qualfied Source O

Atfributes:
=20
novel

Yalue
Organization

novel

novel

A query was generated, provide the response by entering or importing an X0S E@]
instance document on the "Response” tab. *

N || 8

= Attnbute

#OS Builder | Source
@ Mext > l [ Close
Field Description

Parameter Table

Attributes Field

Displays the parameters of the response instance
document. This matches the XML displayed in the
Source tab. For information on using the Parameter
table, see Section 9.2.9, “Parameter and Value,” on
page 152.

Allows you to modify the response by adding or
modifying the attributes in the instance document. For
information on the Attributes field, see Section 9.2.10,
“Attributes,” on page 154.

3 Click Next.

4 In the View Transform Results page, examine the results of the transformation based on your

defined XDS input document.

Trace: The Trace tab displays the events that occur when the policy processes the defined input
document. This is similar to what you would see in DS Trace if the policy processed the same
input in a live IDM environment. You can configure the level of trace detail. For more
information, see Section 9.2.5, “Configuration Options,” on page 151.
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Trace | Oubpuk | Compare |

Stephen Active Directory :Applying policy: %+C%14C'Cors

Scephen_Active Direccory :
Stephen_hotive Directory :

Applying to add #1.
Evaluating selection cr:

Scephe h_.i.l‘.' L= !.V&_D irecrory :
Stephen kctive Directory :
<nds dedversion="3.5" ndaversion="8.x":>
<S0ucce>
<product version="?, 2. 2. PMxDirXAL<S product
<contact>Novell, Inc.</contact>
</ source>
<input:>

Query from policy

<gquery class-names="User® scope="entrcy™>
<association>o=dirilL Test)ou=Usersicn=Userl</a:
<read-attr attr-name=*0M7

<fquery>
<f inpuc>
</ nd=>

Stephen_Accive_Directory :
Stephen hctive Directory :

Query from policy resm

<nds dtdversion="3.5" ndaversion="8.x">

“Sourcer

<product version="?, 2.7,

PraDir UL/ products>

<contact>Novell, Inc.</contact>

</ sources
<outputs
£

W

Output: The Output tab displays the output document generated when the policy processes the

defined input document.

You can edit the output document in the XDS Builder or through the Source tab. If the operation
was vetoed, the operation listed in the Output tab is indicated.

| Trece Ww | Compare |
Cperation:

Parameter Value
Class Liser
Agsatiation
Password
Source DN

Template DN
Ewvant 1D
Operation Data

initialpwd

Attributes:

# Surname
o Given Nams

& Full Name

+ Generational Qualifier
# Facsimile Telephone Number

o=driML Test\ou=Usersicn=_0serl

o=driML Test\ou=Usersicn=Userl
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Compare: The Compare tab displays the input document and the output document side-by-side
so you can examine the changes resulting from the policy processing of the input document.

Trace | Output | Compare

Tewk Compare g WY
Input Docurment: at Oubput Document: |
<add-atcr atcr-n <add-attr ati .
<value type= <wvalue t
</ add-atcr> </add-attr>
<add-attr attr-n <add-attr ac
<value types <value ¢
</ add-attr> </add-attr>
<add=-attr attrc=-n <add=-attr at:
<value type= <value t
<fadd-actr> </add-atte>
<add-attr attr-n <add-attr at
<value type= <value t
</add-accr> </add-attr>
<add-atcr attr-n <add-attr at’

[ <value Lj?pt"‘]—I <value |:]
Leompone <icom:
<Ccompone <com
<Eompone Ralali ) o

</value> <fvaluex
<fadd-atcr> </add-atte>
<passwordrinicia <password>in
</ add> </ add>
</ inpuc> </ inpuc>
</ nda> </nds> W
{ > < >

5 After examining the policy effects on the input document, click one of the buttons at the bottom
of the View Transform Results page:

Back: Re-opens the Input Document page so you can repeat the simulation with a different
settings.

Next: Uses the current output document as the input document for the next policy set in the
driver. This lets you examine how the policies work together as data flows from one policy to
another.

Close: Closes the Policy Simulator.

9.6 Simulating Policies with Java Extensions

Policies that contain references to external Java extensions can now be simulated by adding the
appropriate . jar file or directory to the class path.

To add a . jar file or directory to the Java class path:

1 Select Windows > Preferences from the tool bar.
2 Navigate to the Novell > Identity Manager > Simulation page.

3 Copy the .jar file containing the Java class to the specified directory and simulate the policy.
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9.7

Simulation -

General
Directories | Options

Help
(=) Movell
Designer

Java Extensions

[=]- Identity Manager
Configuration
Dacument Generation
Entitlements
Impart/Deplay
Modeler
Policy Builder
Simulatian
iManager
Package Manager
Pravisioning Referenced Direchories
Validation

Web
WML

Restore Defaults Apply
®

4 Click Apply to save your changes, or click OK to save your changes and close the window.
Designer allows you to specify more than one directory that contains the external Java classes.

1 Click Add files to select a specific . jar file to add to the class path. Alternatively, click Add
directories to add all . jar files in the specified directory to the class path.
2 Browse to and select the desired file or directory, then click OK.

3 To remove a file or directory entry from the Java Extensions list, select the appropriate entry,
then click Remove.

Simulating Policies with Referenced Directories

Policies that contain references to external directories can be simulated by adding the appropriate
.jar file or directory to the class path.

To add a referenced directory or the Java extension:

1 Select Windows > Preferences from the tool bar.
2 Click Novell > Identity Manager > Simulation.
3 Click Add to add the Java extension or the referenced directory, then click OK.

4 Simulate your policy and the Java class path is executed.

Testing Policies with the Policy Simulator
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10.1

10.1.1

Storing Information in Resource Objects

Resource objects store information that drivers use. The resource objects can hold arbitrary data in
any format. Novell Identity Manager contains different types of resource objects.

¢ Section 10.1, “Generic Resource Objects,” on page 171

¢ Section 10.2, “Mapping Table Objects,” on page 172

¢ Section 10.3, “ECMAScript Objects,” on page 173

¢ Section 10.4, “Credential Application Objects,” on page 173

¢ Section 10.5, “Credential Repository Objects,” on page 173

¢ Section 10.6, “Package Objects,” on page 173

¢ Section 10.7, “Library Objects,” on page 174

Generic Resource Objects

Generic Resource objects allow you to store information that a policy consumes. It can be any
information stored in text or XML format. A resource object is stored in a library or driver object. An
example of using a resource object is when multiple drivers need the same set of constant
parameters. The resource object stores the parameters and the drivers use these parameters at any
time.

¢ Section 10.1.1, “Creating a Generic Resource Object,” on page 171

¢ Section 10.1.2, “Using a Generic Resource Object,” on page 172

Creating a Generic Resource Object

1 In the Outline view, right-click the location where you want to create the resource object, then
select New > Resource.

2 Specify the name of the resource object.
3 Select the content type: XML or Text.
4 Select the check box for Open the editor after creating the object, then click OK.
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10.1.2

10.2

Set Resource Name

oooo
Il

Enter a name For vour new resource,

Mame: | Creation F‘arameters|

<

Content bype: | Text

Open the editor after creating the object,

Ok I [ Cancel

5 Click Yes in the file conflict messages.

@ File Conflict g

,  Before editing this item, vou need ko save, Do wou want to save this editor's
\_#\r/ changes and continuey

6 Specify the desired text or XML, then press Ctrl+S to save the resource object.

Using a Generic Resource Object

A resource object is a place to store information. It is an eDirectory object, and to use the information
in the object, you treat it as any other eDirectory object. The attribute DirXML-Data stores the
information in the resource object, and the attribute DirXML-Content type stores the label of the
information.

To read the information stored in the resource object, use the Source Attribute (page 353) or
Destination Attribute (page 330) tokens. To write information to the object, use the following actions:
¢ Clear Destination Attribute Value (page 253)
¢ Clear Source Attribute Value (page 255)
¢ Set Default Attribute Value (page 291)
¢ Set Source Attribute Value (page 304)

Mapping Table Objects

A mapping table object is used by a policy to map a set of values to another set of corresponding
values. After a mapping table object is created, the Map (page 372) token maps the results of the
specified tokens from the values specified in the mapping table. For more information, see
Section 4.14, “Mapping Table Editor,” on page 61.
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10.3

10.4

10.5

10.6

10.6.1

ECMAScript Objects

ECMAScript objects are resource objects that store ECMAScripts. The ECMAScript is used by policies
and style sheets. For more information, see Chapter 11, “Using ECMAScript in Policies,” on page 177.

Credential Application Objects

Application objects store authentication parameter values for Novell Credential Provisioning
policies. There application objects for Novell SecureLogin and for Novell SecretStore. For information
on how to create application objects for SecureLogin, see “Creating an Application Object” in Novell
Credential Provisioning for Identity Manager 4.0.2. For information on how to create application objects
for SecretStore, see “Creating an Application Object” in Novell Credential Provisioning for Identity
Manager 4.0.2.

Credential Repository Objects

Repository objects store static configuration information for Novell Credential Provisioning policies.
There are repository objects for Novell SecureLogin and for Novell SecretStore. For information on
how to create repository objects for SecureLogin, see “Creating a Repository Object” in Novell
Credential Provisioning for Identity Manager 4.0.2. For information on how to create repository objects
for SecretStore, see “Creating a Repository Object” in Novell Credential Provisioning for Identity
Manager 4.0.2.

Package Objects

There are resource objects that are used to make package management work. For more information
about packages, see “Managing Packages” in the Designer 4.0.2 for Identity Manager 4.0.2
Administration Guide.

¢ Section 10.6.1, “DS Objects,” on page 173

¢ Section 10.6.2, “Package Prompts,” on page 174

¢ Section 10.6.3, “Filters,” on page 174

DS Objects

A DS Resource object contains information that creates eDirectory objects in the Identity Vault. To
create a DS object:
1 Right-click on the Identity Vault, driver set, or driver in the modeler, then click New > DS Object.
2 Specity the name for the DS object.

3 Click the browse icon, then browse to and select the DS object you want to add to this Resource
obejct.

4 (Conditional) If your authentication information is not saved in Designer, specify the following
information to log into the Identity Vault:

Host: Specify the IP address or DNS name of the server that contains your Identity Vault.

Username: Specify the DN of a user object to authenticate to the Identity Vault. Specify the name
using dot notation.

Password: Specify the password of the user entered above.
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10.6.2

10.6.3

10.7

5 After selecting the object, click OK.
6 Click Yes, to save the object so it can be opened in the editor.

7 Review the information in the XML editor, then close the editor.

Package Prompts

Package prompts are Resource objects that allow you to add prompts to packages you create. For
more information, see “Adding Default Package Prompts” in the Designer 4.0.2 for Identity Manager
4.0.2 Administration Guide.

Filters

Filters are Resource objects that allow you to add filters to packages. This object can only be created
on driver objects and if the Enable Package Developer Mode option is selected on the Identity Vault.

To create a filter Resource object:

Right-click the Identity Vault, then click Properties.
Verify that the Enable Package Developer Mode option is selected, then close this page.
Right-click the driver, then click New > Resource.

Specify an name for the filter Resource object.

a b~ W N P

In the content type drop-down list, select application/vnd.novell.dirxml filter-ext+xml, then click
OK.

6 Click Yes, to save the object so it can be opened in the editor.

7 Add the desired information to the filter, then close the Filter Editor.

Library Objects

Packages replace and enhance the functionality that library objects provide. For more information
about packages, see “Managing Packages” in the Designer 4.0.2 for Identity Manager 4.0.2
Administration Guide.

Library objects store multiple policies and other resources that are shared by one or more drivers. A
library object can be created in a driver set object or any eDirectory container. Multiple libraries can
exist in an eDirectory tree. Drivers can reference any library in the tree as long as the server running
the driver holds a Read/Write or Master replica of the library object.

Style sheets, policies, rules, and other resource objects can be stored in a library and be referenced by
one or more drivers.

¢ Section 10.7.1, “Creating Library Objects,” on page 175
¢ Section 10.7.2, “Adding Policies to the Library Objects,” on page 175
¢ Section 10.7.3, “Using Policies in the Library Objects,” on page 176
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10.7.1  Creating Library Objects

1 Right-click a driver set or the Identity Vault object in the Outline view, then click New > Library.
2 Specify the name of the library object, then click OK.

Set Library Name
Enter a name For wour new library,

Mame: | Library 1

I Ok ] [ Cancel

10.7.2  Adding Policies to the Library Objects

Libraries can hold any policy, XSLT style sheets, or any type of resource object.

1 Right-click the library object, select New, then select the type of object you want stored in the
library. The options are:

¢ Credential Application: Stores application authentication parameter values for Novell
Credential Provisioning policies. For information, see “Creating an Application Object” or
“Creating an Application Object” in Novell Credential Provisioning for Identity Manager 4.0.2.

¢ Credential Repository: Stores static configuration information for Novell Credential
Provisioning policies. For information, see “Creating a Repository Object” or “Creating a
Repository Object” in Novell Credential Provisioning for Identity Manager 4.0.2.

¢ DirXML Script: Creates a policy set. See Section 3.3, “Creating a Policy,” on page 22 for
more information.

¢+ ECMAScript: Creates an ECMAScript object. See Section 11.1, “Creating an ECMAScript
Object,” on page 177 for more information.

¢ Mapping Table: Creates a mapping table object. For more information, see Section 4.14.1,
“Creating a Mapping Table Object,” on page 62.

¢ Resource: Creates a generic resource object. For more information, see Section 10.1.1,
“Creating a Generic Resource Object,” on page 171.

¢ Schema Map: Creates a Schema Map object. For more information, see Chapter 6,
“Defining Schema Map Policies,” on page 79.

¢ XSLT: Creates an XSLT style sheet in the library. For more information, see “Defining
Policies by Using XSLT Style Sheets” in Understanding Policies for Identity Manager 4.0.2.

¢ From Copy: Creates a copy of an existing object.
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10.7.3  Using Policies in the Library Objects

After you have created the library, you can use any of the resources stored in the library in any policy.

1 Double-click the desired policy in the Outline view.

2 Right-click in the Policy Builder, then select New > Include > Insert Include Before or Insert Include
After.

3 Browse to and select the desired resource stored in the library object, then click OK twice.

Select an object:

= (@] 1dentity waul
= E Driver et
+-4g) Active Directory
+-4g) Delimited Text
+-ig) LDAP
+-4g/ IAS PI¥ Life Cycle Driver
+ ﬂ,,- Entollment Driver For Honewwell SmartPlus Syskem
+-dg) PACS Integration Driver For Honeywell SmartPlus Systemn
= iﬂ Library 1
S E R rnatching policies
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Using ECMAScript in Policies

ECMAScript is a scripting programming language, standardized by Ecma International. It is often
referred to as JavaScript* or JScript, but these are actually implementations of ECMAScript. Identity
Manager supports ECMAScript. ECMAScript objects are resource objects that store ECMAScripts.
The ECMAScript is called through a policy to provide advanced functionality that DirXML Script or
XSLT style sheets cannot provide.

Identity Manager uses the ECMACScript objects in two different ways: to create a custom form in the
provisioning request definition editor, and to call an ECMAScript function in policies. For more
information on custom forms, see Creating Custom Forms (http://www.novell.com/documentation/
idm35/dgpro/data/prdefcreateformschapter.html).

This section explains how to use the ECMAScript editor, how to use ECMAScript with policies, and
how to use ECMAScript with custom forms. It does not explain the ECMAScript language. See the
ECMAScript Language Specification (http://www.ecma-international.org/publications/standards/
Ecma-262.htm) for information on how to use the ECMAScript language.

¢ Section 11.1, “Creating an ECMAScript Object,” on page 177
¢ Section 11.2, “Using the ECMAScript Editor,” on page 178
¢ Section 11.3, “Examples of ECMAScripts with Policies,” on page 187

Creating an ECMAScript Object

ECMAScript objects can be created in a library, driver object, Publisher channel, or Subscriber
channel.

1 In the Outline view, right-click the location to create the ECMAScript object, then select New >
ECMAScript.

2 Specify the name of the ECMAScript object.
3 Select the check box for Open the editor after creating the object, then click OK.

MNew ECMASCcript
Create a Mew ECMASCripE ECMA
Mame:! | ECMAScript Policy Examples|

Dpen the editor after creating the object,

[ Ok, l [ Cancel

4 Click Yes in the file conflict message to save the ECMAScript object.
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11.2

11.2.1

@ File Conflict FE

,  Befare editing this ikem, wou need ko save. Do vou want ko save this editor's
\“‘:r/ changes and continue?

5 Either type the ECMAScript, or copy the ECMAScript into the editor from an existing file.
6 To save the ECMAScript press Ctrl+S after the ECMAScript is finished.

For information on how to use the ECMAScript editor, see Section 11.2, “Using the ECMAScript
Editor,” on page 178.

Using the ECMAScript Editor

ECMAScript objects are supported only with servers that have Identity Manager 3.5 or later installed.
If a server in a selected driver set is earlier than Identity Manager 3.5, an error message is displayed,
and Designer does not allow the object to be created. Change the version of the server to Identity
Manager 3.5 or later on the properties of the server, then the ECMAScript object can be created.

Designer provides an ECMAScript editor, which also includes an ECMA Expression Builder. You use
both to create the ECMAScript.

To access the ECMAScript editor:

1 Right-click an ECMAScript object in the Outline view, then select Edit.
or

When creating an ECMAScript object, select the check box Open the editor after creating the object.

The ECMAScript editor provides different types of functionality depending upon which section you
are using.

¢ Section 11.2.1, “Main Scripting Area,” on page 178

¢ Section 11.2.2, “Expression Builder,” on page 181

¢ Section 11.2.3, “Functions and Variables,” on page 183

¢ Section 11.2.4, “Error Display,” on page 184
Section 11.2.5, “Shell Area,” on page 185

*

Main Scripting Area

The ECMAScript editor provides a main scripting area where the ECMAScript is created. You can
type a new script, or copy an existing one.

178  Policies in Designer 4.0.2



Figure 11-1 Main Scripting Area

ECMAScript Editor &

F=l ECMAScript.Library, Driver Set,Identity Yaulk

=@ getBe4ImageF [ importPackage (Packages.com.hovell . xml. :
& retial importPackage (Packages.com.novell.xml.x
& 5 importPackage (Packages.com.novell.nds.d
& importClass (java. lang.3vatem) ;
& gy importclass (java.net . URL) ;
& bedos importClass (Packages.com.nowvell, io.Base
= @ split importClass (java.io.3tringWriter) ;
& document
& nodeset
& figlds S#% Read an image from & URL and return
& figld # @param {3tcring} url3cring URL of the
& ftextMode # @Atype String
=@ join * [return Basedd encoded content of th
& counk #f
& resyl function getbfdImageFromTEL (url3tring)
& node i w
M £ 2 ¥
=
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¢ “Using an Existing ECMAScript” on page 179
¢ “Editing an ECMAScript” on page 179
¢ “Coding Help for ECMAScript” on page 180

Using an Existing ECMAScript

1 Open the ECMAScript in a text editor, then copy the script.
2 Paste the ECMAScript into the ECMAScript editor.
3 Press Ctrl+S to save the ECMAScript.

Editing an ECMAScript

There are multiple options available for use to edit the ECMAScript.

Table 11-1 ECMAScript Editing Options

Option Description

<JUndo Typing Undoes the typing that has occurred.

> Redo Redoes the last action.

Of‘Cut Cuts the selected area and adds it to the clipboard.
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Option

Description

EEicopy
[HPaste

H Delete

Select All

Find/Replace

Show Expression Builder

Copies the selected area into the clipboard.

Pastes the information in the clipboard into the main
scripting area.

Deletes the selected information from the main
scripting area.

Selectes all of the information in the main scripting
area.

Finds and replaces the specified information.

Launches the Expression Builder. For more
information, see Section 11.2.2, “Expression Builder,
on page 181.

”

Coding Help for ECMAScript

The ECMA Script editor contains coding helps. To access the coding helps, right-click in the left
margin of the main scripting area, then select the desired option.

Table 11-2 Coding Help

Option

Description

Toggle Breakpoints
Enable Breakpoints
Breakpoints Properties

Add Bookmarks

Add Tasks

Revert Block

Delete Added Line
Show Quick Diff
Show Line Numbers

Preferences

To be implemented.
Sets breakpoints in the ECMAScript.
Displays the properties of the breakpoints.

Places a bookmark icon on a line in the ECMAScript
editor.

Places a task icon in a line as a reminder of additional
work that needs to be done. If you open the Task view
from the toolbar, by selecting Window > Show View >
Tasks, the task is displayed.

To be implemented.

Deletes the last line added.

To be implemented.

Displays line numbers in the main scripting area.

Sets the line delimitation and sets the suffix for the files
created in the ECMAScript editor. By default, there is
no translation for line delimiters, and the suffix is js.
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11.2.2

Expression Builder

The Expression Builder helps in creating ECMAScript expressions. The Expression Builder can be
accessed in two ways through the ECMAScript editor; it can also be accessed through the Policy
Builder and the Argument Builder.

To access the Expression Builder in the ECMAScript editor:

1 Right-click in the main scripting area of the ECMAScript editor, then click Show Expression
Builder.

or

Right-click the shell area of the ECMAScript editor, then click Show Expression Builder.

To access the Expression Builder through the Policy Builder:

1 Click the Launch ECMA Expression Builder icon next to the following actions or conditions:.

*

*

*

*

*

*

If XPath Expression
Append XML Element
Append XML Text

Clone By XPath Expressions
Set XML Attribute

Strip XPath Expression

To access the Expression Builder through the Argument Builder:

1 Double click the XPath noun token.
2 Click the Launch ECMA Expression Builder icon in the Argument Builder.

The Expression Builder has three panes; ECMAScript/Variables, Functions/Methods, and ECMAScript
Operators.
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Figure 11-2 Expression Builder

ECMAScript Ohjecks Functions/Methods ECMAScript Operators
F=l Functions = =2 ECMAScript [a' Logical
G Array @ Math
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G Date @ Skring
@ Funckion
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@ Mumber
(® object
G Skring

Ik l [ Cancel ] [Check Synkax

ECMAScript Objects lists all of the current defined functions in the ECMAScript. Function/Methods
contains the standard ECMAScript functions. ECMAScript Operators displays the standard
ECMAScript operators.

To use the Expression Builder:

1 (Optional) Click the desired ECMAScript Objects.

2 (Optional) Click the desired Functions/Methods.

3 (Optional) Click the desired ECMAScript Operators.
4 Click Check Syntax to validate the expression.

5 Click OK to close the Expression Builder.

In the following example, the join ECMAScript variable is used with the toString function or method,
but there is no ECMAScript operator selected.
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Figure 11-3 Expression Builder Example
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11.2.3  Functions and Variables

As functions and variables are defined in the ECMAScript, they are displayed on the left side of the

ECMAScript editor.
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Figure 11-4 Functions and Variables
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All of the variables that are stored in a function are grouped together. You can expand a function to
view all of the variables, by clicking the plus icon (arrow icon in Linux). You can view the function
without the variables by clicking the minus icon (arrow icon in Linux).

11.2.4  Error Display

As the ECMAScript is created, errors are displayed in the main scripting area and in the Problems
view. The main scripting area displays the errors as a red X on the line where the error occurs.
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Figure 11-5 Main Scripting Area Errors

war count = 0; Gl
war result = "U:
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K
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€D :

4 *
The Problems view accumulates the errors as the ECMAScript is typed, displays the cause of the
error.

Double-click the error in the Problems view. The cursor jumps to the problem line in the main
scripting area.

To access the Problems view:

1 In the toolbar, select Window > Show View > Other > General > Problems.

The Problems view is displayed below the ECMAScript editor.

(2 Problems 2 &~ =0
1 error, O warnings, 0 infos
Descripkion Resaurce Path Location
= = Errors (1 ikem)
@ missing ) in parenthetical BESO1672,...  project/ModeliIdentityMan,..  line 122

11.2.5 Shell Area

The shell area of the ECMAScript area allows you execute the ECMAScript. After the ECMAScript is

created, you can test the functionality of the script.
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Figure 11-6 Shell Area

ECMAScript Editor &

F=] Function.Library,Driver Set,Identity Vaulk

@ arealfCircle function areatfCircle | radius | {
return 2 ¥ Math.PI ¥ (radius * radius):;
H

rareaCfCircle (10
6?8.318530?1?958?
=

Figure 11-6 contains an example of a function that determines the area of a circle. The function is
tested by specifying a value of area0OfCircle (10). The shell displays the value of
628.3185307179587.

To execute the expression, press the Enter key. If you want to enter more than one line of code in the
console, press Enter on the numeric keypad.

Additional Options in Shell Area

If you right-click inside the shell area you are presented with the following additional options:
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Figure 11-7 Shell Area Additional Options

ECMAScript Editor
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}
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Shiow Expression Builder

¢ Cut, Copy and Paste: Enables you to cut, copy and paste from and into the shell area.

¢ Show Expression Builder: Launches ECMA Expression Builder.

11.3 Examples of ECMAScripts with Policies

The following examples use the ECMAScript file demo. js (http://www.novell.com/documentation/
idm35/policy_designer/samples/demo.js) with different policies. The demo. js file contains three

ECMAScript function definitions.

NOTE: To be able to call an ECMAScript function within a style sheet, ensure you include the
following namespace definitions in the xs1:stylesheet element:
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11.3.1

xmlns:js="http://www.novell.com/nxsl/ecmascript"
xmlns:es="http://www.novell.com/nxsl/ecmascript"

¢ Section 11.3.1, “DirXML Script Policy Calling an ECMAScript Function,” on page 188
¢ Section 11.3.2, “XSLT Policy Calling an ECMAScript Function at the Driver Level,” on page 189
¢ Section 11.3.3, “XSLT Policy Calling an ECMAScript Function in the Style Sheet,” on page 190

DirXML Script Policy Calling an ECMAScript Function

The DirXML Script policy converts an attribute that is a URL reference to a photo to the Base64
encoded photo data by calling the ECMAScript function getB64ImageFromURL (). The policy can be
used as an Input Transformation or Output Transformation policy.

The function reads an image from a URL and returns the content as a Base64 encoded string.

<?xml version="1.0" encoding="UTF-8"?><!DOCTYPE policy PUBLIC "policy-builder-dtd"
"C:\Program
Files\Novell\Designer\eclipse\plugins\com.novell.designer.idm.policybuilder 1.2.0.
200612180606\DTD\dirxmlscript.dtd" ><policy>
<rule>
<description>Reformat photo from URL to octet</descriptions>
<conditions/>
<actions>
<do-reformat-op-attr name="photo">
<arg-value type="octet">
<token-xpath expression="es:getB64ImageFromURL (string($Scurrent-value))"/>
</arg-values>
</do-reformat-op-attr>
</actions>
</rules>
</policy>

Function: <static> String getB64ImageFromURL (<String> urlString)
Parameters: urlString (URL of the image file)
Returns: Base64 encoded content of the image (or empty string if error)

The file ReformatPhoto.xml (../samples/ReformatPhoto.xml) calls the ECMAScript function
getB64ImageFromURL from a DirXML Script policy. The file phototest .xml (../samples/
phototest.xml) is a sample input document that shows the policy in action.
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11.3.2

Figure 11-8 Reformat Photo Example
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kK Cancel * Required
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The ECMAScript calls the getB64lmageFromURL function, which then returns the current value as a
string.

XSLT Policy Calling an ECMAScript Function at the Driver Level

The XSLT policy either splits a single comma-delimited value into multiple values, or joins multiple
values into a single comma-delimited value. The XSLT policy is defined at the driver level and can be
used as an Input Transformation or Output Transformation policy.

NOTE: DirXML Script has the split and join functionality built into it, but XSLT does not. This type of
function allows XSLT to have the split and join functionality.

There are two functions:

¢ “Join” on page 189
¢ “Split” on page 190

Join

The Join function joins the text values of Nodes in a NodeSet into a single string

Using ECMAScript in Policies 189



11.3.3

<!-- template that joins the joinme attribute values into a single value -->
<xsl:template match="*[@attr-name='joinme']//* [value] | *[@attr-
name="'joinme'] [value] ">
<xsl:copy>
<xsl:apply-templates select="@*|node () [not (self::value)]"/>
<value>
<xsl:value-of select="es:join(value)"/>
</value>
</xsl:copy>
</xsl:template>

Function: <static> String join(<NodeSet> nodeSet, <string> delimiter)

Parameters: nodeSet (the input NodeSet) and delimiter (the delimiter to split on. Optional: default =
none).

Returns: The concatenation of the string values of the Nodes in the nodeSet, separated by the
delimiter.

Split
The Split function splits a string into a NodeSet.

<!-- template that splits the splitme attribute values into multiple values -->
<xsl:template match="*[@attr-name="'splitme']//value">

<xsl:for-each select="es:split (string(.))">

<values

<xsl:value-of select="."/>

</value>

</xsl:for-each>
</xsl:template>

Function: <static> NodeSet split (<String> inputString, <String> delimiter)

Parameters: inputString (the script to split) and delimiter (the delimiter to split on. Optional:
default =“,").

Returns: A NodeSet containing text nodes.

The file SplitJoin.xsl (../samples/SplitJoin.xsl) calls the join or split functions in an XSLT style
sheet. The file splitjointest.xml (../samples/splitjointest.xml) is an input document that shows the
style sheet in action.

XSLT Policy Calling an ECMAScript Function in the Style Sheet

The XSLT policy demonstrates embedding ECMAScript function definitions with the XSLT style
sheet. The functions convert a string to uppercase.

<!-- define ecmascript functions -->
<es:scripts>
function uppercase (input)

return String(input) .toUpperCase () ;
</es:script>

The file uppercase.xsl (../samples/uppercase.xsl) defines the ECMAScript function with the XSLT
style sheet. The file uppercasetest.xml (../samples/uppercasetest.xml) is an input document that
shows the style sheet in action.
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Conditions

Conditions define when actions are performed. Conditions are always specified in either Conjunctive
Normal Form (CNF) (http://mathworld.wolfram.com/ConjunctiveNormalForm.html) or Disjunctive

Normal Form (DNF) (http://mathworld.wolfram.com/DisjunctiveNormalForm.html). These are
logical expression forms. The actions of the enclosing rule are only performed when the logical

expression represented in CNF or DNF evaluates to True or when no conditions are specified.

NOTE: For information about elements in the XML schema, see “NDS DTD” in the Identity Manager
4.0.2 DTD Reference.

This section contains detailed information about all conditions that are available through the Policy
Builder interface.

*

*

*

*

“If Association” on page 192

“If Attribute” on page 194

“If Class Name” on page 197

“If Destination Attribute” on page 200
“If Destination DN” on page 203

“If Entitlement” on page 204

“If Global Configuration Value” on page 207
“If Local Variable” on page 209

“If Named Password” on page 213

“If Operation” on page 214

“If Operation Attribute” on page 217
“If Operation Property” on page 221
“If Password” on page 223

“If Source Attribute” on page 226

“If Source DN” on page 228

“If XML Attribute” on page 230

“If XPath Expression” on page 232
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If Association

Performs a test on the association value of the current operation or the current object. The type of test
performed depends on the operator specified by the operation attribute.

Fields
Operator

Operator Returns True When...

Associated There is an established association for the current object.

Available There is a non-empty association value specified by the current
operation.

Equal The association value specified by the current operation is exactly equal
to the content of the if association.

Greater Than The association value specified by the current operation is greater than
the content of the condition when compared by using the specified
comparison mode.

Less Than The association value specified by the current operation is less than the
content of the condition when compared by using the specified
comparison mode.

Not Associated There is not an established association for the current object.

Not available The association is not available for the current object.

Not Equal The association value specified by the current operation is not equal to
the content of the if association.

Not Greater Than Greater Than or Equal would return False.

Not Less Than Less Than or Equal would return False.

Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Equal

¢ Not Greater Than
¢ Not Less Than

Mode

The condition has a comparison mode parameter that indicates how a comparison is done.
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Mode Description

Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
javalutil/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Greater Than
¢ Less Than
¢ Not Equal
¢ Not Greater Than
¢ Not Less Than

Example

This example tests to see if the association is available. When this condition is met, the actions that are
defined are executed.

Condition | assaciation v | @

Cperator * | available b
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If Attribute

Performs a test on attribute values of the current object in either the current operation or the source
data store. It can be logically thought of as If Operation Attribute or If Source Attribute, because the
test is satisfied if the condition is met in the source data store or in the operation. The test performed
depends on the specified operator.

Fields

Name

Specify the name of the attribute to test. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Operator
Select the condition test type.

Operator Returns True When...

Available There is a value available in either the current operation or the source
data store for the specified attribute.

Equal There is a value available in either the current operation or the source
data store for the specified attribute, which equals the specified value
when compared by using the specified comparison mode.

Greater Than There is a value available in either the current operation or the source
data store for the specified attribute that is greater than the content of the
condition when compared by using the specified comparison mode.

Less Than There is a value available in either the current operation or the source
data store for the specified attribute that is less than the content of the
condition when compared by using the specified comparison mode.

Not Available Available would return False.

Not Equal Equal would return False.

Not Greater Than Greater Than or Equal would return False.

Not Less Than Less Than or Equal would return False.
Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Equal

¢ Not Greater Than
¢ Not Less Than

Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

194  Policies in Designer 4.0.2



Mode Description

Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
javalutil/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

Structured Compares the structured attribute according to the comparison rules for the

structured syntax of the attribute.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Greater Than
¢ Less Than
¢ Not Equal
¢ Not Greater Than
¢ Not Less Than

Example

The example uses the condition If Attribute when filtering for User objects that are disabled or have a
certain title. The policy is Policy to Filter Events, and it is available for download from the Novell
Support Web site. For more information, see “Downloading Identity Manager Policies” in
Understanding Policies for Identity Manager 4.0.2. To view the policy in XML, see 001-Event -
FilterByContainerDisabledOrTitle.xml (../samples/001-Event-
FilterByContainerDisabledOrTitle.xml).
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By & Filter events: From Users sub-tree, Users not disabled, no
—consultants or sales people

Mo description available

Condikions

" Z Condition Group 1

& if source DM not in subtree "Users"
% i attribute 'Login Disabled' equal "Trus"
v & i attribute 'Title' match ", *cansultant|sales, *"

| W & wetal) |

The condition is looking for any User object that has an attribute of Title with a value of consultant or

sales.
Condition |attril:uute V| (7
Marmne * | Title | g &g &
Cperator ¥ |equal o |
Mode |regular EXpression v|
Yalue | oonsultant sales,* | q &
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If Class Name

Performs a test on the object class name in the current operation.

Fields

Operator
Select the condition test type.

Operator Returns True When...
Available There is an object class name available in the current operation.
Equal There is an object class name available in the current operation, and it

equals the specified value when compared by using the specified
comparison mode.

Greater Than There is an object class name available in the current operation, and it is
greater than the content of the condition when compared by using the
specified comparison mode.

Less Than There is an object class name available in the current operation, and it is
less than the content of the condition when compared by using the
specified comparison mode.

Not Available Available would return False.

Not Equal Equal would return False.

Not Greater Than Greater Than or Equal would return False.

Not Less Than Less Than or Equal would return False.
Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Equal

+ Not Greater Than
¢ Not Less Than

Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Conditions 197



Mode Description

Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
javalutil/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

The operators that contain the comparison parameter are:
¢ Equal
¢ Greater Than
¢ Less Than
¢ Not Equal
¢ Not Greater Than
¢ Not Less Than

Example

The example uses the condition If Class Name to govern group membership for a User object based
on the title. The policy is Govern Groups for User Based on Title Attribute, and it is available for
download from the Novell Support Web site. For more information, see “Downloading Identity
Manager Policies” in Understanding Policies for Identity Manager 4.0.2. To view the policy in XML, see
004 - Command-GroupChangeOnTitleChange.xml (../samples/004-Command-
GroupChangeOnTitleChange.xml).
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B ¢ 5 User changing from Manager to Employee

Mo description available

Conditions

+~ % Condition Group 1

& i class name equal "User"
v 5 if destination attribute ‘Title' match *. *manager . *"
v 5 if operation attribute 'Title' not-match " *manager "

v 5 set destination atkribute valued"Group Membership”, "Users\EmploveesGroup™)

& clone operation attribukeGroup Membership”, "Security Equals™)

Checks to see if the class name of the current object is User.

Condition |class name v| @
Operator * |equal v |
Mode | case insensitive v |
value | User| | @ ¢ &
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If Destination Attribute

Performs a test on attribute values of the current object in the destination data store. The test
performed depends on the specified operator.

Fields

Name
Specify the name of the attribute to test. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Operator
Select the condition test type.

Operator Returns True When...

Available There is a value available in the destination data store for the specified
attribute.

Equal There is a value available for the specified attribute in the destination data

store that equals the specified value when compared by using the
specified comparison mode.

Greater Than There is a value available for the specified attribute in the destination data
store that is greater than the content of the condition when compared by
using the specified comparison mode. If mode="structured”, the
content must be a set of <component > elements; otherwise, it must be
text.

Less Than There is a value available for the specified attribute in the destination data
store that is greater than the content of the condition when compared by
using the specified comparison mode. If mode="structured”, the
content must be a set of <component > elements; otherwise, it must be

text.
Not Available Available would return False.
Not Equal Equal would return False.
Not Great Than Greater Than or Equal would return False.
Not Less Than Less Than or Equal would return False.

Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Equal

+ Not Greater Than
¢ Not Less Than
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Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode Description
Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
java/util/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

Structured Compares the structured attribute according to the comparison rules for the

structured syntax of the attribute.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Greater Than
¢ Less Than
¢ Not Equal
¢ Not Greater Than
¢ Not Less Than

Example

The example uses the condition If Attribute to govern group membership for a User object based on
the title. The policy is Govern Groups for User Based on Title Attribute, and it is available for
download from the Novell Support Web site. For more information, see “Downloading Identity
Manager Policies” in “Understanding Policy Components”. To view the policy in XML, see 004 -
CommandGroupChangeOnTitleChange.xml (../samples/004-Command-
GroupChangeOnTitleChange.xml).
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B ¢ 5 User changing from Manager to Employee

Mo description available

Conditions

+~ % Condition Group 1

& i class name equal "User"
v 5 if destination attribute ‘Title' match *. *manager . *"
v 5 if operation attribute 'Title' not-match " *manager "

v 5 set destination atkribute valued"Group Membership”, "Users\EmploveesGroup™)

& clone operation attribukeGroup Membership”, "Security Equals™)

The policy checks to see if the value of the title attribute contains manager.

Condition |destinatin:nn attribute v| (#

Marne * | Title

Cperakor * | equal

Mode |regular Expression

YWalue | Jmanager, ¥
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If Destination DN

Performs a test on the destination DN in the current operation. The test performed depends on the
specified operator.

Fields

Operator

Select the condition test type.

Operator Returns True When...
Available There is a destination DN available.
Equal There is a destination DN available, and it equals the specified value

when compared by using semantics appropriate to the DN format of the
destination data store.

in Container There is a destination DN available, and it represents an object in the

container, specified by value, when compared by using semantics
appropriate to the DN format of the destination data store.

In Subtree There is a destination DN available, and it represents an object in the

subtree, specified by value, when compared by using semantics
appropriate to the DN format of the destination data store.

Not Available Available would return False.

Not Equal Equal would return False.

Not in Container In Container would return False.

Not In Subtree In Subtree would return False.
Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

*

*

*

*

*

*

Equal

In Container

In Subtree

Not Equal

Not in Container

Not in Subtree

Example

Condition | destination DN | (7

Qperator * |in conkainer w

)

Yalue | Users Q
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If Entitlement

Performs a test on entitlements of the current object, in either the current operation or the Identity
Vault. The test performed depends on the specified operator.

Fields

Name

Specify the name of the entitlement to test for the selected condition. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Operator

Select the condition test type.

Operator Returns True When...

Available The named entitlement is available in either the current operation or the
Identity Vault.

Changing The current operation contains a change (modify attribute or add attribute)

Changing From

Changing To

Equal

Greater Than

Less Than

Not available

Not Changing

Not Changing From
Not Changing To
Not Equal

Not Greater Than

Not Less Than

of the named entitlement.

The current operation contains a change that removes a value (remove
value) of the named entitlement, which has a value that equals the
specified value when compared by using the specified comparison mode.

The current operation contains a change that adds a value (add value or
add attribute) to the named entitlement. It has a value that equals the
specified value when compared by using the specified comparison mode.

There is a value available for the specified attribute in the destination data
store that equals the specified value when compared by using the
specified comparison mode.

The named entitlement is available and granted in either the current
operation or the Identity Vault and has a value that is greater than the
content of the condition when compared by using the specified
comparison mode.

The named entitlement is available and granted in either the current
operation or the Identity Vault and has a value that is less than the content
of the condition when compared by using the specified comparison mode.

Available would return False.

Changing would return False.

Changing From would return False.
Changing To would return False.

Equal would return False.

Greater Than or Equal would return False.

Less Than or Equal would return False.
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Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Changing From

¢ Changing To

¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Changing From
¢ Not Changing To

¢ Not Equal

+ Not Greater Than

¢ Not Less Than

Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode Description
Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
java/util/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

The operators that contain the comparison mode parameter are:
¢ Changing From
¢ Changing To
¢ Equal
¢ Greater Than
¢ Less Than
¢ Not Changing From
¢ Not Changing To
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¢ Not Equal
* Not Greater Than
+ Not Less Than

Example

Zondition |entitlement

Marne * | niokes-group

Qperakor * |n:hanging From

Mode |n:ase insensikive

YWalue | sers
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If Global Configuration Value

Performs a test on a global configuration value. The test performed depends on the specified

operator.

Remark

For more information on using variables with policies, see “Understanding Policy Components” in
Understanding Policies for Identity Manager 4.0.2.

Fields

Name

Specify the name of the global value to test for the selected condition. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Operator

Select the condition test type.

Operator Returns True When...
Available There is a global configuration value with the specified name.
Equal There is a global configuration value with the specified name, and its

Greater Than

Less Than

Not Available
Not Equal
Not Greater Than

Not Less Than

value equals the specified value when compared by using the specified
comparison mode.

There is a global configuration value with the specified name, and its
value is greater than the content of the condition when compared by using
the specified comparison mode.

There is a global configuration value with the specified name, and its
value is less than the content of the condition when compared by using
the specified comparison mode.

Available would return False.
Equal would return False.
Greater Than or Equal would return False.

Less Than or Equal would return False.

Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Equal

* Greater Than

¢ Less Than

¢ Not Equal

+ Not Greater Than
* Not Less Than
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Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode Description
Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
java/util/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Greater Than
¢ Less Than
¢ Not Equal
¢ Not Greater Than
¢ Not Less Than

Example

ondition | global configuration wvalue | » IE:I

b

Mame * | my&ElobalYariable 9

Operator * | available W
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If Local Variable

Performs a test on a local variable. The test performed depends on the specified operator.

Remark

For more information on using variables with policies, see “Understanding Policy Components” in
Understanding Policies for Identity Manager 4.0.2.

Fields

Name
Specify the name of the local variable to test for the selected condition. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.
Operator
Select the condition test type.

Operator Returns True When...

Available There is a local variable with the specified name that has been defined by
an action of a earlier rule within the policy.

Equal There is a local variable with the specified name, and its value equals the
specified value when compared by using the specified comparison mode.

Greater Than There is a local variable with the specified name, and its value is greater
than the content of the condition when compared by using the specified
comparison mode.

Less Than There is a local variable with the specified name, and its value is less than
the content of the condition when compared by using the specified
comparison mode.

Not Available Available would return False.

Not Equal Equal would return False.

Not Greater Than Greater Than or Equal would return False.

Not Less Than Less than or equal would return False.
Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Equal

¢ Not Greater Than
¢ Not Less Than
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Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode Description
Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
java/util/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Not Equal
¢ Greater Than
¢ Not Greater Than
¢ Less Than
¢ Not Less Than

Example

The example adds a User object to the appropriate Employee or Manager group based on Title. It also
creates the group, if needed, and sets up security equal to that group. The policy is Govern Groups
for User Based on Title Attribute, and it is available for download from the Novell Support Web site.
For more information, see “Downloading Identity Manager Policies” in Understanding Policies for
Identity Manager 4.0.2. To view the policy in XML, see 003 -Command-AddCreate-Groups.xml (../
samples/003-Command-AddCreateGroups.xml).
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¥

5 Set local variables to test existence of groups and for placement

5 Create ManagersGroup, if needed

and

Mo description available

% Condition Group 1

if local wariable 'manager-group-info' available

5 if local wariable ‘manager-group-infia’ not equal "group”

5 add destination objecticlass name="Group", when="before", dn{Local Yariablef"manager-group-dn" 1)

5 Create EmployeesGroup, if needed

5 If Title indicates Manager, add to ManagerGroup and set rights

5 If Title does not indicate Manager, add to EmployeeGroup and set rights

The policy contains five rules that are dependent on each other.

5- Set local variables to test existence of groups and for placement

Mo description available

Z Condition Group 1

Z i class name equal "User"

And

Z Condition Group 2

fr if operation egual "add"

fr if operation egual "modify"

RN RN RN

set local variable!"manager-group-dn”, "UsersiManagersGroup™)

set local variable!"manager-group-info”, Destination Attributel"Object Class", dnilocal Yarisbled"manager-group-

—dn"
set local variable!"emplovee-group-dn”, "Users\EmployeesGroup™)

set local variable!"emplovee-group-info”, Destination Attributed"Chject Class", dnilocal Variable!"employvee-group-
—dn"Ji}

For the If Locate Variable condition to work, the first rule sets four different local variables to test for
groups and where to place the groups.

Condition |local variable | (7
Mame * | manager-group-info \._:{ Cf
Cperakar * | nak equal w
Maode |case insensitive W
Walue | group Q &

Conditions 211



The condition the rule looks for is to see if the local variable of manager-group-info is available and if
manager-group-info is not equal to group. If these conditions are met, then the destination object of
group is added.
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If Named Password

Performs a test on a named password from the driver in the current operation with the specified
name. The test performed depends on the selected operator.

Fields

Name
Specify the name of the named password to test for the selected condition. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Operator
Select the condition test type.

Operator Returns True When...
Available There is a password with the specified name available.
Not Available Available would return False.
Example
Condition | narmed password v | (@)
Marme * | password Q &
w

Cperakor * | available

Conditions

213



214

If Operation

Performs a test on the name of the current operation. The type of test performed depends on the
specified operator.

Fields

Operator
Select the condition test type.

Operator Returns True When...

Equal The name of the current operation is equal to the content of the condition
when compared by using the specified comparison mode.

Greater Than The name of the current operation is greater than content of the condition
when compared by using the specified comparison mode.

Less Than The name of the current operation is less than content of the condition
when compared by using the specified comparison mode.

Not Equal Equal would return False.

Not Greater Than Greater Than would return False.

Not Less Than Less Than would return False.
Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode Description
Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
javalutil/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

The operators that contain the comparison mode parameter are:
¢ Equal

* Greater Than

Policies in Designer 4.0.2


http://java.sun.com/j2se/1.4/docs/api/java/util/regex/Pattern.html

*

*

*

Value

Contains the value defined for the selected operator. The value is used by the condition. Each

Less Than

Not Equal

Not Greater Than
Not Less Than

value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on

page 33. The operators that contain the value field are:

*

*

*

*

*

*

The values are the operations that the Metadirectory engine looks for:

*

*

*

*

*

Equal

Greater Than
Less Than

Not Equal

Not Greater Than
Not Less Than

add

add-association

check-object-password

check-password
delete

generated-password

get-named-password

init-params
instance

modify
modify-association
modify-password
move

password

query
query-schema
remove-association
rename
schema-def

status

sync

trigger

This list is not exclusive. Custom operations can be implemented by drivers and administrators.
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Example

The example adds a User object to the appropriate Employee or Manager group based on Title. It also
creates the group, if needed, and sets up security equal to that group. The policy name is Govern
Groups for User Based on Title Attribute, and it is available for download from the Novell Support
Web site. For more information, see “Downloading Identity Manager Policies” in Understanding
Policies for Identity Manager 4.0.2. To view the policy in XML, see 003 -Command-
AddCreateGroups.xml (../samples/003-Command-AddCreateGroups.xml).

B 5- Set local variables to test existence of groups and for placement

Mo description available

Conditions

" % Condition Group 1
v §r if class name equal "User"
And

% Condition Group 2

v & if operation equal "add"

v 5' if operation equal "modify"

o §r set local variable!"manager-group-dn”, "UsersiManagersGroup")
4 f, set local variable!"manager-group-info”, Destination attributed"Object Class", dnilocal Yariabled"manager-group-
—dn"}i
v & setlocal variable("employee-group-dn", "Users\EmployvessGroup”)
v f, set local variable!"emplovee-group-info", Destination Attributed" Chbject Class", dnilocal Variable!"emplovee-group-
—dn"1n
Condition |-::perati-::n V| )]
Cperator * |EI:|I.IE|| V|
Mode ||:ase insensitive V|
Yalue | modiFy | Q &

The condition checks to see if an Add or Modify operation has occurred. When one of these occurs, it
sets the local variables.
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If Operation Attribute

Performs a test on attribute values in the current operation. The test performed depends on the

specified operator.

Fields

Name

Specify the name of the attribute to test. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Operator

Select the condition test type.

Operator Returns True When...

Available There is a value available in the current operation (<add-attr>, <add-
value> or <attrs>) for the specified attribute.
Available would return False if there is only a <remove-value> or a
<remove-all-valuess> value for the specified attribute.

Changing The current operation contains a change (<modify-attr> or <add-

Changing From

Changing To

Equal

Greater Than

attrs>) of the specified attribute.

Changing would return True if it is an <add-attr>, <add-value>,
<remove-value>, Of <remove-all-values> operation for the
specified attribute.

The current operation contains a change that removes a value
(<remove-values>) of the specified attribute that equals the content of
the condition when compared by using the specified comparison mode. If
mode=structured, then the content must be a set of <component>'s.
Otherwise, it must be text.

The current operation contains a change that adds a value (<add-
value> or <add-attrs>) to the specified attribute that equals the content
of the condition when compared by using the specified comparison mode.
If mode=structured, then the content must be a set of
<component>"'s. Otherwise, it must be text.

There is a value available in the current operation (other than a
<remove-values>) for the specified attribute that equals the content of
the condition when compared by using the specified comparison mode. If
mode=structured, then the content must be a set of <component>'s.
Otherwise, it must be text.

Supports variable expansion.

There is a value available in the current operation (other than a
<remove-values) for the specified attribute that is greater than the
content of the condition when compared by using the specified
comparison mode. If mode=structured, then the content must be a set
of <component>'s. Otherwise, it must be text.

Supports variable expansion.

Conditions
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Operator Returns True When...

Less Than There is a value available in the current operation (other than a
<remove-values) for the specified attribute that is less than the content
of the condition when compared by using the specified comparison mode.
If mode=structured, then the content must be a set of
<component>"'s. Otherwise, it must be text.

Supports variable expansion.

Not Available Available would return False.

Not Changing Changing would return False.

Not Changing From Changing From would return False.

Not Changing To Changing To would return False.

Not Equal Equal would return False.

Not Greater Than Greater Than or Equal would return False.

Not Less Than Less Than or Equal would return False.
Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Changing From

¢ Changing To

¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Changing From
¢ Not Changing To

¢ Not Equal

+ Not Greater Than

¢ Not Less Than

Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode Description
Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.
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Mode

Description

Regular Expression

Source DN

Destination DN

Numeric
Binary

Structured

The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
javalutil/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Compares by using semantics appropriate to the DN format for the source data
store.

Compares by using semantics appropriate to the DN format for the destination data
store.

Compares numerically.
Compares the binary information.

Compares the structured attribute according to the comparison rules for the
structured syntax of the attribute.

The operators that contain the comparison mode parameter are:

¢ Changing From

¢ Changing To
¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Changing From

¢ Not Changing To

¢ Not Equal

* Not Greater Than

* Not Less Than

Example

The example adds a User object to the appropriate Employee or Manager group based on Title. It also
creates the group, if needed, and sets up security equal to that group. The policy name is Govern
Groups for User Based on Title Attribute, and it is available for download from the Novell Support
Web site. For more information, see “Downloading Identity Manager Policies” in Understanding
Policies for Identity Manager 4.0.2. To view the policy in XML, see 003 -Command-Add-
CreateGroups.xml (../samples/003-Command-AddCreateGroups.xml).
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[+

v 5 Set local variables to test existence of groups and for placement

v 5 Create ManagersGroup, if needed

F ©H

v % Create EmployeesGroup, if needed

|

+ % IFTitle indicates Manager, add to ManagerGroup and set rights

Mo description available

Conditions

+ Z Condition Group 1

v 5 if class name equal "User"

v 5 if operation attribute ‘Title' match *. *manager, *"

& set destination attribube value"Group Membership!, Local Variabledmanager-group-dn')

v 5 clone operation attributel"Group Membership”, "Security Equals™

v 5 IF Title does not indicate Manager, add to EmployeeGroup and set rights

Condition ||:||:|eratin:nn attribute v| @
Mame * | Title 8 & &
Operator * | equal v |
Mode |regular expression v
Walue | Mrnanager,® | Q &

The condition checks to see if the attribute of Title is equal to . *manager. *, which is a regular
expression. The condition looks for a title that has zero or more characters before manager and a
single character after manager. It would find a match if the User object’s title was sales managers.
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If Operation Property

Performs a test on an operation property on the current operation. An operation property is a named
value that is stored as an attribute on an <operation-data> element within an operation. It is
typically used to supply additional context that might be needed by the policy that handles the
results of an operation. The test performed depends on the selected operator.

Fields

Name

Specify the name of the operation property to test for the selected condition. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Operator
Select the condition test type.

Operator Returns True When...

Available There is an operation property with the specified name on the current
operation.

Equal There is an operation property with the specified name on the current

operation, and its value equals the provided content when compared by
using the specified comparison mode.

Greater Than There is an operation property with the specified name on the current
operation, and its value is greater than the content of the condition when
compared by using the specified comparison mode.

Less Than There is an operation property with the specified name on the current
operation, and its value is less than the content of the condition when
compared by using the specified comparison mode.

Not Available Available would return False.

Not Equal Equal would return False.

Not Greater Than Greater Than or Equal would return False.

Not Less Than Less Than or Equal would return False.
Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Equal

¢ Not Greater Than
¢ Not Less Than

Mode

The condition has a comparison mode parameter that indicates how a comparison is done.
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Mode

Description

Case Sensitive
Case Insensitive

Regular Expression

Source DN

Destination DN

Numeric

Binary

Character-by-character case sensitive comparison.
Character-by-character case insensitive comparison.

The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
javalutil/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Compares by using semantics appropriate to the DN format for the source data
store.

Compares by using semantics appropriate to the DN format for the destination data
store.

Compares numerically.

Compares the binary information.

The operators that contain the comparison mode parameter are:

¢ Equal

* Greater Than

¢ Less Than

¢ Not Equal

+ Not Greater Than

* Not Less Than

Example
Condition | operation property W @
Mame * | Title &
Cperakor * | equal w
Mode |regular expression w
Yalue | Hmanager,® Q &
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If Password

Performs a test on a password in the current operation. The test performed depends on the specified
operator.

Fields

Operator
Select the condition test type.

Operator Returns True When...
Available There is a password available in the current operation.
Equal There is a password available in the current operation, and its value

equals the content of the condition when compared by using the specified
comparison mode.

Greater Than There is a password available in the current operation, and its value is
greater than the content of the condition when compared by using the
specified comparison mode.

Less Than There is a password available in the current operation, and its value is
less than the content of the condition when compared by using the
specified comparison mode.

Not Available Available would return False.

Not Equal Equal would return False.

Not Greater Than Greater Than or Equal would return False.

Not Less Than Less Than or Equal would return False.
Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Equal

+ Not Greater Than
¢ Not Less Than

Mode

The condition has a comparison mode parameter that indicates how a comparison is done.
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Mode

Description

Case Sensitive
Case Insensitive

Regular Expression

Source DN

Destination DN

Numeric

Binary

Character-by-character case sensitive comparison.
Character-by-character case insensitive comparison.

The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
javalutil/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Compares by using semantics appropriate to the DN format for the source data
store.

Compares by using semantics appropriate to the DN format for the destination data
store.

Compares numerically.

Compares the binary information.

The operators that contain the comparison mode parameter are:

¢ Equal

* Greater Than

¢ Less Than

¢ Not Equal

+ Not Greater Than

* Not Less Than

Example

If you are implementing Novell Credential Provisioning policies, there is a sample Subscriber
Command Transformation policy that uses the password condition. The sample file is called
SampleSubCommandTransform.xml. It is found in the \dirxml\utilities folder on the Identity
Manager media. For more information, see “Example Credential Provisioning Policies” in Novell
Credential Provisioning for Identity Manager 4.0.2. To view the policy in XML, see
SampleSubCommandTransform.xml (../samples/SampleSubCommandTransform.xml).

The Subscriber Command Transformation policy checks to see if a password is available when an
object is added. If the password is available, then the Novell SecureLogin and Novell SecretStore
credentials are provisioned.
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../samples/SampleSubCommandTransform.xml

+ 5 Add operation-data element to password subscribe operations (if needed)

+ 5 Add payload data to modify-password subscribe operations

= 5 Add payload data to add subscribe operations

Mo description available

£ Condition Group 1

and

Condition | password

5 if operation equal "add"

Z

RhORNORN RN SN RN RN RN R

if passward available

append *ML element(“sso-svnc-daka”®, “operation-data™)

append XML element"sso-target-user-dn”, "operation-data/sso-sync-daka™)

append #ML text("operation-dataysso-sync-data)sso-target-user-dn”, Source Attributed DirEML-A0Conkext" )
append ¥ML element("ss0-app-username”, "operation-datajsso-sync-daka™

append ML texk"oper ation-data)sso-svnc-datafsso-app-username”, Source Attributed"CH"Y)

append ¥ML element“password”, "operation-datajsso-sync-data™

append ¥ML bext("operation-datafsso-sync-dataipassword”, Password())

append #ML element!"nsl-set-passphrase-answer”, "operation-datajsso-sync-data™

append XML text("operation-dataysso-sync-datafnsl-set-passphrase-answer”, Source Attribute " workforceID")

v @

Operator * | available £
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If Source Attribute

Performs a test on attribute values of the current object in the source data store. The test performed
depends on the specified operator.

Fields

Name

Specify the name of the source attribute to test for the selected condition. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Operator

Select the condition test type.

Operator Returns True When...

Available There is a value available in the source data store for the specified
attribute.

Equal There is a value available in the source data store for the specified

Greater Than

Less Than

Not Available
Not Equal
Not Great Than

Not Less Than

attribute. It equals the specified value when compared by using the
specified comparison mode.

There is a value available in the source data store for the specified
attribute that is greater than the content of the condition when compared
by using the specified comparison mode. If the mode is structured, the
content must be a set of components; otherwise, it must be text.

There is a value available in the source data store for the specified
attribute that is less than the content of the condition when compared by
using the specified comparison mode. If the mode is structured, the
content must be a set of components; otherwise, it must be text.

Available would return False.
Equal would return False.
Greater Than or Equal would return False.

Less Than or Equal would return False.

Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Equal

* Greater Than

¢ Less Than

¢ Not Equal
* Not Greater Than
* Not Less Than

Mode

The condition has a comparison mode parameter that indicates how a comparison is done.
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Mode Description

Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
javalutil/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

Structured Compares the structured attribute according to the comparison rules for the

structured syntax of the attribute.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Greater Than
¢ Less Than
¢ Not Equal
¢ Not Greater Than
¢ Not Less Than

Example
Condition | source attribute v | (7
Mame * | QU @ -..:': &
Qperatar * | equal v
Mode | Case insensitive b
Yalue | Users Q &
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If Source DN

Performs a test on the source DN in the current operation. The test performed depends on the
specified operator.

Fields

Operator

Select the condition test type.

Operator Returns True When...
Available There is a source DN available.
Equal There is a source DN available, and it equals the content of the specified

value in-container.

In Container There is a source DN available, and it represents an object in the

container specified by the content of If Source DN, when compared by
using semantics appropriate to the DN format of the source data store.

In Subtree There is a source DN available, and it represents an object in the subtree

identified by the specified value.

Not Available Available would return False.

Not Equal Equal would return False.

Not In Container In Container would return False.

Not In subtree In Subtree would return False.
Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

*

*

*

Equal

In Container

In Subtree

Not Equal

Not in Container

Not in Subtree

Example

The example uses the condition If Source DN to check if the User object is in the source DN. The rule
is from the predefined rules that come with Identity Manager. For more information, see Section 8.8,
“Event Transformation - Scope Filtering - Exclude Subtrees,” on page 124. To view the policy in XML,
see predef_ transformation filter exclude_subtress.xml (../samples/
predef_transformation_filter_exclude_subtrees.xml).

Policies in Designer 4.0.2


../samples/predef_transformation_filter_exclude_subtrees.xml

SR - Fvent Transformation - Scope Filtering - Exclude subtree(s)

Mo description available

Conditions

" % Condition Group 1

v 5 if source DM in subtree "[Enter a subtree to exclude]”

| v & wetal) |

Condition |51:|ur|:e DM v| )]
Qperakar * |in subtres v|
Yalue | [Enter a subtree to excude] | Q @'én

The condition checks to see if the source DN is in the Users container. If the object comes from that
container, it is vetoed.
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If XML Attribute

Performs a test on an XML attribute of the current operation. The type of test performed depends on
the operator specified by the operation attribute.

Fields

Name

Specify the name of the XML attribute. An XML attribute is a name/value pair associated with an
element in an XDS document.

Operator

Select the condition test type.

Operator Returns True When...

Available There is an XML attribute with the specified name on the current
operation.

Equal There is a an XML attribute with the specified name on the current

Greater Than

Less Than

Not Available
Not Equal
Not Greater Than

Not Less Than

operation, and its value equals the content of the condition when
compared by using the specified comparison mode.

There is a an XML attribute with the specified hame on the current
operation, and its value is greater than the content of the condition when
compared by using the specified comparison mode.

The association value specified by the current operation is less than the
content of the condition when compared by using the specified
comparison mode.

Available would return False.
Equal would return False.
Greater Than or Equal would return False.

Less Than or Equal would return False.

Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33. The operators that contain the value field are:

¢ Equal

* Greater Than

¢ Less Than

¢ Not Equal

+ Not Greater Than
* Not Less Than

Mode

The condition has a comparison mode parameter that indicates how a comparison is done.
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Mode Description

Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

For more information, see Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/
javalutil/regex/Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Greater Than
¢ Less Than
¢ Not Equal
¢ Not Greater Than
¢ Not Less Than

Example

Condition | #ML aktribute v | (T
Marme * | From-merge

Cperator * | available w
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If XPath Expression
Performs a test on the results of evaluating an XPath 1.0 expression.

Fields

Operator
Select the condition test type.

Operator Returns True When...
True The XPath expression evaluates to True.
Not True True would return False.

Value

Contains the value defined for the selected operator. The value is used by the condition. Each
value supports variable expansion. For more information on variable expansion and XPath, see
Section 3.6.5, “XPath Expressions,” on page 37. The operators that contain the value field are:

¢ Equal

¢ Greater Than

¢ Less Than

¢ Not Equal

¢ Not Greater Than
¢ Not Less Than

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.

Example

If you are implementing Novell Credential Provisioning policies, there is a sample Subscriber
Command Transformation policy that uses the XPath Expression condition. The sample file is called
SampleSubCommandTransform.xml. It is found in the \dirxml\utilities folder on the Identity
Manager media. For more information, see “Example Credential Provisioning Policies” in Novell
Credential Provisioning for Identity Manager 4.0.2. To view the policy in XML, see
SampleSubCommandTransform.xml (../samples/SampleSubCommandTransform.xml).

The sample Credential Provisioning policy checks each Add operation to see if there is operation
data associated with the Add. If there is no operation data, the Novell SecureLogin and Novell
SecretStore credentials are provisioned.
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= + % Add operation-data element to password subscribe operations {if needed)

Mo description available

Conditions

v~ % Condition Group 1

« & if operation equal "add"

v % if password available
v 5 if ®¥Path expression naot true “operation-daks"

" % Condition Group 2

W % if operation equal "modify-passward
& if ¥Path expression not true "operation-data"

| v 5 append XML element("operation-data", "."}

v 5 Add payload data to modify-password subscribe operations

v 5 Add payload data to add subscribe operations

Condition |:=€F'ath EXpression v| @

Cperakar | nok brue w |

Yalue | operation-data

h [Ef &> &

Conditions

233



234  Policies in Designer 4.0.2



Actions

Policies perform actions when the associated conditions are met. Some actions have a Mode field. The
policy does not honor the mode at run time if the context in which the policy is running is
incompatible with the selected mode.

NOTE: For information about elements in the XML schema, see “NDS DTD” in the Identity Manager
4.0.2 DTD Reference.

This section contains detailed information about the actions available in the Policy Builder interface:

*

*

*

*

“Add Association” on page 237

“Add Destination Attribute Value” on page 238

“Add Destination Object” on page 240
“Add Role” on page 242

“Add Resource” on page 244

“Add Source Attribute Value” on page 246
“Add Source Object” on page 247
“Append XML Element” on page 248
“Append XML Text” on page 250

“Break” on page 252

“Clear Destination Attribute Value” on page 253

“Clear Operation Property” on page 254
“Clear Source Attribute Value” on page 255
“Clear SSO Credential” on page 256

“Clone By XPath Expressions” on page 257
“Clone Operation Attribute” on page 258
“Delete Destination Object” on page 260
“Delete Source Object” on page 261

“Find Matching Object” on page 262

“For Each” on page 265

“Generate Event” on page 266

“If” on page 269

“Implement Entitlement” on page 271
“Move Destination Object” on page 272
“Move Source Object” on page 274
“Reformat Operation Attribute” on page 275

“Remove Association” on page 277

Actions
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¢ “Remove Destination Attribute Value” on page 278
¢ “Remove Role” on page 279

¢ “Remove Resource” on page 281

¢ “Remove Source Attribute Value” on page 283
¢ “Rename Destination Object” on page 284

¢ “Rename Operation Attribute” on page 285

¢ “Rename Source Object” on page 286

¢ “Send Email” on page 287

¢ “Send Email from Template” on page 289

¢ “Set Default Attribute Value” on page 291

¢ “Set Destination Attribute Value” on page 293
¢ “Set Destination Password” on page 295

¢ “Set Local Variable” on page 296

¢ “Set Operation Association” on page 298

¢ “Set Operation Class Name” on page 299

¢ “Set Operation Destination DN” on page 300
¢ “Set Operation Property” on page 301

¢ “Set Operation Source DN” on page 302

¢ “Set Operation Template DN” on page 303

+ “Set Source Attribute Value” on page 304

¢ “Set Source Password” on page 306

¢ “Set S50 Credential” on page 307

¢ “Set SSO Passphrase” on page 308

¢ “Set XML Attribute” on page 309

¢ “Start Workflow” on page 310

¢ “Status” on page 312

¢ “Strip Operation Attribute” on page 313

¢ “Strip XPath Expression” on page 314

¢ “Trace Message” on page 315

¢ “Veto” on page 317

¢ “Veto If Operation Attribute Not Available” on page 318
¢ “While” on page 319

This section contains detailed information about all actions available in the Policy Builder.
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Add Association

Sends an add association command with the specified association to the Identity Vault.

Fields

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

DN
Specify the DN of the target object or leave the field blank to use the current object.

Association

Specify the value of the association to be added.

Example

Do |add association »| @
Select mode: | add ko current operation w
{D Leave the DM Field below blank to use the current object

Specify DM: | Source D)

Specify association: * | Source Mamel)
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Add Destination Attribute Value

Adds a value to an attribute on an object in the destination data store.

Fields

Attribute Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object

Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

DN

Specify the DN, association, or current object as the target object.

Value Type

Select the syntax of the attribute value to be added. The options are string, counter, dn, int,
interval, octet, state, structured, teleNumber, or time.

Value
Specify the attribute value to be added.

Example

The example adds the destination attribute value to the OU attribute. It creates the value from the
local variables that are created. The rule is from the predefined rules that come with Identity
Manager. For more information, see Section 8.1, “Command Transformation - Create Departmental
Container - Part 1 and Part 2,” on page 112. To see the policy in XML, see

predef command create_dept_containerl.xml (../samples/
predef_command_create_dept_containerl.xml) and

predef command_ create_dept_container2.xml (../samples/
predef_command_create_dept_container2.xml).
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../samples/predef_command_create_dept_container1.xml
../samples/predef_command_create_dept_container2.xml

H 5 Command Transformation - Create Departmental Container - Part 1

Mo description available

Conditions

+ % Condition Group 1

v & if operation equal "add"

set local wariabled"target-container”, Destination DNElength="-2"7}

set local variable"does-target-exist”, Destination Attribute
—{"objectclass”, dass name="C0rganizational Unit", dnfLocal
—~ariablei"target-container" )7

B ¢ 5 Command Transformation - Create Departmental Container - Part 2

Mo description available

Conditions

" % Condition Group 1

v 5 if local wariable ‘does-target-exist' available

v 5 if local wariable 'does-target-exist' equal ™

v 5 add destination object{class name="Crganizational Unit", direck="
—true", dnflocal Mariablet"target-container")))

v 5 add destination attribute waluei"ou”, direck="trug", dnflLocal
—Yariable{"target-container")), Parse DR("dest-dn", "dot", length="
—1", start="-1", Local Wariable("target-container™ i1

Do | add destination attribute value v | #
Specify atkribute namne: * | M | @ Lﬂe &
Specify class name: | | s
Select mode: |write directly ko destination dakastore A |
Select object: |DN V|
Specify D * | "Lacal Yariabled"target-conkainker')" |
Specify value type: | string w |

Enker skring: * | "Parse DMN("dest-dn", "dot”, length="1", start="1", Local Yariak |
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Add Destination Object

Creates an object of the specified type in the destination data store, with the name and location
specified in the Enter DN field. Any attribute values to be added as part of the object creation must be
done in subsequent Add Destination Attribute Value actions, using the same DN.

Fields

Class Name
Specify the class name of the object to be created. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Mode
Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

DN
Specify the DN of the object to be created.

Remarks

Any attribute values to be added as part of the object creation must be done in subsequent Add
Destination Attribute Value actions, using the same DN.

Example

The example creates the department container that is needed. The rule is from the predefined rules
that come with Identity Manager. For more information, see Section 8.1, “Command Transformation -
Create Departmental Container - Part 1 and Part 2,” on page 112 from the predefined rules. To see the
policy in XML, see predef command create dept containerl.xml (../samples/
predef_command_create_dept_containerl.xml) and

predef command create dept container2.xml (../samples/
predef_command_create_dept_container2.xml).

B 5 Command Transformation - Create Departmental Container - Part 1

Mo description available

Conditions

+ £ Condition Group 1

« % if operation equal "add"

set local wariabled"target-container”, Destination DNElength="-2"7}

set local wariable"does-target-exist”, Destination Attribute
—{"objectclass”, dass name="C0rganizational Unit", dnfLocal
—~ariablei"target-container" )7

Policies in Designer 4.0.2


../samples/predef_command_create_dept_container1.xml
../samples/predef_command_create_dept_container2.xml

= " % Command Transformation - Create Departmental Container - Part 2

Mo description available

Conditions

+ % Condition Group 1

v 5 if local wariable 'does-target-exist' available

v % iflocal variable 'does-target-exist' equal ™

& add destination objecticlass name="0rganizational Unit®, direct="
—trug”, dnflocal Yariablel"target-containgr )

v 5 add destinakion attribute waluel"ou®, direck="true", dnfLocal
—Yariable{"target-containet")), Parse DR("dest-dn", "dot", length="
—1", skark="-1", Local Yariable{"target-container")))

Do |a|:|-:l destination object v| @

Specify class name: * | Crganizational Unit

eqe

Select mode: |write directly to destination datastore

v)

Specify DM: * | "Local Wariabled"target-containter)"

|

The OU object is created. The value for the OU attribute is created from the destination attribute

value action that occurs after this action.

Actions
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Add Role

Initiates a request to the Roles Based Provisioning Module (RBPM) to assign the specified role (in the
Role DN field) to the specified user (in the Authorized User DN field). This field is only available if
the Identity Manager server version is set to 3.6 or later.

Fields

Role DN

Specify the name of the role to assign, in LDAP format. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

User Application URL

Specify the URL of the User Application server hosting the Roles Based Provisioning module.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Authorized User DN

Specify the name of the user authorized to request the role assignment, in LDAP format.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Timeout Value

Specify the number of milliseconds you want Identity Manager to try to establish a connection to
the User Application server before timing out. The default value is o.

Password

Specify the authorized user password. You can enter a clear text password (not recommended)
or use the Argument Builder to specify a Named Password.

Object

Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

Strings

(Optional) Specify additional argument strings for the Role assignment request. You can enter

the strings manually, or select the Edit the Strings icon. [E to open the Named String Builder and
specify the strings. For more information about the Named String Builder, see Section 4.9,
“Named String Builder,” on page 57.
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The Add Role action supports the following string arguments:

String Name Description

description A description of the reason for the request used for auditing and (if necessary)
approval purposes.

Default: Request generated by policy.

effective-time The time (in CTIME format) the role assignment should become effective.
Default: now
expiration-time The time (in CTIME format) the role assignment automatically expires.

Default: never

sod-justification A justification for requesting an exception for any Separation of Duty violations
this assignment will trigger.

Default: No exception will be requested and the request will fail if it causes a
violation.

NOTE: By default, the Named String Builder does not display this string.
However, you can manually add it to the string list.

Example

Do |add role v | (@

Specify role DM * | Ch=roleManager, CN=5%stem, CH=Level20, CN=FRoleDefs, ChH=

]

Specify user application URL: * | 192,168, 10, 203, 8030,/I0M

Specify authorized user DM * | C=admin, O=novell

M O mpP
7]

Specify password: * | Mamed Password("admin")

Select object: | Current object w

Specify strings: | description, effective-time, expiration-time
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Add Resource

Initiates a request to the Roles Based Provisioning Module (RBPM) to assign the Resource specified
in the Resource DN field to an Identity. The target Identity is specified in the Authorized User DN
field. This action is only available if the Identity Manager server version is set to 4.0.2.

Fields

Resource DN

Specify the name of the resource to assign, in LDAP format. Supports variable expansion. For
more information, see Section 3.6, “Variable Selector,” on page 33.

User Application URL

Specify the URL of the User Application server hosting the Roles Based Provisioning module.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Authorized User DN
Specify the name of the user authorized to request the resource assignment, in LDAP format.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Timeout Value
Specify the number of milliseconds you want Identity Manager to try to establish a connection to
the User Application server before timing out. The default value is o.

Password
Specify the authorized user password. You can enter a clear text password (not recommended)
or use the Argument Builder to specify a Named Password.

Object
Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

Strings
(Optional) Specify additional argument strings for the Resource assignment request. You can

enter the strings manually, or select the Edit the Strings icon. £ to open the Named String Builder
and specify the strings. For more information about the Named String Builder, see Section 4.9,
“Named String Builder,” on page 57.

The Add Resource action supports the following string arguments:

String Name Description

description A description of the reason for the request used for auditing and (if necessary)
approval purposes.

Default: Request generated by policy.

NOTE: You can specify parameter values for the added resources. You can use the plus sign (+)

to insert a new string, or select the Edit the Strings icon E| to open the String Builder and specify
the strings.

You must specify the parameter names as paraml, param2, and so on.
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If you add a dynamic resource, you must specify the parameter name as EntitlementParaKey
and provide the value of the parameter in JSON format (for Identity Manager 4.0 and later) or
the legacy entitlement format (for earlier versions of Identity Manager).

For more information about the Named String Builder, see Section 4.12, “String Builder,” on
page 61.

Example

Do | add resource v | ()
Specify resource DM: * | Ch=resourceManager, Ch=5vskem, ChN=Level20, CH=
Specify user application URL: * | 192,163, 10,203,3080/10M

Specify authorized user DM * | Chl=admin, O=novell

M O m O
M

specify password: * | Named Password("admin"}

Select object: | Current object W

Specify strings: | description
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Add Source Attribute Value

Adds the specified attribute on an object in the source data store.

Fields

Attribute Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Object

Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

DN

Specify the DN, association, or the current object as the target object.

Value Type

Select the syntax of the attribute value to be added. The options are string, counter, dn, int,
interval, octet, state, structured, teleNumber, or time.

String
Specify the attribute value to be added.

Example

Lo |add source atkribute walue v | (@

||f

Specify attribute name: * | Title

L &
P

Specify class name; | User

2

Select objeck: | Associakion w

Specify association: * | "Source Mame!)"

Specify value bype: | string

{

Enker string: * | "Manager"
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Add Source Object

Creates an object of the specified type in the source data store, with the name and location provided
in the DN field. Any attribute values to be added as part of the object creation must be done in
subsequent Add Source Attribute Value actions, using the same DN.

Fields

Class Name

Specify the class name of the object to be added. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

DN
Specify the DN of the object to be added.

Example

Do | add source object | (7

Specify class name: * | User

A
g
y

Specify DM: * | "Userst John Smith"

Actions 247



248

Append XML Element

Appends a custom element, with the name specified in the Name field, to the set of elements selected
by the XPath expression. If Before XPath Expression is not specified, the new element is appended after
any existing children of the selected elements. If Before XPath Expression is specified, it is evaluated
relative to each of the elements selected by the expression to determine which of the children to insert
before. If Before XPath Expression evaluates to an empty node set or a node set that does not contain
any children of the selected element, the new element is appended after any existing children;
otherwise, the new element is inserted before each of the nodes in the node set selected by before that
are children of the selected node.

Fields

Name

Specify the tag name of the XML element. This name can contain a namespace prefix if the prefix
has been previously defined in this policy. Supports variable expansion. For more information,
see Section 3.6, “Variable Selector,” on page 33.

XPath Expression

Specify an XPath 1.0 expression that returns a node set containing the elements to which the new
elements should be appended.

Insert

Select whether to insert the XPath expression before the source XPath expression or append the
XPath expression to the end of the current node in the destination XPath expression.

Before XPath Expression

Specify an XPath 1.0 expression that evaluates relative to each of the nodes selected by the
expression that returns a node set containing the child nodes that the new elements should be
inserted before. Supports variable expansion. For more information on variable expansion and
XPath, see Section 3.6.5, “XPath Expressions,” on page 37.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.

Example

If you are implementing Novell Credential Provisioning policies, there is a sample Subscriber
Command Transformation policy that uses the XPath Expression condition. The sample file is called
SampleSubCommandTransform.xml. It is found in the \dirxml\utilities folder on the Identity
Manager media. For more information, see “Example Credential Provisioning Policies” in Novell
Credential Provisioning for Identity Manager 4.0.2. To view the policy in XML, see
SampleSubCommandTransform.xml (../samples/SampleSubCommandTransform.xml).

The sample file uses the append XML element action to add the Novell SecureLogin or Novell
SecretStore credentials to the user object when it is provisioned.
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../samples/SampleSubCommandTransform.xml

5 Add operation-data element to password subscribe operations (if needed)

5 Add payload data to modify-password subscribe operations

5 Add payload data to add subscribe operations

Mo description available

£ Condition Group 1

5 if operation equal "add"

And Z

RhORNORN RN SN RN RN RN R

if passward available

append *ML element(“sso-svnc-daka”®, “operation-data™)

append XML element"sso-target-user-dn”, "operation-data/sso-sync-daka™)

append #ML text("operation-dataysso-sync-data)sso-target-user-dn”, Source Attributed DirEML-A0Conkext" )
append ¥ML element("ss0-app-username”, "operation-datajsso-sync-daka™

append ML texk"oper ation-data)sso-svnc-datafsso-app-username”, Source Attributed"CH"Y)

append ¥ML element“password”, "operation-datajsso-sync-data™

append ¥ML bext("operation-datafsso-sync-dataipassword”, Password())

append #ML element!"nsl-set-passphrase-answer”, "operation-datajsso-sync-data™

append XML text("operation-dataysso-sync-datafnsl-set-passphrase-answer”, Source Attribute " workforceID")

Do |append =ML element w @
Enter element name: * | sso-sync-data C.‘ &
Specify #Path expression: * | operation-data i E{ Y. &
Insert: | Append to end of ¥Path expression L
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Append XML Text

Appends the specified text to the set of elements selected by the XPath expression. If Before XPath
Expression is not specified, the text is appended after any existing children of the selected elements.
If Before XPath Expression is specified, it is evaluated relative to each of the elements selected by the
expression to determine which of the children to insert before. If Before XPath Expression evaluates
to an empty node set or a node set that does not contain any children of the selected element, then the
text is appended after any existing children; otherwise, the text is inserted before each of the nodes in
the previously selected node set that are children of the selected node.

Fields

XPath Expression

Specify the XPath 1.0 expression that returns a node set containing the elements to which the
new elements should be appended. Supports variable expansion. For more information on
variable expansion and XPath, see Section 3.6.5, “XPath Expressions,” on page 37.

String
Specify the text to be appended.

Insert

Select whether to insert the XPath expression before the source XPath expression or append the
XPath expression to the end of the current node in the destination XPath expression.

Before XPath Expression

Specify the XPath 1.0 expression that evaluates relative to each of the nodes selected by the
expression that returns a node set containing the child nodes that the text should be inserted
before. Supports variable expansion. For more information on variable expansion and XPath, see
Section 3.6.5, “XPath Expressions,” on page 37.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.

Example

If you are implementing Novell Credential Provisioning policies, there is a sample Subscriber
Command Transformation policy that uses the XPath Expression condition. The sample file is called
SampleSubCommandTransform.xml. It is found in the \dirxml\utilities folder on the Identity
Manager media. For more information, see “Example Credential Provisioning Policies” in Novell
Credential Provisioning for Identity Manager 4.0.2. To view the policy in XML, see
SampleSubCommandTransform.xml (../samples/SampleSubCommandTransform.xml).

The example is using the append XML text action to find the Novell SecureLogin or Novell
SecretStore application username. By obtaining the application name, the credentials can be set for
the user object when it is provisioned.
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../samples/SampleSubCommandTransform.xml

+ 5 Add operation-data element to password subscribe operations (if needed)

+ 5 Add payload data to modify-password subscribe operations

= 5 Add payload data to add subscribe operations

Mo description available

£ Condition Group 1
5 if operation equal "add"

And % i password available

append *ML element(“sso-svnc-daka”®, “operation-data™)

append XML element"sso-target-user-dn”, "operation-data/sso-sync-daka™)

append #ML text("operation-dataysso-sync-data)sso-target-user-dn”, Source Attributed DirEML-A0Conkext" )
append ¥ML element("ss0-app-username”, "operation-datajsso-sync-daka™

append ML texk"oper ation-data)sso-svnc-datafsso-app-username”, Source Attributed"CH"Y)

append ¥ML element“password”, "operation-datajsso-sync-data™

append ¥ML bext("operation-datafsso-sync-dataipassword”, Password())

append #ML element!"nsl-set-passphrase-answer”, "operation-datajsso-sync-data™

RhORNORN RN SN RN RN RN R

append XML text("operation-dataysso-sync-datafnsl-set-passphrase-answer”, Source Attribute " workforceID")

Do | append XML text w @
Specify ¥Path expression; * | operation-data/sso-sync-datafsso-target-user-dn el E‘{' gl'.v:. QE
Specify string: * | "Source Atkribute!"DirkML-ADConkext™)"

Insert: | Append to end of XPath expression L
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Break

Ends processing of the current operation by the current policy.

Example

Do |break v @
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Clear Destination Attribute Value

Removes all values for the named attribute from an object in the destination data store.

Fields

Attribute Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object

Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

DN

Select the DN, association, or current object as the target object.

Example

Do |clear destination attribute walue | (7

it

Specify attribute name; * | Member

A &
A

Specify class name: | User ! C&
Select mode; |add ko current operation W
Select object: | DR A

Specify DR: * | "Users)Jobn Smith"
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Clear Operation Property

Clears any operation property with the provided name from the current operation. The operation
property is the XML attribute attached to an <operation-data> element by a policy. An XML
attribute is a name/value pair associated with an element in the XDS document.

Fields

Property Name

Specify the name of the operation property to clear. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Example

Do |clear operation properky 4 @

M

Specify property name: * | MyStoredProperky
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Clear Source Attribute Value

Removes all values of an attribute from an object in the source data store.

Fields

Attribute Name
Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object. This value might be required for schema map purposes if the object is
other than current object. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Object

Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

DN

Select the DN, association, or current object as the target object.
Example

Do |clear destination attribute walue | (7

it

Specify attribute name: * | Member

A &
f S

Specify cass name: | User ! C&
Select mode: |add ko current operation W
Select object: | DR w
Specify DM: * | "UsersJohn Smith"
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Clear SSO Credential

Clears the Single Sign On credential so objects can be deprovisioned. Additional information about
the credential to be cleared can be provided in the Enter login parameter strings field. The number of
the strings and the names used are dependent on the credential repository and application for which
the credential is targeted. For more information, see Novell Credential Provisioning for Identity Manager
4.0.2.If a policy containing this token encounters an error, Designer generates the error as the local
variable error.do-clear-sso-credential. For more information about local error variables, see
“Local Variable Selector” on page 70.

Fields

Credential Repository Object DN
Specify the DN of the repository object. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Target User DN
Specify the DN of the target users.

Application Credential ID
Specify the application credential that is stored in the application object. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Login Parameter Strings

Specify each login parameter for the application. The login parameters are the authentication
keys stored in the application object. You can enter the strings manually, or select the Edit the
Strings icon [E to open the String Builder and specify the strings. For more information about the
Named String Builder, see Section 4.12, “String Builder,” on page 61.

Example
Do | clear 550 credential w| (@
Specify credential repasitary object DR * | L4\ GroupiWisel Groupiwise_Repasitary \._1 C&
Set DM relative to policy
Specify target user DM: * | "RovellUsers"
Piopulate the Following From an application object
Specify application credential ID: * | Group'Wise_Credential l:%
Specify login parameter strings: | Username, Password

Policies in Designer 4.0.2



Clone By XPath Expressions

Appends deep copies of the nodes specified by the source field to the set of elements specified by the
destination field. If Before XPath Expression is not specified, the non-attribute cloned nodes are
appended after any existing children of the selected elements. If Before XPath Expression is specified,
it is evaluated relative to each of the elements selected by expression to determine which of the
children to insert before. If Before XPath Expression evaluates to an empty node set or a node set that
does not contain any children of the selected element, the non-attribute cloned nodes are appended
after any existing children; otherwise, the non-attribute cloned nodes are inserted before each of the
nodes in the previously selected node set that are children of the selected node.

Fields

Source XPath Expression

Specify the XPath 1.0 expression that returns a node set containing the nodes to be copied.
Supports variable expansion. For more information on variable expansion and XPath, see
Section 3.6.5, “XPath Expressions,” on page 37.

Destination XPath Expression

Specify the XPath 1.0 expression that returns a node set containing the elements to which the
copied nodes are to be appended. Supports variable expansion. For more information on
variable expansion and XPath, see Section 3.6.5, “XPath Expressions,” on page 37.

Insert

Select whether to insert the XPath expression before the source XPath expression or append the
XPath expression to the end of the current node in the destination XPath expression.

Before XPath Expression

Specify the XPath 1.0 expression that evaluates relative to each of the nodes selected by the
expression that returns a node set containing the child nodes that the text should be inserted
before. Supports variable expansion. For more information on variable expansion and XPath, see
Section 3.6.5, “XPath Expressions,” on page 37.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.

Example
Do [clone by xPath expressions A @
Specify source ¥Path expression: * | @* i @f B, &
Specify destination ¥Path expression: * | .. fmodify[last(}] [nﬁ?_ﬂ @ }\.p. Cé

Insert; | Append to end of XPath expression LY
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Clone Operation Attribute

Copies all occurrences of an attribute within the current operation to a different attribute within the
current operation.

Fields

Source Name
Specify the name of the attribute to be copied from. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Destination Name

Specify the name of the attribute to be copied to. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Example

The example adds a User object to the appropriate Employee or Manager group based on Title. It also
creates the group, if needed, and sets up security equal to that group. The policy is Govern Groups
for User Based on Title Attribute, and it is available for download from the Novell Support Web site.
For more information, see “Downloading Identity Manager Policies” in Understanding Policies for
Identity Manager 4.0.2. To see the policy in XML, see 003 -Command-AddCreateGroups .xml (../
samples/003-Command-AddCreateGroups.xml).

il Set local variables to test existence of groups and for placement

Z Create ManagersGroup, if needed

H B H

5 Create EmployeesGroup, if needed

E= 5 If Title indicates Manager, add to ManagerGroup and set rights
Mo description available
£ Condition Group 1
Z i class name equal "User"
And 5 if operation attribute ‘Title' match *. *manager, *"

£ et destination attribube valuel"Group Membership!, Local Variabled"manager-group-dnt)

5 clone operation attributel"Group Membership”, "Security Equals™
5 IF Title does not indicate Manager, add to EmployeeGroup and set rights
Lo |clone operation attribute w| @

|

Specify source name; * | Group Membership

fa &
A A

it

Specify destination name: | Security Equals

Policies in Designer 4.0.2


../samples/003-Command-AddCreateGroups.xml

The Clone Operation Attribute is taking the information from the Group Membership attribute and
adding it to the Security Equals attribute so the values are the same.
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Delete Destination Object

Deletes an object in the destination data store.

Fields

Class Name
(Optional) Specify the class name of the object to delete in the destination data store. Supports
variable expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.
Mode
Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.
Object
Select the target object type to delete in the destination data store. This object can be the current
object, or can be specified by a DN or an association.
DN
Select the DN, association, or current object as the target object.

Example
Do | delete destination object LANG)!
Specify class name: | User @&
Select mode: | add ko current operation w
Select object: [DM w
Specify DM * | "Movel\Users\jdoes"
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Delete Source Object

Deletes an object in the source data store.

Fields

Class Name
(Optional) Specify the class name of the object to delete in the source data store. Supports
variable expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.
Object
Select the target object type to delete in the source data store. This object can be the current
object, or can be specified by a DN or an association.
DN

Select the DN, association, or current object as the target object.

Example
Do |delete source object v (3
Specify class name: | User k@ 'CT‘ &
Select object: |DM L
apecify DN * | "NovelliUserstjdoes"

Actions
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Find Matching Object

Finds a match for the current object in the destination data store.

Fields

Scope
Select the scope of the search. The scope might be an entry, a subordinate, or a subtree.

DN
Specify the DN that is the base of the search.

Match Attributes

Specify the attribute values to search for.

IMPORTANT: To improve performance when using the find matching object verb, create an
index for the attributes that you are going to use when querying the Identity Vault. For more
information about indexes, see the Novell eDirectory 8.8 Administration Guide (http://
www.novell.com/documentation/edir88/edir88/index.html?page=/documentation/edir88/
edir88/data/a5tuuub.html).

Remarks

Find Matching Object is only valid when the current operation is an add.

The DN argument is required when the scope is “entry,” and is optional otherwise. At least one
match attribute is required when the scope is “subtree” or “subordinates.”

The results are undefined if the scope is “entry” and there are match attributes specified. If the
destination data store is the connected application, then an association is added to the current
operation for each successful match that is returned. No query is performed if the current operation
already has a non-empty association, thus allowing multiple find matching object actions to be
strung together in the same rule.

If the destination data store is the Identity Vault, then the destination DN attribute for the current
operation is set. No query is performed if the current operation already has a non-empty destination
DN attribute, thus allowing multiple find matching object actions to be strung together in the same
rule. If only a single result is returned and it is not already associated, then the destination DN of the
current operation is set to the source DN of the matching object. If only a single result is returned and
it is already associated, then the destination DN of the current operation is set to the single character
&#xFFFC;. If multiple results are returned, then the destination DN of the current operation is set to
the single character &#xFFFD;.

Example

The example matches on User objects with the attributes CN and L. The location where the rule is
searching starts at the Users container and adds the information stored in the OU attribute to the DN.
The rule is from the predefined rules that come with Identity Manager. For more information, see
Section 8.13, “Matching - By Attribute Value,” on page 133. To see the policy in XML, see
predef_match by attribute.xml (../samples/predef_match_by_attribute.xml).
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http://www.novell.com/documentation/edir88/edir88/index.html?page=/documentation/edir88/edir88/data/a5tuuu5.html
../samples/predef_match_by_attribute.xml

SV M Matching - by attribute value

Mo description available

Conditions

& Condition Group 1

v 5 if class name equal “Lser"

" & find matching object{dn{"[Enter base DM to start search]"), match
—{"[Enter name of attribute ko makch o]

Do |Fin|:| matching object w | )]
Select scope: |su|:|tree V|
Specify DM | “Movel” |
Specify match attributes: | CH, L |

When you click the Argument Builder icon, the Match Attribute Builder comes up. You specify the
attribute you want to match on in the builder. This example uses the CN and L attributes.

Match attributes + K L BE T @
| M | @ L_’.:| Et: | Use walues from the current object v|
|| L | g | Use values from the current object v||

The left fields store the attributes to match. The right fields allow you to specify to use the value from
the current object to match or to use another value. If you select Other Value, there are multiple value
types to specify:

¢ counter

¢ dn

¢ int

¢ interval

¢ octet

¢ state

¢ string

¢ structured

¢ teleNumber

¢ time

To use another value:

1 Launch the Match Attribute Builder by selecting Edit the match attributes, then select Other Value.
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Match Attributes [
The match attributes specify the attributes that are to be used to find a match For the action,

Match Attributes & R 4 BRB LG
| @ & & | other value v

Select Value Type: | string vl

Specify String: | |

2 Select the desired value type.
3 Specity the value, then click Finish.
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For Each

Repeats a set of actions for each node in a node set.

Fields

Node Set
Specify the node set.

Action

Specify the actions to perform on each node in the node set.

Remarks

The current node is a different value for each iteration of the actions, if a local variable is used.

If the current node in the node set is an entitlement element, then the actions are marked as if they are
also enclosed in an Implement Entitlement action. If the current node is a query element returned by
a query, then that token is used to automatically retrieve and process the next batch of query results.

Example

Do |For each v | (7
Specify node set: * | Added Entitlement"Group")

Specify ackion: * | do-add-dest-attr-walue

The following is an example of the Actions Builder, used to provide the action argument:

Lo | add destination attribute value v | (7
Specify attribute name: * | Member Q& e
Specify class name: | Group 'J;' '».': =
Select mode: | add ko current operation W
Select object: | DN w
Specify DM * | Local Mariable!"current-node™)

Specify value bype: | string

Enter string: * | Deskination DR

For more information on the Action Argument Component Builder, see Section 4.2, “Actions
Builder,” on page 44.

Actions
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Generate Event

Sends a user-defined event to Novell Audit or Sentinel.

Fields

ID

ID of the event. The provided value must result in an integer in the range of 1000-1999 when
parsed by using the parselnt method of java.lang.Integer. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Level

Level of the event.

Level

Description

log-informational
log-alert

log-critical

log-debug

log-emergency

Positive events of any importance.
Events that require immediate attention.

Events that can cause parts of the Metadirectory engine or driver to
malfunction.

Events of relevance for support or engineers to debug the operation of
the Metadirectory engine or driver.

Events that cause the Metadirectory engine or driver to shut down.

log-error Events describing errors that can be handled by the Metadirectory
engine or driver.

log-notice Events (positive or negative) that an administrator can use to understand
or improve use and operation.

log-warning Negative events not representing a problem.

Strings

Specify user-defined string, integer, and binary values to include with the event. You can enter
the strings manually, or select the Edit the Strings icon [Z] to open the Named String Builder and
specify the strings. For more information about the Named String Builder, see Section 4.9,
“Named String Builder,” on page 57.

The Generate Event action supports the following strings:

String Name Description

data Data entered here is stored in the blob event field.
data-type Specifies the data-type of the value in the data tag.
subTarget The subcomponent of the target being acted upon.
target The object being acted upon.
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String Name Description

target-type Integer specifying a predefined format for the target. Predefined values
for target-type are currently:

+ 0=None

+ 1 = Slash Notation
+ 2 = Dot Notation

+ 3 =LDAP Notation

textl Text entered here is stored in the textl event field.
text2 Text entered here is stored in the text2 event field.
text3 Text entered here is stored in the text3 event field.
value Any number entered here is stored in the value event field. You can also

access this field using the valuel tag.

value3 Any number entered here is stored in the value3 event field.

Remarks

The Novell Audit or Sentinel event structure contains a target, a subTarget, three strings (text1, text2,
text3), two integers (value, value3), and a generic field (data). The text fields are limited to 256 bytes,
and the data field can contain up to 3 KB of information, unless a larger data field is enabled in your
environment.

Example

The example has four rules that implement a placement policy for User objects based on the first
character of the Surname attribute. It generates both a trace message and a custom Novell Audit or
Sentinel event. The Generate Event action is used to send Novell Audit or Sentinel an event. The
policy name is Policy to Place by Surname and is available for download from the Novell Support
Web site. For more information, see “Downloading Identity Manager Policies” in Understanding
Policies for Identity Manager 4.0.2. To view the policy in XML, see 001-Placement -BySurname .xml (../
samples/001-Placement-BySurname.xml).
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../samples/001-Placement-BySurname.xml

- 5 ctup Local Yariables
B 5 Surname A-I: place in Users1

Mo description available

Condit

% Condition Group 1

& i class name equal "User"

% if operation attribute 'Surname’ match "[a-i].*"

& set operation destination DM{dn{" Training)Users AckivelUsers1"+") "+ Operation Abtributel"C"Y)

v & trace messagelcolor="yellow", Local Yariablef"LyUsers1"))
v 5 generakte event(id="1000", textl=Local ¥ariable("L Y sers1"T)

" % Surname J-R: place in Users2

v % Surname 5-2Z place in Users3

Do | generate event h @
Specify ID: * | 1000 | &
Select level: |informational Lo
Specify strings: | ekl |
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If

Conditionally performs a set of actions.

Fields

If Conditions

Specify the desired condition.

Then Perform Actions

Specify the desired actions, if the conditions are True.

Else Perform Actions
(Optional) Specify the desired actions, if the conditions are False.

Example

During an Add or Modify operation, if the attribute of Title equals manager, the user object is added
to the ManagerGroup group. If the Title does not equal manager, then the user object is added to the

UsersGroup group. To view the policy in XML, see 1if.xml (../samples/if.xml).

SRV |

Conditions

" & Condition Group 1

+ & if operation equal "add"
v 5 if operation equal "modify"
gt

then

if operation attribute 'Title' equal "manager”

set destination attribute walue"Group Membership”, class
—name="User", "MovellUsersiManagerGroup”)

else
set default atbribute valued'Group Membership®,

—"MovelliUsersiUsersGroup™)

Do |if v| @

If conditions: | and(if operation attribute 'Title' equal "manager") |

Then perfarm actions: | do-set-dest-attr-value |

Else perform ackions: | do-set-default-attr-value |

When you create the if action, you must add a condition and one action. In this example, there are
two separate actions. The condition is if a user object has the title of manager.
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../samples/if.xml
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Create a list of Conditions

Create, delete, of rearrange a listk of conditions,

Condition List 2 - R A BB @

v 5 Condition Group 1

v 5.. if operation attribute 'Title' equal "manager”

The action is to add the user object to the ManagerGroup group.

Create a list of Actions

Create, delete, or rearrange a lisk of actions.

Action List Z R A4 BB

- <=t d=stination attribute value("Group Membership®, dass name="

e, "

MNowelliUse

rs\ManagerGroup")

If the title does not equal manager, the user object is placed in the UsersGroup group.

_

Create a list of Actions

Create, delete, or rearrange a lisk of actions,

Action List £+ R of

Ea e

Y=

A = d=fault attribube value("Group Membership”, "hovelliUsersiUse

rsEroup’)
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Implement Entitlement

Designates actions that implement an entitlement so that the status of those entitlements can be
reported to the agent that granted or revoked the entitlement.

Fields

Node Set
Node set containing the entitlement being implemented by the specified actions.

Action

Actions that implement the specified entitlements.

Example
[5u] |implement enkitlernent v| @
Specify node set: * | Removed Entitlement(" account™) |
Specify ackion: * | do-add-dest-attr-value |

The following is an example of the Actions Builder, used to provide the action argument:

Do |add destination attribute value w | #
Specify attribute name; * | Login Disabled | '@ '-..ﬁ:' @@
Specify class name: |Llser | @ 'f:' @E_
Select mode: |a|:||:| ko current operation V|
Select object: |Dr'-.l V|
Specify DM: * | "Local Wariable{"current-nodey" |
Specify value bype: | string v|
Enter string: * | "Destination DH" |

For more information on the Actions Builder, see Section 4.2, “Actions Builder,” on page 44.

Actions
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Move Destination Object

Moves an object into the destination data store.

Fields

Class Name
(Optional) Specify the class name of the object to move into the destination data store. Supports
variable expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.
Mode
Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.
Object to Move
Select the object to be moved. This object can be the current object, or can be specified by a DN or
an association.
Container to Move to

Select the container to receive the object. This container is specified by a DN or an association.

DN or Association

Specify whether the DN or association of the container is used.

Example

The example contains a single rule that disables a user’s account and moves it to a disabled container
when the Description attribute indicates it is terminated. The policy is named Disable User Account

and Move When Terminated, and it is available for download from the Novell Support Web site. For
more information, see “XPath 1.0 Expressions” in Understanding Policies for Identity Manager 4.0.2. To

view this policy in XML, see 005-Command-DisableMoveOnTermination (../samples/005-Command-
DisableMoveOnTermination.xml).

B 5 0On Termination, disable user and move to Disabled container

+ & Condition Group 1

v § if operation equal "modify"

v 5 if class name equal "User"

v 5 if operation attribute 'Description’ match "~terminated, **

¥ 5 set destination atkribute valued"Login Disabled”, direct="trus",
v 5 maove destination object{when="after", dn"Users\Disabled"))

True"}
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../samples/005-Command-DisableMoveOnTermination.xml

Do | move destination object vl )]

Specify dass name: |

ece
Select mode: |a|:||:| ko current operation w |
Select object ko move: |Current abject W |
Select containet bo move Lo |DN b |

Specify DR * | "UsersiDisabled"

The policy checks to see if it is a modify event on a User object and if the attribute Description

contains the value of terminated. If that is the case, then it sets the attribute of Login Disabled to
True and moves the object into the User\Disabled container.
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Move Source Object

Moves an object into the source data store.

Fields

Class Name

(Optional) Specify the class name of the object to move into the source data store. Supports
variable expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Object to Move
Select the object to be moved. This object can be the current object, or it can be specified by a DN
or an association.

Select Container
Select the container to receive the object. This container is specified by a DN or an association.

Example
Do |mowe source object b @
Specify class name: | User g & &
Select object bo move: |DN w
Specify DM: * | "Usersifckive) ldos"
Select container to move ko: | DM b
Specify DM * | "Users\Inactive"
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Reformat Operation Attribute

Reformats all values of an attribute within the current operation by using a pattern.

Fields

Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Value Type

Specify the syntax of the new attribute value.

Value

Specify a value to use as a pattern for the new format of the attribute values. If the original value
is needed to constructed the new value, it must be obtained by referencing the local variable
current-value.

Example

The example reformats the telephone number. It changes it from (nnn)-nnn-nnnn to nnn-nnn-nnnn.
The rule is from the predefined rules that come with Identity Manager. For more information, see
Section 8.9, “Input or Output Transformation - Reformat Telephone Number from (nnn) nnn-nnnn to
nnn-nnn-nnnn,” on page 126. To view the policy in XML, see

predef transformation reformat telephonel.xml (../samples/
predef_transformation_reformat_telephonel.xml).

=4 5 Input or Output Transformation - Reformat Telephone Mumber from
—{nnn}) nnn-nnnn to nnn-nnn-nnnn

Mo description available

" % Condition Group 1

Define new condition here

reformat operation attributed"phone”, Replace Firsk("~i{ddid))
—is*didd)-Cdiddddg, "$1-52-%3", Local variabled"current-

—uwalue")
Do |reformat operation attribute | (7
specify name: * | phone '@ '».': '..:f
Specify value tvpe: | string L

Enter string: * | "Replace First("~\((dvd =0 d)-0d AV DS, "$1-52-%

The action reformat operation attribute changes the format of the telephone number. The rule uses
the Argument Builder and regular expressions to change how the information is displayed.
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../samples/predef_transformation_reformat_telephone1.xml

= Replace First"~(dididis* O didi-Oddididig, "$1-42-43",
i Local Yariable("current-value™)
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Remove Association

Sends a remove association command to the Identity Vault.

Fields

Mode
Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Association

Specify the value of the association to be removed.

Example

The example takes a Delete operation and disables the User object instead. The transforms an event.
The rule is from the predefined rules that come with Identity Manager. For more information, see
Section 8.2, “Command Transformation - Publisher Delete to Disable,” on page 115. To view the
policy in XML, see predef command_delete to_disable.xml (../samples/
predef_command_delete_to_disable.xml).

= + % Command Transformation - Publisher Delete to Disable

Mo description available,

.~ % condition Group 1

v % i operation equal "delete"

v & if class name equal "User"

v Zr  set destination attribute value("Login Disabled”, "true")

v T remove association{association{ Association] 1))

Do | remove association v| @
Select maode: |a|:|d to current operation - |
Specify association: * | Associationt) |

When a Delete operation occurs for a User object, value of the Login Disabled attribute is set to True
and the association is removed from the object. The association is removed because the associated
object in the connected application no longer exists.
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Remove Destination Attribute Value

Removes an attribute value from an object in the destination data store.

Fields

Attribute Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object

Select the target object. This object can be the current object, or can be specified by a DN or an
association.

Value Type

Specify the attribute syntax of the value you want to remove.

Value

Specify the attribute value of the value you want to remove.

Example

Do |remove destination atbribute walue v (?

|||ll

Specify attribute name: * | Member

Specify class name: | User

L &
£y Sy
y 7

Select mode: | add ko current operation w

Select object: |DM

£

Specify DM: * | "NovellUsersiManagercroup”

<

Specify value type: | string

Entet string: * | "Destination DM
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Remove Role

Initiates a request to the Roles Based Provisioning Module (RBPM) to revoke the specified role (in the
Role DN field) from the specified user (in the Authorized User DN field). This field is only available if
the Identity Manager server version is set to 3.6 or later.

Fields

Role DN
Specify the name of the role to revoke, in LDAP format. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

User Application URL
Specify the URL of the User Application server hosting the Roles Based Provisioning module.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Authorized User DN
Specify the name of the user authorized to request the role assignment, in LDAP format.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Timeout Value
Specify the number of milliseconds you want Identity Manager to try to establish a connection to
the User Application server before timing out. The default value is o.

Password
Specify the authorized user password. You can enter a clear text password (not recommended)
or use the Argument Builder to specify a Named Password.

Object
Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

DN or Association
Select the DN or association as the target object.

Strings
(Optional) Specify additional argument strings for the Role assignment request. You can enter

the strings manually, or select the Edit the Strings icon [Z] to open the Named String Builder and
specify the strings. For more information about the Named String Builder, see Section 4.9,
“Named String Builder,” on page 57.

The Remove Role action supports the following string arguments:

String Name Description

description A description of the reason for the request used for auditing and (if necessary)
approval purposes.

Default: Request generated by policy.
effective-time The time (in CTIME format) the role assignment should become effective.

Default: now
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Example

Do |remu:ﬂ-.-'e role V| &

Specify rale DMN: * | Caonfig, CHM=AppConfig, CN=Test App, Ch=entitlement, D=nove | Q @El

Specify user applicakion LRL: * | 192,168, 10,203, 8080/T10M | R%l
Specify authorized user DM: * | Ch=admin, O=novell | Q @é
Specify passwaord; * | Mamed Password!admin®) |
Select object; |Current object V|
Specify skrings: | kextkl |
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Remove Resource

Initiates a request to the Roles Based Provisioning Module (RBPM) to revoke the specified resource
(in the Resource DN field) from the specified user (in the Authorized User DN field). This field is
only available if the Identity Manager server version is set to 4.0.2 or later.

Fields

Resource DN
Specify the name of the resource to revoke, in LDAP format. Supports variable expansion. For
more information, see Section 3.6, “Variable Selector,” on page 33.

User Application URL

Specify the URL of the User Application server hosting the Roles Based Provisioning module.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Authorized User DN
Specify the name of the user authorized to request the resource assignment, in LDAP format.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Timeout Value
Specify the number of milliseconds you want Identity Manager to try to establish a connection to
the User Application server before timing out. The default value is o.

Password

Specify the authorized user password. You can enter a clear text password (not recommended)
or use the Argument Builder to specify a Named Password.

Object
Select the target object type. This object can be the current object, or can be specified by a DN or
an association.
DN or Association
Select the DN or association as the target object.
Strings
(Optional) Specify additional argument strings for the Resource assignment request. You can

enter the strings manually, or select the Edit the Strings icon [ to open the Named String Builder
and specify the strings. For more information about the Named String Builder, see Section 4.9,
“Named String Builder,” on page 57.

The Remove Resource action supports the following string arguments:

String Name Description

description A description of the reason for the request used for auditing and (if necessary)
approval purposes.

Default: Request generated by policy.
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Example

Do |rem-:we resource w | @

Specify rezource DR * | Config, CM=AppConfig, CN=Test App, _h=entitlement, D=nove | Q @:f'

Specify user application URL; * | 192,168, 10,208, 3080, 10M | K%l
Specify authorized user DR * | Ch=adrmin, O=naovel | Q @'él
Specify password; * | Mamed Password("admin) |
Select object: |Current ohiject V|
Specify strings: | descripkion |
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Remove Source Attribute Value

Removes the specified value from the named attribute on an object in the source data store.

Fields

Attribute Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Object

Select the target object. This object can be the current object, or can be specified by a DN or an
association.

DN or Association

Select the DN or association as the target object.

Value Type

Specify the syntax of the attribute value to be removed.

String

Specify the attribute value to be removed.
Example

Do |remove source attribute value v (@

||l‘

specify attribute name: * | Member

A &
LS
A

Specify class name: | User

Select object: |DR W

Specify DR * | "MovellUsersiManagercroop!

£

Specify value bype: | skring

Enter string: * | Source DNG

Actions 283



Rename Destination Object

Renames an object in the destination data store.

Fields

Class Name
(Optional) Specify the class name of the object to rename in the destination data store. Supports
variable expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.
Mode
Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.
Object
Select the target object. This object can be the current object, or can be specified by a DN or an
association.
DN or Association

Select the DN or association as the target object.

String

Specify the new name of the object.

Example
Do |rename destination object v | (7
Specify class name: | User @ & &
Select mode: | add ko current operation w
Select object: |DMN w
specify DM: * | "MovelliUsers)jdos"
Specify string: * | "JoeDog"
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Rename Operation Attribute

Renames all occurrences of an attribute within the current operation.

Fields

Source Name

Specify the original attribute name. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Destination Name

Specify the new attribute name. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Example

Do |rename operation atbribute w @

II{

Specify source name: * | Surname

L &
LS
|

Specify destination name: | sn
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Rename Source Object

Renames an object in the source data store.

Fields

Class Name
(Optional) Specify the class name of the object to rename in the source data store. Supports
variable expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.
Select Object
Select the target object. This object can be the current object, or can be specified by a DN or an
association.
DN or Association

Select the DN or association as the target object.

String

Specify the new name of the object.

Example
Do |rename source object W @
Specify dass name: | User @ & &
Select ohjeck: DM w
Specify DM * | "NovelliJsers)jdos”
Specify string: * | "loelboe"
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Send Emalil

Sends an e-mail notification. If a policy containing this token encounters an error, Designer generates
the error as the local variable error.do-send-email. For more information about local error
variables, see “Local Variable Selector” on page 70.

Fields

ID
(Optional) Specify the User ID in the SMTP system sending the message. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Server
Specify the SMTP server name. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Message Type

Select the e-mail message type.

Password

(Optional) Specify the SMTP server account password.

IMPORTANT: You can store the SMTP server account password as a Named Password on the
driver object. This allows the password to be encrypted; otherwise, you enter the password and
it is stored in clear text. For more information on Named Passwords, see “Securely Storing
Driver Passwords with Named Passwords” in the NetIQ Identity Manager Common Driver .

Strings
Specify the values containing the various e-mail addresses, subject, and message. You can enter

the strings manually, or select the Edit the strings icon [ to open the Named String Builder and
specify the strings. For more information about the Named String Builder, see Section 4.9,
“Named String Builder,” on page 57.

The Send Email action supports the following string arguments:

String Name Description

bcc Adds the address to the list of BCC e-mail recipients; multiple instances
are allowed. Can contain a comma-separated list of recipients.

cc Adds the address to the list of CC e-mail recipients; multiple instances
are allowed. Can contain a comma-separated list of recipients.

custom-smtp-header Specifies a custom SMTP header to add to the e-mail message.

encoding Specifies the character encoding to use for the e-mail message.

from Specifies the address to be used as the originating e-mail address.
message Specifies the content of the e-mail message.

reply-to Specifies the address to be used as the e-mail message reply address.
subject Specifies the e-mail subject.

to Adds the address to the list of e-mail recipients; multiple instances are

allowed. Can contain a comma-separated list of recipients.
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Example

Lo |sen|:| ernail V| )

Specify ID: | samith

Specify server; * | smkp.digitalairlines,com

Select message type: |te:x:t

Specify password: | Mamed Password(smtp-admin®)

Specify strings: | ko, subject, message
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Send Email from Template

Generates an e-mail notification by using a template. If a policy containing this token encounters an
error, Designer generates the error as the local variable error.do-send-email-from-template. For
more information about local error variables, see “Local Variable Selector” on page 70.

Fields

Notification DN

Specify the slash form DN of the SMTP notification configuration object. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Template DN

Specify the slash form DN of the e-mail template object. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Password

(Optional) Specify the SMTP server account password. Select the Edit the arguments icon E to
open the Argument Builder and specify the password argument.

IMPORTANT: You can store the SMTP server account password as a Named Password on the
driver object. This allows the password to be encrypted; otherwise, you enter the password and
it is stored in clear text. For more information on Named Passwords, see “Securely Storing
Driver Passwords with Named Passwords” in the NetIQ Identity Manager Common Driver .

Strings
Specify additional string arguments for the e-mail message. You can enter the strings manually,

or select the Edit the strings icon [ to open the Named String Builder and specify the strings. For
more information about the Named String Builder, see Section 4.9, “Named String Builder,” on
page 57.

Send Email from Template supports the following string arguments that you can use to specify
the various e-mail addresses.

String Name Description

bcc Adds the address to the list of BCC e-mail recipients; multiple instances
are allowed. Can contain a comma-separated list of recipients.

cc Adds the address to the list of CC e-mail recipients; multiple instances
are allowed. Can contain a comma-separated list of recipients.

custom-smtp-header Specifies a custom SMTP header to add to the e-mail message.

encoding Specifies the character encoding to use for the e-mail message.
reply-to Specifies the address to be used as the e-mail message reply address.
to Adds the address to the list of e-mail recipients; multiple instances are

allowed. Can contain a comma-separated list of recipients.

In addition to the reserved field names listed above, Send Email from Template supports Global
Configuration Values (GCVs) for creating the desired string.
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NOTE: If you want to include HTML in a string argument, you can enclose the HTML in <use-
html></use-html> tags within the string.

Each template can also define fields that can be replaced in the subject and body of the e-mail

message.
Example
Lo | send email From kernplate v | (7
Specify notification DM * | SecorikyiDefault Motification Collection =
specify template DM * | SecoribyviDefaule Motification Collection)\Forgot Password '-:é

Specify password: | "Named Password("smtp-admin™)"

B O L

Specify strings: | ko, co
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Set Default Attribute Value

Adds default values to the current operation (and optionally to the current object in the source data
store) if no values for that attribute already exist. It is only valid when the current operation is Add.

Fields

Attribute Name

Specify the name of the default attribute. Supports variable expansion. For more information,
see Section 3.6, “Variable Selector,” on page 33.

Write Back

Select whether or not to also write back the default values to the source data store.

Argument Values

Specify the default values of the attribute.

Example

The example sets the default value for the company attribute. You can set the value for an attribute of
your choice. The rule is from the predefined rules that come with Identity Manager. For more
information, see Section 8.5, “Creation - Set Default Attribute Value,” on page 120. To view the policy
in XML, see predef creation set default attribute value.xml (../samples/
predef_creation_set_default_attribute_value.xml).

SR N Creation - Set Default Attribute Yalue

Mo description available

Conditions

% Condition Group 1

v 5 if class name equal "User"

v 5 set defaulk aktribute walue("[Enter attribute name]”, write-back=
—true", "[Enter default attribute value]")

Do |set default attribute value v| 6]
Specify attribute name; * | COMpany | @ CT &
Write back: |true V|
Specify argument values; * | Digital Airlines |

Argument Yalues

Argurnent values specify the walues that are to be used For an attribute.

Type Argument Yalues + K Dg'l % @

string v| | Sigital airlines |
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../samples/predef_creation_set_default_attribute_value.xml

To build the value, the Argument Value List Builder is launched. See Section 4.8, “Argument Value
List Builder,” on page 56 for more information on the builder. You can set the value to what is
needed. In this case, we used the Argument Builder and set the text to be the name of the company.
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Set Destination Attribute Value

Adds a value to an attribute on an object in the destination data store, and removes all other values
for that attribute.

Fields

Attribute Name
Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Class Name

(Optional) Specify the class name of the target object in the destination data store. Leave the field
blank to use the class name from the current object. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object

Select the target object. This object can be the current object, or can be specified by a DN or an
association.

Value Type
Select the syntax of the attribute value to set.
String

Specify the attribute values to set.

Example

The example takes a Delete operation and disables the User object instead. The rule is from the

predefined rules that come with Identity Manager. For more information, see Section 8.2, “Command

Transformation - Publisher Delete to Disable,” on page 115. To view the policy in XML, see

predef command delete_to_disable.xml (../samples/predef command_delete_to_disable.xml).
= + % Command Transformation - Publisher Delete to Disable

Mo descripkion available.

.~ % Condition Group 1

v % f operation equal "delets"

v & Fclass name equal "User"

& set destination attribute value("Login Disabled”, "true"

v Zr  remove association{association{Association()))
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../samples/predef_command_delete_to_disable.xml

Do | et destination attribute walue Vl @

Specify atkribute name: * | Login Disabled

Qg
ece

Specify class name: |

Select mode: |a-:||:| ko current operation

vl
Select object: |Current abject v|
Specify walue bype: | string Z |

Enter string: * | "true”

The rule sets the value for the attribute of Login Disabled to true. The rule uses the Argument Builder

to add the text of true as the value of the attribute. See Section 4.3, “Argument Builder,” on page 45
for more information about the builder.
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Set Destination Password

Sets the password for an object in the destination data store.

Fields

Class Name

(Optional) Specify the class name for the object to set the password on in the destination data
store. Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object

Select the target object. This object can be the current object, or can be specified by a DN or an
association.

New Password

Specify the password to be set.
Old Password

Specifies the old password, which is used to confirm that you have rights to change the
password.

NOTE: This field is only available if the Identity Manager server version is set to 3.6 or later.

Example
Do | set destination password w @
Specify class name: @ &
Select mode: | add ko current operation w
Select object: | Current object A

Specify new password: * | "Generate Password(policy-dn="1[rook]\3ecurityiPassword Poli

Specify old password: | "Password()"

(0] Cancel * Required
[ ok || cancel]
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Set Local Variable

Sets a local variable.

Fields

Variable Name
Specify the name of the new local variable. Supports variable expansion. For more information,
see Section 3.6, “Variable Selector,” on page 33.
Scope
Select the scope of the local variable. This can be set to the driver or to the policy. Supports
variable expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.
Variable Type

Select the type of local variable. This can be a string, an XPath 1.0 node set, or a Java* object.

String

Specify the attribute values to set.

Example

The example adds a User object to the appropriate Employee or Manager group based on Title. It also
creates the group, if needed, and sets up security equal to that group. The policy name is Govern
Groups for User Based on Title, and it is available for download from the Novell Support Web site.
For more information, see “Downloading Identity Manager Policies” in Understanding Policies for
Identity Manager 4.0.2. To view the policy in XML, see 003-AddCreateGroups.xml (../samples/003-
Command-AddCreateGroups.xml).

= 5- Set local variables to test existence of groups and for placement

Mo description available

Z Condition Group 1
Z i class name equal "User"
And
Z Condition Group 2

fr if operation egual "add"

fr if operation egual "modify"
§r set local variable!"manager-group-dn”, "UsersiManagersGroup™)
5, set local variable!"manager-group-info”, Destination Attributel"Object Class", dnilocal Yarisbled"manager-group-
—dn" i
§r set local variable!"emplovee-group-dn”, "Users\EmployeesGroup™)
f, set local variable!"emplovee-group-info”, Destination Attributed"Chject Class", dnilocal Variable!"employvee-group-

—dn"H
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../samples/003-Command-AddCreateGroups.xml

Do | sek local variable w | @

Enter wariable name; * | rnanager-group-dn | Q &
Select scope: ||:u:|Iin:~;.-' v|
Select variable bype: |String v|
Specify string: * | "UsersiManagersGroup” |

The local variable is set to the value that is in the User object’s destination attribute of Object Class
plus the Local Variable of manager-group-info. The Argument Builder is used to construct the local
variable. See Section 4.3, “Argument Builder,” on page 45 for more information.
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Set Operation Association

Sets the association value for the current operation.

Fields

Association

Provide the new association value.

Example

Do | set operation association w @

Specify association: * | Source Mamed)
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Set Operation Class Name

Sets the object class name for the current operation.

Fields

String

Specify the new class name.
Example

Do |set operation class name W I:i?:l

Specify string: * | "User"

Actions
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Set Operation Destination DN

Sets the destination DN for the current operation.

Fields

DN
Specify the new destination DN.

Example

This example places the objects in the Identity Vault, by using the structure that is mirrored from the
connected system. You need to define at what point the mirroring begins in the source and
destination data stores. The rule is from the predefined rules that come with Identity Manager. For
more information, see Section 8.14, “Placement - Publisher Mirrored,” on page 134. To view the
policy in XML, see predef _place_pub mirrored.xml (../samples/predef_place_pub_mirrored.xml).

H « 5 Placement - Publisher Mirrored

Mo description available

Conditions

% Condition Group 1

% if source DM in subtree "[Enter base of source hierarchy]"

v 5 sek local wariablel"dest-base”, "[Enter base of destination
—hierarchy]")

« & setoperation destination DR{dniLacal Variable"dest-base"H""
—+Unmatched Source DRconverk="true"1})

Da |set operation destination DR W | @

Specify DN * | Local Variable("dest-base")+","+Unmatched Source DM{conwer |

The rule sets the operation destination DN to be the local variable of the destination base location
plus the source DN.
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Set Operation Property

Sets an operation property. An operation property is a named value that is stored within an
operation. It is typically used to supply additional context that might be needed by the policy that
handles the results of an operation.

Fields

Property Name

Specify the name of the operation property. Supports variable expansion. For more information,
see Section 3.6, “Variable Selector,” on page 33.

String
Specify the name of the string.

Example

Do | set operation properky W @

Specify property name: * | MyStoredProperty

A

Specify string: * | "Fred"
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Set Operation Source DN

Sets the source DN for the current operation.

Fields

DN
Specify the new source DN.

Example

Do | set opetation source DN b @

Specify DM: * | "MoveliUsers"+Atkribute!"CH")
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Set Operation Template DN

Sets the template DN for the current operation to the specified value. This action is only valid when
the current operation is Add.

Fields

DN
Specify the template DN.

Example

The example applies the Manager template if the Title attribute contains the word Manager. The
name of the policy is Policy: Assign Template to User Based on Title, and it is available for download
from the Novell Support Web site. For more information, see “Downloading Identity Manager
Policies” in Understanding Policies for Identity Manager 4.0.2. To view the policy in XML, see 003 -
Create-AssignTemplateByTitle.xml (../samples/003-Create-AssignTemplateByTitle.xml).

IV Assign Manager template if Title contains "Manager™

Mo description available

Conditions

+ Z Condition Group 1

& if class name equal "User"

v 5 if operation attribute Title' available
v 5 if operation attribute Title' match . *manager, **

| v 5 set operation template DN{dn("UsersiManager Template™ )

v 5 Assign Employee template if Title does not contain “Manager™

[B0a] |set operation kemplate Db b4 | @:l

Specify Dh: * | "UsersiManager Templake" |

The template Manager Template is applied to any User object the has the attribute of Title available
and contains the word Manager somewhere in the title. The policy uses regular expressions to find all
possible matches.
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Set Source Attribute Value

Adds a value to an attribute on an object in the source data store, and removes all other values for
that attribute.

Fields

Attribute Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Class Name

(Optional) Specify the class name of the target object in the source data store. Leave the field
blank to use the class name from the current object. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Object

Select the target object. This object can be the current object, or can be specified by a DN or an
association.

Value Type

Select the syntax of the attribute value.

Value

Specify the attribute value to be set.

Example

The example detects when an e-mail address is changed and sets it back to what it was. The policy
name is Policy: Reset Value of the E-mail Attribute, and it is available for download from the Novell
Support Web site. For more information, see “Downloading Identity Manager Policies” in
Understanding Policies for Identity Manager 4.0.2. To view the policy in XML, see 001-

Input PushBackOnEmail (../samples/001-Input-PushBackOnEmail.xml).

H 5 Push back on email changing

Mo description available

Conditions

+* & rondition Group 1

v 5 if class name equal "User"

& i operation attribute 'Email' changing

v fv set source attribute value! "Email”, Destination Attributel"Internet EMail Address™))
& strip operation attribube("Email")
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Do | sek source attribuke value v| @

Specify atkribute name; * | Ermail

Specify class name: |

Select objeck: |Current object

Specify value bype: | skring

e
eqs
¥
4

Enter string: * | Destinakion Attributel*Internet EMail Address™

The action takes the value of the destination attribute Internet EMail Address and sets the source

attribute of Email to this same value.

Actions
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Set Source Password

Sets the password for an object in the source data store.

Fields

Class Name
(Optional) Specify the class name of the object to set the password on in the source data store.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Object
Select the target object. This object can be the current object, or can be specified by an DN or an
association.

New Password

Specify the password to be set.
Old Password

Specifies the old password, which is used to confirm that you have rights to change the
password.

NOTE: This field is only available if the Identity Manager server version is set to 3.6 or later.

Example
Do | set source password v (7
Specify class name: | User @ g &
Select object: | Current object A

Specify new password: * | "Generate Password{policy-dn="\[root]\Security|Password Poli

Specify old passwaord: | Password()

#) Action modified, Click OF to update the policy or click " )
Cancel to discard changes. Required
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Set SSO Credential

Sets the SSO credential when a user object is created or when a password is modified. This action is
part of the Credential Provisioning policies. For more information, see Novell Credential Provisioning
for Identity Manager 4.0.2. If a policy containing this token encounters an error, Designer generates the
error as the local variable error.do-set-sso-credential. For more information about local error
variables, see “Local Variable Selector” on page 70.

Fields

Credential Repository Object DN
Specify the DN of the repository object. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Target User DN
Specify the DN of the target users.

Application Credential ID

Specify the application credential that is stored in the application object. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Login Parameter Strings
Specify each login parameter for the application. The login parameters are the authentication
keys stored in the application object. You can enter the strings manually, or select the Edit the

strings icon [ to open the String Builder and specify the strings. For more information about the
Named String Builder, see Section 4.12, “String Builder,” on page 61.

Example
Do | set 550 credential w | (7
Specify credential repository object DM * | | \Group'wise\Grouphise_Repository C\ l:é

Set DM relative to policy
Specify target user DM * | Destination Attributed"DirkML-ADContext", class name="User,:

Populate the Following From an application objeck

Specify application credential 1D * | GroupWise _Credential

T

Specify login parameter strings: | Username, Password
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Set SSO Passphrase

Sets the Novell SecureLogin passphrase and answer when a User object is provisioned. This action is
part of the Credential Provisioning policies. For more information, see Novell Credential Provisioning
for Identity Manager 4.0.2. If a policy containing this token encounters an error, Designer generates the
error as the local variable error.do-set-sso-passphrase. For more information about local error
variables, see “Local Variable Selector” on page 70.

Fields

Credential Repository Object DN

Specify the DN of the repository object. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Target User DN
Specify the DN of the target users.

Question String

Specify the SecureLogin passphrase question.

Answer String

Specify the SecureLogin passphrase answer.

Example
Do |set 5350 passphrase w @
Specify credential repository object DM * | L4 EroopitiselGroupiivise_Repository k.l C&
Set DM relative to policy
Specify target user DN: * | Destination Atkribute!"DirML-ADConkext”, dass name="Usar
Question string: * | "Employee code?"”
Answer string: * | Attribute"waorkforceID")

The SecureLogin passphrase question and answer are stored as strings in the policy.
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Set XML Attribute

Sets an XML attribute on a set of elements selected by an XPath expression.

Fields

Name

Specify the name of the XML attribute. This name can contain a namespace prefix if the prefix
has been previously defined in this policy. Supports variable expansion. For more information,
see Section 3.6, “Variable Selector,” on page 33.

XPath Expression

XPath 1.0 expression that returns a node set containing the elements on which the XML attribute
should be set. Supports variable expansion. For more information on variable expansion and
XPath, see Section 3.6.5, “XPath Expressions,” on page 37.

String
Specify the value of the XML attribute.

Example
Do |set XML attribute v (7
. . =1 =
Enter attribute name: * | cert-id L &
Specify sPath expression: * | . -’Lﬁﬁ @‘ S:y} e 3
Specify string: * | "c:iotustdominaldataleng. id”
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Start Workflow

Starts the workflow specified by workflow-id for the recipient DN on the User Application server
specified by a URL and by using credentials specified by the ID and password. The recipient must be
an LDAP format DN of an object in the directory served by the User Application server. The
additional arguments to the workflow can be specified by named strings. The number of the strings
and the names used are dependent on the workflow to be started. If a policy containing this token
encounters an error, Designer generates the error as the local variable error.do-start-workflow.
For more information about local error variables, see “Local Variable Selector” on page 70.

Remark

There are some names that have special meaning and are available regardless of the workflow being
started.

¢ :InitiatorOverrideDN: The LDAP format DN of the initiator of the workflow, if other than the
User used to authenticate.
¢ :CorrelationID: An identifier used to correlate related workflows.

If any error occurs while starting the workflow, the error string is available to the enclosing policy in
the local variable named error.do-start-workflow. Otherwise, that local variable is unavailable.

Fields

Provisioning Request DN
Specify the DN of the workflow to start in LDAP format. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

User Application URL

Specify the URL of the User Application server where the workflow will run. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Authorized User DN
Specify the DN of a user authorized to start workflows on the User Application server in LDAP
format. Supports variable expansion. For more information, see Section 3.6, “Variable Selector,”
on page 33.

Timeout Value
Specify the number of milliseconds you want Identity Manager to try to establish a connection to
the User Application server before timing out. The default value is 0.

Authorized User Password

Specify the password of the authorized user to start workflows on the User Application server.
Store the password as a Named Password on the driver object. This allows the password to be
encrypted when it is stored.

Recipient DN
Specify the DN of the recipient of the workflow in LDAP format.
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Strings
Specify the arguments for the workflow.You can enter the strings manually, or select the Edit the

strings icon [ to open the Named String Builder and specify the strings. For more information
about the Named String Builder, see Section 4.9, “Named String Builder,” on page 57.

The arguments are defined on the workflow. Depending on how the workflow is defined, some
of the arguments might be required for the workflow to start.

Example

The following example starts a workflow process each time there in an Add operation. The workflow
is a request for a cell phone. To view the policy in XML, see start_workflow.xml (../samples/
start_workflow.xml).

SRV 9 5t ort Workflow |

Mo description available

Conditions

& Condition Group 1

v & if operation equal "add"

v 5 start workFow(id="cn=wWorkfowadmin,o=People", url="http:
—/llocalhost: 8080/ I0MProy", workflow-id="CN=~ApproveCelPhone
—CN=RequestDefs, CN=AppConfig, CN=UserApplication,
—ChN=0Driverset, O=novell", arg-passwaord{Mamed Password
—{"workFlow-admin"}), dn{Parse DN{"gualified-slash”, "ldap”, %Path
—{"imqualified-src-dn™y)), provider="ACMEMWireless", reason="new

—hire'")
Do | start workflow - @
Specify provisioning request DM: * &
Specify user application URL: *
Specify authorized user DMN: * &
Specify Timeout value: * &

*

Specify authorized user password:

Specify recipient DMN: *

HEN®EOLOMEDL

Specify strings:
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Status

Generates a status notification.

Fields

Level

Specify the status level of the notification. The levels are error, fatal, retry, success, and warning.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

String

Provide the status message by using the Argument Builder.

Remarks

If level is retry, then the policy immediately stops processing the input document and schedules a
retry of the event currently being processed.

If the level is fatal, the policy immediately stops processing the input document and initiates a
shutdown of the driver.

If a the current operation has an event-id, that event-id is used for the status notification; otherwise,
there is no event-id reported.

Example
Do |EERE v 3
Specify level: * | warning v
Specify string: * | Source DRNOH": operation vetoed on out-of-scope-object”
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Strip Operation Attribute
Strips all occurrences of an attribute from the current operation.

Fields

Name

Specify the name of the attribute to be stripped. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Example

The example detects when an e-mail address is changed and sets it back to what it was. The policy
name is Policy: Reset Value of the E-mail Attribute, and it is available for download from the Novell

Support Web site. For more information, see “Downloading Identity Manager Policies” in
Understanding Policies for Identity Manager 4.0.2. To view the policy in XML, see 001-Input-
PushBackOnEmail.xml (../samples/001-Input-PushBackOnEmail.xml).

B « 5 Push back on email changing

Mo description available

Conditions

+* & Condition Group 1

v 5 if class name equal "User"

v 5 if operation attribute 'Email' changing

v 5 set source atkribute value!"Email”, Destination &ttributed Internet EMail &ddress")
v 5 strip operation attribute"Email™)

Do |stri|:u operation attribute W | @

Specify name: * | Email | &g &

The action strips the attribute of Email and keeps the value that was in the destination Email
attribute.
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Strip XPath Expression

Strips nodes selected by an XPath 1.0 expression.

Fields

XPath Expression

Specify the XPath 1.0 expression that returns a node set containing the nodes to be stripped.
Supports variable expansion. For more information on variable expansion and XPath, see
Section 3.6.5, “XPath Expressions,” on page 37.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.

Example
Do | strip XPath expression W @
Specify xPath expression: * | ¥[@attr-name="001" ;’ﬂ?ﬂ @’ ?1'} Qé
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Trace Message

Sends a message to DSTRACE.

Fields

Level

Specify the trace level of the message. The default level is 0. The message only appears if the
specified trace level is less than or equal to the trace level configured in the driver.

For information on how to set the trace level on the driver, see “Viewing Identity Manager
Processes” in the NetIQ Identity Manager Common Driver .

Color

Select the color of the trace message.

String

Specify the value of the trace message.

Example

The example has four rules that implement a Placement policy for User objects based on the first
character of the Surname attribute. It generates both a trace message and a custom Novell Audit or
Sentinel event. The Trace Message action is used to send a trace message to DSTRACE. The policy
name is Policy to Place by Surname and it is available for download from the Novell Support Web
site. For more information, see “Downloading Identity Manager Policies” in Understanding Policies for
Identity Manager 4.0.2. To view the policy in XML, see 001-Placement-BySurname.xml (../samples/
001-Placement-BySurname.xml).

- 5 ctup Local Yariables
B 5 Surname A-I: place in Users1

Mo description available

Conditions

% Condition Group 1

& i class name equal "User"

% if operation attribute 'Surname’ match "[a-i].*"

& set operation destination DM{dn{" Training)Users AckivelUsers1"+") "+ Operation Abtributel"C"Y)

v & trace messagelcolor="yellow", Local Yariablef"LyUsers1"))
v 5 generakte event(id="1000", textl=Local ¥ariable("L Y sers1"T)

" % Surname J-R: place in Users2

v % Surname 5-2Z place in Users3
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Do |trace message v| )]

Specify level: | |
Select colar: |*;.-'EII|:|w v|
Specify string: * | Local Variable("LyUsers1") |

The action sends a trace message to DSTRACE. The contents of the local variable is LVUsers1 and it
shows up in yellow in DSTRACE.
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Veto

Vetoes the current operation.

Example

The example excludes all events that come from the specified subtree. The rule is from the predefined
rules that come with Identity Manager. For more information, see Section 8.8, “Event Transformation
- Scope Filtering - Exclude Subtrees,” on page 124. To view the policy in XML, see
predef_transformation filter exclude_subtress.xml (../samples/
predef_transformation_filter_exclude_subtrees.xml).

H 5 Event Transformation - Scope Filtering - Exclude subtree(s)

Mo description awvailable

Conditions

% Condition Group 1

v 5 if source DM in subtree "[Enter a subtree to exclude]”

| W & wetal) |

[ |vet0 1“"| @

The action vetoes all events that come from the specified subtree.
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Veto If Operation Attribute Not Available

Conditionally cancels the current operation and ends processing of the current policy, based on the
availability of an attribute in the current operation.

Fields

Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Example

The example does not allow User objects to be created unless the attributes Given Name, Surname,
Title, Description, and Internet EMail Address are available. The policy name is Policy to Enforce the
Presences of Attributes, and it is available for download from the Novell Support Web site. For more
information, see “Downloading Identity Manager Policies” in Understanding Policies for Identity
Manager 4.0.2. To view the policy in XML, see 001-Create-RequiredAttrs.xml (../samples/001-
Create-Required Attrs.xml).

=R B Iser required attributes: First/Last Name, Title, Description, Email

Mo description available

Conditions

" & Condition Group 1

v 5 if class name equal "User"

e -

veto if operation attribute nok availabled"Given Name")
weto if operation atkribute nok availabled"Surname'")
wetno if operation atkribute not availabled ' Tide")

veto if operation attribute nok availabled"Description™)

ANENENENEN
RN RN R S

veto if operation atkribute not available " Internet EMail Address")

Do |'-.fet|:| if operation atkribute not available s | @

specify name: * | Given Mame | d@ '-.:T '-:‘é

The actions vetoes the operation if the attributes of Given Name, Surname, Title, Description, and
Internet Email Address are not available.
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While

Causes the specified actions to be repeated while the specified conditions evaluate to True.

Fields

Conditions
Specify the condition to be evaluated.
Actions

Specify the actions to be repeated if the conditions evaluate to True.

Example

= v 7 L

Conditions

£ Condition Group 1

% if operation equal "add"

e -

v 5 set local variabled'counter”, "1")
o & whie
if local wariable ‘counter' not greater than "10"
do
trace messagelcolor="yelow", level="0", "Counter =
—"+Local Yariabled"counter"Y)
set local wariabled"counter", XPath(*$counter + 1)
Do | while V| i
Specify conditions: * | andiif local wariable ‘counter’ nok greater than) |

Specify ackion: * | do-trace-message, do-set-local-variable |
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Noun Tokens

Noun tokens expand to values that are derived from the current operation, the source or destination
data stores, or some external source.

NOTE: For information about elements in the XML schema, see “NDS DTD” in the Identity Manager
4.0.2 DTD Reference.

This section contains detailed information about the noun tokens available in the Policy Builder

interface.

*

*

*

*

“Text” on page 323

“Added Entitlement” on page 325
“Association” on page 326
“Attribute” on page 327
“Character” on page 328

“Class Name” on page 329
“Destination Attribute” on page 330
“Destination DN” on page 332
“Destination Name” on page 334
“Document” on page 335
“Entitlement” on page 336
“Generate Password” on page 337
“Global Configuration Value” on page 338
“Local Variable” on page 339
“Named Password” on page 341
“Operation” on page 343
“Operation Attribute” on page 344
“Operation Property” on page 346
“Password” on page 347

“Query” on page 348

“Removed Attribute” on page 350
“Removed Entitlement” on page 351
“Resolve” on page 352

“Source Attribute” on page 353
“Source DN” on page 354

“Source Name” on page 355

“Time” on page 356

Noun Tokens
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¢ “Unique Name” on page 357
¢ “Unmatched Source DN” on page 360
¢ “XPath” on page 361
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Text

Expands to the text.

Fields

Text

Specify the text. Supports variable expansion. For more information, see Section 3.6, “Variable
Selector,” on page 33.

Example

The example is from the Govern Groups for User Based on Title policy, which is available for
download from the Novell Support Web site. For more information, see “Downloading Identity
Manager Policies” in Understanding Policies for Identity Manager 4.0.2. To view the policy in XML, see
003-Command-AddCreateGroups.xml (../samples/003-Command-AddCreateGroups.xml).

The Text token is used in the action Set Location Variable to define the DN of the manager’s group.
The Text token can contain objects or plain text.

H 5- Set local variables to test existence of groups and for placement

Mo description available

Conditions

+* % Condition Group 1
v & if class name equal "User"
And
+*  Z Condition Group 2
v & if operation equal "add"

v fr if operation egual "modify"

set local variable!"manager-group-dn”, "UsersiManagersGroup™)

set local variable!"manager-group-info”, Destination Attributel"Object Class", dnilocal Yarisbled"manager-group-

—dn"
set local variable!"emplovee-group-dn”, "Users\EmployeesGroup™)

v Z
v &
v &
v &

set local variable!"emplovee-group-info”, Destination Attributed"Chject Class", dnilocal Variable!"employvee-group-
—dn"Ji}

&h §r "Users\Managersaroup”

22 Editor

jo)
y

Texk: | UsersiManagersGroup
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../samples/003-Command-AddCreateGroups.xml

The Text token contains the DN for the manager’s group. You can browse to the object you want like
to use, or type the information into the editor.
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Added Entitlement

Expands to the values of an entitlement granted in the current operation.

Fields

Name

Name of the entitlement. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that entitlement. If it is used in a context where a string is expected,
the token expands to the string value found.

Example

oy § Added Entitlerment"manager)
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Association

Expands to the association value from the current operation.

Example

The example is from the predefined rules that come with Identity Manager. For more information on
the predefined rule, see Section 8.2, “Command Transformation - Publisher Delete to Disable,” on
page 115.

The action of Remove Association uses the Association token to retrieve the value from the current
operation. The rule removes the association from the User object so that any new events coming
through do not affect the User object. To view the policy in XML, see
predef_command_delete_to_disable.xml (../samples/predef_command_delete_to_disable.xml).

= + % Command Transformation - Publisher Delete to Disable

Mo description available,

.~ % Condition Group 1

v % if operation equal "delets"

v & iF class name equal "User"

% set destination attribute value("Login Disabled”, "true")

v Zr  remove association{association{Association()))

& & Associationd)
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Attribute

Expands to the value of an attribute from the current object in the current operation and in the source
data store. It can be logically thought of as the union of the operation attribute token and the source
attribute token. It does not include the removed values from a Modify operation.

Fields

Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that attribute. If it is used in a context where a string is expected, the
token expands to the string value found.

Example

The example is from the predefined rules that come with Identity Manager. For more information,
see Section 8.6, “Creation - Set Default Password,” on page 121.

The action of Set Destination Password uses the attribute token to create the password. The password
is made up of the Given Name attribute and the Surname attribute. When you are in the Argument
Builder Editor, you browse and select the attribute you want to use. To view the policy in XML, see
predef creation set default password.xml (../samples/
predef_creation_set_default_password.xml).

B 5 Creation - Set Default Password

Mo description available

Conditions

% Condition Group 1

v 5 if class name equal "User"

& set destination passwaord{Attribute("Given Name"i+Attribute
—{"Surname"y)

& & Attributed"Given Name")
& & Attribuke"Surname")

2# Editor

Mame: * | Giyen Name | g
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Character

Expands to a character specified by a Unicode* code point.

Remarks

For a listing of Unicode values and characters, see Unicode Code Charts (http://www.unicode.org/
charts/).

Fields

Character Value

The Unicode code point of the character. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

A hexadecimal number can be specified if it is prefixed with 0x, as in C-based programming
languages.

Example

& & Character(valus="10")

27 Editor

Character walue: * | 10
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Class Name

Expands to the object class name from the current operation.

Example

& & Class Mame()
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Destination Attribute

Expands to the specified attribute value an object.

Fields

Name
Name of the attribute. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Select Object
Select Current Object, Association, or DN.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that attribute. If it is used in a context where a string is expected, the
token expands to the string value found.

Example

The example is from the Govern Groups for User Based on Title policy, which is available for
download from the Novell Support Web site. For more information, see “Downloading Identity
Manager Policies” in Understanding Policies for Identity Manager 4.0.2. To view the policy in XML, see
003-Command-AddCreateGroups.xml (../samples/003-Command-AddCreateGroups.xml).

The policy creates the Destination Attribute with the Argument Builder. The action of Set Local
Variable contains the Destination Attribute token.
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../samples/003-Command-AddCreateGroups.xml

B §v Set local variables to test existence of groups and for placement

Mo description available

Conditions

+ % Condition Group 1
v §r if class mame equal "Uset"
And
+ & Condition Group 2

v % if operation equal "add"

v 5' if operation equal "modify"

set local variable! " manager-group-dn”, "sersiManagersaEroup™)

set local variable!"manager-group-info”, Destination Attribute!"Object Class", dnilocal Yariabled"manager-group-
—dn"1

set local variable!"emplovee-group-dn”, "Users\EmployeesGroup™)

set local variable!"emplovee-group-info", Destination Attributed"Cbiject Class", dnilocal Variable!"employvee-group-

—dn"30

v &
v Z
v Z
v Z

o 5 Destination Attributed"Object Class", dn))

2 Editor
Marne: * | Object Class | 8 g &
Class name: | | 8 g
Specify DN: * | Local Yariabled"manager-group-dn™ |

You build the Destination Attribute through the Editor. In this example, the attribute of Object Class
is set. The DN is used to select the object. The value of DN is the Local Variable of manager-group-dn.
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Destination DN

Expands to the destination DN specified in the current operation.

Fields

Start
Specify the RDN index to start with:
Index 0 is the root-most RDN

*

+ Positive indexes are an offset from the root-most RDN
¢ Index -1 is the leaf-most segment

¢ Negative indexes are an offset from the leaf-most RDN towards the root-most RDN

Length
Specify the number of RDN segments to include. Negative numbers are interpreted as (total # of
segments + length) + 1. For example, for a DN with 5 segments a length of -1=(5+(-1)) +1=5, -2
=(5+(-2)+1=4, etc.

Convert

Select whether or not to convert the DN to the format used by the source data store.

Remarks

If start and length are set to the default values {0,-1}, the entire DN is used; otherwise, only the
portion of the DN specified by start and length is used.

Example

The example uses the Destination DN token to set the value for the local variable of target-container.
The policy creates a department container for the User object if it does not exist. The policy is from
the predefined rules that come with Identity Manager. For more information, see Section 8.1,
“Command Transformation - Create Departmental Container - Part 1 and Part 2,” on page 112. To
view the policy in XML, see predef command create dept containerl.xml (../samples/
predef_command_create_dept_containerl.xml).

B 5 Command Transformation - Create Departmental Container - Part 1

Mo description available

Conditions

+ £ Condition Group 1

« % if operation equal "add"

set local wariabled"target-container”, Destination DNElength="-2"7}

v £
v &

set local wariable"does-target-exist”, Destination Attribute
—{"objectclass”, dass name="C0rganizational Unit", dnfLocal
—~ariablei"target-container" )7

& % Destination DNength="-2")
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22 Editor

Start: | 0
Length: | -2

Convert bo source DM Format: | false w
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Destination Name

Expands to the unqualified Relative Distinguished Name (RDN) of the destination DN specified in

the current operation.

Example

& & Destination Mame()
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Document

Reads the XML document pointed to by the URI and returns the document node in a node set. The
URI can be relative to the URI of the including policy. With any error, the result is an empty node set.

Fields

XML Document URI
Specify the XML document URL

Example

& § DocumentMovellSouth) Driver SetiDelimited Text")

2 Editor

%ML docurnent URT: * | Movell|SouthiDriver SetiDelimited Tesxt|
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Entitlement

Expands to the values of a granted entitlement from the current object.

Fields

Name

Name of the entitlement. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that entitlement. If it is used in a context where a string is expected,
the token expands to the string value found.

Example

&y % Entitlement{"manager")

22 Editor

Mame; *

jo
y

manager
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Generate Password

Generates a random password that conforms to the specified password policy.

Fields

Password Policy

The DN of the password policy that receives the randomly generated password. Supports
variable expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Set DN relative to policy
Select whether the DN of the password policy is relative to the policy being created.

Example

&L 5- Generate Password(policy-dn="1[rook]\SecurityPassword PoliciestSample Password Policy™)
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Global Configuration Value

Expands to the value of a global configuration variable.

Fields

Name

Name of the global configuration value. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Example

4 § Global Configuration Yalue("ConnectedSystemiame™)
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Local Variable

Expands to the value of a local variable.

Fields

Name

Specify the name of the local variable. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Example

The example is from the Govern Groups for User Based on Title policy, which is available for
download from the Novell Support Web site. For more information, see “Downloading Identity
Manager Policies” in Understanding Policies for Identity Manager 4.0.2. To view the policy in XML, see
003-Command-AddCreateGroups.xml (../samples/003-Command-AddCreateGroups.xml).

The action Add Destination Object uses the Local Variable token.

v 5 Set local variables to test existence of groups and for placement

B ¢ 5 Create ManagersGroup, if needed

Mo description available

Conditions

" % Condition Group 1

if local wariable 'manager-group-info' available

% i local variable 'manager-graup-info' nat equal "group”

& add destination ohject(dass name="Group", wher="before”, dnilacal Yariablemanager-group-dn" 1

v 5 Create EmployeesGroup, if needed
v 5 If Title indicates Manager, add to ManagerGroup and set rights

" & 1fTitle does not indicate Manager, add to EmployeeGroup and set rights

& §r Local Wariablel"manager-aroup-dn')

22 Editor

y 7

Yariable name; * managet-group-dn | q
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@ Local Yariable Selector

X

Local Yariable Selector

Select a local wariable From the list,

Policy Scope . Driver Scope | Error Yariables

employee-group-dn
manager-group-info

emEIDEEB-ErDuE-inFD

':'E:' [ (0] 4 l l Cancel

The Local Variable can only be used if the action Set Local Variable has been used previously in the
policy. It sets the value that is stored in the Local Variable. In the Editor, you click the browse icon and
all of the local variables that have been defined are listed. Select the correct local variable.

The value of the local variable is group-manager-dn. In the example, the Set Local Variable action
defines group-manager-dn as DN of the manager’s group Users\ ManagersGroup.
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Named Password

Expands to the named password from the driver.

Fields

Name

Name of the password. Supports variable expansion. For more information, see Section 3.6,

“Variable Selector,” on page 33.

Example

The Named Password noun token can only be used if a Named Password has been set on the driver
object. The Named Password is used to save a password in an encrypted form. For more information
on Named Passwords, see “Securely Storing Driver Passwords with Named Passwords” in the NetIQ

Identity Manager Common Driver .

The example uses the Start Workflow (page 310) action. It requires that the password for the
workflow administrator be entered. To view the policy in XML, see start_workflow.xml (../
samples/start_workflow.xml).

SRV 9 5t ort Workflow |

Mo description available

Conditions

& Condition Group 1

v & if operation equal "add"

v 5 start workFow(id="cn=wWorkfowadmin,o=People", url="http:
—/llocalhost: 8080/ I0MProy", workflow-id="CN=~ApproveCelPhone
—CN=RequestDefs, CN=AppConfig, CN=UserApplication,
—ChN=0Driverset, O=novell", arg-passwaord{Mamed Password
—{"workFlow-admin"}), dn{Parse DN{"gualified-slash”, "ldap”, %Path
—{"imqualified-src-dn™y)), provider="ACMEMWireless", reason="new

—hire'")
Do | start workflow - @
Specify provisioning request DM: * &
Specify user application URL: *
Specify authorized user DMN: * &
Specify Timeout value: * &

Specify authorized user password: *

Specify recipient DMN: *

HE®EOLOMHELDL

Specify strings:
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../samples/start_workflow.xml

342

& & Mamed Password("workflow-admin®)

2* Editor

I R =
Password name: * | o flow-admin O]

y o

Select Named Password

The selected named passward is passed to the expression in the Srgument Builder.

w
Mame Display Mame

ismpk-admin smpk-admin
warkFlave-admin warkFlow-admin
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Operation

Expands to the name of the current operation.

Example

& & Operationd)
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Operation Attribute

Expands to the value of an attribute in the current operation. The operation can be an <add-attrs,
<add-value>, or <attrs. If this token is evaluated in a context where a node-set result is expected,
then all the available values are returned as nodes in a node-set. Otherwise, the first available value is
returned as a string.

Fields

Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Example

The example has four rules that implement a Placement policy for User objects based on the first
character of the Surname attribute. It generates both a trace message and a custom Novell Audit or
Sentinel event. The policy name is Policy to Place by Surname, and it is available for download from
the Novell Support Web site. For more information, see “Downloading Identity Manager Policies” in
Understanding Policies for Identity Manager 4.0.2. To view the policy in XML, see 001-Placement-
BySurname.xml (../samples/001-Placement-BySurname.xml).

- 5= tup Local Yariables
= + % Surname A-L place in Users1

Mo description available

Conditions

& Condition Group 1

v & i class name equal "User

v 5 if operation attribute "Surname’ makch “[a-i].*"

v 5 set operation destination DN(dn( TrainingiUsersiActivel Jsers1"+" "+ Operation Atkributed"CH")Y)

W & trace messagelcolor="yellow", Local Variablef"LyUsers1"))
v 5 generakte event(id="1000", textl=Local ¥ariable("L Y sers1"T)

" % Surname J-R: place in Users2

v % Surname 5-2Z place in Users3

TraininglUsers! AckivellUsers1"
m

&
o]
e Ciperation Attribuke"CH")

RN RN RN

2# Editor

Mame: * [ -p |@ C‘T @:;
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The action Set Operation Destination DN contains the Operation Attribute token. The Operation
Attribute token sets the Destination DN to the CN attribute. The rule takes the context of
Training\ Users\ Active\Users and adds a \ plus the value of the CN attribute.
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Operation Property

Expands to the value of the specified operation property on the current operation.

Fields

Name

Specify the name of the operation property. Supports variable expansion. For more information,
see Section 3.6, “Variable Selector,” on page 33.

Example

&4 5 Operation PropertydmySkoredproperty™
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Password

Expands to the password specified in the current operation.

Example

&y & Password()
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Query

Queries the source or destination data store and returns the resulting instances.

Fields

Datastore
Specify the data store to query.
Scope
Select the scope of the query. The options are entry, subordinates, or subtree.

Max Result Count

Specify the maximum number of results returned from the query.

Class Name

Specify the class name in the query. If a class name is not specified, all classes are searched.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Select Object

Specify the base of the query. It can be the DN or an association. If neither is selected, the query
starts at the root of the datastore.

Match Attributes

Select the attributes to search for.

IMPORTANT: To improve performance when using the query noun, create an index for the
attributes that you are going to use when querying the Identity Vault. For more information
about indexes, see the Novell eDirectory 8.8 Administration Guide (http://www.novell.com/
documentation/edir88/edir88/index.html?page=/documentation/edir88/edir88/data/
aStuuub.html).

Read Attribute

Specify the set of attributes to return. If nothing is specified, no attributes are read. Use an
asterisk to read all attributes.

Remarks

The Query token returns a node set containing the instance elements found as a result of the query.
To effectively use the results of a Query token it must be used in a context that is expecting a node
set. For example, you could assign the result to a variable of type node set, or iterate through the
result using a for each loop.

Treating the node set as if it were a string seldom provides anything useful. Extracting useful
information from the node set or its constituent instance elements requires the use of an XPath
expression and knowledge of the structure of an instance element. For additional information, see the
following:

¢ “instance” in the Identity Manager 4.0.2 DTD Reference.

¢ “Downloading Identity Manager Policies” in Understanding Policies for Identity Manager 4.0.2.

¢ Chapter 5, “Using the XPath Builder,” on page 73.
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Example

....... & § Query(class name="User", match{"CM"), match{"L"), "Prowvao™

Dataskore:
Scope:

Maz result count:
Class narne
Select object:

Match attributes:

Read attribute:

g | User

|Rcu:ut of datastore  |w

=

|E % <+
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Removed Attribute

Expands to the specified attribute value being removed in the current operation. It applies only to a
Modify operation.

Fields

Name

Specify the name of the attribute. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that attribute. If it is used in a context where a string is expected, the
token expands to the string value found.

Example

& & Removed Attribute("Member")
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Removed Entitlement

Expands to the values of the an entitlement revoked in the current operation.

Fields

Name

Specify the name of the entitlement. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that entitlement. If it is used in a context where a string is expected,
the token expands to the string value found.

Example

&y & Removed Entitlement"manager")

Noun Tokens 351



Resolve

Resolves the DN to an association key, or the association key to a DN in the specified data store.

Fields

Datastore

Select the destination or source datastore to be queried.

Resolve Type

Select to resolve the association key to a DN or to resolve the DN to an association key.

Example

L § Resolvel{datastore="src", dn())

£ Editor

Dataskare: | Source b
Resolve kype: |DM to Association | W

DN: * | Movellsers\ManagerGroup
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Source Attribute

Expands to the values of an attribute from an object in the source data store.

Fields

Name

Name of the attribute. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object. Supports variable expansion. For more information, see Section 3.6,
“Variable Selector,” on page 33.

Object

Select the source object. This object can be the current object, or can be specified by a DN or an
association.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that attribute. If it is used in a context where a string is expected, the
token expands to the string value found.

Example

s 5 Source Attribute"Member”, class name="Group™)

22 Editor

Mame: * | Mampber

A &
A SR
JT

Class name: | Grouop

Select object: | Current object

Noun Tokens 353



Source DN

Expands to the source DN from the current operation.

Fields

Start
Specify the RDN index to start with:
Index 0 is the root-most RDN

*

+ Positive indexes are an offset from the root-most RDN
¢ Index -1 is the leaf-most segment

¢ Negative indexes are an offset from the leaf-most RDN towards the root-most RDN

Length

Number of RDN segments to include. Negative numbers are interpreted as (total # of segments +
length) + 1. For example, for a DN with 5 segments a length of -1=(5+(-1)) +1=5, -2=(5 + (-2))
+1=4, etc.

Convert

Select whether or not to convert the DN to the format used by the destination data store.

Remarks

If start and length are set to the default values {0,-1}, the entire DN is used; otherwise, only the
portion of the DN specified by start and length is used.

Example

&y & Source DRlength="-2"}

2# Editor

Start: |0
Length: | -2

Convvert to destination DM format: |False
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Source Name

Expands to the unqualified relative distinguished name (RDN) of the source DN specified in the
current operation.

Example

& & Source Mame()
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Time
Expands to the current date/time into the format, language, and time zone specified.

Fields

Format

Specify the date/time format. Select a named time format or specify a custom format pattern.
Supports variable expansion. For more information, see Section 3.6, “Variable Selector,” on
page 33.

Language

Specify the language. (It defaults to the current system language.) Supports variable expansion.
For more information, see Section 3.6, “Variable Selector,” on page 33.

Time zone

Specify the time zone. (It defaults to the current system time zone.) Supports variable expansion.
For more information, see Section 3.6, “Variable Selector,” on page 33.

Remark

The Test icon displays the time format that is created by selecting the format, language, and time
zone.

NOTE: If you want to display additional characters in a format pattern string, you can include those
characters by enclosing them in single quotes. For example, you could specify the format pattern Mv/
dd/yy'-Local Time'.

Example

&4 fr Time(Format="MmM/dd/»w", lang="en-U3", tz="America/Denver

& Editor

Format: * | MM{ddfyy b @ {x} &
Language: | English {United States)[en-Us] w
Time zone: | Mountain Standard Time[AmericaDenver]| w
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Unique Name

Expands to a pattern-based name that is unique in the destination data store according to the criteria
specified.

Fields

Attribute Name

Specify the name of attribute to check for uniqueness.

IMPORTANT: To improve performance when using the unique name noun, create an index for
the attributes that you are going to use when querying the Identity Vault. For more information
about indexes, see the Novell eDirectory 8.8 Administration Guide (http://www.novell.com/
documentation/edir88/edir88/index.html?page=/documentation/edir88/edir88/data/
aStuuub.html).

Scope

Specify the scope in which to check uniqueness. The options are subtree or subordinates.

Start Search
Select a starting point for the search. The starting point can be the root of the data store, or can be
specified by a DN or association.

Pattern

Specify patterns to use to generate unique values by using the Argument Builder.

Counters Use
Select when to use a counter. The options are:
¢ never
¢ always
¢ fallback

Counters Pattern
Select which pattern to use the counter with. The options are:
* first
¢ last

* all

Start
The starting value of the counter. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Digits
Specify the width in digits of counter; the default is 1. The Pad counter with leading 0’s option
prepends 0 to match the digit length. For example, with a digit width of 3, the initial unique
value would be appended with 001, then 002, and so on. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

If Cannot Construct Name
Select the action to take if a unique name cannot be constructed. The options are:

¢ Ignore, return empty
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+ Generate warning, return empty name
* Generate error, abort current transaction

+ Generate fatal error, shut down driver

Remarks

Each <arg-string> element provides a pattern to be used to create a proposed name.

A proposed name is tested by performing a query for that value in the name attribute against the
destination data store by using the <arg-dn> element or the <arg-associations> element as the base
of the query and scope as the scope of the query. If the destination data store is the Identity Vault and
name is omitted, then a search is performed against the pseudo-attribute “[Entry].rdn”, which
represents the RDN of an object without respect to what the naming attribute might be. If the
destination data store is the application, then name is required.

A pattern can be tested with or without a counter as indicated by counter-use and counter-pattern.
When a pattern is tested with a counter, the pattern is tested repeatedly with an appended counter
until a name is found that does not return any instances or the counter is exhausted. The counter
starting value is specified by counter-start and the counter maximum value is specified in terms of
the maximum number of digits as specified by counter-digits. If the number of digits is less than
those specified, then the counter is right-padded with zeros unless the counter-pad attribute is set to
False. The counter is considered exhausted when the counter can no longer be represented by the
specified number of digits.

As soon as a proposed name is determined to be unique, the testing of names is stopped and the
unique name is returned.

The order of proposed names is tested as follows:

¢ Each pattern is tested in the order specified. If counter-use="always” and the pattern is one of
the patterns indicated by the counter-pattern, then the pattern is tested with a counter;
otherwise, it is tested without a counter.

¢ If no unique name has been found after the patterns have been exhausted and counter-
use="fallback”, then the patterns indicated by the counter-pattern are retried with a counter.

If all specified combinations of patterns and counters are exhausted, then the action specified by the
on-unavailable is taken.

Example

&y % Unigus Mame("CN", counter-pattern="last", counter-use="fallback", on-unavailable="error", Uppercase{+Uppercasel}+Attributs

The following is an example of the Editor pane when constructing the unique name argument:

Attribute name: | CN & &
Scope: | Subtree w
Start search: |Root of datastore
Pattern: * | "Uppercasefsubstringg Attributel"Given Mame")))+aktributel" sy
when to use counters: |fallback %
Use counter with which pattern: |Firsk %
Counker start: | 1 LL& digits: | 1 LL& Pad counter with leading 0's
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The following pattern was constructed to provide unique names:

5- UppercaselSubstring{Attribuke]"Given Mama"1))
5 Substringl atkributel"Given Mame")
& & Attribute!"Given Name")

& % Artribute("Surname")
5 UppercaselSubstringllength="1", Attribute"MI"N+5ubstring)

5 Substringflength="1", Attribute"MI")
& & AtkribubeMI)
£ subskring()

& & Attribute("Given Mame")
% Uppercase{Attribube!"Given Mame"H+-Attribute!"Surname")

& % Attribute("Given Name")
& & Attribute("Surname")

If this pattern does not generate a unique name, a digit is appended, incrementing up to the specified
number of digits. In this example, nine additional unique names would be generated by the

appended digit before an error occurs (patternl - pattern99).

Noun Tokens
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Unmatched Source DN

Expands to the part of the source DN in the current operation that corresponds to the part of the DN
that was not matched by the most recent match of an If Source DN condition.

Fields

Convert

Select whether or not to convert the DN format used by the destination data store.

Remarks

If there are no matches, the entire DN is used.

Example

The example is from the predefined rules that come with Identity Manager. For more information,
see Section 8.12, “Matching - Subscriber Mirrored - LDAP Format,” on page 131. To view the policy
in XML, see predef_match_sub_mirrored.xml (../samples/predef_match_sub_mirrored.xml).

The action of Finding Matching Object uses the Unmatched Source DN token to build the matching
information in LDAP format. It takes the unmatched portion of the source DN to make a match.

=AY W Matching - Subscriber Mirrored - LDAP Format

Mo description available

Conditions

& Condition Group 1

v 5 if source DM in subtree "[Enter base of source hierarchy]"

ol 5 sek local variable"dest-base”, "[Enter base of destination
—hierarchy]"

& find matching object{scope="entry", dn{Unmatched Source OH
—{convert="trug")+","+Local Variable("dest-base"iY)

&b § Unmatched Source DR{comserk="true")
& 5 II‘III
&L & Local Varisble("dest-base")

22 Editor

Convert to destination DM Format;
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XPath

Expands to the results of evaluating an XPath 1.0 expression.

Fields

Expression

XPath 1.0 expression to evaluate.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.

Example

L 5 #Path"*[@attr-name="00U") fvalue[start-withi skringl, ), oo™

2 Editor

®Path expression: * | #[@attr-name="0U")valuelstart-withéstringl, ), xxx")] Eh [Ep 3 &

Noun Tokens 361



362  Policies in Designer 4.0.2



Verb Tokens

Verb tokens modify the concatenated results of other tokens that are subordinate to them.

This section contains detailed information about all verbs that are available through the Policy
Builder interface.

*

*

“Base64 Decode” on page 364
“Base64 Encode” on page 365

“Convert Time” on page 366

“Escape Destination DN” on page 368
“Escape Source DN” on page 369

“Join” on page 370
“Lowercase” on page 371
“Map” on page 372

“Parse DN” on page 373
“Replace All” on page 375
“Replace First” on page 376
“Split” on page 378
“Substring” on page 379
“Uppercase” on page 381
“XML Parse” on page 382
“XML Serialize” on page 383
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Base64 Decode

Decodes the result of the enclosed tokens from Base64-encoded data to bytes, then converts the bytes
into a string by using the specified character set.

Fields

Character Set

Specify the character set that converts the decoded bytes to a string. It can be any character set
supported by Java. If the field is left blank, the character set defaults to the system encoding as
specified by the file.encoding System property. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Example

= § Basetd Decodelcharset="UTF-3", Operation Attribute"data" )
& & Operation Attribuked"data")
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Base64 Encode

Converts the result of the enclosed tokens to bytes by using the specified character set, then Base64-
encodes the bytes.

Fields

Character Set

Specify the character set that converts the string to bytes. It can be any Java-supported character
set. If the filed is left blank, the character set defaults to the system encoding as specified by the
file.encoding System property. Supports variable expansion. For more information, see

Section 3.6, “Variable Selector,” on page 33.

Example

§ Basetd Encodelcharset="UTF-3", Operation Attributed"Surname")
& 5, Operation Atkribute!"Surname™)

Verb Tokens 365



366

Convert Time

Converts the date and time represented by the result of the enclosed tokens from the source format,
language, and time zone to the destination format, language, and time zone.

Fields

Source Format
Specify the source date/time format. Select a named time format or specify a custom format
pattern. Supports variable expansion. For more information, see Section 3.6, “Variable Selector,”
on page 33.

Source Language
Specify the source language (defaults to the current system language). Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Source Time Zone
Specify the source time zone (defaults to the current system time zone). Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Destination Format
Specify the destination date/time format. Select a named time format or specify a custom format
pattern. Supports variable expansion. For more information, see Section 3.6, “Variable Selector,”
on page 33.

Destination Language
Specify the destination language (defaults to the current system language). Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Destination Time Zone
Specify the destination time zone (defaults to the current system time zone). Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Offset

Specifies an offset to apply to the time in the selected noun. Specify an offset number, then select
the appropriate time unit from the drop-down list (seconds, minutes, hours, days, weeks,
months, years.)

NOTE
¢ This field is only available if the Identity Manager server version is set to 3.6.

¢ If you specify a negative offset value, the time is offset to a previous time or date. For
example, if you specify -2 and select Day, the time in the selected noun is adjusted to two
days prior to the actual date.

Remark

The Test icon displays the time format that is created by selecting the format, language, and time
zone.
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Example

= ./ & Convert Time{dest-format="IMEDILE.DATE", dest-lang="en-U5", dest-tz="UTC", offset="2", offset-unit="day",

Operation Attribute"birthdabe")

2 Editor

* Required

Saurce Format; * |l_.anguage-specﬁ: FULL date Farmat [IFULL. DATE]

IEX

Source language: | Enghsh (United States)[en-US]

Source time 2one: | Mountain Standard Tire[America/Denver]

v [Test]

Destination Format: * |l.,arl;|.|age-speti& MEDIUM date Format [IMEDILM, DATE]

vl_@ ) &

Destination language: | English (United States){en-US]

Destination time 2one: | Universal Time[UTC]

v. [Test]

Offset: |2 |Mv
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Escape Destination DN

Escapes the enclosed tokens according to the rules of the DN format of the destination data store.

Example

The example is from the predefined rules that come with Identity Manager. For more information,
see Section 8.16, “Placement - Publisher Flat,” on page 138. To view the policy in XML, see
predef place pub_flat.xml (../samples/predef_place_pub_flat.xml).

The action of Set Operation Destination DN uses the Escape Destination DN token to build the
destination DN of the User object.

B sl Placement - Publisher Flat

Mo description available

< Condition Group 1

% if class name equal "User"

5 sek local variablel"dest-base”, "[Enter DM of destination container]")

5 sefk operation destination DM{dniLocal Yariableddest-base"1+""
—+Escape Destination DM{Unigue Mame("CN", scope="subkres",
—LowercaselSubstringllength="1", Operation Attributel"Given
—Mame"))+Operation Atkributed"Surname)), Lowercase(Substring
—{length="2", COperation Attribute!"Given Mame" i+ Operation
—Attribuke"Surnanme" 100

& & Local Yariable("dest-base")
& 5 Illllll
5 Escape Destination DR{Unique Mame"CN", scope="subkree", LowercaselSubstringllength="1", Operation AttribukeGven Mame'"+

&h § Unique Mame("CN", scope="subtree", Lowercasel3ubstring{length="1", Operation Attribube Given Mame™))+0peration Aktribuk

The Escape Destination DN token takes the value in Unique Name and sets it to the format for the
destination DN.
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Escape Source DN

Escapes the enclosed tokens according to the rules of the DN format of the source data store.

Example

5 5, Escape Source DR ALtribute" Surname")
& & Attribute("Surname")
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Join

Joins the values of the nodes in the node set result of the enclosed tokens, separating the values by the
characters specified by delimiter. If the comma-separated values (CSV) are true, then CSV quoting
rules are applied to the values.

Fields

Delimiter

(Optional) Specify the string used to delimit the joined values. Supports variable expansion. For
more information, see Section 3.6, “Variable Selector,” on page 33.

Apply CSV Quoting Rules
Applies CSV quoting values.

Example

The example combines all of the members of the group into a CSV record.

= 5, Joinfcsw="true", delimiter=",", Attribute"Member"])
& & Attribute("Member")

= Expression ® o
% Jo M ter=",", "A"+AtTibL Irname'+AtribLitef
& 7
& & Atrbute("surname')
& & Attribute("Given Name'"
3
& Editor
Delimiter: |, &

Apply CSV guoting rules
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Lowercase

Converts the characters in the enclosed tokens to lowercase.

Example

This example sets the e-mail address to be name@slartybartfast.com where the name equals the first
character of the Given Name plus the Surname. The policy name is Policy: Create E-mail from Given
Name and Surname, and it is available for download at the Novell Support Web site. For more
information, see “Downloading Identity Manager Policies” in Understanding Policies for Identity
Manager 4.0.2. To view the policy in XML, see 001-Command-SetEmailByGivenNameAndSurnam. xml
(../samples/001-Command-SetEmailByGivenNameAndSurname.xml).

= 5- Set email address: name@slartybartfast.com; name = {1 char of Given Name + Surname) <= 8 chars

Mo description available

Z Condition Group 1
% i class name equal "User"
And 5' if operation attribute 'Given Mame' available

And 5' if operation attribute 'Surname’ available

£ strip operation attribute("Internet Email Address")

set destination attribute value("Internet Email Address", LowercaselSubstringflength="8", substringilength="1",
—{Operation Attribute!"Firsthame")+Operation Attributel"LastMame"N+"@slartybartFast, com™))

fr Lowercase{Substring{length="8", Substring{length="1", Cperation Attribute! Firsthame™))+0peration Attributel"Lasthame"Yi+"@
§v Substring(length="3", Substringilength="1", Operation Attribute("FirstMame"))+Operation Atkributed"LastMame"))
5- Substring({length="1", Operation Attributed"FirstMName"y)
& & Operation Attribute!"FirstMame")
& % Operation Attribute"LastHame")
& & "@slartybartfast,com

The Lowercase token sets all of the information in the action Set Destination attribute value to

lowercase.
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Map

Maps the result of the enclosed tokens from the values specified by the source column to the
destination column in the specified mapping table.

Remarks

If this token is evaluated in a context where a node set result is expected and multiple rows are
matched by the value being mapped, a node set is returned that contains the values from the
destination column of each matching row. Otherwise, only the value from the first matching row is
returned.

The table attribute should be the slash form DN of the Resource object containing the mapping table
to be used. The DN might be relative to the including policy.

Fields

Mapping Table DN

Specify the slash form DN of a Resource object containing the mapping table. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Set DN Relative to Policy
When it is enabled, it displays the mapping table DN relative to the policy. This is the default.

Source Column Name
Specify the name of the source column. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Destination Column Name
Specify the name of the destination column. Supports variable expansion. For more information,
see Section 3.6, “Variable Selector,” on page 33.

Default Value

Specifies a value to return if the value being mapped does not match any values in the Source
column.

NOTE: This field is only available if the Identity Manager server version is set to 3.6.

Example
& Editor * Raquired
Mapping Table DN: * | ,.\..\Library\Departments Table Q &
[¥] Set DM relative ko policy
Source columnn name: * | dept Q&
Destination column name: * | code Q &

Default walue: | 126
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Parse DN

Converts the enclosed token’s DN to an alternate format.

Fields

Start
Specify the RDN index to start with:
Index 0 is the root-most RDN

*

+ Positive indexes are an offset from the root-most RDN
¢ Index -1 is the leaf-most segment

¢ Negative indexes are an offset from the leaf-most RDN towards the root-most RDN

Length
Number of RDN segments to include. Negative numbers are interpreted as (total # of segments +
length) + 1. For example, for a DN with 5 segments a length of -1=(5+(-1)) +1=5, -2=(5 + (-2))
+1=4, etc.

Source DN Format

Specifies the format used to parse the source DN.

Destination DN Format

Specify the format used to output the parsed DN.

Source DN Delimiter

Specify the custom source DN delimiter set if Source DN Format is set to custom.

Destination DN Delimiter

Specify the custom destination DN delimiter set if Destination DN Format is set to custom.

Remarks

If start and length are set to the default values {0,-1}, then the entire DN is used; otherwise, only the
portion of the DN specified by start and length is used.

When specifying custom DN formats, the eight characters that make up the delimiter set are defined
as follows:
¢ Typed Name Boolean Flag: 0 means names are not typed, and 1 means names are typed

¢ Unicode No-Map Character Boolean Flag: 0 means don't output or interpret unmappable
Unicode characters as escaped hex digit strings, such as \ FEFF. The following Unicode
characters are not accepted by eDirectory: Oxfeff, Oxfffe, Oxfffd, and Oxffff.

¢ Relative RDN Delimiter
¢ RDN Delimiter

¢ Name Divider

+ Name Value Delimiter
+ Wildcard Character

¢ Escape Character
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If RDN Delimiter and Relative RDN Delimiter are the same character, the orientation of the name is
root right, otherwise the orientation is root left.

If there are more than eight characters in the delimiter set, the extra characters are considered as
characters that need to be escaped, but they have no other special meaning.

Example

The example uses the Parse DN token to build the value the Add Destination Attribute Value action.
The example is from the predefined rules that come with Identity Manager. For more information,
see Section 8.1, “Command Transformation - Create Departmental Container - Part 1 and Part 2,” on
page 112. To view the policy in XML, see predef command_create_dept_container2.xml (../
samples/predef_command_create_dept_container2.xml).

=] £ Command Transformation - Create Departmental Container - Part 2

Mo description available

Z Condition Group 1
5 if local wariable ‘does-target-exist' available

And 5 if local wariable 'does-target-exist' equal ™

5 add destination object{class name="Crganizational Unit", direck="
—true", dnflocal Mariablet"target-container")))

5 add destination attribute waluei"ou”, direck="trug", dnflLocal
—Yariablef"target-container")), Parse DM("dest-dn”, "dot”, length="
—1", start="-1", Local Wariable("target-container™ i1

= 5 Parse DM("dest-dn", "dat", length="1", start="-1", Laocal Variable("target-cantainer )
&L 5 Local Yariable!"target-container")

2 Editor

Stark: | -1

Length: |1

Source DM Format: | destination DR

Destination DM Format: | dok A

The Parse DN token takes the information from the source DN and converts it to dot notation. The
information from the Parse DN is stored in the attribute value of OU.
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Replace All

Replaces all occurrences of a regular expression in the enclosed tokens.

Fields

Regular Expression

Specify the regular expression that matches the substring to be replaced. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Replace With

Specify the replacement string. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Remarks

For details on creating regular expressions, see:

¢ Java ‘Class Pattern’” information

¢ Java ‘Class Matcher’ information

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are used but can be
reversed by using the appropriate embedded escapes.

Example

= 5, Replace alll"(", "$1", Destination DR
& % Destination DM

2# Editor

Reqular expression: * | ()

T

Replace withy | 41

Verb Tokens
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Replace First

Replaces the first occurrence of a regular expression in the enclosed tokens.

Fields

Regular Expression

Specify the regular expression that matches the substring to replace. Supports variable
expansion. For more information, see Section 3.6, “Variable Selector,” on page 33.

Replace With

Specify the replacement string. Supports variable expansion. For more information, see
Section 3.6, “Variable Selector,” on page 33.

Remarks

The matching instance is replaced by the string specified in the Replace with field.
For details on creating regular expressions, see:

¢ Java ‘Class Pattern’ information (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Pattern.html)

¢ Java ‘Class Matcher’ information (java.lang.String) (http://java.sun.com/j2se/1.4/docs/api/java/
util/regex/Matcher.html#replaceAll (java.lang.String))

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are used but can be
reversed by using the appropriate embedded escapes.

Example

The example reformats the telephone number (nnn)-nnn-nnnn to nnn-nnn-nnnn. The rule is from the
predefined rules that come with Identity Manager. For more information, see Section 8.9, “Input or
Output Transformation - Reformat Telephone Number from (nnn) nnn-nnnn to nnn-nnn-nnnn,” on
page 126. To view the policy in XML, see predef_ transformation reformat_ telephonel.xml (../
samples/predef_transformation_reformat_telephonel.xml).

The Replace First token is used in the Reformat Operation Attribute action.

=4 5 Input or Output Transformation - Reformat Telephone Mumber from
—{nnn}) nnn-nnnn to nnn-nnn-nnnn

Mo description available

+~ % Condition Group 1

Define new condition here

reformat operation attributed"phone”, Replace Firsk("~i{ddid))
—is*didd)-Cdiddddg, "$1-52-%3", Local variabled"current-
—uwalue")

= 5 Replace First("~y (A0 D-O i, "$1-%2-43", Local Yariable("current-value™)
&5 § Local Yariabled"current-valie™)
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22 Editor

Regular expression: * | ~yWOdWdd\ s O dydvd-0d dydvddg

Feplace with: | $1-$2-43

J T T

The regular expression of *\ (\d\d\d)\)\s*(\d\d\d)-(\d\d\d\d)$ represents (nnn) nnn-nnnn and

the regular expression of $1-$2-$3 represents nnn. This rule transforms the format of the telephone
number from (nnn) nnn-nnnn to nnn-nnn-nnnn.
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Split

Splits the result of the enclosed tokens into a node set consisting of text nodes based on the pattern
specified by delimiter. If comma-separated values (CSV) are true, then CSV quoting rules are
honored during the parsing of the string.

Fields

Delimiter

Regular expression that matches the delimiter characters. Supports variable expansion. For more
information, see Section 3.6, “Variable Selector,” on page 33.

Apply CSV Quoting Rules
Applies CSV quoting values.

Example

= 5 Split{csy="true", delimiter=",", "Does, John,Doe, John'")
&y % "Does,John,Dos, John"

£# Editor

]

Delimiter: * | .

Apply CSY quoting rules
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Substring

Extracts a portion of the enclosed tokens.

Fields

Start
Specify the starting character index:
¢ Index 0 is the first character.
¢ Positive indexes are an offset from the start of the string.
¢ Index -1 is the last character.
¢ Negative indexes are an offset from the last character toward the start of the string.
For example, if the start is specified as -2, then it starts reading at the first character from the end.
If -3 is specified, then it starts 2 characters from the end.
Length

Number of characters from the start to include in the substring. Negative numbers are
interpreted as (total # of characters + length) + 1. For example, -1 represents the entire length of
the original string. If -2 is specified, the length is the entire string -1. For a string with 5
characters, a length of -1=(5+(-1)) +1=5,-2=(5+(-2)) + 1 =4, etc.

Example

This example sets the e-mail address to be name@slartybartfast.com where the name equals the first
character of the Given Name plus the Surname. The policy name is Policy: Create E-mail from Given
Name and Surname, and it is available for download at the Novell Support Web site. For more
information, see “Downloading Identity Manager Policies” in Understanding Policies for Identity
Manager 4.0.2. To view the policy in XML, see 001 -Command-SetEmailByGivenNameAndSurname . xml
(../samples/001-Command-SetEmailByGivenNameAndSurname.xml).

B 5- Set email address: name@slartybartfast.com; name = (1 char of Given Name + Surname) <= 8 chars

Mo description available

+* % Condition Group 1

v §r if class name equal "Usetr"
v 5' if operation attribute 'Given Mame' available
v fr if operation attribute ‘Surname’ available

v 5 skrip operation atbribute"Internet Email Address")

v 5 set destination attribute value("Internet Email Address", LowercaselSubstringflength="8", substringilength="1",
—{Operation Attribute!"Firsthame")+Operation Attributel"LastMame"N+"@slartybartFast, com™))
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= % Lowercase{Substring{length="8", Substring{length="1", Operation Attribube("Firsthame")}+Cperation Attribute"Lasthame"))+"@
= 5 Substring(length="8", Substring{length="1", Operation Attribute"Firsthame")+Oper ation Atkributed"LastMame'))
= 5 Substringilength="1", Operation Attribute! FirstMame"))
& fr Operation AtkributedFirstMame")
& & Operation Attribute"Lasthame")
& & “slartybartfast.com”

The Substring token is used twice in the action Set Destination Attribute Value. It takes the first
character of the First Name attribute and adds eight characters of the Last Name attribute to form one
substring.
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Uppercase

Converts the characters in the enclosed tokens to uppercase.

Example

The example converts the first and last name attributes of the User object to uppercase. The policy
name is Policy: Convert First/Last Name to Uppercase and it is available for download at the Novell
Support Web site. For more information, see “Downloading Identity Manager Policies” in
Understanding Policies for Identity Manager 4.0.2. To view the policy in XML, see 002-Command-
UppercaseNames . xml (../samples/002-Command-UppercaseNames.xml).

B § Converk First/Last name to uppercase

Mo description available

Conditions

+ % Condition Group 1
v 5 if class name equal "User"
And
+ 2% Condition Group 2
v 5 if operation attribute 'Given Mame' changing

% i operation attribute 'Surname’ changing

v 5 reformat operation atkributedGiven Mame”, Uppercase{Operation Akkributel"Given Mamea"1)

v 5 reformat operation attributed"Surname", Uppercase{Operation Attributel"Surname")))

=y fr UppercaselOperation Attribute"Given Marme"))
& 5, Cperation Attribuke!"Given Name")
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XML Parse

Parses the result of the enclosed tokens as XML and returns the resulting document node in a node
set. If the result of the enclosed tokens is not well-formed XML or cannot be parsed for any reason, an
empty node set is returned.

Example
= 5 #ML Parsel(Basetd Decodelcharset="UTF-3", Operation Attribute("data"1)

= 5 Basetd Decode(charset="UTF-3", Operation Attribote!"data")
& % Operation Attribute"data")
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XML Serialize

Serializes the node set result of the enclosed tokens as XML. Depending on the content of the node
set, the resulting string is either a well-formed XML document or a well-formed parsed general
entity. If a node set is passed, it returns a string representation of the node set. If a string value of a
node set is passed, it returns a string of valid tokens escaped of XML or HTML characters that can be
included in a text node. For example, you can use the XML Serialize token to trace a node set and
return a particular variable in a readable format, which can be useful for debugging purposes. You
can also use XML Serialize to escape special characters, including &, &amp;, <, or &1t ;.

Example

- & ¥ML Serialize(xPath("."))
& & wPath(.")
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16.1

16.1.1

Pre-ldentity Manager 3.5 Builders

Although you define most arguments by using the Argument Builder, there are several more
builders that are used by the Condition Editor and Action Editor in the Policy Builder. Each builder
can recursively call anyone of the builders in the following list:

*

*

*

*

Section 16.1, “Action Builder,” on page 385

Section 16.2, “Actions Builder,” on page 386

Section 16.3, “Argument Builder,” on page 387

Section 16.4, “Action Argument Component Builder,” on page 391
Section 16.5, “Condition Builder,” on page 392

Section 16.6, “Condition Argument Component Builder,” on page 393
Section 16.7, “Match Attribute Builder,” on page 394

Section 16.8, “Named String Builder,” on page 396

Section 16.9, “Pattern String Builder,” on page 397

Section 16.10, “Argument Value List Builder,” on page 399

Section 16.11, “Namespace Editor,” on page 399

Action Builder

The Action Builder enables you to add, view, and delete the actions that make up a rule. Action can
also contain other actions.

Creating an Action

1 In the Policy Builder, create a new rule or edit an existing rule.
2 Double-click the Actions tab to launch the Action Builder.

Actions

Define new action below

Do | <Seleck an action:> v @

3 Select the desired action from the drop-down list, then click OK.
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16.1.2  Additional Options for the Action Builder

1 Right-click the action to see the additional options:

2 Edit... 1 Insert Action After. .,
of” Cut Chrl+2,
Copy Chrl+iC
[ Paste Chrl+Y
¥ Delete Delete

Preferences, .,

¢+ New > Insert Action Before: Adds a new action before the current action.

¢ New > Insert Action After: Adds a new action after the current action.

¢ Edit: Launches the Action Builder.

¢ Move the selected item up: Moves the selected action up in the order of execution.

¢ Move the selected item down: Moves the selected action down in the order of execution.
¢ Cut, Copy, Paste, or Delete an Action: Cuts, copies, pastes, or deletes the action.

¢ Undo or Redo: Undoes or redoes the last action.

¢ Preferences: Allows you to set default functionality in the Policy Builder.

¢ Help: Select an action, then click the Help icon to see information specific to that action.

16.2 Actions Builder

The Actions Builder allows you to create an action inside of another action.To launch the Actions
Builder, select one of the following actions, then click the Edit the arguments icon E.

¢ For Each (page 448)
¢ Implement Entitlement (page 451)

In the following example the add destination attribute value action is performed for each Group
entitlement that is being added in the current operation.
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Figure 16-1 For Each Action

Do |Far each v @
Specify node set; * | Added Entitlement(Group”)
Specify action: * | do-add-dest-atkr-walue

To define the action of the add destination attribute value, click the icon that launches the Actions
Builder. In the Actions Builder, you define the desired action. In the following example, the member
attribute is added to the destination object for each added Group entitlement.

Figure 16-2 Actions Builder

Do |add destination attribute valus » | (?

|||II

Specify attribuke name: * | Member

A &
£ S

Specify class name: | Group ! '-:é
Select mode: | add to current operation w
Select object: [DM L
Specify DM * | Local Yariable! " current-node™)

Specify walue type; | string

Enter string: * | Destination DM

Argument Builder

The Argument Builder provides a dynamic graphical interface that enables you to construct complex
argument expressions for use within Rule Builder.

The Argument Builder consists of five separate sections:

+ Nouns: Contains a list of all of the available noun tokens. Select a noun token, then click Add to
add the noun token to the Expression pane. See “Pre-Identity Manager 3.5 Noun Tokens” on
page 485 for more information.

+ Verbs: Contains a list of all of the available verb tokens. Select a verb token, then click Add to add
the verb token to the Expression pane. See “Pre-Identity Manager 3.5 Verb Tokens” on page 511
for more information.

¢ Description: Contains a brief description of the noun or verb token. Click the help icon to launch
additional help.

¢ Expression: Contains the argument that is being built. Multiple noun and verb tokens can be
added to a single argument. Tokens can be arranged in different orders through the Expression
pane.

¢ Editor: Provide the values for the nouns and the verbs in the Editor pane.
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Figure 16-3 Pre-Identity Manager 3.5 Argument Builder

Create and edit arguments

=i

add or remove your components to the expression area to conskruck your argument, Enker component values
under Editor,

= Expression i) (7) &4 Mouns

Texk rs
Added Entitlerment

Associakion

Attribute

Class Mame

Destination Attribute b

Yerbs

Escape Destination DN
Escape Source DM
Lower Case

Parse DM

Feplace Al

Replace First
Substring

Upper Case

22 Editor * Required # Description 6

¢ Section 16.3.1, “Launching the Argument Builder,” on page 388
¢ Section 16.3.2, “Argument Builder Example,” on page 389

16.3.1 Launching the Argument Builder

388

To launch the Argument Builder, select one of the following actions, then click the Edit the Arquments
icon E.

¢ Add Association (page 431)

¢ Add Destination Attribute Value (page 432)

¢ Add Destination Object (page 433)

¢ Add Source Attribute Value (page 434)

¢ Append XML Text (page 437)

¢ Clear Destination Attribute Value (page 439) (when the selected object is DN or Association)

¢ Clear Source Attribute Value (page 441) (when the selected object is DN or Association)

¢ Delete Destination Object (page 445) (when the selected object is DN or Association)

¢ Delete Source Object (page 446) (when the selected object is DN or Association)
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¢ Find Matching Object (page 447)

¢ For Each (page 448)

¢ Move Destination Object (page 452)

+ Move Source Object (page 453)

¢ Reformat Operation Attribute Value (page 454)
¢ Remove Association (page 455)

¢+ Remove Destination Attribute Value (page 456)
¢ Remove Source Attribute Value (page 457)

¢ Rename Destination Object (page 458) (when the selected object is DN or Association and Enter
String)

¢ Rename Source Object (page 460) (when the selected object is DN or Association and Enter
String)

¢ Set Destination Attribute Value (page 464) (when the selected object is DN or Association and
Enter Value Type is not structured)

¢ Set Destination Password (page 465)

¢ Set Local Variable (page 466)

¢ Set Operation Association (page 467)

¢ Set Operation Class Name (page 468)
¢ Set Operation Destination DN (page 469)
¢ Set Operation Property (page 470)

¢ Set Operation Source DN (page 471)

¢ Set Operation Template DN (page 472)
¢ Set Source Attribute Value (page 473)
¢ Set Source Password (page 474)

¢ Set XML Attribute (page 477)

¢ Status (page 478)

¢ Trace Message (page 481)

16.3.2  Argument Builder Example

The following example creates an argument for a user name from the first letter of the first name and
the entire last name:

1 Double-click Attribute from the list of nouns.

4 Nouns o

Text A
added Enkitlemnent

Association

—haracker

Class Mame

Destination Attribuke

Destination DM

Destination Mame

Docurnent

Enkitlerment bt
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2 Specify or select the Given Name attribute.

22 Editor * Required

MName: * | Given Mame | @ & &

3 Double-click Substring from the list of verbs.

... Yerbs v

Map

Parse DN
Replace ol
Replace First

SEIit
Uppetcase
#ML Parse

*ML Serialize

[

54

4 Type 1 in the Length field.

22 Editor

Start: El
Length:

5 Select the Given Name attribute, then click the Move Down icon.

- Expression i °f" % @ @

. AOttributed"Given Mame")

./ & 3Substring(length="1")

6 Double-click Attribute from the list of nouns.

7 Specify or browse to the Surname attribute.

o= Expression

= ./ & Substringflength="1")
& & Attribute("Given Name")

“ Attributed"Surname")

The argument takes the first character of the Given Name attribute and adds it to the Surname
attribute to build the desired value.

8 Click OK to save the argument.
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16.4  Action Argument Component Builder

To launch the Action Argument Component Builder, select one of the following actions when the
Enter value type selection is structured, then click the Edit components icon E.

¢ Add Destination Attribute Value (page 432)

¢ Add Source Attribute Value (page 434)

¢ Reformat Operation Attribute Value (page 454)

¢ Remove Destination Attribute Value (page 456)

¢ Remove Source Attribute Value (page 457)

¢ Set Destination Attribute Value (page 464)

¢ Set Source Attribute Value (page 473)

Figure 16-4 Add Destination Attribute Value Action

Do | add destination attribute value w | @

specify attribute name: * | Given Mame | 8 ad e
Spedify class name: |Llser | d &

Select mode: |write directly to destination datastore L |

Select object: |Current object w |

a— —.
Specify value bype:l| structured w
(nares) |
Enter components; * | user |

1 Click the Edit the components icon [E| when the value type is set to structured.

2 Create the value of the action component.

You can type the value, or click the Edit the arguments [E] icon to create the value in the Argument

Builder.
Argument Components |
The argument components are skruckured argument walues, 5 =
Name Yalues + K Of" IE @
| User | | value |

3 Click Finish.
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16.5 Condition Builder

The Condition Builder enables you to add, view, and delete the conditions that make up a rule. A
condition contains one or more conditions and one or more condition groups. The condition groups
contain two different condition structures, which define the logic of condition groups. The two
condition structures are:

¢ OR Conditions, AND Groups

¢ AND Conditions, OR Groups

¢ Section 16.5.1, “Creating a Condition,” on page 392
¢ Section 16.5.2, “Additional Options for the Condition Builder,” on page 392

16.5.1 Creating a Condition

1 In the Policy Builder, create a new rule or edit and existing rule.

2 Double-click the Conditions tab to launch the Condition Builder.

Condikions

% rCondition Group 1

Define new condition below

Condition |SEIect a condition v| @

3 Select the desired condition from the drop-down list, then click OK.

16.5.2  Additional Options for the Condition Builder

1 Right-click the condition to see the additional options:
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& Insert Condition Group After

+| Expand All Conditions
i.) Append Condition. ..

o Cuk Chrl+
Copy Chrl+C
[ Paste Chrl+y
¥ Delete Delete
< Undo Ctr+2

Preferences. ..

¢+ New > Insert Condition Before: Adds a condition before the current condition.

¢+ New > Insert Condition After: Adds a condition after the current condition.

¢ Edit: Launches the Condition Builder.

¢ Move the selected item up: Moves the selected condition up in the order of execution.

* Move the selected item down: Moves the selected condition down in the order of
execution.

¢ Cut, Copy, Paste, or Delete: Cuts, copies, pastes, or deletes the condition.
* Undo or Redo: Undoes or redoes the last action.
¢ Preferences: Allows you to set default functionary in the Policy Builder.

¢ Help: Select a condition, then click the Help icon to see information specific to that
condition.

For additional information on the Condition Builder and the rules, see Section 3.4, “Creating a Rule,”
on page 26.

16.6  Condition Argument Component Builder

To launch the Condition Argument Component Builder, select one of the following conditions, then
select the structured selection for Mode in order to see the Launch ArgComponent Builder icon E1.

¢ If Attribute (page 403)
¢ If Destination Attribute (page 407)
¢ If Association (page 402)
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16.7

Figure 16-5 If Attribute mode

Condition |destinatiu:un attribute vl @
Mame * | Given Marme | uf_gl E:I &
Cperakor * |equal v|

Mnde@ucture__i) W |
Yalue | | &

1 Specify the name and value of the condition component.

2

@ Condition Argument Component Builder

Argument Components |
The condition argument components are namefvalue pairs. :!1 =
MName Yalues + B of @& @
| | |
Click Finish.

Match Attribute Builder

The Match Attribute Builder enables you to select attributes and values used by the Find Matching
Object (page 447) action to determine if a matching object exists in a data store.

For example, if you wanted to match users based on a common name and a location:

1
2
3
4

Select the action of find matching object.
Select the scope of the search for the matching objects. Select from entry, subordinates, or subtree.

Specify the DN of the starting point for the search.
Click the Edit match attributes icon [E] to launch the Match Attribute Builder.

Co |Find makching object v| )]
Select scope: |su|:utree V|
Specify DM | "Mowell” |

Specify match attributes: |

Click the Browse attributes 2, icon to launch the Schema Browser.

Click the Attributes tab, then browse to and select the desired attribute.
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& @

Attributes of | <All Classes>

<

[Anwvthing] ~
[Mathing]

accessCardhumber

Account Balance

ACL

Aliased Object Mame
allowiliasToAnceskar

Allows Unlirmited Credit
assistant

assiskantPhone
associatedilame
attrEncryptionefinition
attrEncryptionRequiresSecure
attributeCertificate

audin

Audit: & Encryplion Kesy
Audit:B Encryption Key
Audit: Contents

audit: Current Encryption £ey
Audit:File Link,

Audit:Link List

Audit:Path

audit: Palicy

Audit: Type

anbharikakive

[Jonly shaw changes

[ K ] [ Cancel E]

7 Click OK.

If you want to add more than one attribute, click the Append new item icon 5 to add another line.

Match Attributes @ X of @ @
\I@ \i:' = | Use values from the current object w
u.?;l Ct' Cé Use walues From the current object w

8 Click Finish.

The Match Attribute Builder also allows you to specify another value, instead of using the value from
the current object. To use a different value, select Other Value instead of Use values from current object.
There are multiple value types to specify:

¢ counter

¢ dn

¢ int

¢ interval

¢ octet

¢ state

¢ string

+ structured
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+ teleNumber

+ time
To use the another value:

1 Launch the Match Attribute Builder, then select Other Value.

Match Attributes [
The match attributes specify the attributes that are to be used to find a match For the action,
Match Attributes + X f BB @
| ega | Other Value w |
Select Value Type: | skring v|
Specify String: | |

2 Select the desired value type.
3 Specify the value, then click OK.

16.8 Named String Builder

To launch the Named String Builder, select one of the following actions, then click the Edit the strings

icon [E.
¢ Generate Event (page 449)
¢ Send Email (page 461)
¢ Send Email from Template (page 462)
1 Select the name of the string from the drop-down list.
2 Create the value for the string by clicking the Edit the arguments icon [Z to launch the Argument
Builder.
& Named String Builder, |:,
Named String Builder | o
I
String elements provide walues For argurents. v =
Name String ¥alue + K of E 4 @
k- v | |
| subject v| | |
| message v| | |

3 Click Finish.
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For a Send Email action, the named strings correspond to the elements of the e-mail:

@ Named String Builder

Named String Builder _
String elemerts provide values For arguments. =
Name String Yalue + X o4 BB 4 @
E ¥

| subject v/ | |

| message vl| |

A complete list of possible values is contained in the help file corresponding to the action that
launches the Named String Builder.

16.9 Pattern String Builder

You can launch the Pattern String Builder from the Argument Builder editor when the Unique Name

(page 507) token is selected. The Argument Builder editor pane shows a Pattern field where you can
click to launch the Pattern String Builder.
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Figure 16-6 Unique Name Token in the Argument Builder

Create and edit arguments

add or remove your components ko the expression area bo constrock yoor argument. Enter component walues under Editar,

I Enpression ® of i) () &4 Nouns
&5 Unique Mame™") Operation Atkribute -~
Operation Propetty
Password

Removed Attribute
Removed Entitlement
Source Attribute
Source DN

Source Mare

Unigue Name

... ¥erbs

Escape Destination DM
Escape Source DM
Lower Case

Parse DM

Replace Al

Replace Firsk
Substring

Upper Case

2 Editor * Required % Description Q)]

Akkribute narme: | | Q, & generated unique narne,

Skart search: |Rcu:t of dataskore W |

CPattern: "ﬂ | |

Counker stark: | 1 | digits: | 1 | Pad counter with leading 0's

1 Click the Edit patterns icon E to launch the Pattern Builder.

2 Specify the pattern or click the Edit the arguments icon Ei to use the Argument Builder to create
the pattern.

@ Pattern Builder |_| E

Pattern Builder

Define a list of patterns

Pattern Yalues + XK °3b % @
Patterm: | .

3 Click Finish.
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16.10 Argument Value List Builder

To launch the Argument Value List Builder, select the following action, then click the Edit the

arguments icon [E.
¢ Set Default Attribute Value (page 463)

Figure 16-7 Set Default Attribute Value

Do | sek default attribute value v| @

Specify attribute name: * | Comparry | 8 g e

v|

Write back: | false

Specify argurment values: * |

1 Select the type of the value: counter, dn, int, interval, octet, state, string, structured, teleNumber, time.

2 Click the Edit the value lists icon E.

k3 Argument Value List Builder |:|@

Argument Yalues
Argument values specify the values that are to be used For an attribute,

¢ X LBB ®
=

Type Argument ¥alues

structured
telehumber
tirne

3 Click the Edit the arguments icon [E.

4 Create the value of the action component.
You can type the value, or click the Edit the arguments i icon to create the value in the Argument
Builder.

5 Click Finish.

16.11 Namespace Editor

The Policy Builder enables you to use multiple XML namespaces within your XML documents. To
define a namespace, specify the namespace prefix in the Name field, and the URI in the URI field.

Leave the Java Extension check box deselected.

You can also access Java classes through XPath by using XML namespaces. To create a namespace for
a Java class, specify the namespace prefix in the Name field, the class name in the URI field, and select

the Java Extension check box.
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Figure 16-8 Namespace Editor

@ Namespace Editor

Edit Policy's Namespace Definitions ‘
)
Policy Builder enables you to use multiple XML namespace definitions within wour XML < >
documents,
+- XK 4 BB @
Prefix URI Java Extension
| I =N
Finish l [ Cancel

16.11.1  Accessing Java Classes by Using Namespaces

Novell provides several Identity Manager Java classes that can be called by using XPath expressions
from the Policy Builder. The following links open JavaDoc references for these Java classes:

¢ com.novell.nds.dirxml.driver.XdsQueryProcessor (http://developer.novell.com/documentation/
dirxml/dirxmlbk/api/com/novell/nds/dirxml/driver/XdsQueryProcessor.html)

¢ com.novell.nds.dirxml.driver.XdsCommandProcessor (http://developer.novell.com/
documentation/dirxml/dirxmlbk/api/com/novell/nds/dirxml/driver/
XdsCommandProcessor.html)

¢ com.novell.nds.dirxml.driver. DNConverter (http://developer.novell.com/documentation/
dirxml/dirxmlbk/api/com/novell/nds/dirxml/driver/DNConverter.html)

The Java Developer Kit (JDK*) also provides several useful classes, such as java.lang.String, and
java.lang.System. References for these classes are available with the JDK.

For additional information on using XPath and the Novell Java classes listed above, consult the
DirXML Driver Developer Kit (http://developer.novell.com/documentation/dirxml/dirxmlbk/ref/
dirxmlfaq.html).
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Pre-ldentity Manager 3.5 Conditions

Conditions define when actions are performed. Conditions are always specified in either Conjunctive
Normal Form (CNF) (http://mathworld.wolfram.com/ConjunctiveNormalForm.html) or Disjunctive
Normal Form (DNF) (http://mathworld.wolfram.com/DisjunctiveNormalForm.html). These are
logical expression forms. The actions of the enclosing rule are only performed when the logical
expression represented in CNF or DNF evaluates to True or when no conditions are specified.

This section contains detailed information about all conditions that are available through the pre-
Identity Manager 3.5 Policy Builder interface.

*

*

*

“If Association” on page 402

“If Attribute” on page 403

“If Class Name” on page 405

“If Destination Attribute” on page 407
“If Destination DN” on page 409

“If Entitlement” on page 410

“If Global Configuration Value” on page 412
“If Local Variable” on page 414

“If Named Password” on page 416

“If Operation Attribute” on page 417
“If Operation Property” on page 419
“If Operation” on page 421

“If Password” on page 423

“If Source Attribute” on page 424

“If Source DN” on page 426

“If XPath Expression” on page 427
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If Association

Performs a test on the association value of the current operation or the current object. The type of test
performed depends on the operator specified by the operation attribute.

Fields

Operator
Select the condition test type.

Operator Returns True when...

Associated There is an established association for the current object.

Not Association There is not an established association for the current object.

Available There is a non-empty association value specified by the current
operation.

Not available The association is not available for the current object.

Equal The association value specified by the current operation is exactly equal

to the content of the if association.

Not Equal The association value specified by the current operation is not equal to
the content of the if association.

Value
Contains the value defined for the select operator. The value is used by the condition.
¢ Equal
¢ Not Equal

402  Policies in Designer 4.0.2



If Attribute

Performs a test on attribute values of the current object in either the current operation or the source
data store. It can be logically thought of as If Operation Attribute or If Source Attribute, because the
test is satisfied if the condition is met in the source data store or in the operation. The test performed
depends on the specified operator.

Fields
Name
Specify the name of the attribute to test.

Operator
Select the condition test type.

Operator Returns True when...

Available There is a value available in either the current operation or the source
data store for the specified attribute.

Not Available Available would return False.

Equal There is a value available in either the current operation or the source

data store for the specified attribute, which equals the specified value
when compared by using the specified comparison mode.

Not Equal Equal would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

¢ Equal
¢ Not Equal
Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.
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Mode

Description

Case Sensitive
Case Insensitive

Regular Expression

Source DN

Destination DN

Numeric

Binary

Character-by-character case sensitive comparison.
Character-by-character case insensitive comparison.

The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

See Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Compares by using semantics appropriate to the DN format for the source data
store.

Compares by using semantics appropriate to the DN format for the destination data
store.

Compares numerically.

Compares the binary information.

The operators that contain the comparison mode parameter are:

¢ Equal
¢ Not Equal
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If Class Name
Performs a test on the object class name in the current operation.

Fields

Operator
Select the condition test type.

Operator Returns True when...

Available There is an object class name available in the current operation.

Not Available Available would return False.

Equal There is an object class name available in the current operation, and it

equals the specified value when compared by using the specified
comparison mode.

Not Equal Equal would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

¢ Equal
¢ Not Equal

Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode Description
Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

See Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.
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The operators that contain the comparison mode parameter are:
¢ Equal
¢ Not Equal
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If Destination Attribute

Performs a test on attribute values of the current object in the destination data store. The test
performed depends on the specified operator.

Fields

Name

Specify the name of the attribute to test.

Operator
Select the condition test type.

Operator Returns True when...

Available There is a value available in the destination data store for the specified
attribute.

Not Available Available would return False.

Equal There is a value available for the specified attribute in the destination data

store that equals the specified value when compared by using the
specified comparison mode.

Not Equal Equal would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

¢ Equal
¢ Not Equal

Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode Description
Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

See Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.
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Mode Description

Numeric Compares numerically.
Binary Compares the binary information.
Structured Compares the structured attribute according to the comparison rules for the

structured syntax of the attribute.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Not Equal
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If Destination DN

Performs a test on the destination DN in the current operation. The test performed depends on the
specified operator.

Fields

Operator
Select the condition test type.

Operator Returns True when...

Available There is a destination DN available.

Not Available Available would return False.

Equal There is a destination DN available, and it equals the specified value

when compared by using semantics appropriate to the DN format of the
destination data store.

Not Equal Equal would return False.

In Container There is a destination DN available, and it represents an object in the
container, specified by value, when compared by using semantics
appropriate to the DN format of the destination data store.

Not in Container In Container would return False.

In Subtree There is a destination DN available, and it represents an object in the
subtree, specified by value, when compared by using semantics
appropriate to the DN format of the destination data store.

Not in Subtree In Subtree would return False.
Value
Contains the value defined for the select operator. The value is used by the condition.
¢ Equal
¢ Not Equal

+ In Container
+ Not in Container
* In Subtree

+ Not in Subtree
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If Entitlement

Performs a test on entitlements of the current object, in either the current operation or the Identity
Vault. The test performed depends on the specified operator.

Fields

Name

Specify the name of the entitlement to test for the selected condition.

Operator
Select the condition test type.

Operator Returns True when...

Available The named entitlement is available in either the current operation or the
Identity Vault.

Not available Available would return False.

Equal There is a value available for the specified attribute in the destination data

store that equals the specified value when compared by using the
specified comparison mode.

Not Equal Equal would return False.

Changing The current operation contains a change (modify attribute or add attribute)
of the named entitlement.

Not Changing Changing would return False.

Changing From The current operation contains a change that removes a value (remove
value) of the named entitlement, which has a value that equals the
specified value, when compared by using the specified comparison mode.

Not Changing From Changing From would return False.

Changing To The current operation contains a change that adds a value (add value or
add attribute) to the named entitlement. It has a value that equals the
specified value, when compared by using the specified comparison mode.

Not Changing To Changing To would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

¢ Equal

¢ Not Equal

¢ Changing To

¢ Changing From

¢ Not Changing To

¢ Not Changing From

Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.
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Mode Description

Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

See Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Not Equal
¢ Changing To
¢ Changing From
¢ Not Changing To
¢ Not Changing From
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If Global Configuration Value

Performs a test on a global configuration value. The test performed depends on the specified
operator.

Remark

For more information on using variables with policies, see “Downloading Identity Manager Policies”
in Understanding Policies for Identity Manager 4.0.2.

Fields

Name

Specify the name of the global value to test for the selected condition.

Operator
Select the condition test type.

Operator Returns True when...

Available There is a global configuration value with the specified name.

Not Available Available would return False.

Equal There is a global configuration value with the specified name, and its

value equals the specified value when compared by using the specified
comparison mode.

Not Equal Equal would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

¢ Equal
¢ Not Equal
Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.
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Mode Description

Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

See Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Not Equal
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If Local Variable

Performs a test on a local variable. The test performed depends on the specified operator.

Remark

For more information on using variables with policies, see “Variables”in Understanding Policies for
Identity Manager 4.0.2.

Fields
Name
Specify the name of the local variable to test for the selected condition.

Operator
Select the condition test type.

Operator Returns True when...

Available There is a local variable with the specified name that has been defined by
an action of a earlier rule within the policy.

Not Available Available would return False.

Equal There is a local variable with the specified name, and its value equals the
specified value when compared by using the specified comparison mode.

Not Equal Equal would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

¢ Equal
¢ Not Equal
Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.
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Mode Description

Case Sensitive Character-by-character case sensitive comparison.
Case Insensitive Character-by-character case insensitive comparison.

Regular Expression  The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

See Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Source DN Compares by using semantics appropriate to the DN format for the source data
store.

Destination DN Compares by using semantics appropriate to the DN format for the destination data
store.

Numeric Compares numerically.

Binary Compares the binary information.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Not Equal
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If Named Password

Performs a test on a named password from the driver in the current operation with the specified
name. The test performed depends on the selected operator.

Fields

Name
Specify the name of the named password to test for the selected condition.

Operator
Select the condition test type.

Operator Returns True when...
Available There is a password with the specified name available.
Not Available Available would return False.
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If Operation Attribute

Performs a test on attribute values in the current operation. The test performed depends on the

specified operator.

Fields

Name

Specify the name of the attribute to test.

Operator

Select the condition test type.

Operator Returns True when...

Operator Returns True when...

Available There is a value available in the current operation other than a remove
value for the specified attribute.

Not Available Available would return False.

Equal There is a value available in the current operation other than a remove
value for the specified attribute. It equals the specified value when
compared by using the specified comparison mode.

Not Equal Equal would return False.

Changing The current operation contains a change other than a remove value for

Not Changing

Changing From

Not Changing From

Changing To

Not Changing To

the specified attribute.
Changing would return False.

The current operation contains a change that removes a value other than
a remove value of the specified attribute. It equals the specified value
when compared by using the specified comparison mode.

Changing From would return False.

The current operation contains a change that adds a value other than a
remove value to the specified attribute. It equals the specified value when
compared by using the specified comparison mode.

Changing To would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

¢ Equal
¢ Not Equal
¢ Changing To

¢ Changing From
¢ Not Changing To

¢ Not Changing From
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Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode

Description

Case Sensitive
Case Insensitive

Regular Expression

Source DN

Destination DN

Numeric
Binary

Structured

Character-by-character case sensitive comparison.
Character-by-character case insensitive comparison.

The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

See Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/javalutil/regex/
Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Compares by using semantics appropriate to the DN format for the source data
store.

Compares by using semantics appropriate to the DN format for the destination data
store.

Compares numerically.
Compares the binary information.

Compares the structured attribute according to the comparison rules for the
structured syntax of the attribute.

The operators that contain the comparison mode parameter are:

¢ Equal
¢ Not Equal
¢ Changing To

¢ Changing From

¢ Not Changing To

¢ Not Changing From
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If Operation Property

Performs a test on an operation property on the current operation. An operation property is a named
value that is stored as an attribute on an <operation-data> element within an operation. It is
typically used to supply additional context that might be needed by the policy that handles the
results of an operation. The test performed depends on the selected operator.

Fields

Name
Specify the name of the operation property to test for the selected condition.

Operator
Select the condition test type.

Operator Returns True when...

Available There is an operation property with the specified name on the current
operation.

Not Available Available would return False.

Equal There is a an operation property with the specified name on the current

operation, and its value equals the provided content when compared by
using the specified comparison mode.

Not Equal Equal would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

¢ Equal
¢ Not Equal
Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.
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Mode

Description

Case Sensitive
Case Insensitive

Regular Expression

Source DN

Destination DN

Numeric

Binary

Character-by-character case sensitive comparison.
Character-by-character case insensitive comparison.

The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

See Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Compares by using semantics appropriate to the DN format for the source data
store.

Compares by using semantics appropriate to the DN format for the destination data
store.

Compares numerically.

Compares the binary information.

The operators that contain the comparison mode parameter are:

¢ Equal
¢ Not Equal
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If Operation

Performs a test on the name of the current operation. The type of test performed depends on the
specified operator.

Fields

Operator

Select the condition test type.

Operator Returns True when...

Equal The name of the current operation is equal to the content of the condition

when compared by using the specified comparison mode.

Not Equal Equal would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

*

*

Equal
Not Equal

The values are the operations that the Metadirectory engine looks for:

*

*

*

*

*

add

add-association
check-object-password
check-password
delete
get-named-password
init-params

instance

modify
modify-association
modify-password
move

password

query

query-schema
remove-association
rename

schema-def

status

sync

This list is not exclusive. Custom operations can be implemented by drivers and administrators.
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Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode

Description

Case Sensitive
Case Insensitive

Regular Expression

Source DN

Destination DN

Numeric

Binary

Character-by-character case sensitive comparison.
Character-by-character case insensitive comparison.

The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

See Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/javalutil/regex/
Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Compares by using semantics appropriate to the DN format for the source data
store.

Compares by using semantics appropriate to the DN format for the destination data
store.

Compares numerically.

Compares the binary information.

The operators that contain the comparison mode parameter are:

¢ Equal
¢ Not Equal
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If Password

Performs a test on a password in the current operation. The test performed depends on the specified
operator.

Fields

Operator
Select the condition test type.

Operator Returns True when...
Available There is a password available in the current operation.
Not Available Available would return False.
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If Source Attribute

Performs a test on attribute values of the current object in the source data store. The test performed
depends on the specified operator.

Fields

Name

Specify the name of the source attribute to test for the selected condition.

Operator

Select the condition test type.

Operator

Returns True when...

Available

Not Available

Equal

Not Equal

There is a value available in the source data store for the specified
attribute.

Available would return False.

There is a value available in the source data store for the specified
attribute. It equals the specified value when compared by using the
specified comparison mode.

Equal would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

¢ Equal
¢ Not Equal

Comparison Mode

The condition has a comparison mode parameter that indicates how a comparison is done.

Mode

Description

Case Sensitive
Case Insensitive

Regular Expression

Source DN

Destination DN

Character-by-character case sensitive comparison.
Character-by-character case insensitive comparison.

The regular expression matches the entire string. It defaults to case insensitive, but
can be changed by an escape in the expression.

See Sun’s Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Pattern.html).

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are
used but can be reversed by using the appropriate embedded escapes.

Compares by using semantics appropriate to the DN format for the source data
store.

Compares by using semantics appropriate to the DN format for the destination data
store.
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Mode Description

Numeric Compares numerically.
Binary Compares the binary information.
Structured Compares the structured attribute according to the comparison rules for the

structured syntax of the attribute.

The operators that contain the comparison mode parameter are:
¢ Equal
¢ Not Equal
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If Source DN

Performs a test on the source DN in the current operation. The test performed depends on the
specified operator.

Fields

Operator
Select the condition test type.

Operator Returns True when...

Available There is a source DN available.

Not Available Available would return False.

Equal There is a source DN available, and it equals the content of the specified

value in-container.
Not Equal Equal would return False.

In Container There is a source DN available, and it represents an object in the
container specified by the content of If Source DN, when compared by
using semantics appropriate to the DN format of the source data store.

Not In Container In Container would return False.

In Subtree There is a source DN available, and it represents an object in the subtree
identified by the specified value.

Not In subtree In Subtree would return False.

Value

Contains the value defined for the select operator. The value is used by the condition. The
operators that contain the value field are:

¢ Equal

¢ Not Equal

¢ In Container

+ Not in Container
¢ In Subtree

+ Not in Subtree
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If XPath Expression

Performs a test on the results of evaluating an XPath 1.0 expression.

Fields

Operator
Select the condition test type.

Operator Returns True when...
True The XPath expression evaluates to True.
Not True True would return False.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.
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Pre-ldentity Manager 3.5 Actions

Actions are performed when conditions of the enclosing rule are met. Some actions have a Mode field.

The mode is not honored at run time if the context in which the policy is running is incompatible

with the selected mode.

This section contains detailed information about all actions that are available through using the pre-
Identity Manager Policy Builder interface.

*

*

*

*

“Add Association” on page 431

“Add Destination Attribute Value” on page 432
“Add Destination Object” on page 433

“Add Source Attribute Value” on page 434

“Add Source Object” on page 435

“Append XML Element” on page 436

“Append XML Text” on page 437

“Break” on page 438

“Clear Destination Attribute Value” on page 439
“Clear Operation Property” on page 440

“Clear Source Attribute Value” on page 441
“Clear SSO Credential” on page 442

“Clone By XPath Expression” on page 443
“Clone Operation Attribute” on page 444
“Delete Destination Object” on page 445

“Delete Source Object” on page 446

“Find Matching Object” on page 447

“For Each” on page 448

“Generate Event” on page 449

“Implement Entitlement” on page 451

“Move Destination Object” on page 452

“Move Source Object” on page 453

“Reformat Operation Attribute Value” on page 454
“Remove Association” on page 455

“Remove Destination Attribute Value” on page 456
“Remove Source Attribute Value” on page 457
“Rename Destination Object” on page 458

“Rename Operation Attribute” on page 459
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¢ “Rename Source Object” on page 460

¢ “Send Email” on page 461

¢ “Send Email from Template” on page 462

¢ “Set Default Attribute Value” on page 463

¢ “Set Destination Attribute Value” on page 464
¢ “Set Destination Password” on page 465

¢ “Set Local Variable” on page 466

¢ “Set Operation Association” on page 467

¢ “Set Operation Class Name” on page 468

¢ “Set Operation Destination DN” on page 469
¢ “Set Operation Property” on page 470

¢ “Set Operation Source DN” on page 471

¢ “Set Operation Template DN” on page 472

¢ “Set Source Attribute Value” on page 473

¢ “Set Source Password” on page 474

+ “Set S50 Credential” on page 475

¢ “Set S50 Passphrase” on page 476

¢ “Set XML Attribute” on page 477

¢ “Status” on page 478

¢ “Strip Operation Attribute” on page 479

¢ “Strip XPath” on page 480

¢ “Trace Message” on page 481

¢ “Veto” on page 482

¢ “Veto If Operation Attribute Not Available” on page 483
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Add Association

Sends an add association command with the specified association to the Identity Vault.

Fields

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

DN
Specify the DN of the target object or leave the field blank to use the current object.

Association

Specify the value of the association to be added.
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Add Destination Attribute Value

Adds a value to an attribute on an object in the destination data store.

Fields

Attribute Name
Specify the name of the attribute.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object.

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object

Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

DN
Specify the DN, association, or current object as the target object.

Value Type

Select the syntax of the attribute value to be added. The options are string, counter, dn, int,
interval, octet, state, structured, teleNumber, or time.

Value
Specify the attribute value to be added.
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Add Destination Object

Creates an object of the specified type in the destination data store, with the name and location
specified in the Enter DN field. Any attribute values to be added as part of the object creation must be
done in subsequent Add Destination Attribute Value actions, using the same DN.

Fields

Class Name

Specify the class name of the object to be created.

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

DN
Specify the DN of the object to be created.

Remarks

Any attribute values to be added as part of the object creation must be done in subsequent Add
Destination Attribute Value actions, using the same DN.
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Add Source Attribute Value

Adds the specified attribute on an object in the source data store.

Fields

Attribute Name
Specify the name of the attribute.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object.

Object

Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

DN
Specify the DN, association, or the current object as the target object.

Value Type

Select the syntax of the attribute value to be added. The options are string, counter, dn, int,
interval, octet, state, structured, teleNumber, or time.

Value

Specify the attribute value to be added.
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Add Source Object

Creates an object of the specified type in the source data store, with the name and location provided
in the DN field. Any attribute values to be added as part of the object creation must be done in
subsequent Add Source Attribute Value actions, using the same DN.

Fields

Class Name

Specify the class name of the object to be added.

DN
Specify the DN of the object to be added.
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Append XML Element

Appends a custom element, with the name specified in the Name field, to the set of elements selected
by the XPath expression.

Fields

Name

Specify the tag name of the XML element. This name can contain a namespace prefix if the prefix
has been previously defined in this policy.

XPath Expression

Specify an XPath 1.0 expression that returns a node set containing the elements to which the new
elements should be appended.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.
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Append XML Text

Appends the specified text to the set of elements selected by the XPath expression.

Fields

XPath Expression

Specify the XPath 1.0 expression that returns a node set containing the elements to which the
new elements should be appended.

String
Specify the text to be appended.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.
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Break

Ends processing of the current operation by the current policy.

Fields

There are no fields for the Break action.
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Clear Destination Attribute Value

Removes all values for the named attribute from an object in the destination data store.

Fields

Attribute Name
Specify the name of the attribute.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object.

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object

Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

DN

Select the DN, association, or the current object as the target object.
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Clear Operation Property

Clears any operation property with the provided name from the current operation. The operation
property is the XML attribute attached to an <operation-data> element by a policy. An XML
attribute is a name/value pair associated with an element in the XDS document.

Fields

Property Name

Specify the name of the operation property to clear.
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Clear Source Attribute Value

Removes all values of an attribute from an object in the source data store.

Fields

Attribute Name
Specify the name of the attribute.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object. This value might be required for schema map purposes if the object is
other than current object.

Object
Select the target object type. This object can be the current object, or can be specified by a DN or
an association.

DN

Select the DN, association, or current object as the target object.
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Clear SSO Credential

Clears the Single Sign On credential so objects can be deprovisioned. Additional information about
the credential to be cleared can be provided in the Enter login parameter strings field. The number of
the strings and the names used are dependent on the credential repository and application for which
the credential is targeted. For more information, see Novell Credential Provisioning for Identity Manager

4.0.2.

Fields

Credential Repository Object DN
Specify the DN of the repository object.

Target User DN
Specify the DN of the target users.

Application Credential ID
Specify the application credential that is stored in the application object.

Login Parameter Strings

Specify each login parameter for the application. The login parameters are the authentication
keys stored in the application object.
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Clone By XPath Expression

Appends deep copies of the nodes specified by the source field to the set of elements specified by the
destination field.

Fields

Source XPath Expression

Specify the XPath 1.0 expression that returns a node set containing the nodes to be copied.

Destination XPath Expression

Specify the XPath 1.0 expression that returns a node set containing the elements to which the
copied nodes are to be appended.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.
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Clone Operation Attribute

Copies all occurrences of an attribute within the current operation to a different attribute within the
current operation.

Fields

Source Name

Specify the name of the attribute to be copied from.

Destination Name

Specify the name of the attribute to be copied to.
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Delete Destination Object

Deletes an object in the destination data store.

Fields

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object
Select the target object type to delete in the destination data store. This object can be the current
object, or can be specified by a DN or an association.

DN
Select the DN, association, or current object as the target object.
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Delete Source Object

Deletes an object in the source data store.

Fields

Object
Select the target object type to delete in the source data store. This object can be the current
object, or can be specified by a DN or an association.

DN
Select the DN, association, or current object as the target object.

446  Policies in Designer 4.0.2



Find Matching Object

Finds a match for the current object in the destination data store.

Fields

Scope

Select the scope of the search. The scope might be an entry, a subordinate, or a subtree.

DN
Specify the DN that is the base of the search.

Match Attributes

Specify the attribute values to search for.

Remarks

Find Matching Object is only valid when the current operation is an add.

The DN argument is required when the scope is “entry,” and is optional otherwise. At least one
match attribute is required when the scope is “subtree” or “subordinates.”

The results are undefined if the scope is “entry” and there are match attributes specified. If the
destination data store is the connected application, then an association is added to the current
operation for each successful match that is returned. No query is performed if the current operation
already has a non-empty association, thus allowing multiple find matching object actions to be
strung together in the same rule.

If the destination data store is the Identity Vault, then the destination DN attribute for the current
operation is set. No query is performed if the current operation already has a non-empty destination
DN attribute, thus allowing multiple find matching object actions to be strung together in the same
rule. If only a single result is returned and it is not already associated, then the destination DN of the
current operation is set to the source DN of the matching object. If only a single result is returned and
it is already associated, then the destination DN of the current operation is set to the single character
&#xFFFC;. If multiple results are returned, then the destination DN of the current operation is set to
the single character &#xFFFD;.
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For Each

Repeats a set of actions for each node in a node set.

Fields

Node Set
Specify the node set.

Action
Specify the actions to perform on each node in the node set.

Remarks
The current node is a different value for each iteration of the actions, if a local variable is used.

If the current node in the node set is an entitlement element, then the actions are marked as if they are
also enclosed in an Implement Entitlement action. If the current node is a query element returned by
a query, then that token is used to automatically retrieve and process the next batch of query results.
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Generate Event

Sends a user-defined event to Novell Audit or Sentinel.

Fields

ID

ID of the event. The provided value must result in an integer in the range of 1000-1999 when

parsed by using the parselnt method of java.lang.Integer.

Level

Level of the event.

Level

Description

log-emergency

Events that cause the Metadirectory engine or driver to shut down.

log-alert Events that require immediate attention.

log-critical Events that can cause parts of the Metadirectory engine or driver to
malfunction.

log-error Events describing errors that can be handled by the Metadirectory
engine or driver.

log-warning Negative events not representing a problem.

log-notice Events (positive or negative) that an administrator can use to understand
or improve use and operation.

log-info Positive events of any importance.

log-debug Events of relevance for support or engineers to debug the operation of
the Metadirectory engine or driver.

Strings

Specify user-defined string, integer, and binary values to include with the event. These values

are provided by using the Named String Builder.

Tag Description
target The object being acted upon.
target-type Integer specifying a predefined format for the target. Predefined values
for target-type are currently:

+ 0=None

+ 1 = Slash Notation

+ 2 = Dot Notation

+ 3 =LDAP Notation
subTarget The subcomponent of the target being acted upon.
textl Text entered here is stored in the textl event field.
text2 Text entered here is stored in the text2 event field.
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Tag Description

text3 Text entered here is stored in the text3 event field.

value Any number entered here is stored in the value event field.

value3 Any number entered here is stored in the value3 event field.

data Data entered here is stored in the blob event field.
Remarks

The Novell Audit or Sentinel event structure contains a target, a subTarget, three strings (textl, text2,
text3), two integers (value, value3), and a generic field (data). The text fields are limited to 256 bytes,
and the data field can contain up to 3 KB of information, unless a larger data field is enabled in your
environment.
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Implement Entitlement

Designates actions that implement an entitlement so that the status of those entitlements can be
reported to the agent that granted or revoked the entitlement.

Fields

Node Set
Node set containing the entitlement being implemented by the specified actions.

Action
Actions that implement the specified entitlements.
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Move Destination Object

Moves an object into the destination data store.

Fields

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object to Move

Select the object to be moved. This object can be the current object, or can be specified by a DN or
an association.

Container to Move to

Select the container to receive the object. This container is specified by a DN or an association.

DN or Association
Specify whether the DN or association of the container is used.
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Move Source Object

Moves an object in the source data store.

Fields

Object to Move
Select the object to be moved. This object can be the current object, or it can be specified by a DN
or an association.

Select Container
Select the container to receive the object. This container is specified by a DN or an association.
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Reformat Operation Attribute Value

Reformats all values of an attribute within the current operation by using a pattern.

Fields

Name
Specify the name of the attribute.

Value Type
Specify the syntax of the new attribute value.

Value

Specify a value to use as a pattern for the new format of the attribute values. If the original value
is needed to constructed the new value, it must be obtained by referencing the local variable

current-value.
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Remove Association

Sends a remove association command to the Identity Vault.

Fields

Mode
Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Association
Specify the value of the association to be removed.
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Remove Destination Attribute Value

Removes an attribute value from an object in the destination data store.

Fields

Attribute Name
Specify the name of the attribute.

Class Name
(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object.

Mode
Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Select Object
Select the target object. This object can be the current object, or can be specified by a DN or an
association.

Value Type

Specify the syntax of the new attribute value.

String

Specify the value of the new attribute.
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Remove Source Attribute Value

Removes the specified value from the named attribute on an object in the source data store.

Fields

Attribute Name
Specify the name of the attribute.

Class Name
(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object.

Object
Select the target object. This object can be the current object, or can be specified by a DN or an
association.

Value Type
Specify the syntax of the attribute value to be removed.

String

Specify the attribute value to be removed.

Pre-ldentity Manager 3.5 Actions 457



Rename Destination Object

Renames an object in the destination data store.

Fields

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object
Select the target object. This object can be the current object, or can be specified by a DN or an
association.

String
Specify the new name of the object.
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Rename Operation Attribute

Renames all occurrences of an attribute within the current operation.

Fields

Source Name
Specify the original attribute name.

Destination Name

Specify the new attribute name.
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Rename Source Object

Renames an object in the source data store.

Fields

Select Object
Select the target object. This object can be the current object, or can be specified by a DN or an
association.

String
Specify the new name of the object.
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Send Emalil

Sends an e-mail notification.

Fields

ID

(Optional) Specify the User ID in the SMTP system sending the message.

Server

Specify the SMTP server name.

Password

(Optional) Specify the SMTP server account password.

IMPORTANT: You can store the SMTP server account password as a Named Password on the
driver object. This allows the password to be encrypted; otherwise, you enter the password and
it is stored in clear text. For more information on Named Passwords, see Using Named
Password in the Novell Identity Manager Administration Guide (http://www.novell.com/
documentation/idm35/index.html).

Message Type

Select the e-mail message type.

Strings

Specify the values containing the various e-mail addresses, subject, and message. The following
table lists valid named string arguments:

String Name Description

to Adds the address to the list of e-mail recipients; multiple instances are
allowed. Can contain a comma-separated list of recipients.

cc Adds the address to the list of CC e-mail recipients; multiple instances
are allowed. Can contain a comma-separated list of recipients.

bcc Adds the address to the list of BCC e-mail recipients; multiple instances
are allowed. Can contain a comma-separated list of recipients.

from Specifies the address to be used as the originating e-mail address.

reply-to Specifies the address to be used as the e-mail message reply address.

subject Specifies the e-mail subject.

message Specifies the content of the e-mail message.

encoding Specifies the character encoding to use for the e-mail message.
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Send Email from Template

Generates an e-mail notification by using a template.

Fields

Notification DN
Specify the slash form DN of the SMTP notification configuration object.

Template DN
Specify the slash form DN of the e-mail template object.

Password

(Optional) Specify the SMTP server account password.

IMPORTANT: You can store the SMTP server account password as a Named Password on the
driver object. This allows the password to be encrypted; otherwise, you enter the password and
it is stored in clear text. For more information on Named Passwords, see Using Named
Passwords in the Novell Identity Manager Administration Guide (http://www.novell.com/
documentation/idm35/index.html).

Strings

Specify additional fields for the e-mail message. The following table contains reserved field
names, which specify the various e-mail addresses:

String Name Description

to Adds the address to the list of e-mail recipients; multiple instances are
allowed. Can contain a comma-separated list of recipients.

cc Adds the address to the list of CC e-mail recipients; multiple instances
are allowed. Can contain a comma-separated list of recipients.

bcc Adds the address to the list of BCC e-mail recipients; multiple instances
are allowed. Can contain a comma-separated list of recipients.

reply-to Specifies the address to be used as the e-mail message reply address.

encoding Specifies the character encoding to use for the e-mail message.

Each template can also define fields that can be replaced in the subject and body of the e-mail
message.
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Set Default Attribute Value

Adds default values to the current operation (and optionally to the current object in the source data
store) if no values for that attribute already exist. It is only valid when the current operation is Add.

Fields

Attribute Name
Specify the name of the default attribute.

Write Back

Select whether or not to also write back the default values to the source data store.

Values

Specify the default values of the attribute.
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Set Destination Attribute Value

Adds a value to an attribute on an object in the destination data store, and removes all other values
for that attribute.

Fields

Attribute Name
Specify the name of the attribute.

Class Name

(Optional) Specify the class name of the target object in the destination data store. Leave the field
blank to use the class name from the current object.

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

Object

Select the target object. This object can be the current object, or can be specified by a DN or an
association.

Value Type

Select the syntax of the attribute value to set.

String
Specify the attribute values to set.
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Set Destination Password

Sets the password for an object in the destination data store.

Fields

Mode

Select whether this action should be added to, before, or after the current operation, or written
directly to the destination data store.

String
Specify the password to be set.
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Set Local Variable

Sets a local variable with the given name to the string value specified, the XPath 1.0 Node Set
specified, or the Java* Object specified.

Fields

Variable Name

Specify the name of the new local variable.

Variable Type
Select the type of local variable. This can be a string, an XPath 1.0 node set, or a Java object.

String
Specify the value of the variable, in the format required by the Variable Type field.
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Set Operation Association

Sets the association value for the current operation.

Fields

Association

Specify the new association value.
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Set Operation Class Name

Sets the object class name for the current operation.

Fields

String

Specify the new class name.
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Set Operation Destination DN

Sets the destination DN for the current operation.

Fields

DN
Specify the new destination DN.
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Set Operation Property

Sets an operation property. An operation property is a named value that is stored within an
operation. It is typically used to supply additional context that might be needed by the policy that
handles the results of an operation.

Fields

Property Name
Specify the name of the operation property.

String
Specify the name of the string.
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Set Operation Source DN

Sets the source DN for the current operation.

Fields

DN
Specify the new source DN.
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Set Operation Template DN

Sets the template DN for the current operation to the specified value. This action is only valid when
the current operation is Add.

Fields

DN
Specify the template DN.
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Set Source Attribute Value

Adds a value to an attribute on an object in the source data store, and removes all other values for
that attribute.

Fields

Attribute Name
Specify the name of the attribute.

Class Name

(Optional) Specify the class name of the target object in the source data store. Leave the field
blank to use the class name from the current object.

Object

Select the target object. This object can be the current object, or can be specified by a DN or an
association.

Value Type

Select the syntax of the attribute value.

Value

Specify the attribute value to be set.
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Set Source Password

Sets the password for an object in the source data store.

Fields

String
Specify the password to be set.
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Set SSO Credential

Sets the SSO credential when a user object is created or when a password is modified. This action is
part of the Credential Provisioning policies. For more information, see Novell Credential Provisioning
for Identity Manager 4.0.2.

Fields
Credential Repository Object DN
Specify the DN of the repository object.

Target User DN
Specify the DN of the target users.

Application Credential ID
Specify the application credential that is stored in the application object.

Login Parameter Strings

Specify each login parameter for the application. The login parameters are the authentication
keys stored in the application object.
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Set SSO Passphrase

Sets the Novell SecureLogin passphrase and answer when a User object is provisioned. This action is
part of the Credential Provisioning policies. For more information, see Novell Credential Provisioning

for Identity Manager 4.0.2.

Fields

Credential Repository Object DN
Specify the DN of the repository object.

Target User DN
Specify the DN of the target users.

Question Strings

Specify the SecureLogin passphrase question.

Answer String

Specify the SecureLogin passphrase answer.
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Set XML Attribute

Sets an XML attribute on a set of elements selected by an XPath expression.

Fields

Name

Specify the name of the XML attribute. This name can contain a namespace prefix if the prefix
has been previously defined in this policy.

XPath Expression

XPath 1.0 expression that returns a node set containing the elements on which the XML attribute
should be set.

String
Specify the value of the XML attribute.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.
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Status

Generates a status notification.

Fields
Level
Specify the status level of the notification. The levels are error, fatal, retry, success, and warning.

Message

Provide the status message by using the Argument Builder.

Remarks

If level is retry, then the policy immediately stops processing the input document and schedules a
retry of the event currently being processed.

If the level is fatal, the policy immediately stops processing the input document and initiates a
shutdown of the driver.

If a the current operation has an event-id, that event-id is used for the status notification; otherwise,
there is no event-id reported.
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Strip Operation Attribute

Strips all occurrences of an attribute from the current operation.

Fields

Name

Specify the name of the attribute to be stripped.
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Strip XPath

Strips nodes selected by an XPath 1.0 expression.

Fields

XPath Expression
Specify the XPath 1.0 expression that returns a node set containing the nodes to be stripped.

Remarks

For more information on by using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.
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Trace Message

Sends a message to DSTRACE.

Fields

Level

Specify the trace level of the message. The default level is 0. The message only appears if the
specified trace level is less than or equal to the trace level configured in the driver.

For information on how to set the trace level on the driver, see “Viewing Identity Manager
Processes” in the NetIQ Identity Manager Common Driver .

Color

Select the color of the trace message.

String

Specify the value of the trace message.
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Veto

Vetoes the current operation.

Fields

There are no fields.
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Veto If Operation Attribute Not Available

Conditionally cancels the current operation and ends processing of the current policy, based on the
availability of an attribute in the current operation.

Fields

Name

Specify the name of the attribute.
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Pre-ldentity Manager 3.5 Noun Tokens

Noun tokens expand to values that are derived from the current operation, the source or destination
data stores, or some external source.

This section contains detailed information about all noun tokens that are available through using the
pre-Identity Manager Policy Builder interface.

*

*

*

*

“Added Entitlement” on page 486
“Association” on page 487
“Attribute” on page 488

“Class Name” on page 489
“Destination Attribute” on page 490
“Destination DN” on page 491
“Destination Name” on page 492
“Entitlement” on page 493

“Global Configuration Value” on page 494
“Local Variable” on page 495
“Named Password” on page 496
“Operation” on page 497

“Operation Attribute” on page 498
“Operation Property” on page 499
“Password” on page 500

“Removed Attribute” on page 501
“Removed Entitlements” on page 502
“Source Attribute” on page 503
“Source DN” on page 504

“Source Name” on page 505

“Text” on page 506

“Unique Name” on page 507
“Unmatched Source DN” on page 509
“XPath” on page 510
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Added Entitlement

Expands to the values of an entitlement granted in the current operation.

Fields

Name

Name of the entitlement.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that entitlement. If it is used in a context where a string is expected,
the token expands to the string value found.
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Association

Expands to the association value from the current operation.

Fields

There are no fields.
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Attribute

Expands to the value of an attribute from the current object in the current operation and in the source
data store. It can be logically thought of as the union of the operation attribute token and the source
attribute token. It does not include the removed values from a Modify operation.

Fields

Name

Specify the name of the attribute.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that attribute. If it is used in a context where a string is expected, the
token expands to the string value found.
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Class Name

Expands to the object class name from the current operation.

Fields

There are no fields.
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Destination Attribute

Expands to the specified attribute value an object.

Fields
Name
Name of the attribute.

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object.

Select Object
Select Current Object, DN, or Association.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that attribute. If it is used in a context where a string is expected, the
token expands to the string value found.
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Destination DN

Expands to the destination DN specified in the current operation.

Fields

Convert

Select whether or not to convert the DN to the format used by the source data store.

Start
Specify the RDN index to start with:
¢ Index 0 is the root-most RDN
¢ Positive indexes are an offset from the root-most RDN
¢ Index -1 is the leaf-most segment

¢ Negative indexes are an offset from the leaf-most RDN towards the root-most RDN

Length

Specify the number of RDN segments to include. Negative numbers are interpreted as (total # of
segments + length) + 1. For example, for a DN with 5 segments a length of -1 =(5+(-1)) +1=5, -2
=(5+(-2)+1=4, etc.

Remarks

If start and length are set to the default values {0,-1}, the entire DN is used; otherwise only the portion
of the DN specified by start and length is used.
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Destination Name

Expands to the unqualified Relative Distinguished Name (RDN) of the destination DN specified in
the current operation.

Fields

There are no fields.
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Entitlement

Expands to the values of a granted entitlement from the current object.

Fields

Name

Name of the entitlement.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that entitlement. If it is used in a context where a string is expected,
the token expands to the string value found.
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Global Configuration Value

Expands to the value of a global configuration variable.

Fields

Name

Name of the global configuration value.
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Local Variable

Expands to the value of a local variable.

Fields

Name

Specify the name of the local variable.
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Named Password

Expands to the Named Password from the driver.

Fields

Name
Specify the Named Password.
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Operation

Expands to the name of the current operation.

Fields

There are no fields.
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Operation Attribute

Expands to the value of an attribute from the current operation. It does not include the removed
values from a modify operation.

Fields

Name

Specify the name of the attribute.

498  Policies in Designer 4.0.2



Operation Property

Expands to the value of the specified operation property on the current operation.

Fields

Name

Specify the name of the operation property.
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Password

Expands to the password specified in the current operation.

Fields

There are no fields.
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Removed Attribute

Expands to the specified attribute value being removed in the current operation. It applies only to a
Modify operation.

Fields

Name
Specify the name of the attribute to remove.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that attribute. If it is used in a context where a string is expected, the
token expands to the string value found.
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Removed Entitlements

Expands to the values of the an entitlement revoked in the current operation.

Fields

Name

Specify the name of the entitlement.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that entitlement. If it is used in a context where a string is expected,
the token expands to the string value found.

502  Policies in Designer 4.0.2



Source Attribute

Expands to the values of an attribute from an object in the source data store.

Fields

Class Name

(Optional) Specify the class name of the target object. Leave the field blank to use the class name
from the current object.

Name
Name of the attribute.

Object

Select the source object. This object can be the current object, or can be specified by a DN or an
association.

Remarks

If the token is used in a context where a node set is expected, the token expands to a node set
containing all of the values for that attribute. If it is used in a context where a string is expected, the
token expands to the string value found.
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Source DN

Expands to the source DN from the current operation.

Fields

Convert

Select whether or not to convert the DN to the format used by the destination data store.

Start
Specify the RDN index to start with:
¢ Index 0 is the root-most RDN
¢ Positive indexes are an offset from the root-most RDN
¢ Index -1 is the leaf-most segment

¢ Negative indexes are an offset from the leaf-most RDN towards the root-most RDN

Length

Number of RDN segments to include. Negative numbers are interpreted as (total # of segments +
length) + 1. For example, for a DN with 5 segments a length of -1=(5+(-1)) +1=5, -2=(5 + (-2))
+1=4, etc.

Remarks

If start and length are set to the default values {0,-1}, the entire DN is used; otherwise, only the
portion of the DN specified by start and length is used.
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Source Name

Expands to the unqualified relative distinguished name (RDN) of the source DN specified in the
current operation.

Fields

There are no fields.
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Text

Expands to the text.

Fields

Text
Specify the text.
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Unique Name

Expands to a pattern-based name that is unique in the destination data store according to the criteria
specified.

Fields

Attribute Name

Specify the name of attribute to check for uniqueness.

Scope

Specify the scope in which to check uniqueness. The options are subtree or subordinates.

Start Search

Select a starting point for the search. The starting point can be the root of the data store, or be
specified by a DN or association.

Pattern

Specify patterns to use to generate unique values by using the Argument Builder.

Counter Start
The starting value of the counter.
Digits
Specify the width in digits of counter; the default is 1. The Pad counter with leading 0’s option

prepends 0 to match the digit length. For example, with a digit width of 3, the initial unique
value would be appended with 001, then 002, and so on.

Remarks

Each <arg-string> element provides a pattern to be used to create a proposed name.

A proposed name is tested by performing a query for that value in the name attribute against the
destination data store, using the <arg-dn> element or the <arg-association> element as the base of
the query and scope as the scope of the query. If the destination data store is the Identity Vault and
name is omitted, then a search is performed against the pseudo-attribute “[Entry].rdn”, which
represents the RDN of an object without respect to what the naming attribute might be. If the
destination data store is the application, then name is required.

A pattern can be tested with or without a counter as indicated by counter-use and counter-pattern.
When a pattern is tested with a counter, the pattern is tested repeatedly with an appended counter
until a name is found that does not return any instances or the counter is exhausted. The counter
starting value is specified by counter-start and the counter maximum value is specified in terms of
the maximum number of digits as specified by counter-digits. If the number of digits is less than
those specified, then the counter is right-padded with zeros unless the counter-pad attribute is set to
False. The counter is considered exhausted when the counter can no longer be represented by the
specified number of digits.

As soon as a proposed name is determined to be unique, the testing of names is stopped and the
unique name is returned.
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The order of proposed names is tested as follows:

¢ Each pattern is tested in the order specified. If counter-use="always” and the pattern is one of
the patterns indicated by the counter-pattern, then the pattern is tested with a counter;
otherwise, it is tested without a counter.

¢ If no unique name has been found after the patterns have been exhausted and counter-
use="fallback”, then the patterns indicated by the counter-pattern are retried with a counter.

If all specified combinations of patterns and counters are exhausted, then the action specified by the
on-unavailable is taken.
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Unmatched Source DN

Expands to the part of the source DN in the current operation that corresponds to the part of the DN
that was not matched by the most recent match of an If Source DN condition.

Fields

Convert
Select whether or not to convert the DN format used by the destination data store.

Remarks

If there are no matches, the entire DN is used.
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XPath

Expands to the results of evaluating an XPath 1.0 expression.

Fields

Expression

XPath 1.0 expression to evaluate.

Remarks

For more information on using XPath expressions with policies, see “XPath 1.0 Expressions” in
Understanding Policies for Identity Manager 4.0.2.
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Pre-ldentity Manager 3.5 Verb Tokens

Verb tokens modify the concatenated results of other tokens that are subordinate to them.

This section contains detailed information about all verbs that are available through the pre-Identity
Manager Policy Builder interface.

¢ “Hscape Destination DN” on page 512

¢ “Escape Source DN” on page 513

¢ “Lowercase” on page 514

¢ “Parse DN” on page 515

+ “Replace All” on page 517

¢ “Replace First” on page 518

¢ “Substring” on page 519

¢ “Uppercase” on page 520
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Escape Destination DN

Escapes the enclosed tokens according to the rules of the DN format of the destination data store.

Fields

There are no fields.
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Escape Source DN

Escapes the enclosed tokens according to the rules of the DN format of the source data store.

Fields

There are no fields.
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Lowercase

Converts the characters in the enclosed tokens to lowercase.

Fields

There are no fields.
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Parse DN

Converts the enclosed token’s DN to an alternate format.

Fields

Start
Specify the RDN index to start with:
Index 0 is the root-most RDN

*

+ Positive indexes are an offset from the root-most RDN
¢ Index -1 is the leaf-most segment

¢ Negative indexes are an offset from the leaf-most RDN towards the root-most RDN

Length
Number of RDN segments to include. Negative numbers are interpreted as (total # of segments +
length) + 1. For example, for a DN with 5 segments a length of -1=(5+(-1)) +1=5, -2=(5 + (-2))
+1=4, etc.

Source DN Format

Specifies the format used to parse the source DN.

Destination DN Format

Specify the format used to output the parsed DN.

Source DN Delimiter

Specify the custom source DN delimiter set if Source DN Format is set to custom.

Destination DN Delimiter

Specify the custom destination DN delimiter set if Destination DN Format is set to custom.

Remarks

If start and length are set to the default values {0,-1}, then the entire DN is used; otherwise, only the
portion of the DN specified by start and length is used.

When specifying custom DN formats, the eight characters that make up the delimiter set are defined
as follows:
¢ Typed Name Boolean Flag: 0 means names are not typed, and 1 means names are typed

¢ Unicode No-Map Character Boolean Flag: 0 means don't output or interpret unmappable
Unicode characters as escaped hex digit strings, such as \ FEFF. The following Unicode
characters are not accepted by eDirectory: Oxfeff, Oxfffe, Oxfffd, and Oxffff.

¢ Relative RDN Delimiter
¢ RDN Delimiter

¢ Name Divider

+ Name Value Delimiter
+ Wildcard Character

¢ Escape Character
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If RDN Delimiter and Relative RDN Delimiter are the same character, the orientation of the name is
root right, otherwise the orientation is root left.

If there are more than eight characters in the delimiter set, the extra characters are considered as
characters that need to be escaped, but they have no other special meaning.
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Replace All

Replaces all occurrences of a regular expression in the enclosed tokens.

Fields

Regular Expression
Specify the regular expression that matches the substring to be replaced.

Replace With

Specify the replacement string.

Remarks

For details on creating regular expressions, see:

¢ Sun’s Java Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/Pattern.html)

¢ Sun’s Java Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Matcher.html#replaceAll (java.lang.String))

The pattern options CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are used but can be
reversed by using the appropriate embedded escapes.
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Replace First

Replaces the first occurrence of a regular expression in the enclosed tokens.

Fields
Regular Expression
Specify the regular expression that matches the substring to replace.

Replace With

Specify the replacement string.

Remarks
The matching instance is replaced by the string specified in the Replace with field.
For details on creating regular expressions, see:

¢ Sun’s Java Web site (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/Pattern.html)
¢ Sun’s Java Web site (java.lang.String) (http://java.sun.com/j2se/1.4/docs/api/java/util/regex/
Matcher.html#replaceAll (java.lang.String))

The pattern option CASE_INSENSITIVE, DOTALL, and UNICODE_CASE are used but can be
reversed by using the appropriate embedded escapes.
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Substring

Extracts a portion of the enclosed tokens.

Fields

Start

Specify the starting character index:

*

Index 0 is the first character.
¢ Positive indexes are an offset from the start of the string.
¢ Index -1 is the last character.
¢ Negative indexes are an offset from the last character toward the start of the string.
For example, if the start is specified as -2, then it starts reading at the first character from the end.
If -3 is specified, then is starts 2 characters from the end.
Length

Number of characters from the start to include in the substring. Negative numbers are
interpreted as (total # of characters + length) + 1. For example, -1 represents the entire length of
the original string. If -2 is specified, the length is the entire string -1. For a string with 5
characters, a length of -1=(5+(-1)) +1=5,-2=(5+(-2)) + 1 =4, etc.
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Uppercase

Converts the characters in the enclosed tokens to uppercase.

Fields

There are no fields.
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	12 Conditions
	If AssociationPerforms a test on the association value of the current operation or the current object. The type of test performed depends on the operator specified by the operation attribute. 
	Fields
	Example

	If AttributePerforms a test on attribute values of the current object in either the current operation or the source data store. It can be logically thought of as If Operation Attribute or If Source Attribute, because the test is satisfied if the conditi
	Fields
	Example

	If Class NamePerforms a test on the object class name in the current operation.
	Fields
	Example

	If Destination AttributePerforms a test on attribute values of the current object in the destination data store. The test performed depends on the specified operator.
	Fields
	Example

	If Destination DNPerforms a test on the destination DN in the current operation. The test performed depends on the specified operator. 
	Fields
	Example

	If EntitlementPerforms a test on entitlements of the current object, in either the current operation or the Identity Vault. The test performed depends on the specified operator.
	Fields
	Example

	If Global Configuration ValuePerforms a test on a global configuration value. The test performed depends on the specified operator.
	Remark
	Fields
	Example

	If Local VariablePerforms a test on a local variable. The test performed depends on the specified operator.
	Remark
	Fields
	Example

	If Named PasswordPerforms a test on a named password from the driver in the current operation with the specified name. The test performed depends on the selected operator.
	Fields
	Example

	If OperationPerforms a test on the name of the current operation. The type of test performed depends on the specified operator.
	Fields
	Example

	If Operation AttributePerforms a test on attribute values in the current operation. The test performed depends on the specified operator.
	Fields
	Example

	If Operation Property
	Fields
	Example

	If PasswordPerforms a test on a password in the current operation. The test performed depends on the specified operator.
	Fields
	Example

	If Source AttributePerforms a test on attribute values of the current object in the source data store. The test performed depends on the specified operator. 
	Fields
	Example

	If Source DNPerforms a test on the source DN in the current operation. The test performed depends on the specified operator.
	Fields
	Example

	If XML AttributePerforms a test on an XML attribute of the current operation. The type of test performed depends on the operator specified by the operation attribute. 
	Fields
	Example

	If XPath ExpressionPerforms a test on the results of evaluating an XPath 1.0 expression.
	Fields
	Remarks
	Example


	13 Actions
	Add Association
	Fields
	Example

	Add Destination Attribute ValueAdds a value to an attribute on an object in the destination data store.
	Fields
	Example

	Add Destination Object
	Fields
	Remarks
	Example

	Add RoleInitiates a request to the Roles Based Provisioning Module (RBPM) to assign the specified role (in the Role DN field) to the specified user (in the Authorized User DN field). This field is only available if the Identity Manager server version is
	Fields
	Example

	Add ResourceInitiates a request to the Roles Based Provisioning Module (RBPM) to assign the Resource specified in the Resource DN field to an Identity. The target Identity is specified in the Authorized User DN field. This action is only available if th
	Fields
	Example

	Add Source Attribute ValueAdds the specified attribute on an object in the source data store.
	Fields
	Example

	Add Source Object
	Fields
	Example

	Append XML Element
	Fields
	Remarks
	Example

	Append XML TextAppends the specified text to the set of elements selected by the XPath expression. If Before XPath Expression is not specified, the text is appended after any existing children of the selected elements. If Before XPath Expression is spec
	Fields
	Remarks
	Example

	BreakEnds processing of the current operation by the current policy.
	Example

	Clear Destination Attribute ValueRemoves all values for the named attribute from an object in the destination data store.
	Fields
	Example

	Clear Operation Property
	Fields
	Example

	Clear Source Attribute ValueRemoves all values of an attribute from an object in the source data store.
	Fields
	Example

	Clear SSO Credential
	Fields
	Example

	Clone By XPath ExpressionsAppends deep copies of the nodes specified by the source field to the set of elements specified by the destination field. If Before XPath Expression is not specified, the non-attribute cloned nodes are appended after any existi
	Fields
	Remarks
	Example

	Clone Operation AttributeCopies all occurrences of an attribute within the current operation to a different attribute within the current operation.
	Fields
	Example

	Delete Destination ObjectDeletes an object in the destination data store.
	Fields
	Example

	Delete Source ObjectDeletes an object in the source data store.
	Fields
	Example

	Find Matching Object
	Fields
	Remarks
	Example

	For EachRepeats a set of actions for each node in a node set.
	Fields
	Remarks
	Example

	Generate EventSends a user-defined event to Novell Audit or Sentinel.
	Fields
	Remarks
	Example

	IfConditionally performs a set of actions.
	Fields
	Example

	Implement EntitlementDesignates actions that implement an entitlement so that the status of those entitlements can be reported to the agent that granted or revoked the entitlement.
	Fields
	Example

	Move Destination ObjectMoves an object into the destination data store.
	Fields
	Example

	Move Source ObjectMoves an object into the source data store.
	Fields
	Example

	Reformat Operation AttributeReformats all values of an attribute within the current operation by using a pattern.
	Fields
	Example

	Remove AssociationSends a remove association command to the Identity Vault.
	Fields
	Example

	Remove Destination Attribute ValueRemoves an attribute value from an object in the destination data store.
	Fields
	Example

	Remove RoleInitiates a request to the Roles Based Provisioning Module (RBPM) to revoke the specified role (in the Role DN field) from the specified user (in the Authorized User DN field). This field is only available if the Identity Manager server versi
	Fields
	Example

	Remove ResourceInitiates a request to the Roles Based Provisioning Module (RBPM) to revoke the specified resource (in the Resource DN field) from the specified user (in the Authorized User DN field). This field is only available if the Identity Manager 
	Fields
	Example

	Remove Source Attribute ValueRemoves the specified value from the named attribute on an object in the source data store.
	Fields
	Example

	Rename Destination ObjectRenames an object in the destination data store.
	Fields
	Example

	Rename Operation AttributeRenames all occurrences of an attribute within the current operation.
	Fields
	Example

	Rename Source ObjectRenames an object in the source data store.
	Fields
	Example

	Send Email
	Fields
	Example

	Send Email from Template
	Fields
	Example

	Set Default Attribute ValueAdds default values to the current operation (and optionally to the current object in the source data store) if no values for that attribute already exist. It is only valid when the current operation is Add.
	Fields
	Example

	Set Destination Attribute ValueAdds a value to an attribute on an object in the destination data store, and removes all other values for that attribute.
	Fields
	Example

	Set Destination PasswordSets the password for an object in the destination data store.
	Fields
	Example

	Set Local VariableSets a local variable.
	Fields
	Example

	Set Operation AssociationSets the association value for the current operation. 
	Fields
	Example

	Set Operation Class NameSets the object class name for the current operation. 
	Fields
	Example

	Set Operation Destination DNSets the destination DN for the current operation.
	Fields
	Example

	Set Operation PropertySets an operation property. An operation property is a named value that is stored within an operation. It is typically used to supply additional context that might be needed by the policy that handles the results of an operation. 
	Fields
	Example

	Set Operation Source DNSets the source DN for the current operation.
	Fields
	Example

	Set Operation Template DNSets the template DN for the current operation to the specified value. This action is only valid when the current operation is Add.
	Fields
	Example

	Set Source Attribute ValueAdds a value to an attribute on an object in the source data store, and removes all other values for that attribute.
	Fields
	Example

	Set Source PasswordSets the password for an object in the source data store. 
	Fields
	Example

	Set SSO Credential
	Fields
	Example

	Set SSO Passphrase
	Fields
	Example

	Set XML AttributeSets an XML attribute on a set of elements selected by an XPath expression.
	Fields
	Example

	Start Workflow
	Remark
	Fields
	Example

	StatusGenerates a status notification.
	Fields
	Remarks
	Example

	Strip Operation AttributeStrips all occurrences of an attribute from the current operation.
	Fields
	Example

	Strip XPath ExpressionStrips nodes selected by an XPath 1.0 expression.
	Fields
	Remarks
	Example

	Trace MessageSends a message to DSTRACE.
	Fields
	Example

	VetoVetoes the current operation.
	Example

	Veto If Operation Attribute Not AvailableConditionally cancels the current operation and ends processing of the current policy, based on the availability of an attribute in the current operation. 
	Fields
	Example

	WhileCauses the specified actions to be repeated while the specified conditions evaluate to True. 
	Fields
	Example


	14 Noun Tokens
	TextExpands to the text.
	Fields
	Example

	Added EntitlementExpands to the values of an entitlement granted in the current operation. 
	Fields
	Remarks
	Example

	AssociationExpands to the association value from the current operation. 
	Example

	AttributeExpands to the value of an attribute from the current object in the current operation and in the source data store. It can be logically thought of as the union of the operation attribute token and the source attribute token. It does not include
	Fields
	Remarks
	Example

	CharacterExpands to a character specified by a Unicode* code point.
	Remarks
	Fields
	Example

	Class NameExpands to the object class name from the current operation. 
	Example

	Destination AttributeExpands to the specified attribute value an object.
	Fields
	Remarks
	Example

	Destination DNExpands to the destination DN specified in the current operation.
	Fields
	Remarks
	Example

	Destination NameExpands to the unqualified Relative Distinguished Name (RDN) of the destination DN specified in the current operation.
	Example

	DocumentReads the XML document pointed to by the URI and returns the document node in a node set. The URI can be relative to the URI of the including policy. With any error, the result is an empty node set.
	Fields
	Example

	EntitlementExpands to the values of a granted entitlement from the current object. 
	Fields
	Remarks
	Example

	Generate PasswordGenerates a random password that conforms to the specified password policy.
	Fields
	Example

	Global Configuration ValueExpands to the value of a global configuration variable.
	Fields
	Example

	Local VariableExpands to the value of a local variable.
	Fields
	Example

	Named PasswordExpands to the named password from the driver.
	Fields
	Example

	OperationExpands to the name of the current operation.
	Example

	Operation Attribute
	Fields
	Example

	Operation PropertyExpands to the value of the specified operation property on the current operation.
	Fields
	Example

	PasswordExpands to the password specified in the current operation.
	Example

	QueryQueries the source or destination data store and returns the resulting instances.
	Fields
	Remarks
	Example

	Removed AttributeExpands to the specified attribute value being removed in the current operation. It applies only to a Modify operation.
	Fields
	Remarks
	Example

	Removed EntitlementExpands to the values of the an entitlement revoked in the current operation. 
	Fields
	Remarks
	Example

	ResolveResolves the DN to an association key, or the association key to a DN in the specified data store.
	Fields
	Example

	Source AttributeExpands to the values of an attribute from an object in the source data store. 
	Fields
	Remarks
	Example

	Source DNExpands to the source DN from the current operation.
	Fields
	Remarks
	Example

	Source NameExpands to the unqualified relative distinguished name (RDN) of the source DN specified in the current operation.
	Example

	TimeExpands to the current date/time into the format, language, and time zone specified.
	Fields
	Remark
	Example

	Unique NameExpands to a pattern-based name that is unique in the destination data store according to the criteria specified.
	Fields
	Remarks
	Example

	Unmatched Source DNExpands to the part of the source DN in the current operation that corresponds to the part of the DN that was not matched by the most recent match of an If Source DN condition.
	Fields
	Remarks
	Example

	XPathExpands to the results of evaluating an XPath 1.0 expression. 
	Fields
	Remarks
	Example


	15 Verb Tokens
	Base64 DecodeDecodes the result of the enclosed tokens from Base64-encoded data to bytes, then converts the bytes into a string by using the specified character set.
	Fields
	Example

	Base64 EncodeConverts the result of the enclosed tokens to bytes by using the specified character set, then Base64- encodes the bytes.
	Fields
	Example

	Convert TimeConverts the date and time represented by the result of the enclosed tokens from the source format, language, and time zone to the destination format, language, and time zone.
	Fields
	Remark
	Example

	Escape Destination DNEscapes the enclosed tokens according to the rules of the DN format of the destination data store.
	Example

	Escape Source DNEscapes the enclosed tokens according to the rules of the DN format of the source data store. 
	Example

	JoinJoins the values of the nodes in the node set result of the enclosed tokens, separating the values by the characters specified by delimiter. If the comma-separated values (CSV) are true, then CSV quoting rules are applied to the values.
	Fields
	Example

	LowercaseConverts the characters in the enclosed tokens to lowercase.
	Example

	MapMaps the result of the enclosed tokens from the values specified by the source column to the destination column in the specified mapping table. 
	Remarks
	Fields
	Example

	Parse DNConverts the enclosed token’s DN to an alternate format.
	Fields
	Remarks
	Example

	Replace AllReplaces all occurrences of a regular expression in the enclosed tokens.
	Fields
	Remarks
	Example

	Replace FirstReplaces the first occurrence of a regular expression in the enclosed tokens.
	Fields
	Remarks
	Example

	SplitSplits the result of the enclosed tokens into a node set consisting of text nodes based on the pattern specified by delimiter. If comma-separated values (CSV) are true, then CSV quoting rules are honored during the parsing of the string.
	Fields
	Example

	SubstringExtracts a portion of the enclosed tokens.
	Fields
	Example

	UppercaseConverts the characters in the enclosed tokens to uppercase.
	Example

	XML ParseParses the result of the enclosed tokens as XML and returns the resulting document node in a node set. If the result of the enclosed tokens is not well-formed XML or cannot be parsed for any reason, an empty node set is returned.
	Example

	XML Serialize
	Example
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	17 Pre-Identity Manager 3.5 Conditions
	If AssociationPerforms a test on the association value of the current operation or the current object. The type of test performed depends on the operator specified by the operation attribute. 
	Fields

	If AttributePerforms a test on attribute values of the current object in either the current operation or the source data store. It can be logically thought of as If Operation Attribute or If Source Attribute, because the test is satisfied if the conditi
	Fields

	If Class NamePerforms a test on the object class name in the current operation.
	Fields

	If Destination AttributePerforms a test on attribute values of the current object in the destination data store. The test performed depends on the specified operator.
	Fields

	If Destination DNPerforms a test on the destination DN in the current operation. The test performed depends on the specified operator. 
	Fields

	If EntitlementPerforms a test on entitlements of the current object, in either the current operation or the Identity Vault. The test performed depends on the specified operator.
	Fields

	If Global Configuration ValuePerforms a test on a global configuration value. The test performed depends on the specified operator.
	Remark
	Fields

	If Local VariablePerforms a test on a local variable. The test performed depends on the specified operator.
	Remark
	Fields

	If Named PasswordPerforms a test on a named password from the driver in the current operation with the specified name. The test performed depends on the selected operator.
	Fields

	If Operation AttributePerforms a test on attribute values in the current operation. The test performed depends on the specified operator.
	Fields

	If Operation Property
	Fields

	If OperationPerforms a test on the name of the current operation. The type of test performed depends on the specified operator.
	Fields

	If PasswordPerforms a test on a password in the current operation. The test performed depends on the specified operator.
	Fields

	If Source AttributePerforms a test on attribute values of the current object in the source data store. The test performed depends on the specified operator. 
	Fields

	If Source DNPerforms a test on the source DN in the current operation. The test performed depends on the specified operator.
	Fields

	If XPath ExpressionPerforms a test on the results of evaluating an XPath 1.0 expression.
	Fields
	Remarks
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	Add Association
	Fields

	Add Destination Attribute ValueAdds a value to an attribute on an object in the destination data store.
	Fields

	Add Destination Object
	Fields
	Remarks

	Add Source Attribute ValueAdds the specified attribute on an object in the source data store.
	Fields

	Add Source Object
	Fields

	Append XML Element
	Fields
	Remarks

	Append XML TextAppends the specified text to the set of elements selected by the XPath expression.
	Fields
	Remarks

	BreakEnds processing of the current operation by the current policy.
	Fields

	Clear Destination Attribute ValueRemoves all values for the named attribute from an object in the destination data store.
	Fields

	Clear Operation Property
	Fields

	Clear Source Attribute ValueRemoves all values of an attribute from an object in the source data store.
	Fields

	Clear SSO Credential
	Fields

	Clone By XPath ExpressionAppends deep copies of the nodes specified by the source field to the set of elements specified by the destination field.
	Fields
	Remarks

	Clone Operation AttributeCopies all occurrences of an attribute within the current operation to a different attribute within the current operation.
	Fields

	Delete Destination ObjectDeletes an object in the destination data store.
	Fields

	Delete Source ObjectDeletes an object in the source data store.
	Fields

	Find Matching Object
	Fields
	Remarks

	For EachRepeats a set of actions for each node in a node set.
	Fields
	Remarks

	Generate EventSends a user-defined event to Novell Audit or Sentinel.
	Fields
	Remarks

	Implement EntitlementDesignates actions that implement an entitlement so that the status of those entitlements can be reported to the agent that granted or revoked the entitlement.
	Fields

	Move Destination ObjectMoves an object into the destination data store.
	Fields

	Move Source ObjectMoves an object in the source data store.
	Fields

	Reformat Operation Attribute ValueReformats all values of an attribute within the current operation by using a pattern.
	Fields

	Remove AssociationSends a remove association command to the Identity Vault.
	Fields

	Remove Destination Attribute ValueRemoves an attribute value from an object in the destination data store.
	Fields

	Remove Source Attribute ValueRemoves the specified value from the named attribute on an object in the source data store.
	Fields

	Rename Destination ObjectRenames an object in the destination data store.
	Fields

	Rename Operation AttributeRenames all occurrences of an attribute within the current operation.
	Fields

	Rename Source ObjectRenames an object in the source data store.
	Fields

	Send EmailSends an e-mail notification.
	Fields

	Send Email from TemplateGenerates an e-mail notification by using a template.
	Fields

	Set Default Attribute ValueAdds default values to the current operation (and optionally to the current object in the source data store) if no values for that attribute already exist. It is only valid when the current operation is Add.
	Fields

	Set Destination Attribute ValueAdds a value to an attribute on an object in the destination data store, and removes all other values for that attribute.
	Fields

	Set Destination PasswordSets the password for an object in the destination data store.
	Fields

	Set Local VariableSets a local variable with the given name to the string value specified, the XPath 1.0 Node Set specified, or the Java* Object specified. 
	Fields

	Set Operation AssociationSets the association value for the current operation. 
	Fields

	Set Operation Class NameSets the object class name for the current operation. 
	Fields

	Set Operation Destination DNSets the destination DN for the current operation.
	Fields

	Set Operation PropertySets an operation property. An operation property is a named value that is stored within an operation. It is typically used to supply additional context that might be needed by the policy that handles the results of an operation. 
	Fields

	Set Operation Source DNSets the source DN for the current operation.
	Fields

	Set Operation Template DNSets the template DN for the current operation to the specified value. This action is only valid when the current operation is Add.
	Fields

	Set Source Attribute ValueAdds a value to an attribute on an object in the source data store, and removes all other values for that attribute.
	Fields

	Set Source PasswordSets the password for an object in the source data store. 
	Fields

	Set SSO Credential
	Fields

	Set SSO Passphrase
	Fields

	Set XML AttributeSets an XML attribute on a set of elements selected by an XPath expression.
	Fields
	Remarks

	StatusGenerates a status notification.
	Fields
	Remarks

	Strip Operation AttributeStrips all occurrences of an attribute from the current operation.
	Fields

	Strip XPathStrips nodes selected by an XPath 1.0 expression.
	Fields
	Remarks

	Trace MessageSends a message to DSTRACE.
	Fields

	VetoVetoes the current operation.
	Fields

	Veto If Operation Attribute Not AvailableConditionally cancels the current operation and ends processing of the current policy, based on the availability of an attribute in the current operation. 
	Fields
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	Added EntitlementExpands to the values of an entitlement granted in the current operation. 
	Fields
	Remarks

	AssociationExpands to the association value from the current operation. 
	Fields

	AttributeExpands to the value of an attribute from the current object in the current operation and in the source data store. It can be logically thought of as the union of the operation attribute token and the source attribute token. It does not include
	Fields
	Remarks

	Class NameExpands to the object class name from the current operation. 
	Fields

	Destination AttributeExpands to the specified attribute value an object.
	Fields
	Remarks

	Destination DNExpands to the destination DN specified in the current operation.
	Fields
	Remarks

	Destination NameExpands to the unqualified Relative Distinguished Name (RDN) of the destination DN specified in the current operation.
	Fields

	EntitlementExpands to the values of a granted entitlement from the current object. 
	Fields
	Remarks

	Global Configuration ValueExpands to the value of a global configuration variable.
	Fields

	Local VariableExpands to the value of a local variable.
	Fields

	Named PasswordExpands to the Named Password from the driver.
	Fields

	OperationExpands to the name of the current operation.
	Fields

	Operation AttributeExpands to the value of an attribute from the current operation. It does not include the removed values from a modify operation. 
	Fields

	Operation PropertyExpands to the value of the specified operation property on the current operation.
	Fields

	PasswordExpands to the password specified in the current operation.
	Fields

	Removed AttributeExpands to the specified attribute value being removed in the current operation. It applies only to a Modify operation.
	Fields
	Remarks

	Removed EntitlementsExpands to the values of the an entitlement revoked in the current operation. 
	Fields
	Remarks

	Source AttributeExpands to the values of an attribute from an object in the source data store. 
	Fields
	Remarks

	Source DNExpands to the source DN from the current operation.
	Fields
	Remarks

	Source NameExpands to the unqualified relative distinguished name (RDN) of the source DN specified in the current operation.
	Fields

	TextExpands to the text.
	Fields

	Unique NameExpands to a pattern-based name that is unique in the destination data store according to the criteria specified.
	Fields
	Remarks

	Unmatched Source DNExpands to the part of the source DN in the current operation that corresponds to the part of the DN that was not matched by the most recent match of an If Source DN condition.
	Fields
	Remarks

	XPathExpands to the results of evaluating an XPath 1.0 expression. 
	Fields
	Remarks
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	Escape Destination DNEscapes the enclosed tokens according to the rules of the DN format of the destination data store.
	Fields

	Escape Source DNEscapes the enclosed tokens according to the rules of the DN format of the source data store. 
	Fields

	LowercaseConverts the characters in the enclosed tokens to lowercase.
	Fields

	Parse DNConverts the enclosed token’s DN to an alternate format.
	Fields
	Remarks

	Replace AllReplaces all occurrences of a regular expression in the enclosed tokens.
	Fields
	Remarks

	Replace FirstReplaces the first occurrence of a regular expression in the enclosed tokens.
	Fields
	Remarks

	SubstringExtracts a portion of the enclosed tokens.
	Fields

	UppercaseConverts the characters in the enclosed tokens to uppercase.
	Fields



